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关于本使用说明书（功能手册）

本使用说明书（功能手册）旨在用作Panasonic集团电话的总体功能参考文件。

本使用说明书（功能手册）介绍了集团电话系统的用途，以及如何最大限度地利用其众多功能与设备。

本手册结构

本手册包含以下章节：

章节1，安全注意事项

提供有关防止人身伤害和/或财产损坏的安全注意事项详情。

章节2，呼叫处理功能

提供关于呼叫处理功能的详细说明。

章节3，统一消息系统

提供有关统一消息系统功能的详情。

章节4，网络功能

提供有关您可将集团电话连接至的公共和专用网络的详情。

章节5，系统配置与管理功能

提供关于系统配置与管理功能的详细说明。

章节6，附录

提供列有系统资源容量的表格、每种型号集团电话的专有功能、音调和振铃音图表以及本使用说明书（功

能手册）的修订记录。

功能限制

根据集团电话的软件版本，有些功能可能无效。有关哪些版本支持这些功能的详情，请咨询您的经销商。

只有下列型号支持在显示PT的LCD的第二行上显示注册姓名的功能（在下面介绍）：

• KX-DT543　KX-DT546
如果已在个人速拨号码簿或系统速拨电话号簿中注册姓名，在以下列一种方式拨打该号码簿号码时，相应姓名

将显示在显示PT的LCD的第二行上：

1. 使用该号码簿进行中继线呼叫。

2. 使用重拨键重拨在第1项中拨打的号码。

3. 使用去电呼叫记录重拨在第1项中拨打的号码。

此限制适用于下列手册和章节。

使用说明书（功能手册）

• 2.6.3  最后号码重拨

• 2.6.4  速拨—个人/系统

使用说明书（用户手册）

• 1.14.1  使用呼叫记录

• 1.14.2  使用号码簿
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使用说明书（功能手册）中可找到的参考

使用说明书（安装手册）参考

对使用说明书（安装手册）中介绍的所需安装说明标题已加以标记，供您参考。

使用说明书（PC编程手册）参考

对使用说明书（PC编程手册）中介绍的PC编程标题和参数已加以标记，供您参考。

使用说明书（PT编程手册）参考

对使用说明书（PT编程手册）中介绍的PT编程标题已加以标记，供您参考。

使用说明书（功能手册）参考

对本使用说明书（功能手册）中介绍的有关功能标题已加以标记，供您参考。

使用说明书（用户手册）参考

对使用说明书（用户手册）中介绍的执行功能所需操作已加以标记，供您参考。

缩写

本手册中使用了许多缩写（例如："PT"表示集团电话专用话机）。关于每个缩写的含义，请参考下一节中的

列表。

关于其它手册

结合使用本使用说明书（功能手册）与以下手册能帮助您安装和使用本集团电话：

使用说明书（安装手册）

提供有关集团电话的硬件安装和维护的说明。

使用说明书（PC编程手册）

提供关于使用PC进行系统编程的逐步说明。

使用说明书（PT编程手册）

提供关于使用PT进行系统编程的逐步说明。

使用说明书（用户手册）

为使用IP-PT、DPT、APT、SIP电话、SLT、电话或DSS话务台的最终用户提供操作说明。

其它信息

商标

• Microsoft和Outlook是Microsoft公司在美国和/或其它国家或地区的注册商标或商标。

• Bluetooth®文字商标和标识是Bluetooth SIG, Inc.所有的注册商标，松下电器产业株式会社使用该商标已获

得许可。

• 此处的所有其它商标均为其各自公司拥有产权。

注

• 本手册的内容适用于具有某一软件版本的集团电话，有关版本请参见本手册封面所示。请参阅使用说明

书（PC编程手册）的2.3  Frequently Asked Questions (FAQ)中的How do I confirm the software version
of the PBX or installed cards?或使用说明书（PT编程手册）中的[190]主处理（MPR）软件版本参考。

• 某些任选硬件、软件和功能在一些国家/地区或某些集团电话型号上不能使用。有关详细情况，请咨询

合格的Panasonic经销商。

• 在本手册中，PT显示和其它显示均为英文。根据国家或地区不同，也可能提供其它语言。

• 在本手册中，除非必要，否则一律省略每个型号的后缀（例如，KX-NS300CN）。
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• 所有系统编程都可以通过PC编程（®5.5.2  PC编程）进行。但是，只有一部分可以通过PT编程

（®5.5.3  PT编程）进行。在章节1呼叫处理功能和章节2系统配置与管理功能，包含3位数的编程参考

例如"000"，表示系统编程可以通过PT编程来进行。

PC编程

括号中的数字表示维护控制台的系统菜单编号。

→ 14.1  PBX Configuration—[6-1] Feature—System Speed Dial— CO Line Access Number +
Telephone Number

PT编程

括号中的数字表示进行PT编程时输入的编程号码。

→ [001]系统速拨号码

有关详情，请参阅使用说明书（PC编程手册）和使用说明书（PT编程手册）。
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缩写列表

A
AA

自动值机员

ACD
自动呼叫分配

ANI
号码自动识别

AOC
话费通知

APT
集团电话专用话机（模拟式）

ARS
自动路由选择

B
BGM

背景音乐

C
CCBS

完成对占线用户的呼叫

CDPG
呼叫分配端口群

CF
呼叫转送─用ISDN

CLI
呼叫线路识别

CLIP
呼叫线路识别显示

CLIR
呼叫线路识别限制

CNIP
呼叫姓名识别显示

CNIR
呼叫姓名识别限制

COLP
连接线路识别显示

COLR
连接线路识别限制

CONP
连接姓名识别显示

CONR
连接姓名识别限制

COS
服务等级

CPC
呼叫方控制

CT
呼叫转移─用ISDN

CTI
电脑电话集成

D
DDI

直接拨入

DHCP
动态主机配置协议

DID
直接向内拨号

DIL
外线直接到分机振铃的功能

DISA
直接拨入系统接入

DND
免打扰

DPT
集团电话专用话机（数字式）

DSS
直接分机选择

DTMF
双音多频

E
EFA

外部功能接入
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F
FWD

呼叫转送

G
G-CO

群-CO

I
ICD

来电呼叫分配

ICMP
互联网控制消息协议

IP-PT
IP专用话机

IRNA
截取路由─无应答

ISDN
综合业务数字网

L
L-CO

环路-CO

LCS
现场呼叫屏蔽

LED
发光二极管

M
MCID

恶意电话识别

MSN
多个用户号码

N
NDSS

网络直接分机选择

NTP
网络时间协议

O
OGM

外播留言

OHCA
摘机呼叫通知

P
P2P

对等

PDN
主要号码簿号码

PIN
个人识别号码

PING
互联网包探测器

P-MP
点到多点

P-P
点到点

PRI
主要速率接口

P-SIP
Panasonic SIP电话（KX-HDV系列）

PT
集团电话专用话机

S
S-CO

单-CO

SDN
次要号码簿号码

SIP
会话初始协议

SLT
单线电话

SMDR
电话通信详细记录

SNMP
简单网络管理协议
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T
TAFAS

从任意用户电话应答中继线上的呼叫

TEI
终端端点识别器

TRG
中继线群

TRS/限制

长途限制/呼叫限制

U
UCD

均匀呼叫分配

UM
统一消息

UPS
不间断电源

V
VM

语音信箱

VoIP
通过互联网传输语音协议

VPN
虚拟专用网

VPS
语音处理系统

X
XDP

附加设备端口
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章节  1
安全注意事项
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1.1  安全注意事项

1.1.1  安全注意事项

说明

为防止人身伤害和/或财产损失，请务必遵守以下安全预防措施。

下列符号对不当操作或使用本机时所造成的危险以及伤害的级别进行了分类和说明。

表示预想可能造成轻微人身伤害或机器损坏的危险。

以下符号类型用于分类和说明需要遵守的指示类型。

此符号用于提醒用户留意必须遵守安全操作本机的特定操作步骤。
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• 允许用户接入网络的TRS/限制和ARS功能中所含软件必须升级，以便识别新建立并投入使用的网络区域代

码和交换代码。如果没有升级集团电话系统内部设置或外围设备，导致不能识别新建立的代码，将会限制

集团电话的客户和用户接入网络和这些代码。

请保持软件与最新数据同步更新。

• 以下情况下可能会存在欺诈呼叫的危险：

– 第三方发现了集团电话的个人识别号码（PIN）（验证代码PIN或分机PIN）。

– 使用DISA的中继线间通话功能。

此类呼叫将向集团电话的所有者/租用者收费。为保护集团电话免受此类欺诈使用，我们强烈建议：

a. 对PIN进行保密。

b. 选择不容易猜到的复杂、随机PIN。

c. 定期更改PIN。

• 关于帐户密码，对管理员或安装人员的要求

1. 请将所有的系统密码提供给顾客。

2. 为了防止未经授权的访问和滥用集团电话，请保管好密码，并且告知顾客密码的重要性，以及向他人泄

露的危害。

3. 集团电话在初始情况下没有设定密码。为安全起见，请在现场安装集团电话系统时尽快选择安装者密

码。

4. 定期更改密码。

5. 强烈建议使用10个数字或字符的密码，尽可能避免未经授权的访问。
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章节  2
呼叫处理功能
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2.1  来电功能

2.1.1  中继线呼叫来电功能

2.1.1.1  中继线呼叫来电功能—概要

说明

通过中继线（公共线路）的来电呼叫按照几种分配方法中的一种被分配到它们的目的地。

1. 每种卡类型的可用网络类型

可以为任选中继卡或主板的每个中继线端口指定一种网络类型：公共、专用或VPN（虚拟专用网）。

卡类型 信道/协议类型

网络类型

公共（DIL/DID/
DDI/MSN）

专用（TIE）*1 虚拟专用网

（VPN）

主板

(V-IPGW)
H.323

ü ü* ü

主板

(V-SIPGW)
SIP

ü*
  

LCOT — ü*   

PRI CO ü*  ü*2

分机    

QSIG-主  ü*  

QSIG-从  ü*  

E1 DR2 ü* ü

ü*：允许（默认）；ü ：允许
*1 ® 4.3.1  TIE线路业务
*2 ® 4.3.3  ISDN虚拟专用网（ISDN-VPN）

2. 分配方法

可以将下面其中一种方法指定给每个中继线端口：

方法 说明与参考

外线直接到分机振铃的功能

（DIL）
将呼叫直接接入预编程设定的单一目的地（例如：话务员）。

® 2.1.1.2  外线直接到分机振铃的功能（DIL）
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方法 说明与参考

直接向内拨号（DID） 将具有来自DID线路的DID号码的呼叫直接接入预编程设定的目的

地。

DID也被称为直接拨入（DDI）。

® 2.1.1.3  直接向内拨号（DID）/直接拨入（DDI）

多个用户号码（MSN）振铃服

务

将具有来自ISDN线路的MSN的呼叫直接接入预编程设定的目的地。

® 2.1.1.4  多个用户号码（MSN）振铃服务

3. 根据来电的识别号码改变目的地

呼叫线路识别（CLI）分配功能与DIL/DID/DDI/MSN功能一起工作。

功能 说明与参考

呼叫线路识别（CLI）分配 如果来电的识别号码已在来电显示表中指定，则将呼叫直接接入CLI
目的地。

® 2.1.1.5  呼叫线路识别（CLI）分配

4. 每种任选中继卡类型的可用分配功能

中继卡类型 信道类型
功能

DIL DID/DDI MSN

主板

(V-IPGW)
— ü ü*

主板

(V-SIPGW)
— ü ü*

LCOT — ü*

PRI CO ü ü*

E1 DR2 ü ü*

ü*：允许（默认）；ü ：允许

5. 可用目的地

目的地 可用性

有线分机（PT/SLT/SIP分机/ISDN分机） ü

来电呼叫分配群 ü

UM群 ü

语音信箱群（DTMF/DPT） ü

外部广播机（TAFAS） ü
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目的地 可用性

DISA ü

模拟/ISDN远程维护 ü

空闲线路接入号码 + 电话号码

中继线群接入号码 + 中继线群号码 + 电话号码

其它集团电话分机（无集团电话代码的TIE） ü

其它集团电话分机（带集团电话代码的TIE）

6. 截取路由

设定分配后，可能还需要设定以下功能。

功能 说明与参考

截取路由 无应答（IRNA） 如果在预编程设定的时间内（截接时间）被叫方没有应

答呼叫，呼叫就会被转接到预编程设定的目的地。

® 2.1.1.6  截取路由

占线/免打扰 如果被叫方占线或处于DND方式，呼叫就会被转接到预

编程设定的目的地。

® 2.1.1.6  截取路由

无目的地 如果没有指定目的地，呼叫就被转接到话务员。

® 2.1.1.7  截取路由—无目的地

使用说明书（PC编程手册）参考

18.2  PBX Configuration—[10-2] CO & Incoming Call—DIL Table & Port Settings—DIL— Trunk Property
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2.1.1.2  外线直接到分机振铃的功能（DIL）
说明

将中继线呼叫来电自动接入预编程设定的目的地。根据时间方式的不同（白天/午餐/休息/夜间），每条中继线都

有相应的目的地。

[方法流程图]

CLI

Yes

Yes

No

No

DIL

CLI

—

Yes

No

* CLI

     CLI DIL

     CLI

CLI

DIL

CLI* CLI

[DIL表的编程示例]
可以针对每条中继线对该表进行编程。

中继线号

码

CLI 目的地*1

白天 午餐 ... 白天 午餐 ...

01 允许 停用 ... 101 100 ...

02 允许 停用 ... 102 100 ...
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中继线号

码

CLI 目的地*1

白天 午餐 ... 白天 午餐 ...

: : : : : : :

*1 ® 18.2  PBX Configuration—[10-2] CO & Incoming Call—DIL Table & Port Settings—DIL— DIL Destination—Day,
Lunch, Break, Night

注

也可在DIL表中指定以下设定：

• 租户号码：确定对应中继线的时间方式（白天/午餐/休息/夜间）。

• UM服务群号码：确定统一消息系统处理呼叫时要使用的服务群。

• VM中继线群号码：用在带VPS的语音信箱DPT（数字）集成当中。

解释：

如果从中继线01上收到一个中继线呼叫；

白天方式：允许CLI。路由到CLI目的地。

午餐方式：停用CLI。路由到DIL目的地，分机100。

使用说明书（PC编程手册）参考

18.2  PBX Configuration—[10-2] CO & Incoming Call—DIL Table & Port Settings—DIL
→ DIL Destination—Day, Lunch, Break, Night
→ Tenant Number
→ UM Service Group No.
→ VM Trunk Group No.

使用说明书（PT编程手册）参考

[450] DIL 1:1目的地

使用说明书（功能手册）参考

2.1.1.5  呼叫线路识别（CLI）分配

3.2.1.39  服务群

5.1.3  租户业务

5.1.4  定时服务

6.1  系统资源的容量

26 使用说明书（功能手册）

2.1.1 中继线呼叫来电功能



2.1.1.3  直接向内拨号（DID）/直接拨入（DDI）
说明

将具有DID/DDI号码的来电自动接入预编程设定的目的地。根据时间方式的不同（白天/午餐/休息/夜间），每个

DID/DDI号码都有相应的目的地。

带有匹配本集团电话分机号码的DID/DDI号码的来电将被发送到相应的分机。带有匹配其它集团电话分机号码

或中继线接入号码的DID/DDI号码的来电将被发送到相应的TIE线路或中继线。

[方法流程图]

CLI

Yes

Yes

No

No

No

Yes

Yes

No

Yes

Yes

No

No

DID/DDI DID/DDI

CLI* CLI

CLI  

DID/DDI

CLI DID/DDI

* CLI

CLI DID/DDI

CLI

DID/DDI

DID/DDI

TIE

[DID/DDI表的编程示例]
可以把DDI编程设定为DID。
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位置 号码*1 姓名*2
CLI*3 目的地*4

白天 午餐 ... 白天 午餐 ...

0001 123-4567 John
White

允许 停用 ... 105 100 ...

0002 123-2468 Tom
Smith

允许 停用 ... 102 100 ...

0003 123-456 A公司 允许 停用 ... 101 101 ...

: : : : : : : : :

*1 ® 18.3  PBX Configuration—[10-3] CO & Incoming Call—DDI / DID Table— DDI / DID Number
*2 ® 18.3  PBX Configuration—[10-3] CO & Incoming Call—DDI / DID Table— DDI / DID Name
*3 ® 18.3  PBX Configuration—[10-3] CO & Incoming Call—DDI / DID Table— CLI Ring for DDI/DID—Day, Lunch,

Break, Night
*4 ® 18.3  PBX Configuration—[10-3] CO & Incoming Call—DDI / DID Table— DDI / DID Destination—Day, Lunch,

Break, Night

注

也可在DID/DDI表中指定以下设定：

• 租户号码：确定对应中继线的时间方式（白天/午餐/休息/夜间）。

• UM服务群号码：确定统一消息系统处理呼叫时要使用的服务群。

• VM中继线群号码：用在带VPS的语音信箱DPT（数字）集成当中（®2.28.3  语音信箱DPT（数字）集

成）。

解释：

如果DID/DDI号码是"123-4567"：
1. 检查表中的号码。

®与位置0001上的号码匹配。

2. 检查时间方式。

白天方式：允许CLI。路由到CLI目的地。

午餐方式：停用CLI。路由到DID/DDI目的地，分机100。

条件

• 若要使用该功能，必须将DID/DDI服务指定为一个中继线端口的分配方法。

• 修改DID/DDI号码

可以修改收到的DID/DDI号码，这在对DID/DDI表进行编程时可能很方便。可以在中继线端口基础上对修改

方法（删除的位数/增加的号码）进行编程。

[修改示例]

6

10

DID/DDI 87654321

DID/DDI 876543  21 = 1021

1) 6 2) "10"
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• 数字码间时间

当数字码间时间到期时，集团电话停止接收DID/DDI号码并开始检查DID/DDI表。（参考以上[DID/DDI表的

编程示例]）。
在DID/DDI表上找到了接收号码后，即使数字码间时间未到期，集团电话也会停止接收DID/DDI号码。然

后，集团电话将呼叫路由到相应的目的地。如果接收号码与表中的多个条目相匹配，该呼叫将被转接到第

一个与其匹配的条目的目的地。

[示例]
如果在午餐方式下收到一个呼叫；

接收号码 目的地 解释

123-4567 分机100 接收到"7"后，集团电话在表的位置0001上找到了匹配

号码。因此，呼叫就被路由到分机100。

123-456 分机101 接收到"6"后，数字码间时间到期。集团电话在表的位置

0003上找到了匹配号码。因此，呼叫就被路由到分机

101。

使用说明书（PC编程手册）参考

10.3  PBX Configuration—[2-3] System—Timers & Counters—Miscellaneous— Incoming Call Inter-digit
Timer—DDI / DID (s)
18.2  PBX Configuration—[10-2] CO & Incoming Call—DIL Table & Port Settings—DDI / DID / TIE / MSN

→ Distribution Method
→ DDI/DID/TIE/MSN—Remove Digit
→ DDI/DID/TIE/MSN—Additional Dial

18.3  PBX Configuration—[10-3] CO & Incoming Call—DDI / DID Table

使用说明书（PT编程手册）参考

[451] DID号码

[452] DID名称

[453] DID目的地

使用说明书（功能手册）参考

2.1.1.5  呼叫线路识别（CLI）分配

3.2.1.39  服务群

5.1.3  租户业务

5.1.4  定时服务

6.1  系统资源的容量
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2.1.1.4  多个用户号码（MSN）振铃服务

说明

将具有MSN的来电ISDN-BRI（基本速率接口）线路呼叫自动接入预编程设定的目的地。一个ISDN-BRI端口最

多能支持10个MSN。根据时间方式的不同（白天/午餐/休息/夜间），每个MSN都有相应的目的地。

ISDN配置必须选择点到多点。在中国，此功能可能不可用。有关详细情况，请咨询合格的Panasonic经销商。

[方法流程图]

CLI

Yes

Yes

No
CLI*

CLI

No

CLI

MSN CLI

No

Yes

Yes

MSN  

MSN

MSN

 

No

* CLI

CLI MSN

CLI

No
MSN

MSN

Yes
—

—

[ISDN BRI端口1的MSN表编程示例]
可以对每个ISDN-BRI端口的MSN表进行编程。每个BRI端口有10个MSN位置。

® 18.4  PBX Configuration—[10-4] CO & Incoming Call—MSN Table
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位置 号码 姓名
CLI 目的地

白天 午餐 ... 白天 午餐 ...

01
123-
4567

A公司 允许 停用 ... 101 100 ...

02
123-
2468

C公司 允许 停用 ... 102 100 ...

: : : : : : : : :

10 : : : : : : : :

注

也可在MSN表中指定以下设定：

• 租户号码：确定对应中继线的时间方式（白天/午餐/休息/夜间）。

• UM服务群号码：确定统一消息系统处理呼叫时要使用的服务群。

• VM中继线群号码：用在带VPS的语音信箱DPT（数字）集成当中。

解释：

如果从BRI端口1收到MSN "123-4567"：
1. 检查表中的号码。

®与位置01上的号码匹配。

2. 检查时间方式。

白天方式：允许CLI。路由到CLI目的地。

午餐方式：停用CLI。路由到MSN目的地，分机100。

条件

• 若要使用该功能，必须将MSN服务指定为一个中继线端口的分配方法。

• 修改MSN
可以修改收到的MSN使其更短，这在对MSN表进行编程时可能很方便。可以在中继线端口基础上对修改方

法（删除的位数/增加的号码）进行编程。

[修改示例]

6

10

DID/DDI 87654321

DID/DDI 876543  21 = 1021

1) 6 2) "10"

• 当使用BRI的点到多点配置时，请勿将另一个ISDN终端设备与集团电话并联。因为BRI一次只能使用两个

信道，其它ISDN终端设备可能会独占这两个信道。

使用说明书（PC编程手册）参考

18.2  PBX Configuration—[10-2] CO & Incoming Call—DIL Table & Port Settings—DDI / DID / TIE / MSN
→ Distribution Method

使用说明书（功能手册） 31

2.1.1 中继线呼叫来电功能



→ DDI/DID/TIE/MSN—Remove Digit
→ DDI/DID/TIE/MSN—Additional Dial

18.4  PBX Configuration—[10-4] CO & Incoming Call—MSN Table

使用说明书（功能手册）参考

2.1.1.5  呼叫线路识别（CLI）分配

3.2.1.39  服务群

5.1.3  租户业务

5.1.4  定时服务

6.1  系统资源的容量
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2.1.1.5  呼叫线路识别（CLI）分配

说明

当中继线呼叫来电的识别号码（例如：来电显示）与用作来电显示表的系统速拨表中的号码匹配时，将该来电

直接接入预编程设定的目的地。每个来电显示号码（各系统速拨号码的电话号码）都可以有它自己的目的地。

CLI功能 说明与参考

来电显示 从模拟中继线发送来电号码。

® 2.19.1  来电显示

呼叫线路识别显示（CLIP） 从ISDN线路发送来电号码。

® 4.1.2.2  呼叫/连接线路识别显示（CLIP/COLP）

号码自动识别（ANI） 从E1线路发送来电号码。

® 2.29.1  E1线路业务

CLI总是结合以下呼叫分配方法工作：

a. DIL
b. DID/DDI
c. MSN振铃服务

每条中继线（对于DIL）和DID/DDI/MSN号码都可以允许或停用每种时间方式（白天/午餐/休息/夜间）的CLI功
能（® 5.1.4  定时服务）。

当呼叫有来电显示信息，而且该时间方式下允许CLI，则将用CLI方法处理呼叫。

[CLI的系统速拨表编程示例]
位置

（系统速拨号码）
系统速拨名称*1 电话号码*2 CLI目的地*3

000 ABC公司 901234567890 200

001 : : :

: : : :

*1 ® 14.1  PBX Configuration—[6-1] Feature—System Speed Dial— Name
*2 ® 14.1  PBX Configuration—[6-1] Feature—System Speed Dial— CO Line Access Number + Telephone Number
*3 ® 14.1  PBX Configuration—[6-1] Feature—System Speed Dial— CLI Destination

解释：

如果来电号码是"0123-456-7890"（不考虑中继线接入号码）：

1. 检查表中的号码。

®与位置000上的号码匹配。

2. 呼叫被路由到CLI目的地，分机200。

条件

• 自动修改来电显示号码
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在通过自动修改来电显示号码进行修改后使用来电显示号码。（® 2.19.1  来电显示）

使用说明书（PC编程手册）参考

18.2  PBX Configuration—[10-2] CO & Incoming Call—DIL Table & Port Settings—CLI for DIL— CLI Ring
for DIL—Day, Lunch, Break, Night
18.3  PBX Configuration—[10-3] CO & Incoming Call—DDI / DID Table— CLI Ring for DDI/DID—Day, Lunch,
Break, Night
18.4  PBX Configuration—[10-4] CO & Incoming Call—MSN Table— CLI Ring for MSN—Day, Lunch, Break,
Night
14.1  PBX Configuration—[6-1] Feature—System Speed Dial

→ Name
→ CO Line Access Number + Telephone Number
→ CLI Destination

使用说明书（PT编程手册）参考

[001]系统速拨号码

[002]系统速拨名称

使用说明书（功能手册）参考

2.1.1.2  外线直接到分机振铃的功能（DIL）
2.1.1.3  直接向内拨号（DID）/直接拨入（DDI）
2.1.1.4  多个用户号码（MSN）振铃服务

2.6.4  速拨—个人/系统
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2.1.1.6  截取路由

说明

提供中继线和内线电话来电的自动转接。有如下三种截取路由类型：

功能 说明

截取路由—无应答（IRNA） 如果在预编程设定的时间内（IRNA定时器）被叫方没有应答呼叫，呼

叫就会被转接到预编程设定的目的地。

截取路由—占线 如果被叫方已在处理一个呼叫，新的呼叫将按如下方式处理：

– 该呼叫会被转接到预编程的截取器由—占线目的地。

– 如果未允许截取路由—占线目的地，来电者将听到忙音。但是，

如果通过LCOT卡拨打电话，来电者将听到回铃音。

截取路由—免打扰 如果被叫方处于DND方式，呼叫就会被转接到预编程设定的目的地。

可将截取目的地分配给分机端口。

® 12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Intercept
Destination— Intercept Destination—When called party does not answer—Day, Lunch, Break, Night

原目的地： 可用的截取目的地：

• 有线分机（PT/SLT/SIP分机） 分配给原分机的目的地。

12.1.1  PBX Configuration—[4-1-1]
Extension—Wired Extension—Extension
Settings—Intercept Destination
→ Intercept Destination—When called party

does not answer—Day, Lunch, Break, Night
→ Intercept Destination—When Called Party is

Busy

• ICD群 分配给群的ICD群溢出目的地（® 2.2.2.7  溢出功能）

® 11.5.1  PBX Configuration—[3-5-1] Group—In-
coming Call Distribution Group—Group
Settings—Overflow No Answer— Time out & Man-
ual Queue Redirection—Destination-Day, Lunch,
Break, Night

• UM群 分配给UM群的第一部分机的目的地。

• 语音信箱群（DTMF/DPT） 分配给VM群的第一部分机的目的地。
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原目的地： 可用的截取目的地：

• DISA*1 如果在使用DISA拨打电话时所有的DISA端口都占线，

可以通过系统编程选择以下选项之一：

• 停用：向来电者发送忙音。使用模拟中继线时，

会发送回铃音。

• 话务员：呼叫将转接给话务员。

• AA-0，AA-9：呼叫将转接到分配给该AA号码的

目的地。

® 13.3.1  PBX Configuration—[5-3-1] Optional De-
vice—Voice Message—DISA System—Option 1—
DISA Intercept—Intercept when all DISA ports are
busy

• 外部广播机（TAFAS）*2

• 模拟/ISDN远程维护

• 其它集团电话分机（无集团电话代码的TIE）

不可分配（截取路由不可用。）

*1 只有在所有的直接拨入系统接入（DISA）端口都占线时，DISA的截取路由才将转接呼叫。一旦呼叫通过使用DISA功
能到达目的地分机，将使用分机的截取路由功能。

*2 通过向外部广播机分配虚拟PS的转送目的地，并向虚拟PS分配截取路由目的地，可将到达这些目的地的呼叫转接到虚

拟PS的截取路由目的地。

FWD Destination

< PS >

Ext. No. of the Virtual PS

2001 600

......

"600"

Intercept Destination

< PS >

...

...

...

2001 1001 1001 1001 1001

Day Lunch Break Night

...... ... ... ...

Ext. No. of the Virtual PS

2001

IRNA 600

1001

可以为每种时间方式（白天/午餐/休息/夜间）编程设定不同的截接目的地。

[可用的截接目的地]

截接目的地 可用性

有线分机（PT/SLT/SIP分机/ISDN分机） ü
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截接目的地 可用性

来电呼叫分配群 ü

UM群 ü

语音信箱群（DTMF/DPT） ü

外部广播机（TAFAS） ü

DISA ü

模拟/ISDN远程维护 ü

空闲线路接入号码 + 电话号码 ü

中继线群接入号码 + 中继线群号码 + 电话号码 ü

其它集团电话分机（无集团电话代码的TIE） ü

其它集团电话分机（带集团电话代码的TIE） ü

截取至外线目的地的呼叫

当分机接收到内线、中继线或DISA呼叫并使用FWD—全部电话或FWD—占线将其转移到外线目的地时，如果

外线目的地正忙或没有应答，可以使用截取路由功能。例如，当使用FWD—全部电话将呼叫转移到移动电话，

而移动电话正忙，该呼叫将被路由至集团电话中的语音信箱。

在下列情况下，当使用FWD—无应答转移呼叫时，也可以使用此功能：

– 转移目的地位于专用网络内并且正忙或没有应答。

– 转移目的地位于公共网络内并没有应答。

但是，当使用FWD—无应答将呼叫转移到正忙的公共网络中的目的地时，此功能不可用。

条件

• 截取路由—免打扰开/关
截取路由—免打扰可以通过系统编程允许或停用。

如果停用，将依据呼叫到达所通过的线路类型启动以下选项之一：

a. LCOT卡：中继线呼叫来电将在原目的地振铃，同时主叫方听到回铃音。

b. 其它中继卡：给主叫方发送忙音。

• 如果截接目的地不能接收呼叫：

a. 截取路由—无应答：截接定时器将在原目的地重新启动，直到呼叫被应答。

b. 截取路由—占线/免打扰：当呼叫通过LCOT卡到达时，呼叫将被送回原目的地。当电话通过其它中继卡

到达时，主叫方将听到忙音。

• 空闲分机搜索

如果某分机是空闲分机搜索群中的一员，至该分机的呼叫将不会被截取路由—占线/免打扰转接。如果分机

占线或处于DND方式，至该分机的呼叫将被转接至空闲分机搜索群中的下一个分机。

• 内线电话的截取路由可以在系统基础上允许或停用。

® 18.5  PBX Configuration—[10-5] CO & Incoming Call—Miscellaneous— Intercept—Intercept Routing
for Extension Call

• IRNA定时器

可以在系统基础和分机基础上为每种时间方式（白天、午餐、休息、夜间）设定IRNA定时器。
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® 12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Intercept No
Answer Time— Intercept No Answer Time—Day, Lunch, Break, Night

• 每种时间方式的截取路由目的地均不适用截取路由—占线。当原目的地占线时，呼叫将被转接到通过系统

编程分配的截取路由—占线目的地。如果没有分配目的地，来电者将听到忙音。

• 为到达分机和UM群的中继线呼叫选择的时间方式是在租户基础上确定的。

• 截取至外线目的地的呼叫

– LCOT的此功能取决于反向信号检测的设定。（® 2.5.4.5  反向电路）

– 此功能是否可用取决于电话网络的规格。

– 从SIP分机进行原始呼叫时，此功能不可用。

使用说明书（PC编程手册）参考

10.3  PBX Configuration—[2-3] System—Timers & Counters
→Dial / IRNA / Recall / Tone— Intercept Routing No Answer (IRNA)—Day (s), Lunch (s), Break (s), Night
(s)
→DISA / Door / Reminder / U. Conf— DISA—Intercept Timer—Day (s), Lunch (s), Break (s), Night (s)

11.5.1  PBX Configuration—[3-5-1] Group—Incoming Call Distribution Group—Group Settings—Overflow No
Answer— Time out & Manual Queue Redirection—Destination-Day, Lunch, Break, Night
12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings

→Intercept Destination
→Intercept No Answer Time

13.3.1  PBX Configuration—[5-3-1] Optional Device—Voice Message—DISA System—Option 1— DISA
Intercept—Intercept when all DISA ports are busy
18.5  PBX Configuration—[10-5] CO & Incoming Call—Miscellaneous

→ Intercept—Intercept Routing - DND (Destination sets DND.)
→ Intercept—Routing to Operator - No Destination (Destination is not programmed.)
→ Intercept—Intercept Routing for Extension Call

使用说明书（PT编程手册）参考

[203]截接时间

[604]分机截接目的地

[625]溢出时间终了的目的地

使用说明书（功能手册）参考

2.3  呼叫转送（FWD）/免打扰（DND）功能
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2.1.1.7  截取路由—无目的地

说明

为没有指定目的地的中继线呼叫来电提供自动转接。截接目的地是话务员（租户/集团电话）。

条件

• 截取路由—无目的地开/关
通过系统编程，可以允许或停用截取路由—无目的地功能。

如果停用，将给主叫方发送挂机重拨音。然而，对于通过LCOT卡的呼叫而言，即使停用截取路由—无目的

地功能，此功能仍然有效。

• 如果没有指定话务员（租户/集团电话）：

连接到最小编号端口且准备好接收呼叫的分机将是截接目的地。

• 截取路由—无目的地也适用于来自门电话的呼叫。

使用说明书（PC编程手册）参考

10.2  PBX Configuration—[2-2] System—Operator & BGM— PBX Operator—Day, Lunch, Break, Night
18.5  PBX Configuration—[10-5] CO & Incoming Call—Miscellaneous— Intercept—Routing to Operator -
No Destination (Destination is not programmed.)

使用说明书（PT编程手册）参考

[006]话务员分配

使用说明书（功能手册）参考

5.1.5  话务员功能
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2.1.2  内部通话功能

2.1.2.1  内部通话功能—概要

说明

有以下内部通话类型可用：

功能 说明与参考

内线电话 从一部分机到另一部分机的呼叫。

® 2.5.3  内线电话

门电话呼叫 当来自门电话的呼叫到达其目的地时，受话人可以与来访者通话。

® 2.18.1  门电话呼叫

[可用目的地]
在门电话端口基础上，可以为每种时间方式（白天/午餐/休息/夜间）（® 5.1.4  定时服务）指定门电话呼叫的目

的地。

目的地
呼叫来自

分机 门电话

有线分机（PT/SLT/SIP分机/ISDN分机） ü ü

来电呼叫分配群 ü ü

UM群 ü ü

语音信箱群（DTMF/DPT） ü ü

外部广播机（TAFAS） ü ü

DISA   

模拟/ISDN远程维护 ü  

空闲线路接入号码 + 电话号码 ü ü

中继线群接入号码 + 中继线群号码 + 电话号码 ü ü

其它集团电话分机（无集团电话代码的TIE） ü ü

其它集团电话分机（带集团电话代码的TIE） ü ü

ü：可用

使用说明书（PC编程手册）参考

13.1  PBX Configuration—[5-1] Optional Device—Doorphone— Destination—Day, Lunch, Break, Night
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使用说明书（PT编程手册）参考

[720]门电话呼叫目的地
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2.1.2.2  内部通话阻止

说明

在COS基础上可以限制内部通话。通过为每个COS指定限制哪些COS目的地，可以实现上述功能。

[编程示例]

主叫方
被叫方

COS 1 COS 2 COS 3 ...

COS 1     

COS 2  ü ü ü

COS 3 ü ü  ü

: : : : :

ü：限制

解释：

a. COS 1分机能给全部分机打电话。

b. COS 2分机只能给COS 1目的地打电话。（COS 2分机不能给COS 2目的地打电话。）

c. COS 3分机只能给COS 3目的地打电话。

COS 1

100 101

COS 2

102 103

COS 3

104 105 106

条件

• 限制的分机号码不能用作功能设定（例如：呼叫转送）的参数。

• 所有分机都能拨打话务员呼叫（® 5.1.5  话务员功能），不论是否有内部通话阻止。

• 该功能还可以在指定给分机和门电话端口的COS基础上限制从分机呼叫门电话。（® 2.18.1  门电话呼叫）

42 使用说明书（功能手册）

2.1.2 内部通话功能



使用说明书（PC编程手册）参考

10.7.3  PBX Configuration—[2-7-3] System—Class of Service—Internal Call Block— COS Number of the
Extension Which Receive the Call from Other Extension 1–64
11.5.1  PBX Configuration—[3-5-1] Group—Incoming Call Distribution Group—Group Settings—Main—
COS
12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Main— COS
13.1  PBX Configuration—[5-1] Optional Device—Doorphone— COS
13.4  PBX Configuration—[5-4] Optional Device—External Relay— COS Number

使用说明书（功能手册）参考

5.1.1  服务等级（COS）
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2.1.3  来电指示功能

2.1.3.1  来电指示功能—概要

说明

来电指示方法有如下几种：

类型 功能 说明与参考

振铃音 振铃音类型选择 收到呼叫时电话振铃。对于每种来电类型，可以改

变振铃音的类型。

® 2.1.3.2  振铃音类型选择

语音呼叫 交替接收—振铃/话音 通过个人编程，PT用户可以选择用振铃音或用话音

接收内线电话。

® 2.5.3  内线电话

LED
（发光二极管）

LED指示 该灯用各种灯图案表示线路状况。

® 2.21.3  发光二极管提示

显示器（来电信息） 显示信息 该显示器显示来电信息。

® 2.21.4  显示信息

外部广播机 从任意用户电话应答中

继线上的呼叫（TA-
FAS）

当收到呼叫时，外部广播机发送振铃音。

® 2.17.2  从任意用户电话应答中继线上的呼叫

（TAFAS）

在通话过程中的音频/话
音

呼叫等待 占线分机从话筒/内置扬声器听到音频或话音，提示

另一个来电正在等待。

® 2.1.3.3  呼叫等待
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2.1.3.2  振铃音类型选择

说明

可以为每种来电类型选择到达分机的振铃音类型。

[振铃音类型]

1 280 *

S-

*：振铃音的时间长短可能因国家/地区不同而不同。

[振铃音类型表]
振铃音类型表分为三部分，每部分都含有指定数目的类型方案。

振铃音类型表分类如下：

• 中继线呼叫来电：每种类型方案都可以为各中继线群指定一个振铃音类型。

® 10.8.1  PBX Configuration—[2-8-1] System—Ring Tone Patterns—Call from CO
• 门电话呼叫来电：每种类型方案都可以为各门电话指定一个振铃音类型。

® 10.8.2  PBX Configuration—[2-8-2] System—Ring Tone Patterns—Call from DOORPHONE
• 其它：每种类型方案都可以为内线电话来电指定一个振铃音类型，也可以为某些功能（例如：定时提醒）

指定振铃音。

® 10.8.3  PBX Configuration—[2-8-3] System—Ring Tone Patterns—Call from Others
到达某一分机的振铃音类型由通过系统编程指定给该分机的类型方案来确定。

[振铃音类型表的编程示例]

表编号
内线电话/
保留重呼

中继线呼叫/
保留重呼

门电话呼叫
定时提醒 回叫 LCS

外部传感

器
TRG1 ... 端口1 ...

1 双 单 单

2 单 双 双

: : : : : : : : : :

条件

• 通过系统编程可以允许或停用"PT Ring Off Setting（PT振铃关闭设定）"。如果停用，PT用户将无法关闭

自己分机的来电振铃。
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• 有关S-CO键、G-CO键、L-CO键、ICD群键、内线键、PDN键及SDN键的振铃音，可以通过个人编程在30
个振铃音指定其中一个。

• 对于一个编号分机功能，可以单独设定主分机和副分机的振铃音类型。（® 2.11.11  一个编号分机）

使用说明书（PC编程手册）参考

10.8.1  PBX Configuration—[2-8-1] System—Ring Tone Patterns—Call from CO— Ring Tone Pattern Plan
1–8
10.8.2  PBX Configuration—[2-8-2] System—Ring Tone Patterns—Call from DOORPHONE— Ring Tone
Pattern Plan 1–8
10.8.3  PBX Configuration—[2-8-3] System—Ring Tone Patterns—Call from Others— Extension—Ring Tone
Pattern Plan 1–8
10.9  PBX Configuration—[2-9] System—System Options—Option 1— PT Operation—PT Ring Off Setting
12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings

→Option 1— Ring Pattern Table
→Option 6— ICM Tone

12.1.4  PBX Configuration—[4-1-4] Extension—Wired Extension—Flexible Button— Optional Parameter
(Ringing Tone Type Number) (for Loop CO, Single CO, Group CO, ICD Group, SDN)

使用说明书（功能手册）参考

6.1  系统资源的容量

使用说明书（用户手册）参考

3.1.3  订制按键—指定每个CO键、ICD群键、PDN键、SDN键或内线键的振铃音（仅限DPT/IP-PT）
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2.1.3.3  呼叫等待

说明

用于通知一部占线分机另一个来电正在等待。占线分机用户可以通过切断或保留当前呼叫来应答第二个呼叫。

此功能也称为占线用户电话信令（BSS）。
根据呼叫等待和电话类型不同，可以给每部分机指定以下通知方法：

a. 呼叫等待音：来自话筒或内置扬声器的话音

b. OHCA：来自内置扬声器的话音

c. 耳语OHCA：来自话筒的话音

d. 关闭：无通知。

呼叫类型
通知方法

DPT IP-PT 其它电话

内线电话 呼叫等待音/OHCA/耳语

OHCA/关闭

呼叫等待音/耳语OHCA/
关闭

呼叫等待音/关闭

中继线呼叫*1 呼叫等待音/关闭

*1 包括门电话呼叫、经来电呼叫分配群的呼叫以及转移自另一部分机的中继线呼叫。

条件

• 自动呼叫等待

通过系统编程，可以选择接收中继线呼叫、门电话呼叫、外部传感器呼叫和保留重呼呼叫时是否自动向分

机发送呼叫等待音。通过系统编程，还可以选择分机是否将接收内线电话的自动呼叫等待。

• UM群或VM群（DTMF/DPT）中的分机无法使用呼叫等待功能。

• 数据线路安全

设定数据线路安全会取消呼叫等待设定。（® 2.11.5  数据线路安全）

• 呼叫等待音

如果通过个人编程（呼叫等待音类型选择）选择了"Tone 2"，PT用户听到的中继线呼叫与内线电话的呼叫

等待音会不同。如果选择了"Tone 1"，就会听到相同的中继线呼叫与内线电话的呼叫等待音。

所有呼叫等待音类型都有一个默认值（® 6.2.1  音频/振铃音）。

• 来电信息

呼叫等待音响起时，来电信息在显示器上闪烁5秒，继而暂停10秒，然后再闪烁5秒。

• 电话公司的呼叫等待

除了集团电话范围内的呼叫等待服务外，电话公司通过模拟线路提供的呼叫等待音也会通知分机用户另一

个中继线呼叫来电正在等待。通过使用EFA断开或保留当前呼叫，可以应答第二个呼叫 (® 2.11.7  外部功

能接入（EFA）)。 有关详情，请咨询电话公司。

呼叫等待来电显示（可视来电显示）：

当使用电话公司通过模拟线路提供的呼叫等待音时，可以接收到等待中的主叫方电话号码。该号码将在显

示器上闪烁5秒，继而暂停10秒，然后再闪烁5秒。

请注意，接收到的来电信息可能不会显示在连接到SLT端口的电话上。
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使用说明书（PC编程手册）参考

9.23  PBX Configuration—[1-1] Configuration—Slot—Card Property - LCO type— Caller ID—Caller ID
Signalling
10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features

→ Manual Call Waiting for Extension Call
→ Automatic Call Waiting

10.6.3  PBX Configuration—[2-6-3] System—Numbering Plan—B/NA DND Call Feature
→ BSS / OHCA / Whisper OHCA / DND Override
→ BSS / OHCA / Whisper OHCA / DND Override-2

10.9  PBX Configuration—[2-9] System—System Options—Option 5— Call Waiting—Automatic Call Waiting
for Extension Call
12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings

→Option 2— Manual C. Waiting for Extension Call
→Option 2— Automatic C. Waiting
→Option 4— Call Waiting Tone Type

使用说明书（功能手册）参考

2.10.4  给占线分机第二个呼叫的通知

2.19.2  来电记录

2.22.1.1  电话通信详细记录（SMDR）

使用说明书（用户手册）参考

1.4.4  应答呼叫等待

1.9.3  接收呼叫等待（呼叫等待/摘机呼叫通知[OHCA]/耳语OHCA）
3.1.2  编程方式设定
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2.2  接收群功能

2.2.1  空闲分机搜索

说明

如果被叫分机占线或处于免打扰方式，空闲分机搜索将来电转接到属于同一空闲分机搜索群的一部空闲电话，

可以通过系统编程对转接进行编程。根据预编程设定的搜索类型自动搜索空闲分机。此功能也称为分机搜索。

类型 说明

循环搜索 以循环方式按空闲分机搜索群中规定的顺序寻找一部空闲分机。

终止搜索 按空闲分机搜索群中规定的顺序寻找一部空闲分机，直至达到指定的

最后一部分机。

条件

• 空闲分机搜索功能适用于：

拨打到单一目的地分机的内线电话、中继线呼叫和门电话呼叫。

• 一个分机用户只能属于一个空闲分机搜索群。

• 如果全部被搜索的分机都占线：

集团电话将把呼叫转接到溢出目的地，可以为每个空闲分机搜索群和每种时间方式（白天/午餐/休息/夜间）

（® 5.1.4  定时服务）指定一个溢出目的地。

[可用目的地]

目的地 可用性

有线分机（PT/SLT/SIP分机/ISDN分机） ü

来电呼叫分配群 ü

UM群 ü

语音信箱群（DTMF/DPT） ü
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目的地 可用性

外部广播机（TAFAS） ü

DISA ü

模拟/ISDN远程维护  

空闲线路接入号码 + 电话号码 ü

中继线群接入号码 + 中继线群号码 + 电话号码 ü

其它集团电话分机（无集团电话代码的TIE） ü

其它集团电话分机（带集团电话代码的TIE） ü

• FWD/DND方式

在一个空闲分机搜索群内搜索一部空闲分机时，任何设定了FWD—全部电话或DND功能的分机都将被跳

过，呼叫转到群中的下一部分机。

使用说明书（PC编程手册）参考

11.6  PBX Configuration—[3-6] Group—Extension Hunting Group
11.6.1  PBX Configuration—[3-6] Group—Extension Hunting Group—Member List

使用说明书（PT编程手册）参考

[680]空闲分机搜索类型

[681]空闲分机搜索群成员

使用说明书（功能手册）参考

2.3  呼叫转送（FWD）/免打扰（DND）功能

6.1  系统资源的容量
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2.2.2  来电呼叫分配群功能

2.2.2.1  来电呼叫分配群功能—概要

说明

来电呼叫分配群是一个通过系统编程进行编程的分机群。

® 11.5.1.1  PBX Configuration—[3-5-1] Group—Incoming Call Distribution Group—Group Settings—Member
List

来电呼叫分配群接收接入该群的呼叫。每个来电呼叫分配群都有一个浮动分机号码（默认：6 + 两位数群号码

[最大为群64]）。
使用分配方法将接入一个来电呼叫分配群的来电分配到群中的成员分机。当群中有预编程设定数目的分机占线

时，来电可以排队等候。

可以根据需要对每个来电呼叫分配群和成员分机进行编程，以便处理来电。拨打到该群的电话可以用一部指定

为监控员的分机监听。

11.5.1  PBX Configuration—[3-5-1] Group—Incoming Call Distribution Group—Group Settings
® Main
® Overflow Queuing Busy
® Overflow No Answer
® Miscellaneous

 1 

 A  F 

Group 

No.

1

2

3

:

3

Max.

Queuing 

Call 

Capacity

Hurry-up 

Level

3

8

Overflow 

Time

60

90

Tenant 

No.
*2

1

5

Overflow Destination

Day

100

200

...

...

...

...

...

...

Night

100

200

Group 

Name

Sales

Engineering

Floating 

Extn. No.
*1

601

602

Distribution 

Method

Ring

UCD

A B C D E F

5

11

Max. No. of 

Busy 

Extensions

*1 Floating Extn. No的位数取决于简易设置中Numbering Plan指定的值。请参阅使用说明书（安装手册）中的"5.4.1  简
易设置指示"。

*2 确定时间方式（白天/午餐/休息/夜间）（® 5.1.4  定时服务）和每个群的音乐源（待机音乐）需要租户号码。
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 1 

4

5

8

9

1

2

3

D

E

F

B

A

*2

*1

6

7

 1 

601  

Sales

  

 101  102  103  104  105  105 100

[ ]

   

a) 

b) 

C

*3

*1 ® 2.2.2.4  排队功能
*2 ® 2.2.2.9  监控功能
*3 ® 2.2.2.8  注册/注销

1. 群呼叫分配 [® 2.2.2.2  群呼叫分配]
使用以下方法之一分配来电：

分配方法 说明

均匀呼叫分配（UCD） 每次接到呼叫时，将呼叫平均地分配到不同的分机。

优先搜索 总是从同一个位置开始，并按规定顺序搜索空闲分机。

振铃 来电呼叫分配群中的全部分机同时振铃。

2. 排队功能 [® 2.2.2.4  排队功能]
当来电呼叫分配群中的占线分机达到预编程设定的数目，预编程设定数目的呼叫可以排队等候。

当呼叫排队等候时，可以给等候的来电者发送外播留言（OGM）或待机音乐。

3. 贵宾电话 [® 2.2.2.6  贵宾电话]
可以给来电呼叫分配群指定优先权，以便能按优先顺序接收来电呼叫。

4. 溢出功能 [® 2.2.2.7  溢出功能]
当一个呼叫不能被应答或排队时，它将被转接到预编程设定的目的地（截取路由—来电呼叫分配群溢出）。

还可以发送忙音（置忙占线）或切断线路。

5. 来电呼叫分配群控制功能
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功能 说明与参考

注册/注销 成员分机可以加入群处理呼叫（注册）或离开群

休息（注销）。

当有人离开办公桌时，为防止电话打到他们的分

机上，可以暂时离开该群。

® 2.2.2.8  注册/注销

监控功能 来电队列监听 监控员分机可以在显示器上监听关于每个来电呼

叫分配群的来电的各种信息。

® 2.2.2.9  监控功能

注册/注销监听与远程控

制

监听：监控员分机可以监听群成员的注册/注销状

态。

远程控制：监控员分机能更改各成员的状态。

® 2.2.2.9  监控功能

条件

• 一部分机可以属于多个来电呼叫分配群。

• ICD群键

可以为每个来电呼叫分配群在一个灵活键上指定一个来电呼叫分配（ICD）群键。它将来电接收到该群。

一部分机可以有相同或不同来电呼叫分配群的一个以上ICD群键（多个ICD群）。如果相同来电呼叫分配群

中的全部ICD群键均被占用，下一个来电将排队保留或溢出。如果没有指定ICD群键，来电将到达内线、CO
或PDN键。

可以通过系统编程选择ICD群键方式，如下所示：

– 标准方式（群DN键方式）

通过系统编程，分机可以有用于该分机所不属于的来电呼叫分配群的ICD群键。但是，该ICD群键不会

接收到达该群的呼叫。

– 加强假键方式

分机只需创建某个ICD群的键，就可以加入该群，即使该分机并没有注册为该群的成员。键创建后，分

机将在该群的最小编号可用成员槽中自动注册。不需进一步的编程，该分机就可以接收拨打到该群的电

话。如果该群没有成员槽可用，则无法创建键，并将听到一声警报音。

用该方式创建ICD群键时，用户还可以指定延迟振铃设定。

如果分机用户在自己的分机上删除了某群的最后一个ICD群键，他也将同时撤消成为该群成员的注册。

• 群FWD
可以在来电呼叫分配群基础上指定FWD功能。

• 来电呼叫分配群的COS
每个来电呼叫分配群都有一个指定的COS号码。对于每个COS，可以允许或停用群FWD至外线用户。来电

呼叫分配群的COS也可用于内部通话阻止功能；当分机用户呼叫某个来电呼叫分配群时，集团电话根据来

电呼叫分配群的COS检查主叫分机的COS（® 2.1.2.2  内部通话阻止）。
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使用说明书（安装手册）参考

5.4.1  简易设置指示

使用说明书（PC编程手册）参考

11.5.1  PBX Configuration—[3-5-1] Group—Incoming Call Distribution Group—Group Settings
→Main
→Overflow Queuing Busy
→Overflow No Answer
→Miscellaneous

11.5.1.1  PBX Configuration—[3-5-1] Group—Incoming Call Distribution Group—Group Settings—Member
List
11.5.3  PBX Configuration—[3-5-3] Group—Incoming Call Distribution Group—Miscellaneous—
Options—ICD Group Key Mode

使用说明书（PT编程手册）参考

[620]来电呼叫分配群成员

[621]来电呼叫分配群延迟振铃

[622]来电呼叫分配群浮动分机号码

[623]来电呼叫分配群名称

[624]来电呼叫分配群分配方法

[625]溢出时间终了的目的地

[626]溢出时间

[627]全部占线时的目的地

[628]排队呼叫能力

[629]排队快速等级

[630]排队时间表

[631]排队时间表顺序

[632]代理人的最大数

使用说明书（功能手册）参考

2.3.2  呼叫转送（FWD）

2.21.2  灵活键

5.5.8  浮动分机

6.1  系统资源的容量
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2.2.2.2  群呼叫分配

说明

使用选定的分配方法将接入来电呼叫分配群的来电分配到成员分机，直到接听电话的分机（代理）数目达到预

编程设定的数目。

当来电超过可用分机的数目时，呼叫进入排队（® 2.2.2.4  排队功能）。

1. 分配方法

可将以下三种分配方法中的任一种分配给每个来电呼叫分配群。

分配方法 说明

均匀呼叫分配（UCD） 每次接到呼叫时，将呼叫平均地分配到不同的分机。从接到最后呼叫的

分机之后的分机开始，按群的预编程顺序以循环方式搜索各分机。

A

B  

A 

B C D

根据系统编程，可以将呼叫接到空闲时间最长的分机。这称为自动呼叫

分配（ACD）。

优先搜索 按群的预编程顺序搜索一部空闲分机。

A

....

B C D

振铃 群的全部分机同时振铃。

延迟振铃：

可以给群中的每部分机编程设定延迟振铃或不振铃。即使设定了不振铃

或延迟振铃，仍可以通过按闪断键应答呼叫。

A B C D

2. 来电呼叫分配群的呼叫等待（群呼叫等待）

当来电呼叫分配群中无可用分机时，群成员可以收到呼叫等待音。若要使用此功能：

• 通过系统编程选择群呼叫等待方式。这就确定了等待呼叫的分配方法。
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• 成员分机必须个别指定呼叫等待方式，否则将不会收到通知。（® 2.1.3.3  呼叫等待）

[如何启动群呼叫等待功能]

UCD

Priority Hunting

Ring

UCD/Priority Hunting/ 

Ring

ICD

PT

UCD

Priority Hunting

*

Ring

*：来电立刻进入排队。成员分机不接受呼叫等待音。

[示例]

UCD Ring•

•

[群呼叫等待用ICD群键]
群呼叫等待功能的工作方式取决于群呼叫等待分配方法，如下所述：

a. 振铃：所有遇忙成员分机只对一个来电同时启动群呼叫等待功能（即使这些分机没有ICD群键也是如

此）—其它呼叫将排队等候。

b. UCD/优先搜索：群呼叫等待功能以某种顺序在位于遇忙成员分机的空闲ICD群键上启动。（该顺序取决

于类型：UCD或优先搜索。）呼叫将到达空闲键，直至所有ICD群键均被占用—其它呼叫将排队等候。

注

在方法b)中，如果一部分机有一个或多个用于某一来电呼叫分配群的ICD群键，而且该分机上的所

有ICD群键均被占用，则用于该群的群呼叫等待功能对该分机不起作用。

 

1

601

2

602

ICD 1 601

ICD 1 601

ICD 2 602

2 1

3

3. 无应答转接（UCD或优先搜索方法）

如果在预编程设定的时间（无应答时间）内没有应答成员分机上收到的呼叫，呼叫将被转接到下一部成员

分机。如果没有空闲群成员，呼叫就在目标分机上排队，直到有一个群成员可用。
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条件

• 自动呼叫分配（ACD）对ISDN分机不起作用。

• FWD/DND分机

为了跳过设定了FWD或DND功能的分机或使其振铃，需要对每个来电呼叫分配群进行系统编程。如果设定

为分机振铃，则忽略FWD/DND设定。（® 2.3  呼叫转送（FWD）/免打扰（DND）功能）

• 群呼叫等待功能不能与贵宾电话功能（® 2.2.2.6  贵宾电话）和/或收转功能（® 2.2.2.8  注册/注销）同时

使用。若要使用贵宾电话功能和/或收转功能，应关闭每部分机上的呼叫等待方式。

使用说明书（PC编程手册）参考

11.1.1  PBX Configuration—[3-1-1] Group—Trunk Group—TRG Settings—Main— Line Hunting Order
11.5.1  PBX Configuration—[3-5-1] Group—Incoming Call Distribution Group—Group Settings

→Main— Distribution Method
→Main— Call Waiting Distribution
→Miscellaneous— Extension No Answer Redirection Time
→Miscellaneous— Maximum No. of Busy Extension

11.5.1.1  PBX Configuration—[3-5-1] Group—Incoming Call Distribution Group—Group Settings—Member
List— Delayed Ring
11.5.3  PBX Configuration—[3-5-3] Group—Incoming Call Distribution Group—Miscellaneous

→ Options—Wrap-up Timer based on
→ Options—Longest Idle Distribution

使用说明书（PT编程手册）参考

[621]来电呼叫分配群延迟振铃

[624]来电呼叫分配群分配方法

[632]代理人的最大数
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2.2.2.3  来电呼叫分配群中的外线目的地

说明

可以将最多4个另一部集团电话的外线用户或外线目的地指定为来电呼叫分配（ICD）群的成员，方法如下：将

虚拟PS注册为该ICD群的成员。然后，将外线目的地的电话号码指定为FWD－所有呼叫的目的地。拨打到该

ICD群的电话也将在外线目的地振铃，就好像该目的地是集团电话内的一部分机一样。

这在下列情况下很有用：

• 在呼叫时，分机用户可以使自己的PT和多个移动电话同时振铃。

• 员工即使不在办公室，仍然可以应答呼叫，并且可以接收到达ICD群的呼叫。

-1

PS 3

PS 2

PS 1

ICD

PS 4

-2

TIE

移动电话XDP并联

ICD群中首台注册的分机可以通过PT编程将中继线呼叫的转送设定编程为最多4个虚拟PS。使用此功能，分机

用户可以指定让自己的移动电话与PT同时振铃，这样即使不在办公桌前，他也可以轻松地接收中继线呼叫。

条件

• 使用此功能需要KX-NSE101或KX-NSE110（移动分机的激活密钥）。每个使用此功能的分机（虚拟PS）都

需要一个激活密钥。

• 若要启动该功能，必须满足以下条件：

– 指定虚拟PS为ICD群的成员。（® 5.2.4.1  虚拟PS）
– 虚拟PS分机的Mobile Extension设定必须设为Enable。
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– 设定虚拟PS的转送类型为所有呼叫。（® 2.3.2  呼叫转送（FWD））

– 转送目的地为外线用户，包括网络中另一台集团电话的分机。

– 通过COS编程允许虚拟PS将呼叫FWD到中继线。

• 可以为单个ICD群指定最多4台虚拟PS。如果指定的数目多于4台，则使用4台最小成员编号的虚拟PS。
• LCOT的此功能取决于反向信号检测的设定。（® 2.5.4.5  反向电路）

• 即使所有指定给群的其它分机占线时，拨打到ICD群的呼叫也将在虚拟PS上振铃。

• 如果一个ICD群的所有成员都是虚拟PS，并且中继线线路可用但所有被叫方占线，则排队或者溢出功能都

不会执行。因此，建议为ICD群指定至少一台PT或SLT。
• 若要注册到群或从其中注销，虚拟PS用户可以通过DISA接入集团电话，输入流动COS功能号码（如果需

要），并且接入注册/注销设定。

• 可以使用和其它分机同样的方法为虚拟PS指定延迟振铃。

• 虚拟PS无法使用收转时间功能和自动注销功能。

• 当呼叫转送到公共中继线时，系统编程会选择是将主叫方还是虚拟PS的CLIP号码发送到转送目的地。

当呼叫使用的是专用网络时，将始终发送主叫方的CLIP号码。

• 移动电话XDP并联的DSS键
如果并联移动电话处于下列状态，则在ICD群中首先注册分机的DSS键灯将呈红色：

– 正在接听通过ICD群接收的中继线呼叫。

– 正在进行使用通过DISA的流动COS功能拨打的中继线呼叫。（® 2.16.1  直接拨入系统接入（DISA））

使用说明书（PC编程手册）参考

10.9  PBX Configuration—[2-9] System—System Options—Option 4
→ Send CLIP of CO Caller—when call is forwarded to CO
→ Send CLIP of Extension Caller—when call is forwarded to CO

12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Option 9— Mobile
Extension

使用说明书（功能手册）参考

5.2.4.1  虚拟PS
4.3.6  网络ICD群
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2.2.2.4  排队功能

说明

当来电呼叫分配群中的占线分机达到预编程设定的数目，新的来电可以排队等待。可排队等候的呼叫数目是可

编程设定的。

当呼叫排队等候时，由排队时间表处理呼叫，可以为每种时间方式（白天/午餐/休息/夜间）（® 5.1.4  定时服

务）指定排队时间表。本集团电话支持特定数目的排队时间表，各排队时间表具有特定的序列数目（呼叫进入

排队时执行的特定命令）。制定排队时间表时，可以将以下命令指定给各序列：

[命令表]

命令 说明 条件

OGM xx 将外播留言发送给主叫方。"xx"为
OGM号码。

发送OGM之后，会发送待机音乐，并启

动序列中下一项操作。

Wait xx s 让来电排队等候b（01-16）´ 5秒钟。

"xx"为要等待的秒数（05-80）。
如果未向主叫方发送OGM，主叫方会听

到回铃音。

如果已向主叫方发送OGM，主叫方会听

到待机音乐。

Sequence xx 转接到序列xx。"xx"为序列号码。 无

Overflow 转接到溢出目的地。 无

断开连接 断开线路。 无

Queue No. 告知排在在主叫方之前等待呼叫的数

量。

必须安装SD卡，才能使用此功能。

需要激活密钥：

Call Centre Feature Enhancement
（KX-NSF201）或Queue Position An-
nouncement（KX-NSXF021）

Queue No. and Time 告知排在主叫方之前等待呼叫的数量

和估计的等待时间。

必须安装SD卡，才能使用此功能。

需要激活密钥：

Call Centre Feature Enhancement
（KX-NSF201）或Queue Position An-
nouncement（KX-NSXF021）

无

（无命令）

转接到下一个序列。 如果指定为序列01，排队时间表就不会启

动。

[排队时间表的编程示例]

排队时间表编号
序列*1

Sequence 01 Sequence 02 Sequence 03 Sequence 04 ...

01 OGM 01 等待30 s OGM 03 Overflow  

02*2 OGM 02 等待30 s OGM 04 无  

03      

60 使用说明书（功能手册）

2.2.2 来电呼叫分配群功能



排队时间表编号
序列*1

Sequence 01 Sequence 02 Sequence 03 Sequence 04 ...

: : : : : :

*1 ® 11.5.2  PBX Configuration—[3-5-2] Group—Incoming Call Distribution Group—Queuing Time Table— Queuing
Sequence—Sequence 01–16

*2 如果呼叫在完成最终序列时仍未到达目的地，呼叫将被断开。

对排队时间表01的解释：

 02

 01

OGM 01  

Panasonic

 

 01

 

30

 04

OGM 03  

 03

从排队中退出

如果将DISA自动值机员设置（® 2.16.1  直接拨入系统接入（DISA）—DISA内装自动值机员号码（DISA AA
服务））分配到排队时间表中所使用的OGM，呼叫者在收听OGM时也可以拨打号码并且会被转接到分配到该号

码的目的地。

例如，为OGM将VM群浮动分机号码预设为DISA AA号码1可让呼叫者被转接到语音信箱：

（OGM）"感谢您致电。您所拨打的部门正忙。请等待，或按1键留言。"
如果正在播放OGM时按下1，来电者会被转接到可以留言的语音信箱。

条件

• 如果呼叫被转移到来电呼叫分配群并且由排队时间表处理：

即使转移重呼时间到期也不会发生转移重呼。

• 人工排队管理

按快速键可将队列中等候最久的呼叫转接到溢出目的地。（如果呼叫已经在一部分机上振铃，则不会进行转

接。）此功能也称为快速转移。

• 快速键

可将一个灵活键定制为快速键。在可以执行人工排队管理之前排队的呼叫数目是可编程的。该键的灯以如

下方式显示当前状态：

指示灯类型 排队等候的呼叫

关闭 无排队呼叫

红灯亮 处于或低于快速的指定数目
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指示灯类型 排队等候的呼叫

红灯快闪 超过快速的指定数目

使用说明书（PC编程手册）参考

10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features— Incoming Call Queue
Monitor
11.5.1  PBX Configuration—[3-5-1] Group—Incoming Call Distribution Group—Group Settings

→Overflow Queuing Busy
→Overflow No Answer
→Queuing Time Table
→Miscellaneous— Extension No Answer Redirection Time
→Miscellaneous— Maximum No. of Busy Extension

11.7.1  PBX Configuration—[3-7-1] Group—UM Group—System Settings— Call Waiting on UM Group
12.1.4  PBX Configuration—[4-1-4] Extension—Wired Extension—Flexible Button

→ Type
→ Extension Number (for Hurry-up)

使用说明书（PT编程手册）参考

[628]排队呼叫能力

[629]排队快速等级

[630]排队时间表

[631]排队时间表顺序

[632]代理人的最大数

使用说明书（功能手册）参考

2.2.2.7  溢出功能

2.30.2  外播留言（OGM）

2.21.2  灵活键

6.1  系统资源的容量

使用说明书（用户手册）参考

1.10.3  转送等待的呼叫（人工排队管理）
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2.2.2.5  分配顺序

说明

可以通过系统编程选择将来电呼叫分配群中排队的呼叫分配到属于多个群的空闲分机的方法。

可以使用下列方式。

方式 说明

循环式 分机接听排在发出上一呼叫的来电呼叫分配群之后的来电呼叫分

配群收到的第一个可接听电话。

FIFO（先进先出式） 分机接听它所属的所有来电呼叫分配群收到的第一个可接听电话。

[示例]
• 循环式

DIL/DID/DDI/CLI

1

6 1

3

5 2

2

4 3

1 62 43 5

解释：

根据来电呼叫分配群的顺序分配呼叫。继群1中的呼叫1后收到的下一个呼叫是3中的呼叫2。但使用此方法

时，将优先分配群2中的呼叫3。
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• FIFO

DIL/DID/DDI/CLI

1

6 1

3

5 2

2

4 3

1 62 43 5

解释：

根据接收呼叫的顺序分配呼叫，与群分配顺序无关。

使用说明书（PC编程手册）参考

11.5.3  PBX Configuration—[3-5-3] Group—Incoming Call Distribution Group—Miscellaneous—
Options—ICD Group Distribution order
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2.2.2.6  贵宾电话

说明

可以为来电呼叫分配群指定优先权。如果一部分机属于多个群，当该分机变为空闲时，这些群中排队的呼叫将

以优先权顺序分配至该分机。

每个来电呼叫分配群都能允许或停用贵宾电话方式。当对某个群启用贵宾电话方式时，该群将优先于其他群，

而与群分配顺序无关。当多个群允许贵宾电话方式时，编号最小的来电呼叫分配群具有最高的优先权。分配该

群中排队的所有呼叫后，将分配下一编号最小的群中排队的呼叫。

如果一些群启用贵宾电话，而其它群未启用，则分配了启用的群中排队的所有呼叫后，将根据设定的分配顺序

分配其它群中排队的呼叫。

[示例]
在呼叫中心，来电呼叫分配群1和3允许贵宾电话方式，而来电呼叫分配群2和4则停用贵宾电话方式。

• 循环式

DIL/DID/DDI/CLI

1

6 1

3

5 2

24

 3  48 7

8 71 6 24 3 5

解释：

启用贵宾电话方式的群1和3中排队的呼叫根据其群获得优先权。

继群1中的呼叫1后，接收到几个其它呼叫。但接下来分配的是群1中的呼叫8。
分配群1和3中的所有呼叫后，将从编号最小的群开始均等地分配群2和4中的呼叫。
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• FIFO

DIL/DID/DDI/CLI

1

6 1

3

5 2

24

 3  48 7

8 71 6 24 3 5

解释：

由于启用贵宾电话方式的群不遵循常规分配顺序，因此这些群中的呼叫将按1、8、4、6的顺序进行分配。

分配群1和3中的所有呼叫后，将按接收呼叫的顺序分配群2和4中的呼叫。

使用说明书（PC编程手册）参考

11.5.1  PBX Configuration—[3-5-1] Group—Incoming Call Distribution Group—Group
Settings—Miscellaneous— VIP Call Mode

使用说明书（功能手册）参考

2.2.2.5  分配顺序
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2.2.2.7  溢出功能

说明

当等候的呼叫超过等候排队能力时，呼叫就被转接到预编程设定的目的地，或通过以下功能给来电发送忙音：

1. 截取路由—来电呼叫分配群溢出

2. 置忙占线

1. 截取路由—来电呼叫分配群溢出

截取路由—来电呼叫分配群溢出在以下条件之一下工作：

a. 等候队列中没有空间。

b. 没有指定排队时间表并且没有注册分机。

c. 指定了排队时间表，但没有注册分机并且允许"Overflow immediately when All Logout"设定。

d. 给排队时间表指定了一个Overflow命令。

e. 溢出时间到期。

f. 执行人工排队管理。

[可用目的地]
可以为每个来电呼叫分配群和每种时间方式（白天/午餐/休息/夜间）（® 5.1.4  定时服务）指定溢出目的

地。取决于上述条件，可按如下方式指定目的地。

• 对于a）、b）和c）：
® 11.5.1  PBX Configuration—[3-5-1] Group—Incoming Call Distribution Group—Group
Settings—Overflow Queuing Busy— Queuing Busy—Destination-Day, Lunch, Break, Night

• 对于d）、e）和f）：
® 11.5.1  PBX Configuration—[3-5-1] Group—Incoming Call Distribution Group—Group
Settings—Overflow No Answer— Time out & Manual Queue Redirection—Destination-Day, Lunch,
Break, Night

目的地 可用性

有线分机（PT/SLT/SIP分机/ISDN分机） ü

来电呼叫分配群 ü

UM群 ü

语音信箱群（DTMF/DPT） ü

外部广播机（TAFAS） ü

DISA ü

模拟/ISDN远程维护 ü

空闲线路接入号码 + 电话号码 ü

中继线群接入号码 + 中继线群号码 + 电话号码 ü

其它集团电话分机（无集团电话代码的TIE） ü

其它集团电话分机（带集团电话代码的TIE） ü

2. 置忙占线

当在以下条件之一下没有为来电呼叫分配群功能中的截取路由—溢出指定目的地时，置忙占线功能起作用：
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a. 等候队列中没有空间。

b. 没有指定排队时间表并且没有注册分机。

[a)的示例]
一家商店有5个伙计。当应答代理数为"2"，排队呼叫数为"0"：
如果其中两个伙计在打电话，为了防止来电者以为店里没人或商店关门了，下一个来电者将听到忙音。

条件

[截取路由—来电呼叫分配群溢出]
• 如果溢出时间到期，溢出目的地就不可用：

a. 如果中继线呼叫通过LCOT卡到达：

（1）如果该呼叫曾经在排队，并且已向其发送了外播留言（OGM），或该呼叫是通过使用DISA功能到

达来电呼叫分配群的（® 2.16.1  直接拨入系统接入（DISA））：线路断开。

（2）在所有其它情况下：忽略转接，溢出定时器再次启动。

b. 如果呼叫通过另一个卡到达：忽略转接，溢出定时器再次启动。

[置忙占线]
• 如果中继线呼叫通过LCOT卡到达，则不会给来电发送忙音。

使用说明书（PC编程手册）参考

11.5.1  PBX Configuration—[3-5-1] Group—Incoming Call Distribution Group—Group Settings
→Overflow Queuing Busy
→Overflow No Answer

11.5.2  PBX Configuration—[3-5-2] Group—Incoming Call Distribution Group—Queuing Time Table
11.5.3  PBX Configuration—[3-5-3] Group—Incoming Call Distribution Group—Miscellaneous—
Options—Overflow immediately when All Logout

使用说明书（PT编程手册）参考

[625]溢出时间终了的目的地

[626]溢出时间

[627]全部占线时的目的地

[628]排队呼叫能力

[632]代理人的最大数

使用说明书（功能手册）参考

2.2.2.4  排队功能
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2.2.2.8  注册/注销

说明

来电呼叫分配群的成员可以人工加入（注册）或离开（注销）群。

当有人离开办公桌时，为防止电话打到他们的分机上，可以暂时离开该群。当他们准备好应答呼叫时，可以返

回到该群。

收转：

注册后，成员分机可以自动获得一段预编程设定的时间，当完成上一个呼叫后处于该时间段内时，可以拒绝呼

叫（收转时间）。收转定时器启动后，该分机所属的所有来电呼叫分配群接到的呼叫都会跳过该分机，以便该

分机用户可以完成必要的工作，如对前一呼叫进行报告等。分机将在从无法接听呼叫的状态（占线、注销、收

转或未准备）更改为可以接听呼叫的状态（注册或准备）时接听呼叫。

也可以通过按收转键人工（未准备）启动收转方式。

[注册/注销和收转状态示例]

< >

 101

 102

 102  103  104  105  106 /

条件

• 关于最后剩下的注册分机是否能注销是可编程的。

• 注册/注销键

利用以下参数可以将一个灵活键定制为注册/注销键：

参数 用途
指示灯类型

红灯亮 关闭

无参数 结合ICD群键使用，或结合来电

呼叫分配群的浮动分机号码使

用，或结合 （全部）使用。

— —

指定来电呼叫分配群的浮动分

机号码

用于注册到指定的来电呼叫分

配群或从其中注销。

注销状态 注册状态
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参数 用途
指示灯类型

红灯亮 关闭

（全部） 用于注册到分机用户所属的全

部来电呼叫分配群或从其中注

销。

注销操作后 注册操作后

• 如果指定了ICD群键，它也会显示相应群的注册/注销状态。

指示灯类型与包括群号码的注册/注销键相同。

• 收转定时器

– 可以对两个收转定时器进行编程：ICD群成员收转定时器和分机收转定时器。系统编程选择使用哪个定

时器。当选择ICD群成员收转定时器时，该定时器只在呼叫通过ICD群到达分机后才启动。当选择分机

收转定时器时，该定时器在所有呼叫到达分机或从分机拨出呼叫后启动（包括恢复的保留呼叫在内）。

– 在收转时间内，只有来自ICD群的呼叫无法接收。其它呼叫仍可照常接收。

– 收转定时器对ISDN分机不起作用。

• 收转键

可以将一个灵活键定制为收转键。它以如下方式显示当前状态：

指示灯类型 状态

红灯慢闪 收转

红灯亮 未准备

关闭 准备（取消收转方式）

• 自动注销

如果连续未应答次数超过预编程设定的次数，成员分机可能会自动注销。可以为每个来电呼叫分配群指定

连续未应答呼叫的次数。如果该分机是一个以上来电呼叫分配群的成员，所有相应来电呼叫分配群上的未

应答次数都会计算在内。可以人工返回到注册方式。

对于使用振铃分配方法的来电呼叫分配群中的分机，自动注销功能不起作用（® 2.2.2.2  群呼叫分配）。

• 注册/注销监听

监控员分机可以监听和控制来电呼叫分配群成员的注册/注销状态。（® 2.2.2.9  监控功能）

• 关于SMDR的注册/注销信息

可以在SMDR上打印注册/注销信息。（® 2.22.1.1  电话通信详细记录（SMDR））

使用说明书（PC编程手册）参考

10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features
→ Log-in / Log-out
→ Not Ready (Manual Wrap-up) Mode On / Off

11.5.1  PBX Configuration—[3-5-1] Group—Incoming Call Distribution Group—Group Settings—Miscellaneous
→ No. of Unanswered Calls for Automatic Log-out
→ Last Extension Log-out

11.5.1.1  PBX Configuration—[3-5-1] Group—Incoming Call Distribution Group—Group Settings—Member
List— Wrap-up Timer
11.5.3  PBX Configuration—[3-5-3] Group—Incoming Call Distribution Group—Miscellaneous—
Options—Wrap-up Timer based on
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12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Option 8— Wrap-up
Timer
12.1.4  PBX Configuration—[4-1-4] Extension—Wired Extension—Flexible Button

→ Type
→ Parameter Selection (for Log-in/Log-out)
→ Extension Number (for Log-in/Log-out)

19.1  PBX Configuration—[11-1] Maintenance—Main—SMDR— Print Information—Log-in / Log-out

使用说明书（功能手册）参考

2.21.2  灵活键

使用说明书（用户手册）参考

1.10.1  离开来电呼叫分配群（注册/注销、收转）
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2.2.2.9  监控功能

说明

预编程为监控员的分机（监控员分机）可以使用一部6行显示PT监听和控制来电呼叫分配群内的每个成员的状

态。

功能 说明

来电队列监听 监控员分机可以使用显示器监听来电呼叫分配群的状态。

注册/注销监听与远程控制 监听：监控员分机可以通过相应的DSS键的灯来监听来电呼叫分

配群成员的注册/注销状态。

远程控制：通过按相应的DSS键，监控员分机可以更改各成员的

状态。

[示例]

--- 

--- ICD

--- 

--- 

< >

< DDS >

 JAN.31  08:13AM FRI

601:Sales Section

Waiting Calls Now  :00006

Max. Waiting Time  :05'10

   EXIT   LOG     SPRVS

/

DDS

/

DDS

    Since JAN.29  09:10AM

Total Calls        :00996

Overflow Calls     :00131

Lost Calls         :00039

Average Waiting    :02'12

   EXIT           CLEAR

 JAN.31  08:13AM FRI

601:Sales Section

Waiting Calls Now  :00006

Max. Waiting Time  :05'10

   EXIT      

--- 

--- 

--- 

--- 

--- 

ICD

条件

• 可用作监控员分机的分机

a. 可以为每个来电呼叫分配群指定一部监控员分机，但它无需属于该群。
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b. 一部分机可以是不止一个来电呼叫分配群的监控员分机。

• 可用成对DSS话务台

KX-T7640、KX-T7440、KX-T7441、KX-DT390和KX-DT590可以使用此功能。

• 累计值清除

可以人工清除累计值数据（总来电呼叫、总溢出呼叫、未接呼叫、平均排队时间）。清除的日期和时间会被

保存并且显示在显示器上（监听开始日期和时间）。如果此值超过了99999时还未清除，将显示"****"。
• 如果拨打到来电呼叫分配群的电话溢出：

如果显示器处于空闲状态，它将自动变成监听方式以监听相应的来电呼叫分配群。

如果显示器正在监听另一个来电呼叫分配群，它就不会改变方式。

• 监听方式下的其它功能

即使处于监听方式时，监控员也能使用分机的其它功能（例如：打电话，按留言键等等）。结束每个操作

时，其电话会返回到排队监听显示。

使用说明书（PC编程手册）参考

10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features— Incoming Call Queue
Monitor
11.5.1  PBX Configuration—[3-5-1] Group—Incoming Call Distribution Group—Group
Settings—Miscellaneous— Supervisor Extension Number

使用说明书（用户手册）参考

1.10.2  监听和控制来电呼叫分配群的呼叫状态（来电呼叫分配群监听）
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2.2.2.10  监控功能（ACD）

说明

通过为分机用户指定ACD管理者，ACD管理者可以检查和分析ICD群的操作状况。通过监听ICD群的当前状况

以及通过收集和分析统计ACD报表信息来完成此操作。

功能 说明

ICDG Management–Group Mon-
itor

ACD管理者通过指定监听条件可以在相同屏幕上监听最多4个
ICD群的状况。此外，ACD管理者可以管理最多64个ICD群并监

听最多16个ICD群。

ICDG Management–ACD Report ACD管理者可以分析监听结果如下：

• Filter：根据Group、代理和呼叫过滤监听结果。

• View Report：以易于分析的格式（图表、文件导出或打印）

显示已过滤监听结果。

设为ACD管理者的用户屏幕显示如下。共有2种方式——简单方式和标准方式——且所显示信息会因方式而不

同。

群监听可以全屏方式显示。要允许此功能，请将显示器的分辨率与Full Screen Display (pixels)分辨率设置保持

一致。有关详情，请参阅使用说明书（PC编程手册）中的"8.4.1  Users—ICDG Management—Group
Monitor"。

[群监听示例]
标准方式
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简单方式

[ACD报表]
通过包含以下项目可以制作ACD报表。

Group

项目 说明

Incoming Calls

Total 目标ICD群收到的来电数量。

Answered 目标ICD群应答的来电数量。

Lost 主叫方取消的呼至目标ICD群的来电数量。

Overflow 呼至目标ICD群的溢出来电数量。

Talk Time

Total 目标ICD群已应答呼叫的总通话时间。（HH:MM:SS(D)）*1

Average 目标ICD群已应答呼叫的平均通话时间。（HH:MM:SS）

Max. 目标ICD群已应答呼叫的最长通话时间。（HH:MM:SS）

Wait Time

Wait Time (Answered)

Total 目标ICD群已应答呼叫的总等待时间。（HH:MM:SS(D)）*1

Average 目标ICD群已应答呼叫的平均等待时间。（HH:MM:SS）

Max. 目标ICD群已应答呼叫的最长等待时间。（HH:MM:SS）

Wait Time (Lost)

Total 目标ICD群已取消呼叫的总等待时间。（HH:MM:SS(D)）*1

Average 目标ICD群已取消呼叫的平均等待时间。（HH:MM:SS）
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项目 说明

Max. 目标ICD群已取消呼叫的最长等待时间。（HH:MM:SS）

Max. Waiting Calls 目标ICD群的队列中正在等待的最大呼叫数量。

*1 "D"表示天数（D=1–367）。如果天数是0，则不显示(D)。

Agent

项目 说明

Total Answer

Total Answer 目标代理应答的呼叫数量。

Talk Time

Total 目标代理的总通话时间。（HH:MM:SS(D)）*1

Average 目标代理的平均通话时间。（HH:MM:SS）

Max. 目标代理的最长通话时间。（HH:MM:SS）

Login Time 目标代理的总登录时间。（HH:MM:SS(D)）*1

Not-ready Time 目标代理的总未就绪时间。（HH:MM:SS(D)）*1

Wrap-up Time 目标代理的总收转时间。（HH:MM:SS(D)）*1

*1 "D"表示天数（D=1–367）。如果天数是0，则不显示(D)。

Call

项目 说明

ACD Report - Call Report

Start Date 呼叫的开始日期。

Start Time 呼叫的开始时间。（HH:MM:SS）

End Date 呼叫的结束日期。

End Time 呼叫的结束时间。（HH:MM:SS）

Result 处理结果。（Answered/Abandoned/Overflowed/Unanswered）

ICDG 进来的ICD群号码。

Incoming Agent 接听呼叫的代理的分机号码。

（仅当ICD群分配方法设置为均匀呼叫分配或优先搜索时显示。）

Answering Agent 正在应答的成员。（Extension Name/Extension Number）

Talk Time 通话时间。（HH:MM:SS）

Wait Time 等待时间。（HH:MM:SS）

Trunk 进来的中继线群号码。
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项目 说明

Caller ID/CLIP 主叫方号码。

根据需要过滤结果后，可以将报表输出为图表、导出为文件或打印输出。

有关ACD报表项目的详情，请参阅使用说明书（PC编程手册）。

有2种导出报表的方法。

• 手动导出

将报表手动导出为CSV文件。导出的文件可以保存到可访问Web维护控制台的NAS或PC。

• 计划导出

报表在指定时间自动导出为CSV文件。最多可以注册10个计划，并且可以单独允许或停用每个计划。文件

根据选定的报表配置文件过滤设置导出，导出的文件可以保存到与集团电话或NAS连接的USB存储设备。

如果文件超过10 000行，则将拆分为最多10 000行的独立文件。

将记录与导出相关的数据（日期和时间、描述、导出类型和设置值、报表配置文件以及完成状态），并可以在

导出历史记录中进行查看。

[图表示例]

条件

注意

如果通过系统编程允许管理监听（ACD）控制功能的内置ACD报表呼叫记录设置，则无法使用友好功能。

有关详情，请参阅本使用说明书（功能手册）中的相关章节或咨询您的系统管理员。
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• 使用此功能需要KX-NSF201（Call Centre Feature Enhancement）或KX-NSXF022（Built-in ACD
report）。

• 通过系统编程可将最多16位用户设为ACD管理者。

• 应定期备份必须保留的任何ACD报表数据。

• 保存ACD报告需要SD存储卡（KX-NS3134　KX-NS3135　KX-NS3136）。
– 使用SD存储卡：300000个呼叫

– 最多保存12个月（367天）的ACD报表。

但是，如果在Select Period中选择Custom Period，Start Date便可设定为当前日期之前1年内的日期

（例如，如果今天是2016年12月22日，Start Date最早的允许日期便是2015年12月22日），而且，End
Date可以设定为当前日期。

– 如果旧ACD报表超过保存期或超过保存ACD报表的最大数量，将被删除。

使用说明书（功能手册）参考

2.23.2  房间状态控制

2.23.3  客房呼叫计费

使用说明书（PC编程手册）参考

8.4  Users—ICDG Management
11.5.3  PBX Configuration—[3-5-3] Group—Incoming Call Distribution Group—Miscellaneous
11.5.4  PBX Configuration–[3-5-4] Group—Incoming Call Distribution Group—ACD Supervisor

使用说明书（用户手册）参考

1.12.1  在宾馆类环境中使用电话（友好功能）

4.1.3  监控监听（ACD）控制
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2.3  呼叫转送（FWD）/免打扰（DND）功能

2.3.1  呼叫转送（FWD）/免打扰（DND）—概要

说明

当分机用户无法应答呼叫时（例如：他在忙，或不在办公桌旁），可以使用以下功能转送或拒绝呼叫：

1. 呼叫转送（FWD）

2. 免打扰（DND）

1. FWD
分机和来电呼叫分配群可以将其来电转送到预定目的地。（® 2.3.2  呼叫转送（FWD））

2. DND
拨打分机的主叫方会听到声音，表明该分机用户现在无法接通。（® 2.3.3  免打扰（DND））

3. 呼叫转送/免打扰键，群FWD键

呼叫转送/免打扰固定键，或定制的灵活键，可以显示分机的FWD/DND设定状态。（® 2.3.4  呼叫转送/免
打扰键，群FWD键）

条件

• FWD和DND是为内线电话（包括门电话呼叫）和中继线呼叫（包括来自将中继线呼叫设定为协商保留的分

机的呼叫）分别设定的。
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2.3.2  呼叫转送（FWD）

说明

分机和来电呼叫分配群可以将其呼叫转送到预定目的地。有几种不同的转送类型，每种类型的呼叫转送所处的

情形也不同，如下所述：

类型 情形

全部电话 随时

随我转移：

如果分机用户在离开办公桌前未设定此功能，可以从目的地分机设定

此功能。

占线 当分机用户的线路占线时。

无应答 当分机用户在预编程设定的时间内未应答时。

占线/无应答 当分机用户的线路占线或用户在预编程设定的时间内未应答时。

根据内线电话或中继线呼叫来电的类型不同，可以为每种类型设定不同的目的地。

 

[可用目的地]

目的地 可用性 原分机/来电呼叫分配群的条件

有线分机（PT/SLT/SIP分机/ISDN分机） ü 只有在通过COS编程允许FWD到分

机时才可用。*1
来电呼叫分配群 ü

UM群 ü –
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目的地 可用性 原分机/来电呼叫分配群的条件

语音信箱群（DTMF/DPT） ü –

外部广播机（TAFAS） ü –

DISA ü 只有中继线呼叫来电才可用。不能将

内线电话和门电话呼叫来电转送至

DISA浮动分机号码。

模拟/ISDN远程维护 ü –

空闲线路接入号码 + 电话号码 ü 只有在通过COS编程允许呼叫转送到

中继线时才可用。
中继线群接入号码 + 中继线群号码 + 电话号码 ü

其它集团电话分机（无集团电话代码的TIE） ü –

其它集团电话分机（带集团电话代码的TIE） ü 只有在通过COS编程允许呼叫转送到

中继线时才可用。

*1 如果COS不允许分机用户呼叫某部分机（® 2.1.2.2  内部通话阻止），而该分机已被设定为转送目的地，则FWD功能将

不起作用。

转送到中继线时并联振铃

未应答呼叫被转送到外线（如移动电话）时，转送分机的电话将持续振铃直到任意电话应答转送的呼叫。可以

通过系统编程为每个分机启用此功能。即使当外线目的地应答呼叫时，转送分机的DSS键将显示为占线。当没

有应答并联振铃时可以使用截取路由功能。

条件

[一般]
• 用于中继线呼叫/内线电话的FWD

分机用户可以为中继线呼叫、内线电话或上述两者设定FWD功能。

• 来自来电呼叫分配群的FWD（群FWD）

COS编程确定可以使用此功能的来电呼叫分配群。

• FWD到中继线

COS编程确定可以向外转送呼叫的分机或来电呼叫分配群。原分机的TRS/限制和ARS仍适用于转送的呼

叫。

• 中继线呼叫持续时间

系统定时器可以限制中继线呼叫的持续时间。对于分机用户与外线用户之间的呼叫以及两个外线用户之间

的呼叫，中继线呼叫持续时间是分别指定的。

如果定时器到期，线路将被断开。（® 2.11.8  中继线呼叫限制）

• 多个呼叫转送

来电最多可以转送4次。以下转送功能被算作多个呼叫转送：

– FWD—占线或占线/无应答（当目的地分机占线），或全部电话

– 空闲分机搜索—溢出

– 截取路由—占线/免打扰/无应答（当目的地分机处于占线或免打扰或无应答方式时）*1

– 来电呼叫分配群—溢出
*1 可以将截取路由功能应用至原始目的地（请参阅2.1.1.6  截取路由）。
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1 2 3 54

A B C D E F

在上面的插图中，转送停在分机E。但是，在下列情况下，可以再往前转送：

– 如果目的地分机振铃，然后该呼叫被FWD—无应答或占线/无应答功能转接到转送目的地。

– 如果呼叫在来电呼叫分配群的队列中等候，然后该呼叫被排队时间表转接到溢出目的地。（® 2.2.2.4  排
队功能）

在上述情况下，转送计数器复位到零，呼叫可以再从上述目的地分机转送最多4次。

1 2 3 21

FWD—

A B C D E F

• 老板与秘书功能

不管转送设定如何，都能从目的地分机呼叫原分机。

—

( ) (FWD )

• 远程转送设置

可以通过指定分机号码并使用定制为"群FWD"键的灵活键来设置或取消设置分机的呼叫转送功能。

要允许此功能，负责执行此操作的分机必须指定Remote FWD COS设置。然后，具有指定Remote FWD
COS设置的授权分机方可分配群FWD键来执行远程转送。可以通过该键的LED查看目标分机的转送状态。

注

按下此键仅允许或停用转送功能。转送目的地应在待执行此操作的分机上设置。此外，无法允许或停用

免打扰功能。

[示例]

– 设置从"秘书"分机到"老板"分机的群FWD
如果"秘书"（分机号102）按下分配的群

FWD键，将开启"老板"（分机号101）的转

送功能（LED将变为红色）。

 102  101

DSS 

(FWD 101)
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– 取消从"秘书"分机到"老板"分机的群FWD
如果"秘书"（分机号102）再次按下分配的

群FWD键，将关闭"老板"（分机号101）的

转送功能（LED将熄灭）。

 102  101

DSS 

(FWD 101)

• 留言待取

转送呼叫时，不会转送留言待取信息。留言键的指示灯在原被叫分机上打开。（® 2.20.1  留言待取）

• 空闲分机搜索

空闲分机搜索功能适用于被转送到空闲分机搜索群中的占线分机的呼叫。

• ICD群转接呼叫的第二行LCD显示信息

如果来电呼叫分配接到转接呼叫，收到呼叫的PT的第二行可以通过系统编程设置为显示以下信息之一。

– 原来收到呼叫的分机或ICD群的分机号码和名称。

– 当前收到呼叫的ICD群的浮动分机号码和名称。

[全部电话与占线]
• 如果转送目的地无法应答呼叫，此功能就被取消，原目的地将对以下呼叫类型振铃：

– 门电话呼叫

– 经过LCOT卡的中继线呼叫

[无应答与占线/无应答]
• 无应答时间

转送呼叫前每部分机的振铃次数是可编程的。

[随我转移]
• 只有在原分机通过COS编程将"Remote Operation by Other Extension"设定为"Allow"时，此功能才可

用。

[转送到中继线时并联振铃]
• 使用此功能需要KX-NSE101或KX-NSE110（移动分机的激活密钥）。每个使用此功能的分机都需要一个激

活密钥。

• 即使转送分机的DSS键表示分机占线，其仍可接收呼叫。如果接收另一呼叫，则FWD—无应答会正常操

作。

• 可以通过系统编程将转送分机设置为占线。

• 当转送分机为虚拟PS时（® 5.2.4.1  虚拟PS）
– 忽略无应答时间设定：即使转送方法指定为无应答，仍立即转送所有呼叫。

– 如果转送目的地不可用，则将转送分机处理为占线。（在此情况下，即使启用FWD—占线，也会将其忽

略）。但是，如果原始主叫方在无法发送占线信号/振铃的模拟中继线上，则集团电话会继续尝试连接转

送目的地，直至建立连接或原始主叫方挂机。

– 可以通过ICD群编程将转送分机虚拟PS设置为占线。

• 如果在将呼叫转送到分机并与中继线并联振铃时分机挂机，中继线将停止振铃片刻，然后开始重新振铃。

• LCOT的此功能取决于反向信号检测的设定。（® 2.5.4.5  反向电路）

• 此功能是否可用取决于电话网络的规格。
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使用说明书（PC编程手册）参考

10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features— FWD No Answer Timer
Set
10.7.1  PBX Configuration—[2-7-1] System—Class of Service—COS Settings

→CO & SMDR— Call Forward to CO
→Manager— Group Forward Set
→Optional Device & Other Extensions— Remote Operation by Other Extension

10.9  PBX Configuration—[2-9] System—System Options—Option 1— PT Fwd / DND—Extension Status of
Mobile Integration (FWD NA to CO)
11.1.1  PBX Configuration—[3-1-1] Group—Trunk Group—TRG Settings—Main

→ CO-CO Duration Time (*60s)
→ Extension-CO Duration Time (*60s)

11.5.1  PBX Configuration—[3-5-1] Group—Incoming Call Distribution Group—Group
Settings—Miscellaneous— Status of FWD for Virtual PS
11.5.1  PBX Configuration—[3-5-1] Group—Incoming Call Distribution Group—Group Settings—Group Log /
Group FWD
11.5.3  PBX Configuration—[3-5-3] Group—Incoming Call Distribution Group—Miscellaneous—
Options—2nd line LCD display information for ICD Group redirected call
12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—FWD / DND
12.1.2  PBX Configuration—[4-1-2] Extension—Wired Extension—FWD/DND

使用说明书（PT编程手册）参考

[472]分机至中继线通话时间

[473]中继线间通话时长

[504]呼叫转送到中继线

[605]呼叫转送—无应答时间

使用说明书（功能手册）参考

2.1.1.6  截取路由

2.2.1  空闲分机搜索

2.2.2.7  溢出功能

5.1.1  服务等级（COS）

使用说明书（用户手册）参考

1.6.1  转送呼叫
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2.3.3  免打扰（DND）

说明

分机用户可以使用DND功能。如果设定了此功能，呼叫将不会到达该分机，而会使用空闲分机搜索功能（®
2.2.1  空闲分机搜索）或截取路由—占线/免打扰功能（® 2.1.1.6  截取路由）到达其它分机。当不能找到目的

地时，主叫分机将听到DND音，而主叫外线用户将听到忙音。

条件

• 用于中继线呼叫/内线电话的DND
分机用户可以为中继线呼叫、内线电话或上述两者设定DND功能。

• DND方式中的DSS键
如果指定的分机已设定DND，DSS键的灯将呈红色。

• 免打扰占优插入

处于DND方式中的分机可以被允许占优插入在COS中免打扰的其它分机用户呼叫。

• 广播免打扰

通过系统编程，可以对集团电话是否广播处于DND方式的分机进行编程。（® 2.17.1  广播）

• 截取路由─占线/免打扰

如果呼叫到达处于DND方式的分机，可以通过截取路由—占线/免打扰功能将该呼叫转接到预编程设定的目

的地。

• 空闲分机搜索

在空闲分机搜索群内寻找空闲分机时，任何已设定DND的分机都将被跳过。呼叫将转到该群中的下一部分

机，而不是截取路由—占线/免打扰目的地。

• 如果（1）经过LCOT卡的中继线呼叫到达处于免打扰方式的分机，（2）截取路由—占线/免打扰目的地不可

用，并且（3）空闲分机搜索群中没有可用分机，则处于免打扰方式的原分机将振铃。

• 即使分机处于DND方式，来自门电话的呼叫仍会到达该分机。

使用说明书（PC编程手册）参考

10.3  PBX Configuration—[2-3] System—Timers & Counters—Dial / IRNA / Recall / Tone— Tone
Length—Busy Tone / DND Tone (s)
10.6.3  PBX Configuration—[2-6-3] System—Numbering Plan—B/NA DND Call Feature

→ BSS / OHCA / Whisper OHCA / DND Override
→ BSS / OHCA / Whisper OHCA / DND Override-2

10.7.1  PBX Configuration—[2-7-1] System—Class of Service—COS Settings—Assistant— DND Override
12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—FWD / DND
12.1.2  PBX Configuration—[4-1-2] Extension—Wired Extension—FWD/DND

使用说明书（PT编程手册）参考

[507]免打扰占优插入

使用说明书（功能手册）参考

5.1.1  服务等级（COS）
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使用说明书（用户手册）参考

1.2.4  当被拨线路占线或没有应答时

1.9.2  拒绝来电呼叫（免打扰[DND]）
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2.3.4  呼叫转送/免打扰键，群FWD键

说明

呼叫转送/免打扰固定键，或定制的灵活键，可以显示分机的FWD/DND设定状态。使用此键，可以不必清除

FWD目的地设定，而临时地设定或取消分机的FWD状态和DND状态。

呼叫转送/免打扰键类型

一部分机上可以定制设置多种类型的呼叫转送/免打扰键。

类型 说明

用于分机的FWD/DND FWD/DND—内部 对内线电话来电起作用

FWD/DND—外部 对中继线呼叫来电起作用

FWD/DND—两者 对全部来电起作用

[键状态]
呼叫转送/免打扰键的灯以如下方式显示当前状态：

指示灯类型 状态（默认）

红灯亮 FWD开启

红灯慢闪 DND开启

关闭 FWD/DND关闭

通过系统编程可以改变指定给"点亮"和"闪烁"类型的功能。

群FWD键类型

来电呼叫分配群的FWD功能可以定制设置在灵活键上。一部分机上可以定制设置多种类型的群FWD键。

类型 说明

用于来电呼叫分配群的

FWD
群FWD—内部 对内线电话来电起作用

群FWD—外部 对中继线呼叫来电起作用

群FWD—两者 对全部来电起作用

[键状态]
群FWD键的灯以如下方式显示当前状态：

指示灯类型 状态（默认）

红灯亮 FWD开启

关闭 FWD关闭

用呼叫转送/免打扰固定键设定FWD/DND
在空闲状态时按呼叫转送/免打扰固定键，分机用户可以设定FWD/DND的以下项目：

• 用于中继线呼叫的FWD/DND

使用说明书（功能手册） 87

2.3.4 呼叫转送/免打扰键，群FWD键



可以不必清除FWD目的地，而临时切换至该分机的中继线呼叫的FWD/DND状态。在设定期间，键的发光

二极管显示当前中继线呼叫的FWD/DND状态。也可以设定中继线呼叫的转送类型和转送目的地。

• 用于内线电话的FWD/DND
可以不必清除FWD目的地，而临时切换至该分机的内线电话的FWD/DND状态。在设定期间，键的发光二

极管显示当前内线电话的FWD/DND状态。也可以设定内线电话的转送类型和转送目的地。

• FWD—无应答定时器

未应答呼叫被转送的等待时间长度可以修改。此设定对内线电话转送和中继线呼叫转送都适用。

• 虚拟PS的FWD
如果分机为来电呼叫分配群中首台注册的分机，则其用户可以为最多4台在该群预注册的虚拟PS设定FWD
目的地和转送状态（开/关）。（® 5.2.4.1  虚拟PS）

这些设定只有在通过系统编程将呼叫转送/免打扰键设定为FWD/DND设定方式时可用。

条件

• 当呼叫转送/免打扰键设定为FWD/DND循环切换方式时，按下呼叫转送/免打扰键可以循环FWD/DND设定。

在此方式下，当内线电话的处理方式被设定成与中继线呼叫的处理方式不同时（转送目的地、免打扰开启/
关闭）：

a. 在空闲方式下，呼叫转送/免打扰—两键（包括呼叫转送/免打扰键[固定键]）和群FWD—两键的灯类型

会指示中继线呼叫或内线电话的设定，但不会两者都指示。

b. 按下呼叫转送/免打扰—两键（包括呼叫转送/免打扰键[固定键]）或群FWD—两键将被忽略。

• 同时指定FWD和DND这两个功能后，按此键将以如下方式更改设定：

FWD DND

• 定制设置在灵活键上的呼叫转送/免打扰键总是处于FWD/DND循环切换方式，该方式无法更改。

使用说明书（PC编程手册）参考

10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features
→ FWD/DND Set / Cancel: Call from CO & Extension
→ FWD/DND Set / Cancel: Call from CO
→ FWD/DND Set / Cancel: Call from Extension
→ Group FWD Set / Cancel: Call from CO & Extension
→ Group FWD Set / Cancel: Call from CO
→ Group FWD Set / Cancel: Call from Extension

10.9  PBX Configuration—[2-9] System—System Options—Option 1
→ PT Fwd / DND—Fwd LED
→ PT Fwd / DND—DND LED
→ PT Fwd / DND—Fwd/DND key mode when Idle

12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—FWD / DND
12.1.4  PBX Configuration—[4-1-4] Extension—Wired Extension—Flexible Button

→ Type
→ Extension Number (for Group Fwd (Both))
→ Extension Number (for Group Fwd (External))
→ Extension Number (for Group Fwd (Internal))
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使用说明书（功能手册）参考

2.21.1  固定键

2.21.2  灵活键

使用说明书（用户手册）参考

3.1.2  编程方式设定
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2.4  应答功能

2.4.1  应答功能—概要

说明

分机用户可以通过以下方法应答来电：

目的地 功能 说明与参考

在自己的分机上（仅

PT）
线路优先─来电 用户可以选择摘机时所获得的线路。

® 2.4.2  线路优先─来电

直接单键应答 用户只需按闪断键就能应答来电。

免提应答 用户可以自动接收呼叫并建立免提通话。

® 2.4.4  免提应答

在另一部分机上 呼叫接听—直接/群 用户可以接听指定分机的呼叫或指定呼叫接听群中的呼叫。

® 2.4.3  呼叫接听
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2.4.2  线路优先─来电

说明

PT用户可从下列三种线路优先中选择用来应答来电的方法：

通过个人编程，可以将每种线路优先分配在每部分机上（优先线路分配—来电）。

类型 说明

无线路 摘机后按所需的线路接入键选择一条线路来应答来电。

PDN 只需摘机即可应答到达主要号码簿号码（PDN）的呼叫。即使同

时收到多个呼叫，此功能仍起作用。

(® 2.9.1  主要号码簿号码（PDN）/次要号码簿号码（SDN）分

机)

主要线路 只需摘机就能应答到达灵活CO或ICD群键（其上分配了"主要线

路"）的呼叫。即使同时收到多个呼叫，此功能仍起作用。

振铃线路（默认） 当多个呼叫到达时，只需摘机就能应答在电话上振铃时间最长的

呼叫。

条件

[主要线路]
• 来电的优先权系如下：

1. 到达其上分配了"主要线路"的键的呼叫。

2. 到达内线键的呼叫。

使用说明书（PC编程手册）参考

12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Option 4— Incoming
Preferred Line

使用说明书（用户手册）参考

3.1.2  编程方式设定
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2.4.3  呼叫接听

说明

分机用户可以应答正在任何其他分机上振铃的呼叫。

有以下类型可用：

类型 接听呼叫类型

直接 指定分机的呼叫。

群 指定呼叫接听群内的呼叫。

拒绝呼叫接听：

可以防止其它分机接听正在您分机上振铃的呼叫。

呼叫接听之前的来电信息显示

如同事等PT用户可在接听呼叫前使用DSS键确认呼叫另一部分机的来电信息。

按对应的DSS键而非接听呼叫将呼叫收到呼叫的分机。当听到忙音时，用户可在LCD上检查来电信息。可通过

再次按相同的DSS键接听呼叫。

[示例]

(01-2345-6789) 

 101  102

DSS 

(  101)

呼叫接听群监听

通过呼叫接听群和分机设置，同事等PT用户（具有3行或更大的LCD）可以查看呼入属于同一呼叫接听群的另

一分机的呼叫的主叫方信息。当其PT处于空闲状态时，该用户可以在LCD上查看主叫方的信息。可以按ANSWER
（应答）键接听该呼叫。

注

当主叫方信息显示在LCD上时，摘机不会应答该呼叫。

92 使用说明书（功能手册）
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[示例]

(01-2345-6789) 

 101

 

 103  104 102

条件

• 呼叫接听适用于：

内线电话、中继线呼叫和门电话呼叫

• 内部通话阻止

如果一部分机受COS限制而不能呼叫某些分机（® 2.1.2.2  内部通话阻止），则该分机也不能接听在这些分

机上振铃的任何呼叫。

[直接呼叫应答]
• 用户也可以通过按相应的DSS键来接听到达特定分机的呼叫。该功能只有在满足以下条件时才能使用：（1）

通过COS编程允许用户分机使用该功能，（2）通过系统编程，分机或来电分配（ICD）群的DSS键允许使

用该功能，以及（3）通过系统编程将用于到达分机或ICD群的来电的DSS键的指示灯类型设定为"On or
Flash（点亮或闪烁）"。
可以通过系统编程对用于到达分机或来电呼叫分配群的来电的DSS键的指示灯类型进行编程。只有当DSS
键为红灯闪烁时，呼叫接听才可用。

[群呼叫应答]
• 可以创建指定数目的呼叫接听群，每个群都由分机用户群组成。一个分机用户群可以属于数个呼叫接听群。

（® 5.1.2  群）
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[示例]

1

1

100 101

2

102 103

3

104 105

2 3

4

106 107

[呼叫接听之前的来电信息显示]
• 仅在下列情况下可使用此功能：

– 允许"Caller Information Display before Call Pick-up"设定。

– 分机接听呼叫允许直接呼叫应答。

– 分配的键为DSS键而非NDSS键。

[呼叫接听群监听]
• 仅在下列情况下可使用此功能：

– 呼叫接听群设置中允许Call Pickup Group Monitor Feature设置。

– 分机设置中的Call Pickup Group Monitoring设置设为"Display & Tone1–3"或"Display only"。
– 在定时器设置中的Call Pickup Group Monitor—LCD Display Duration (s)中设置LCD显示时间。

• 当呼叫到达呼叫接听群时，空闲PT上将显示以下信息。

– 与来电号码关联的名称

– 来电号码

– 被叫分机的名称和分机号码

– 被叫分机的缺席留言

• 如果分机号属于多个呼叫接听群，其用户可以监听所有呼叫接听群的呼叫。但会优先监听编号最小的呼叫

接听群。

• 最多可以监听256个分机（请参阅分机设置中的Call Pickup Group Monitoring）。
• 在下列情况下，将停止显示来电信息：

– 当PT从空闲状态变为活动状态时。

– 当按下ANSWER（应答）键以外的键时。（显示将根据执行的操作而变化。）

• 对于一个编号分机，主分机和子分机可以根据其各自的呼叫接听群监听设置单独执行。

• 支持此功能的电话如下：

– IP-PT*1

– DPT*1

*1 单行LCD的型号除外。

• 受COS限制（例如内部或中继线呼叫限制）的分机无法显示监听信息。

• 无论是否设置了DSS键以在指定分机接听呼叫，此功能均不受影响。

• 处于下列状态的分机无法使用此功能：

– 处于收转模式时

– 等待自动重拨功能时

– 在LCD上显示CTI信息时

– 接收广播呼叫时

• 来电信息将在听到背景音乐时显示。
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• LCD与呼叫等待音1、2和3对应如下。

1

2

3

15

( 5 )

使用说明书（PC编程手册）参考

10.3  PBX Configuration—[2-3] System—Timers & Counters—Miscellaneous— Call Pickup Group
Monitor—LCD Display Duration (s)
10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features

→ Group Call Pickup
→ Directed Call Pickup
→ Call Pickup Deny Set / Cancel

10.7.1  PBX Configuration—[2-7-1] System—Class of Service—COS Settings—Assistant— Call Pickup by
DSS
10.9  PBX Configuration—[2-9] System—System Options—Option 4

→ DSS Key—DSS key mode for Incoming Call
→ DSS Key—Call Pick-up by DSS key for Direct Incoming Call
→ DSS Key—Call Pick-up by DSS key for ICD Group Call
→ DSS Key—Caller Information Display before Call Pick-up

11.3  PBX Configuration—[3-3] Group—Call Pickup Group
11.3.1  PBX Configuration—[3-3] Group—Call Pickup Group—All Setting— Main—Call Pickup Group Monitor
Feature
12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Option 3

→ Call Pickup Deny
→ Call Pickup Group Monitoring

使用说明书（功能手册）参考

5.1.1  服务等级（COS）
6.1  系统资源的容量

使用说明书（PT编程手册）参考

[650]应答群的分机用户群
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使用说明书（用户手册）参考

1.3.3  应答在另一部电话上的呼叫振铃（呼叫接听）
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2.4.4  免提应答

说明

带有免提扬声器的PT用户可以在不拿起话筒的情况下与来电者通话。当用户以免提应答方式接收呼叫时，免提

通话使用以下方法之一建立：

类型 应答方法

内线电话 在被叫分机上听到嘟嘟音后立即建立，而且来电者会听到证实音。

中继线呼叫 经过指定振铃次数后建立，被叫分机听到嘟嘟音。

具有免提应答的服务等级（COS）
可以根据主叫方的COS设定只为特定的主叫方启用免提应答。例如，护理人员可以呼叫一个房间，被叫分机将

自动应答，这样护士人员就可以检查这个房间里居住人的情况。但是，即使设定了免提应答，其他内线呼叫也

会振铃。也可以将流动COS与此功能配合使用。

条件

• 免提应答适用于：

内线电话和中继线呼叫，包括使用UCD或优先搜索分配方法接入来电呼叫分配群的呼叫。（® 2.2.2.2  群呼

叫分配）

• 中继线呼叫的免提应答

使用此功能需要系统编程。

• 对来自一台将中继线呼叫设定为协商保留的分机的呼叫的免提应答

通过此功能，来自一部将中继线呼叫设定为协商保留的分机的呼叫可以被视为内线电话或者中继线呼叫，

这取决于系统编程。如果视为内线电话，则将立即建立呼叫。

当从模拟中继线转移呼叫时，强烈建议用户执行屏蔽转移，这样，当分机用户缺席时，外线来电者才不会

被自动连接到使用免提应答的分机上。

经常执行未屏蔽转移的分机（如话务员），应将具有免提应答的服务等级（COS）功能禁用。否则，即使没

有转移目的地，免提应答也可能会自动连接转移的外线呼叫。

• 秘密监听

通过系统编程可以消除被叫方在应答前听到的嘟嘟音。

• 交替接收/呼叫方式（振铃/话音）占优插入

免提应答功能优先于电话上预定的交替接收方式和来自来电的交替呼叫方式。

• 用头戴式耳机免提应答

用头戴式耳机也能使用免提应答功能。

使用说明书（PC编程手册）参考

10.3  PBX Configuration—[2-3] System—Timers & Counters—Dial / IRNA / Recall / Tone— Tone
Length—Reorder Tone for PT Hands-free (s)
10.7.1  PBX Configuration—[2-7-1] System—Class of Service—COS Settings—Assistant— Automatic
Answer (Caller)
10.9  PBX Configuration—[2-9] System—System Options

→Option 1— PT Operation—Automatic Answer for Call from CO after
→Option 3— Confirmation Tone—Tone 2 : Paged / Automatic Answer
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→Option 4— Transfer—Automatic Answer for Transferred Call
12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings

→Option 5— Automatic Answer for CO Call
→Option 6— Forced Automatic Answer

使用说明书（功能手册）参考

2.5.3  内线电话

5.1.1  服务等级（COS）

使用说明书（用户手册）参考

1.3.2  应答免提（免提应答）
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2.5  拨打电话功能

2.5.1  预拨号

说明

挂机时，显示PT用户在拨号前可以对输入的号码进行检查和纠正。摘机后即启动呼叫。

条件

• 将预拨号码储存在个人速拨中

按自动拨号/存储键可将预拨号码储存在个人速拨中。（® 2.6.4  速拨—个人/系统）在这种情况下，分机将

自动进入个人编程方式，以便为储存的号码指定姓名。

使用说明书（用户手册）参考

3.1.2  编程方式设定
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2.5.2  分机自动释放

说明

摘机后，如果分机用户在预编程设定的时间内没有拨任何数字，则用户会听到挂机重拨音。此操作仅适用于内

线电话。此功能也称为用户电话自动释放。

条件

• PT用户会听到预编程设定的时间的挂机重拨音，然后PT自动返回到空闲状态。但是，SLT用户在挂机前一

直会听到挂机重拨音。

• 此功能在以下情况之一下起作用：

拨打内线电话时

a. 如果在预编程设定的时间内没有拨第一位数字。

b. 在拨了一位数后，如果在预编程设定的时间内没有拨后续数字。

使用说明书（PC编程手册）参考

10.3  PBX Configuration—[2-3] System—Timers & Counters—Dial / IRNA / Recall / Tone
→ Dial—Extension First Digit (s)
→ Dial—Extension Inter-digit (s)
→ Tone Length—Reorder Tone for PT Handset (s)
→ Tone Length—Reorder Tone for PT Hands-free (s)

100 使用说明书（功能手册）
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2.5.3  内线电话

说明

一个分机用户可以呼叫另一个分机用户。

条件

• 指定分机号码/姓名

给全部分机指定分机号码和姓名。在内线通话过程中，显示PT上会显示所指定的号码和姓名。

• DSS键
通过按相应的直接分机选择（DSS）键，可以单键接入另一部分机。可以将一个灵活键定制为DSS键。

• 电话号码簿—分机拨号

显示PT用户可以通过选择显示器上显示的存储姓名来拨打电话。

• 按租户限制显示—电话号码簿

对于电话号码簿，根据系统编程，分机可以参考所有租户或分机所属每个租户的数据。在"每个租户"方式

中，显示PT上会显示电话号码簿如下：

仅显示属于该租户的分机相关信息。

• 交替接收—振铃/话音

通过个人编程，PT用户可以选择用振铃音或用话音接收内线电话（交替接收—振铃/话音）。如果用户选择

语音呼叫，主叫方在听到证实音后立即就能与用户通话。也可以选择拒绝语音呼叫。

• 交替呼叫—振铃/话音

来电者可以暂时改变被叫方的预定呼叫接收方法（振铃音或话音）。这样，被叫方的振铃呼叫就被转换成语

音呼叫，反之亦然。被叫方可以拒绝语音呼叫。

• PDN/SDN
当使用主要号码簿号码（PDN）或次要号码簿号码（SDN）键进行呼叫时，不能暂时改变被叫方的预定呼

叫接收方法（® 2.9.1  主要号码簿号码（PDN）/次要号码簿号码（SDN）分机）。

• 拨号后的声音

拨打分机号码后，用户将听到以下信号音之一：

类型 说明

回铃音 表示被叫方正在呼叫。

证实音 表示被叫方设定了语音呼叫。

忙音 表示被叫方占线。

DND音 表示被叫方设定了DND。

使用说明书（PC编程手册）参考

10.6.3  PBX Configuration—[2-6-3] System—Numbering Plan—B/NA DND Call Feature— Alternate Calling
- Ring / Voice
12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings

→Main— Extension Number
→Main— Extension Name
→Option 3— Intercom Call by Voice
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使用说明书（PT编程手册）参考

[003]分机号码

[004]分机名称

使用说明书（功能手册）参考

2.21.2  灵活键

使用说明书（用户手册）参考

1.2.1  基本呼叫

1.2.6  交替呼叫方法（交替呼叫—振铃/话音）

1.14.2  使用号码簿

3.1.2  编程方式设定

102 使用说明书（功能手册）
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2.5.4  中继线呼叫功能

2.5.4.1  中继线呼叫功能—概要

说明

拨打中继线电话时，分机用户可以使用以下功能：

功能 说明与参考

紧急呼叫 用户可以拨打预编程设定的紧急号码，而不管是否对分机施加了

限制。

® 2.5.4.2  紧急呼叫

计费代码输入 为了计费和记帐，用户可以输入一个计费代码来识别去电呼叫。

® 2.5.4.3  计费代码输入

脉冲至音频转换 用户可以暂时把脉冲方式切换成DTMF方式，以便接入特殊服务。

® 2.5.4.4  拨号类型选择

暂停插入 用户可以通过按暂停键把预编程设定的暂停时间插入所拨号码中，

或在用户所拨代码（例如：集团电话主机接入代码或特殊运营商

接入代码）与随后数字之间自动插入暂停时间。

® 2.5.4.7  暂停插入

® 2.5.4.8  集团电话主机接入代码（从集团电话主机接入电话公

司的接入代码）

® 2.5.4.9  特殊运营商接入代码
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2.5.4.2  紧急呼叫

说明

不管是否对分机设定了限制，分机用户在获得中继线后都可以拨打预编程设定的紧急号码。

条件

• 可以储存指定数目的紧急号码（一些号码可能有默认值）。

• 甚至在以下情况下也可以拨打紧急号码：

– 在计费代码─强制方式下（® 2.5.4.3  计费代码输入）

– 在任何TRS/限制级下（® 2.7.1  长途限制（TRS）/呼叫限制（限制））

– 在达到预编程设定的话费限额后（® 2.7.2  预算管理）

– 在分机锁定状态下（® 2.7.3  分机锁定）

• CLIP号码通知

拨打紧急号码时，预先指定给分机的CLIP号码将被当作位置识别号码发送。（® 4.1.2.2  呼叫/连接线路识

别显示（CLIP/COLP））

使用说明书（PC编程手册）参考

15.4  PBX Configuration—[7-4] TRS—Emergency Dial

使用说明书（PT编程手册）参考

[304]紧急号码

使用说明书（功能手册）参考

6.1  系统资源的容量

104 使用说明书（功能手册）
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2.5.4.3  计费代码输入

说明

计费代码用于识别中继线呼叫去电，以便进行计费和记帐。计费代码会附加到SMDR呼叫记录上。例如，如果

公司对每个顾客都使用一个计费代码，则公司可以确定顾客拨打过什么电话，并可以根据SMDR呼叫记录上顾

客的计费代码向顾客提交帐单。

输入计费代码的方法有如下两种：

在COS基础上为每部分机选择其中一种方法。

方式 说明

任选 用户可以根据需要随时输入计费代码。

强制 获得中继线之前用户必须输入计费代码。

条件

• 可以将计费代码储存到存储器拨号中（例如：单键拨号）。

• 计费键

可以将一个灵活键定制为计费键。使用计费键来代替输入计费代码所用的功能号码。此键会很有用，因为

可以随时使用它，而功能号码只有在获得中继线前听到拨号音时才允许输入。

• 分机用户可以在呼叫过程中的任何时间输入计费代码，包括呼叫断开后听到挂机重拨音时。但是，如果在

挂机重拨音消失后输入计费代码，则不会将呼叫储存在SMDR记录中。

• 如果输入了多个计费代码，最后输入的代码将打印输出在SMDR上。

• 即使在强制方式下，没有计费代码也能拨出紧急号码。（® 2.5.4.2  紧急呼叫）

• PT用户在通话过程中也能为中继线呼叫来电输入计费代码。

• 验证码输入

为了识别何人拨打了中继线呼叫以进行计费和记帐，需使用验证代码。任何分机上都能使用此代码。（®
2.7.6  验证码输入）

使用说明书（PC编程手册）参考

10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features— Account Code Entry
10.7.1  PBX Configuration—[2-7-1] System—Class of Service—COS Settings—CO & SMDR— Account
Code Mode

使用说明书（PT编程手册）参考

[508]计费代码方式

使用说明书（功能手册）参考

2.21.2  灵活键

2.22.1.1  电话通信详细记录（SMDR）

5.1.1  服务等级（COS）
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使用说明书（用户手册）参考

1.2.1  基本呼叫
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2.5.4.4  拨号类型选择

说明

通过系统编程可以为每条模拟中继线选择拨号方式（旋转或音频），而不管始发分机如何（根据与电话公司签

订的合同）。

有如下方式：

方式 说明

DTMF（双音多频） 分机的拨号信号被转换成音频拨号。

DTMF信号被发送到中继线。

脉冲拨号（旋转） 分机的拨号信号被转换成旋转拨号。

旋转脉冲被转送到中继线。

条件

• 脉冲至音频转换

分机用户可以暂时从脉冲方式切换至DTMF方式，以便接入特殊服务，如计算机接入的长途呼叫或语音信

箱服务等。若要切换至DTMF方式，请在连接中继线后等待预编程设定的一段时间（默认：5秒），或按  。
此功能只在设定成脉冲方式的中继线上起作用。不能将DTMF方式变成脉冲方式。

• 可以为已设定成脉冲方式的中继线端口选择脉冲率。有两种脉冲率可供选择：低（10 pps）和高（20
pps）。

• 可以为发送到已设定成DTMF方式的中继线端口的DTMF信号指定最短的持续时间。

使用说明书（PC编程手册）参考

9.24  PBX Configuration—[1-1] Configuration—Slot—Port Property - LCO Port
→ Dialling Mode
→ DTMF Width
→ Pulse Speed

使用说明书（PT编程手册）参考

[410] LCOT拨号方式

[411] LCOT脉冲率

[412] LCOT DTMF最短持续时间
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2.5.4.5  反向电路

说明

当分机用户试图拨打中继线呼叫时，集团电话中的电路可以检测来自电话公司的反向信号。它可以检测中继线

呼叫去电的开始（被叫方摘机）和结束（被叫方挂机）。当收到中继线呼叫时，该电路还可以在外线来电者挂

机后检测反向信号。

如果停用反向电路检测，集团电话将不能准确地探知呼叫的总持续时间。使用此功能可以在SMDR上验证呼叫

的持续时间（® 2.22.1.1  电话通信详细记录（SMDR））。

通过系统编程，可以选择集团电话只是检测中继线呼叫去电的反向信号，或是对呼出和呼入的中继线呼叫都作

检测，或是不对中继线呼叫进行检测（停用检测）。

使用说明书（PC编程手册）参考

9.24  PBX Configuration—[1-1] Configuration—Slot—Port Property - LCO Port— Reverse Detection

使用说明书（PT编程手册）参考

[415] LCOT反向电路
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2.5.4.6  中继线忙

说明

集团电话可以监听通过模拟中继线发送到回路电流，防止用户取得没有检测到回路电流的中继线。当没有检测

到回路电流时，中继线被设定成忙状态，因而无法拨打或接收电话。处于忙状态的中继线无法用作TIE线路、

用作中继线群的一部分或结合ARS功能来拨打电话，也无法接收中继线呼叫。如果用户要接通的中继线处于忙

状态，用户会听到挂机重拨音。

如果由于外部电信环境问题导致部分或全部中继线有时不可用，上述功能会很有用。

条件

• 对活动中继线的回路电流检测是在取得中继线时执行，或以固定时间间隔执行。

• 当中继线处于忙状态时，回路电流检测是以固定时间间隔执行，一旦检测到回路电流，便使中继线返回到

工作中状态。指定为管理员的分机可以人工将中继线更改回工作中状态。

• 中继线状态的更改记录在集团电话的故障记录中。

• 即使集团电话复位，忙状态仍会保持。

• 下列情况下，忙状态被清除：

– 该中继线上成功接收了呼叫（即：检测到回路电流）。

– 按下了该中继线的S-CO键并检测到回路电流。

使用说明书（PC编程手册）参考

9.24  PBX Configuration—[1-1] Configuration—Slot—Port Property - LCO Port— Busy Out Status
10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features— Busy Out Cancel
10.7.1  PBX Configuration—[2-7-1] System—Class of Service—COS Settings—Manager— Manager
10.9  PBX Configuration—[2-9] System—System Options—Option 5— Busy Out—Busy Out for Analogue
CO

使用说明书（PT编程手册）参考

[511]管理员分配

使用说明书（功能手册）参考

5.1.6  管理员功能

使用说明书（用户手册）参考

2.1.6  允许用户取得不可用的外线（中继线忙）
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2.5.4.7  暂停插入

说明

拨出号码之前，按暂停键在用户所拨号码的数字之间插入预编程设定的暂停时间，从而让以暂停分隔的某些号

码可用来接入某些功能（例如：接入代码，取得空闲线路等）。

需要暂停时，除下列接入代码外，所有其它情况下都必须人工插入暂停（按暂停键）。对于下列接入代码，在

用户所拨接入代码与后续数字之间会自动插入暂停：

a. 集团电话主机接入代码（® 2.5.4.8  集团电话主机接入代码（从集团电话主机接入电话公司的接入代码））

b. 特殊运营商接入代码（® 2.5.4.9  特殊运营商接入代码）

c. 第二个拨号音等待代码

条件

• 对每条中继线而言，暂停时间是可编程的。

• 存储器拨号中可以存储暂停。

• 在取得中继线后拨第二个拨号音等待代码时，代码后会插入预编程设定的暂停次数。

• ARS
启用ARS方式时，在用户所拨接入代码与其后的数字之间不会自动插入暂停。（2.8.1  自动路由选择

（ARS））

使用说明书（PC编程手册）参考

9.24  PBX Configuration—[1-1] Configuration—Slot—Port Property - LCO Port— Pause Time
10.3  PBX Configuration—[2-3] System—Timers & Counters—Miscellaneous— During Conversation—Pause
Signal Time (s)
14.4  PBX Configuration—[6-4] Feature—Second Dial Tone

使用说明书（PT编程手册）参考

[416] LCOT暂停时间
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2.5.4.8  集团电话主机接入代码（从集团电话主机接入电话公司的接入代码）

说明

将集团电话主机的分机端口连接到本集团电话的中继线端口（集团电话后面）后，便可将本集团电话安装在现

有集团电话（集团电话主机）之后。后方集团电话要通过集团电话主机接入电话公司（例如：为了拨打外线电

话），需要输入集团电话主机接入代码。集团电话主机的中继线接入号码应作为集团电话主机接入代码存储在

后方集团电话的中继线群上。

在用户所拨集团电话主机接入代码与后续数字之间会自动插入预编程设定的暂停时间（2.5.4.7  暂停插入）。

[示例]

"9-0-01-23-4567"

(01-23-4567)

101 102

TRG1

"9-101"

9

"0-01-23-4567"

0

注

应将"0"指定为后方集团电话中继线群（TRG）1的集团电话主机接入代码。

条件

• TRS/限制

当通过集团电话主机接入电话公司时，TRS/限制功能仅检查所拨的电话号码，不包括集团电话主机接入代

码。（® 2.7.1  长途限制（TRS）/呼叫限制（限制））
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• ARS
启用ARS方式时，在用户所拨接入代码与其后的数字之间不会自动插入暂停。（2.8.1  自动路由选择

（ARS））
• SMDR

仅当在SMDR的ARS设定中选择修改后的号码设定时，SMDR上才会记录包括集团电话主机接入代码的所

拨号码。

• 如果为中继线群指定了集团电话主机接入代码，SMDR上就不会记录到达集团电话主机的分机的呼叫。

• 当中继线端口直接连接到电话公司（而不是集团电话主机）时，可以使用集团电话主机接入代码以只将长

途电话记录在SMDR上。当将长途代码（例如："0"）指定为集团电话主机接入代码时，就可以这样做。所

有市话（例如：不需要首先拨"0"的电话）都将被当作电话公司的分机来处理，而不会记录在SMDR上，因

为在这种情况下，本集团电话将电话公司识别为集团电话主机。

因此，只有长途电话会记录在SMDR上。

使用说明书（PC编程手册）参考

11.1.1  PBX Configuration—[3-1-1] Group—Trunk Group—TRG Settings—Host PBX Access Code
19.1  PBX Configuration—[11-1] Maintenance—Main—SMDR Options— Option—ARS Dial

使用说明书（PT编程手册）参考

[471]集团电话主机接入代码

使用说明书（功能手册）参考

2.22.1.1  电话通信详细记录（SMDR）

6.1  系统资源的容量

112 使用说明书（功能手册）
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2.5.4.9  特殊运营商接入代码

说明

如果集团电话可以接入多家电话公司，则每次不使用ARS拨打中继线呼叫时，就需要输入通过系统编程指定的

特殊运营商接入代码。

在用户所拨特殊运营商接入代码与后续数字之间会自动插入预编程设定的暂停时间。（® 2.5.4.7  暂停插入）

条件

• TRS/限制

TRS/限制功能只检查所拨的电话号码，不包括特殊运营商接入代码。（® 2.7.1  长途限制（TRS）/呼叫限

制（限制））

• ARS
启用ARS方式时，在用户所拨接入代码与其后的数字之间不会自动插入暂停。（2.8.1  自动路由选择

（ARS））
• 如果本集团电话安装在现有集团电话主机后面：

应分别指定特殊运营商接入代码和集团电话主机接入代码：这些代码不能作为一个代码一起指定。（®
2.5.4.8  集团电话主机接入代码（从集团电话主机接入电话公司的接入代码））

使用说明书（PC编程手册）参考

15.3  PBX Configuration—[7-3] TRS—Special Carrier

使用说明书（PT编程手册）参考

[303]特殊运营商接入代码

使用说明书（功能手册）参考

2.8.1  自动路由选择（ARS）
6.1  系统资源的容量
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2.5.5  取得线路功能

2.5.5.1  取得线路功能—概要

说明

分机用户可以通过以下方法选择取得的线路打电话：

功能 说明与参考

线路优先─去电 用户可以选择摘机时要取得的线路。

® 2.5.5.2  线路优先─去电

中继线接入 用户每次拨打中继线呼叫时可以选择中继线接入方法。

® 2.5.5.3  中继线接入

114 使用说明书（功能手册）
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2.5.5.2  线路优先─去电

说明

通过个人编程（优先线路分配—去电），PT用户在摘机时可以从以下线路优先中选择所需的去电线路打电话：

线路优先 说明

ICM/PDN 当分机用户摘机时，自动选择一条分机线路。对于PDN分机，会自动选

择第一个可用的主要号码簿号码（PDN）。

(® 2.9.1  主要号码簿号码（PDN）/次要号码簿号码（SDN）分机)

空闲线路 当分机用户摘机时，自动从指定的中继线群中选择一条空闲中继线。

无线路 当分机用户摘机时，没有选择任何线路。分机用户必须选择所需线路来

打电话。

主要线路 当分机用户摘机时，自动选择预定线路。可以从线路接入键选择一条主

要线路：S-CO，G-CO，L-CO，ICD群。

条件

• 线路优先占优插入

摘机前按所需的线路接入键或存储器拨号键（例如：单键拨号），用户就能临时占优插入预定的线路优先。

• 若要选择空闲线路优先，应在COS基础上对分机可用的中继线群进行编程。还应该指定空闲线路接入可用

的中继线群。

使用说明书（PC编程手册）参考

10.7.2  PBX Configuration—[2-7-2] System—Class of Service—External Call Block
11.1.2  PBX Configuration—[3-1-2] Group—Trunk Group—Local Access Priority
12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Option 4— Outgoing
Preferred Line

使用说明书（PT编程手册）参考

[103]空闲线路接入（市话接入）

[500]中继线群号码

使用说明书（用户手册）参考

3.1.2  编程方式设定
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2.5.5.3  中继线接入

说明

可以使用以下方法接入中继线：

方法 说明 接入方法

空闲线路接入（市话接

入）

从指定的中继线群中自动选择一

条空闲中继线。

拨空闲线路接入号码，或按L-CO键。

中继线群接入 从相应中继线群中选择一条空闲

中继线。

拨中继线群接入号码和中继线群号码，

或按G-CO键。

S-CO线路接入 直接选择所需的中继线。 拨S-CO线路接入号码和中继线号码，

或按S-CO键。

条件

• COS编程决定了可用于打电话的中继线群。

• 可以在中继线端口基础上引用中继线号码。

• 键指定

可以将一个灵活键定制为G-CO键、L-CO键或S-CO键，如下所示：

类型 参数

环路-CO（L-CO） 无参数（应用通过系统编程指定的全部中继线群。）

群-CO（G-CO） 指定的中继线群。

单-CO（S-CO） 指定的中继线。

可以进行下列指定：

– 将同一条中继线指定给S-CO键和G-CO键。

– 将同一个中继线群指定给一个以上的G-CO键。

– 指定一个以上的L-CO键。

拨打中继线接入号码，将按以下顺序选择CO键：S-CO ® G-CO ® L-CO
• 直接中继线接入

按空闲CO键将自动切换到免提操作方式，并允许用户使用挂机拨号。用户无需按免提键、监听键或拿起话

筒。

• 空闲线路接入的群搜索顺序

从指定用于空闲线路接入的中继线群中选择一条空闲中继线。如果有多个中继线群可用，则中继线群搜索

顺序可通过系统编程来决定。

• 空闲线路接入和中继线群接入的中继线搜索顺序

中继线群中的中继线搜索顺序（从最低编号中继线开始，或从最高编号中继线开始，或旋转搜索）可通过

系统编程来决定。

• 可以在中继线端口基础上指定公司名称或客户名称，以便话务员或分机用户可以在应答前查看外线来电试

图到达的目的地。当多个公司共享同一话务员时，这很有用。

• 可以识别已连接有中继线的中继线端口。这样就可以防止分机用户给未连接的中继线打电话。
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使用说明书（PC编程手册）参考

9.22  PBX Configuration—[1-1] Configuration—Slot—Port Property—Extension Type— Connection
9.24  PBX Configuration—[1-1] Configuration—Slot—Port Property - LCO Port— Connection
9.27  PBX Configuration—[1-1] Configuration—Slot—Port Property - PRI Port— Connection
10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features

→ Idle Line Access (Local Access)
→ Trunk Group Access
→ Single CO Line Access

10.7.2  PBX Configuration—[2-7-2] System—Class of Service—External Call Block
11.1.1  PBX Configuration—[3-1-1] Group—Trunk Group—TRG Settings—Main— Line Hunting Order
11.1.2  PBX Configuration—[3-1-2] Group—Trunk Group—Local Access Priority
12.1.4  PBX Configuration—[4-1-4] Extension—Wired Extension—Flexible Button

→ Type
→ Parameter Selection (for Single CO)
→ Parameter Selection (for Group CO)

16.1  PBX Configuration—[8-1] ARS—System Setting— ARS Mode
18.1  PBX Configuration—[10-1] CO & Incoming Call—CO Line Settings— CO Name

使用说明书（PT编程手册）参考

[400]中继线连接

[401]中继线名称

[409]中继线号码参考

[500]中继线群号码

使用说明书（功能手册）参考

2.21.2  灵活键

5.1.1  服务等级（COS）

使用说明书（用户手册）参考

1.2.1  基本呼叫
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2.6  存储器拨号功能

2.6.1  存储器拨号功能—概要

说明

分机用户可以在集团电话分机数据和/或集团电话系统数据中储存常拨的号码。通过简单的操作就能自动拨出储

存的号码。

1. 功能

功能 存储方法与参考

单键拨号 • 个人编程

• 系统编程

（仅PC编程）

® 2.6.2  单键拨号

最后号码重拨（去电呼叫记录） 自动存储最近拨打的电话号码。

® 2.6.3  最后号码重拨

速拨 个人 • 个人编程

• 用功能号码进行个人操作

• 系统编程

（仅PC编程）

® 2.6.4  速拨—个人/系统

系统 系统编程

® 2.6.4  速拨—个人/系统

快速拨号 系统编程

（仅PC编程）

® 2.6.5  快速拨号

热线 • 个人编程

• 用功能号码进行个人操作

• 系统编程

（仅PC编程）

® 2.6.6  热线

KX-T7710单键拨号 系统编程（仅PC编程）

® 2.6.7  KX-T7710单键拨号

118 使用说明书（功能手册）
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功能 存储方法与参考

来电记录 自动存储来电信息。

® 2.19.2  来电记录

2. 有效输入

输入 在输入时显示 说明

0–9/ /# 0–9/ /# 存储数字、  和#。

PAUSE（暂停） P 通过按暂停键存储暂停。（® 2.5.4.7  暂
停插入）

FLASH/RECALL（挂机）*1 F 在号码开始处按闪断键可存储闪断/重呼

信号（EFA方式）。（® 2.11.7  外部功能

接入（EFA））

INTERCOM（保密）*1 [ ] 在要隐藏的号码的开始和结束处按内线键

可隐藏此号码的全部或部分。隐藏部分是

否将在SMDR上显示可以通过编程确定。

TRANSFER（转移）*1 T 在号码开始处按转移键可存储转移命令

（仅用于单键拨号）。（® 2.12.1  呼叫转

移）

[示例] 存储"T + 305"=转移呼叫至分机

305。

*1 仅在系统/个人编程方式下可用

[保密拨号示例]
当要存储号码"9-123-456-7890"并隐藏电话号码"123-456-7890"时，

9 1 2 3 4 5 6 7 8 9 0

注

• 可以在存储器拨号号码开始处存储一个存储器拨号功能号码。

• 一个存储器拨号位置上可以存储数个功能号码。

条件

• 用存储器拨号进行中继线接入

特定的中继线接入号码可以与电话号码一起存储在存储器拨号中。但是，如果在选择中继线后进行存储器

拨号，所存储的中继线接入号码将被忽略，而使用选定的中继线发送电话号码。
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2.6.2  单键拨号

说明

PT用户可以通过按一个键来接通一个人或功能。这是通过将号码（例如：分机号码、电话号码或功能号码）存

储在单键拨号键中来启动的。

示例：单键语音信箱功能接入

可以为直接接入统一消息功能（® 章节  3  统一消息系统）指定一个单键拨号键。例如，要直接将留言记录至

信箱号码123且UM群的浮动分机号码为165，则将"165#6123"分配至单键拨号键。当按此键时，会听到信箱的

外播留言。

条件

• 单键拨号键

可以将一个灵活键定制为单键拨号键。

• 完全单键拨号

按单键拨号键之前不需要摘机。

使用说明书（PC编程手册）参考

12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Option 6— Flexible
Button Programming Mode
12.1.4  PBX Configuration—[4-1-4] Extension—Wired Extension—Flexible Button

→ Type
→ Dial (for One-touch)

使用说明书（功能手册）参考

2.21.2  灵活键

6.1  系统资源的容量

使用说明书（用户手册）参考

1.2.2  简易拨号

120 使用说明书（功能手册）
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2.6.3  最后号码重拨

说明

每部分机会自动保存最近拨打的外部电话号码和分机号码以便再次拨打相同的号码。通过系统编程，可将去电

呼叫记录设为记录拨号的分机号码。

自动重拨：

如果在免提方式下进行最后号码重拨并且被叫方占线，则将以预编程设定的时间间隔自动重拨预编程设定的次

数。重拨电话无应答振铃持续时间是可编程设定的。

此功能只适用于某些具有免提键的PT型号。

去电呼叫记录：

关于中继线呼叫去电和内线电话（包括TIE）的信息会自动记录在每部分机中。显示PT的用户可以查看预设数

目的最近拨打电话号码的详情，并且可以轻松地再次呼叫同一用户。

条件

[一般]
• 如果在去电呼叫记录已满和/或自动重拨包含一个号码时拨新号码，将删除所存储的最旧呼叫数据，而存储

新号码。

• 如果在自动重拨过程中进行任何拨号操作或应答来电，自动重拨就被取消。

• 根据忙音类型，自动重拨可能不可用。

• SIP分机上无法使用自动重拨。

• 中断重拨

当外线用户、取得的中继线或分机号码（包括TIE连接）占线时，用户可以通过按重拨键尝试重拨，而不必

挂机。这可以进行数次而不必挂机。

• 用重拨键显示去电呼叫记录

在挂机时按显示PT上的重拨键，可以显示去电呼叫记录。该操作需要系统编程。

• 如果使用去电呼叫记录重拨外线用户或分机号码（包括TIE连接），或人工再次重拨去电呼叫记录中存储的

号码，呼叫记录中将多次存储该号码。但是，使用重拨键拨打的电话不会再次存储在去电呼叫记录中。

• 可以通过系统编程更改每部分机可以存储的记录数目。

• 要在去电呼叫记录中记录内线电话，请参阅使用说明书（PC编程手册）中的"10.9  PBX
Configuration—[2-9] System—System Options—Option 7— Outgoing Call Log—Extension Call"。

• 最近呼叫记录会组合并显示相同目的地的多个呼叫的记录。

• 如果分机用户使用集团电话代码方法（用集团电话代码接入）通过TIE连接进行呼叫，则去电呼叫记录不会

在PT显示上显示接入代码。

• 如果分机用户使用DSS键呼叫另一分机，则用户可以使用重拨功能呼叫相同的分机号码。

• 如果分机用户使用SDN键呼叫相应的所有者分机，则用户无法使用重拨功能再次呼叫所有者分机。

[个人/系统速拨名称显示]
• 从去电呼叫记录进行中继线呼叫时，如果已在个人/系统速拨条目注册了名称，该名称将显示在显示PT的

LCD的第二行。单行LCD的电话上不会显示该名称。

• 如果已在个人/系统速拨条目注册了名称，使用个人/系统速拨进行中继线呼叫后使用重拨键进行另一呼叫

时，该名称将显示在显示PT的LCD的第二行。

• 从去电呼叫记录进行中继线呼叫时，如果未在个人/系统速拨条目注册名称，显示PT的LCD上将显示拨出的

号码。
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• 如果在个人/系统速拨中注册的号码在记录到去电呼叫记录中后发生了更改，将不会显示个人/系统速拨条目

名称。而是显示在去电呼叫记录中注册的名称。

• 如果在个人/系统速拨中注册的名称在记录到去电呼叫记录中后发生了更改，显示PT的LCD上将显示更改后

的名称。

• 如果允许连接后保存拨出的数字的模式，在呼叫结束前拨打的所有数字（包括暂停时自动输入的"P"）都必

须注册到个人/系统速拨条目中才能支持此功能。

使用说明书（PC编程手册）参考

10.3  PBX Configuration—[2-3] System—Timers & Counters—Dial / IRNA / Recall / Tone
→ Automatic Redial—Repeat Counter
→ Automatic Redial—Repeat Interval (x10s)
→ Automatic Redial—Redial Call Ring Duration (x10s)

10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features— Redial
10.9  PBX Configuration—[2-9] System—System Options—Option 2

→ Redial—Automatic Redial when No Answer (ISDN)
→ Redial—Save Dial After Connection to Redial Memory
→ Redial—Call Log by Redial key

10.9  PBX Configuration—[2-9] System—System Options—Option 7— Outgoing Call Log—Extension Call
12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Option 7— Outgoing
Call Log Memory

使用说明书（PT编程手册）参考

[205]自动重拨重复次数

[206]自动重拨间隔

使用说明书（功能手册）参考

5.2.1  IP专用话机（IP-PT）
6.1  系统资源的容量

使用说明书（用户手册）参考

1.2.3  重拨

1.14.1  使用呼叫记录

122 使用说明书（功能手册）
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2.6.4  速拨—个人/系统

说明

分机用户可以使用缩位拨号来拨打存储在集团电话分机数据或集团电话系统数据中的常拨号码。

个人速拨也被称为话机速拨。

根据系统编程，可将显示PT上显示的系统速拨项目限制为分机租户的相关项目。

条件

[一般]
• 任何号码（例如：电话号码，功能号码）都可以存储在速拨号码中。通过个人编程可以为每个个人速拨号

码和系统速拨号码指定名称。

[中继线呼叫的名称显示]
• 使用个人/系统速拨进行中继线呼叫时，如果已在个人/系统速拨条目注册了名称，该名称将显示在显示PT

的LCD的第二行。单行LCD的电话上不会显示该名称。

• 使用个人/系统速拨进行中继线呼叫后，如果返回了连接姓名识别显示（CONP）信息，CONP信息中注册

的名称将优先于个人/系统速拨名称，并显示在显示PT的LCD上。（® 4.3.4.2  呼叫/连接线路识别显示（CLIP/
COLP）和呼叫/连接姓名识别显示（CNIP/CONP）—用QSIG）

• 如果使用了重呼或转移功能，注册到个人/系统速拨条目的名称将不再显示在显示PT的LCD上。

[个人速拨]
• 显示锁定

通过个人编程（显示锁定），分机用户可以锁定个人速拨号码显示，防止在其他分机看到这些号码。这样，

来电/去电呼叫记录显示也会被锁定，用户信箱中的语音留言也无法播放。使用此功能需要分机个人识别号

码（PIN）。（® 2.24.1  分机个人识别号码（PIN））

[系统速拨]
• 用系统速拨占优插入长途限制/限制

使用系统速拨可以占优插入TRS/限制。（® 2.7.1  长途限制（TRS）/呼叫限制（限制））

• 用自动拨号/存储键显示系统速拨

在挂机时按显示PT上的自动拨号/存储键，可以显示系统速拨电话号簿。

[按租户限制显示—系统速拨]
对于系统速拨，根据系统编程，分机可以参考系统或分机所属每个租户的数据。在"Tenant Exclusive"方式中，

显示PT上会显示系统速拨如下：

• 仅显示属于该租户的分机相关信息。

• 系统速拨设定的改变仅影响各租户。不会影响整个系统。

使用说明书（PC编程手册）参考

10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features
→ System Speed Dialling / Personal Speed Dialling
→ Personal Speed Dialling - Programming

10.7.1  PBX Configuration—[2-7-1] System—Class of Service—COS Settings—TRS— TRS Level for System
Speed Dialling
12.1.3  PBX Configuration—[4-1-3] Extension—Wired Extension—Speed Dial
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14.1  PBX Configuration—[6-1] Feature—System Speed Dial
14.6  PBX Configuration—[6-6] Feature—Tenant— System Speed Dial
14.6  PBX Configuration—[6-6] Feature—Tenant— Extension Directory

使用说明书（PT编程手册）参考

[001]系统速拨号码

[002]系统速拨名称

[509]系统速拨的TRS/限制级

使用说明书（功能手册）参考

6.1  系统资源的容量

使用说明书（用户手册）参考

1.2.2  简易拨号

1.14.1  使用呼叫记录

1.14.2  使用号码簿

3.1.2  编程方式设定

124 使用说明书（功能手册）
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2.6.5  快速拨号

说明

分机用户只需拨1–8位快速拨号号码就可以接入分机或功能。

条件

• 在诸如以下情况下使用快速拨号会很方便：

– 宾馆的客房服务电话

– 通过公共网络呼叫另一分部。

• 快速拨号号码遵照灵活编号方案。

(® 5.5.7  灵活编号/固定编号)
• 以下示例说明如何存储和使用快速拨号号码：

位置编号 快速拨号号码 所需号码

快速拨号01 110 9110（中继线呼叫）

快速拨号02 5 3016（客房服务）

快速拨号03 2011 90123456789（另一分部）

: : :

• 当集团电话处于休息方式时，可以通过一体化网络中另一现场的分机使用快速拨号进行中继线呼叫（®
5.1.4  定时服务）。要允许此功能，需要在每个现场从主设备执行系统编程。呼叫位于您自己的现场的分机

时，无法使用此功能。有关详情，请参阅KX-NS1000的使用说明书（PC编程手册）。

使用说明书（PC编程手册）参考

10.6.2  PBX Configuration—[2-6-2] System—Numbering Plan—Quick Dial

使用说明书（功能手册）参考

4.3.3  ISDN虚拟专用网（ISDN-VPN）

5.1.4  定时服务

6.1  系统资源的容量

使用说明书（用户手册）参考

1.2.2  简易拨号
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2.6.6  热线

说明

分机用户可以将自己的分机设定为只要摘机即自动拨打预编程设定的电话或分机号码。此功能也称为应答拨

号。

如果设定了热线功能，当用户摘机时将产生拨号音，该拨号音的等待时间是通过系统编程设定的。在等待时间

内，用户可以占优插入热线功能而拨另一个用户号码。如果没有拨任何号码，预编程设定的号码将自动开始拨

号。

条件

• 可用电话

PT和SLT

使用说明书（PC编程手册）参考

10.3  PBX Configuration—[2-3] System—Timers & Counters—Dial / IRNA / Recall / Tone— Dial—Hot Line
(Pickup Dial) Start (s)
10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features— Hot Line (Pickup Dial)
Program Set / Cancel
12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Option 2

→ Pickup Dial Set
→ Pickup Dial No.

使用说明书（PT编程手册）参考

[204]热线等待时间

使用说明书（功能手册）参考

6.1  系统资源的容量

使用说明书（用户手册）参考

1.2.2  简易拨号
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2.6.7  KX-T7710单键拨号

说明

通过系统编程，可以一次完成所有连接到集团电话的KX-T7710电话上的留言键和单键拨号键的定制设置。相

同的分机号码、电话号码或功能号码将被分配给各KX-T7710上的相同键，这对宾馆客房分机或类似应用会很

有用。

[编程示例]

键 所需号码

留言 702（留言待取[回叫]）

单键拨号01 100（宾馆话务员）

单键拨号02 7601（唤醒电话）

单键拨号03 102（餐馆）

: :

留言键在默认编程情况下会回叫留下留言待取指示的来电者。

但是，留言键也可以编程设定为执行其它功能。8个单键拨号键没有默认设定值。

条件

• KX-T7710有两种方式：NORMAL方式和PBX方式，方式由电话上的开关来选择。

此功能只适用于当KX-T7710处于PBX方式时。

• 在听到拨号音时，此功能可用。

• 请参考KX-T7710的快速参考指南以了解更多信息。

使用说明书（PC编程手册）参考

10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main

使用说明书（功能手册）参考

2.21.2  灵活键

使用说明书（用户手册）参考

1.2.2  简易拨号

使用说明书（功能手册） 127

2.6.7 KX-T7710单键拨号



2.7  长途限制（TRS）/呼叫限制（限制）功能

2.7.1  长途限制（TRS）/呼叫限制（限制）

说明

TRS/限制可以用COS编程禁止分机用户拨打某些中继线呼叫。当用户摘机取得一条中继线，然后将所拨号码

发送到该中继线时，就会应用限制。

每个COS都被编程设定有一个用于每种时间方式（白天/午餐/休息/夜间）的TRS/限制级。

有7级可用。1级为最高级而7级为最低级。1级允许拨打全部中继线呼叫，而7级则禁止拨打一切中继线呼叫。

2级至6级结合使用预编程设定的拒绝和特殊代码表，用于限制呼叫。

拒绝代码表

对于用具有2至6级的分机拨打的中继线呼叫去电，首先要对照适用的拒绝代码表进行检查。如果在表上找不到

所拨号码的前几位数（不包括中继线接入号码），电话就可以拨出。有5个拒绝代码表，分别用于2至6级。

把要禁止的号码填写在各表上。这些号码将被确定为拒绝代码。

特殊代码表

这些表用于占优插入编程设定的拒绝代码。对照适用的特殊代码表检查被适用的拒绝代码表拒绝的呼叫，如果

找到一个匹配的代码，电话就可以拨出。

有5个特殊代码表，分别用于2至6级。

把拒绝代码中的特殊号码填写在各表上。这些号码被确定为特殊代码。

用系统速拨占优插入长途限制/限制

如果使用系统速拨打电话，该电话可以占优插入TRS/限制。每个COS都被编程设定有系统速拨的TRS/限制级。

一旦设定此功能，它就允许全部分机用户用系统速拨的等级拨打系统速拨电话。任何设定了分机锁定的分机也

能用系统速拨打电话。

® 10.7.1  PBX Configuration—[2-7-1] System—Class of Service—COS Settings—TRS— TRS Level for
System Speed Dialling

TRS/限制级

TRS/限制级是由拒绝代码表和特殊代码表中设定的电话代码来决定的。

如下表所示，拒绝代码表中的较高级别可应用到该级以下的所有级别，特殊代码表中的较低级别可应用到该级

以上的所有级别。

 拒绝代码表*1 特殊代码表*2

1级 不能编程 不能编程

2级 2级的表 2级至6级的表

3级 2级和3级的表 3级至6级的表

4级 2级至4级的表 4级至6级的表

5级 2级至5级的表 5级至6级的表

6级 2级至6级的表 6级的表
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 拒绝代码表*1 特殊代码表*2

7级 不能编程 不能编程

*1 ® 15.1  PBX Configuration—[7-1] TRS—Denied Code— Level 2–Level 6
*2 ® 15.2  PBX Configuration—[7-2] TRS—Exception Code— Level 2–Level 6

[使用示例]使用此方法，某些中继线呼叫去电（例如：国际/移动电话/长途）如在以下的情况下可以受到限制：

 限制 允许

1级 没有限制

2级
（老板）

• 国际电话 • 顾客所在的国家

• 移动电话呼叫

• 长途电话

• 市话

3级
（秘书）

• 国际电话

• 移动电话呼叫

• 老板的移动电话

• 长途电话

• 市话

4级
（话务员）

• 国际电话

• 移动电话呼叫

• 长途电话

• 市话

: : :

在此例子中，1级用户可以拨打任何中继线呼叫。2级用户可以拨打国际电话至顾客所在的国家，以及可以拨打

移动电话/长途/市话。除了拨打至老板的移动电话之外，3级用户不能拨打国际/移动电话，但可以拨打长途/市
话。4级用户不能拨打任何国际/移动电话/长途电话，但可以拨打市话。

若要如上述例子般设定TRS/限制，需要如下编程拒绝代码表及特殊代码表：

 拒绝代码表 特殊代码表

1级 不能编程 不能编程

2级 00 拒绝国际电话的前置号码 00xx 允许国家的前置号码

3级 090
拒绝移动电话呼叫的前置号码 090xxxxx

xxx
老板的移动电话号码

4级 0 拒绝长途电话的前置号码 – 不需要

: : :

[编程示例：COS设定]

COS号码
适用于时间方式的等级*1

适用于系统速拨的等级*2

白天 午餐 休息 夜间

1 1 1 1 6 1

2 2 2 2 6 1
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COS号码
适用于时间方式的等级*1

适用于系统速拨的等级*2

白天 午餐 休息 夜间

: : : : : :

*1 ® 10.7.1  PBX Configuration—[2-7-1] System—Class of Service—COS Settings—TRS— TRS Level—Day, Lunch,
Break, Night

*2 ® 15.5  PBX Configuration—[7-5] TRS—Miscellaneous— TRS Override by System Speed Dialling

130 使用说明书（功能手册）
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[流程图]
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COSCOS

每一级的TRS/限制设定

通过系统编程，可以选择不同的TRS/限制方法。使用此方法，每一级均有一套独立的仅能应用于本级别的拒绝

代码和特殊代码。

® 15.5  PBX Configuration—[7-5] TRS—Miscellaneous— TRS Table Mode for Level N (N=2_6)

 拒绝代码表*1 特殊代码表*2

1级 不能编程 不能编程
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 拒绝代码表*1 特殊代码表*2

2级 2级的表 2级的表

3级 3级的表 3级的表

4级 4级的表 4级的表

5级 5级的表 5级的表

6级 6级的表 6级的表

7级 不能编程 不能编程

*1 ® 15.1  PBX Configuration—[7-1] TRS—Denied Code— Level 2–Level 6
*2 ® 15.2  PBX Configuration—[7-2] TRS—Exception Code— Level 2–Level 6

[使用示例] 使用此方法，可以如下限制按部门划分的某些中继线呼叫去电（例如：国际/移动电话/长途）：

 限制 允许

1级 没有限制

2级
（工程部）

• 国际电话 • 工厂所在的国家

• 移动电话呼叫

• 长途电话

• 市话

3级
（海外营业部）

• 移动电话呼叫 • 公司的移动电话

• 国际电话

• 长途电话

• 市话

4级
（会计部）

• 国际电话

• 长途电话

• 顾客所在的城市

• 移动电话呼叫

• 市话

: : :

在此例子中，1级用户可以拨打任何中继线呼叫。2级用户仅可以拨打国际电话至工厂所在的国家，以及可以拨

打移动电话/长途/市话。3级用户仅可以拨打移动电话呼叫至公司的移动电话，以及可以拨打任何国际/长途/市
话。4级用户不能拨打任何国际电话或多数的长途电话，但可以拨打长途电话至顾客所在的城市、移动电话及

市话。

若要如上述例子般设定TRS/限制，需要如下编程拒绝代码表及特殊代码表：

 拒绝代码表 特殊代码表

1级 不能编程 不能编程

2级 00 拒绝国际电话的前置号码 00xx 允许国家的前置号码

3级 090 拒绝移动电话呼叫的前置号码 090xxxx 允许移动电话的前置号码
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 拒绝代码表 特殊代码表

4级 0
拒绝国际电话及长途电话的前

置号码

03
允许城市的长途号码，以及移

动电话的前置号码
06

090

: : :

条件

注意

允许用户接入网络的TRS/限制功能中所含的软件必须升级，以便辩认新建立并投入使用的网络区域代码和

交换代码。

如果没有升级集团电话系统内部设置或外围设备，导致不能识别新建立的代码，将会限制集团电话的客户

和用户接入网络和这些代码。

请保持软件与最新数据同步更新。

• 应给每部分机指定一个COS。
® 12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Main— COS

• TRS/限制检查适用于以下情况：

– ARS
– 中继线接入（空闲线路/中继线群/S-CO线路）

• 可以编程设定是否用TRS/限制检查" "或"#"。这对于防止可能通过某些电话公司交换而拨打的未经许可的

电话会很有用。

® 15.5  PBX Configuration—[7-5] TRS—Miscellaneous— TRS Check for Dial " * # "
• 可以编程设定TRS/限制是否检查中继线呼叫过程中在外部功能接入后拨的数字。（® 2.11.7  外部功能接入

（EFA））
® 15.5  PBX Configuration—[7-5] TRS—Miscellaneous— TRS Check after EFA

• 集团电话主机接入代码/特殊运营商接入代码

在下列情况下，TRS/限制检查用集团电话主机接入代码（® 2.5.4.8  集团电话主机接入代码（从集团电话

主机接入电话公司的接入代码））或特殊运营商接入代码（® 2.5.4.9  特殊运营商接入代码）拨的号码：

类型
已储存

未储存
找到 未找到

集团电话主机接入代码 删除此代码。对其后的

数字进行TRS/限制检

查。

电话可以拨出（不受

TRS/限制）。

TRS/限制检查整个号

码。

特殊运营商接入代码 删除此代码。对其后的

数字进行TRS/限制检

查。

TRS/限制检查整个号

码。

TRS/限制检查整个号

码。

• ARS
如果将ARS应用于所拨号码，TRS/限制将检查用户所拨号码（而不是用ARS修改的号码）。这种情况下，

将不会检查集团电话主机接入代码和/或特殊运营商接入代码。

• 在通话过程中的拨号位数限制
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与已接听的中继线呼叫通话时，可以限制拨号位数。如果所拨号码的位数超过预编程设定的限制，该线路

将被断开。

® 15.5  PBX Configuration—[7-5] TRS—Miscellaneous— Dial Digits Limitation After Answering—Dial
Digits

• 可以通过系统编程选择当数字码间时间到期时，是否不待TRS/限制检查完成即断开中继线。

® 15.5  PBX Configuration—[7-5] TRS—Miscellaneous— Mode when Dial Time-out before TRS Check
– 如果选择不断开，当数字码间时间到期后，仍然会进行TRS/限制检查。

– 如果选择断开，当中继线数字码间时间到期时，线路将断开。这也可以防止使用EFA。
本设定适用于所有中继线。

• 某些功能可以更改TRS/限制级。当使用多个功能时，各功能的优先权系如下：

1. 拨号音转移（® 2.7.4  拨号音转移）

2. 预算管理（® 2.7.2  预算管理）

3. 用系统速拨占优插入长途限制/限制

4. 流动COS/验证码输入

(® 2.7.5  流动COS, 2.7.6  验证码输入)
5. 分机锁定

使用说明书（PC编程手册）参考

10.7.1  PBX Configuration—[2-7-1] System—Class of Service—COS Settings—TRS
→ TRS Level—Day, Lunch, Break, Night
→ TRS Level for System Speed Dialling

12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Main— COS
12.1.4  PBX Configuration—[4-1-4] Extension—Wired Extension—Flexible Button

→ Type
→ Parameter Selection (for TRS Level Change)

15.1  PBX Configuration—[7-1] TRS—Denied Code
15.2  PBX Configuration—[7-2] TRS—Exception Code
15.3  PBX Configuration—[7-3] TRS—Special Carrier
15.5  PBX Configuration—[7-5] TRS—Miscellaneous

使用说明书（PT编程手册）参考

[300]用系统速拨占优插入长途限制/限制

[301] TRS/限制拒绝代码

[302] TRS/限制特殊代码

[501] TRS/限制级

[509]系统速拨的TRS/限制级

[602]服务等级

使用说明书（功能手册）参考

2.5.5.3  中继线接入

2.6.4  速拨—个人/系统

2.7.3  分机锁定

2.8.1  自动路由选择（ARS）

134 使用说明书（功能手册）
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5.1.1  服务等级（COS）
5.1.4  定时服务

6.1  系统资源的容量
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2.7.2  预算管理

说明

以分机为基础，为电话使用预编程设定预算限额。如果话费总额达到限额，分机用户就不能再打中继线电话

了。被指定为管理员的分机可以增加限额或清除话费总额。

条件

• 如果达到限额，则适用TRS/限制级7。（® 2.7.1  长途限制（TRS）/呼叫限制（限制））

• 验证电话的预算管理

如果分机用户用验证代码进行中继线呼叫，话费将计算在该验证代码（而不是分机）的总金额中。（®
2.7.6  验证码输入）可以为每个验证代码分配一个话费限额。

• 流动COS的预算管理

如果分机用户使用流动COS功能从一部分机拨打中继线呼叫，话费将计算在分机用户的分机（而不是拨打

电话的分机）上。（2.7.5  流动COS）
• 此功能需要ISDN话费通知（AOC）服务。

• 当通话过程中话费总额达到预编程设定的限额时，可以选择是在发送警告音后断开线路（断开方式）还是

只发送警告音。

• 当多个分机用户同时使用相同的验证代码或相同的分机（通过使用流动COS）时，每个用户都可以接入该

分机或验证代码的剩余总预算额。

使用说明书（PC编程手册）参考

12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Option 3— Charge
Limit
14.2  PBX Configuration—[6-2] Feature—Hotel & Charge—Charge— Charge Options—Action at Charge
Limit
14.3  PBX Configuration—[6-3] Feature—Verification Code— Budget Management

使用说明书（用户手册）参考

4.1.2  管理员编程

136 使用说明书（功能手册）
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2.7.3  分机锁定

说明

分机用户可以改变电话的TRS/限制级（® 2.7.1  长途限制（TRS）/呼叫限制（限制）），这样，其他用户就不

能拨打不适当的中继线呼叫。分机个人识别号码（PIN）用于解除电话锁定（® 2.24.1  分机个人识别号码

（PIN））。此功能也称为电子话机锁定。

条件

• 此功能还限制更改FWD目的地。（® 2.3.2  呼叫转送（FWD））

• 远程分机锁定

占优插入分机锁定。如果被指定为管理员的分机在已经被分机用户锁定的分机上设定远程分机锁定，则该

用户不能解除锁定。如果管理员分机解除已经被分机用户锁定的分机锁定，则将解除该分机的锁定。此功

能也称为远程电话锁控制。

• TRS/限制级

COS编程决定了分机锁定的TRS/限制级。

使用说明书（PC编程手册）参考

10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features
→ Extension Dial Lock Set / Cancel
→ Remote Extension Dial Lock Off
→ Remote Extension Dial Lock On

10.7.1  PBX Configuration—[2-7-1] System—Class of Service—COS Settings—TRS— TRS Level on
Extension Lock

使用说明书（PT编程手册）参考

[510]分机锁定的TRS/限制级

使用说明书（功能手册）参考

5.1.1  服务等级（COS）

使用说明书（用户手册）参考

1.6.3  防止其它人使用您的电话（分机锁定）

2.1.1  分机控制
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2.7.4  拨号音转移

说明

被指定为管理员的分机可以临时改变分机用户的TRS/限制级（® 2.7.1  长途限制（TRS）/呼叫限制（限制））。

之后，分机用户就能打电话。

[示例]分机用户可以呼叫管理员释放对去电呼叫（例如：国际长途）的限制。

(1) 

(2)  TRS

(3) 

条件

• 修改后的TRS/限制级仅适用于该用户分机所拨的下一个电话。

• 长途限制/呼叫限制键

管理员分机必须将所需的TRS/限制级存储在长途限制/呼叫限制键中。可以将一个灵活键定制为长途限制/
呼叫限制键。

使用说明书（PC编程手册）参考

12.1.4  PBX Configuration—[4-1-4] Extension—Wired Extension—Flexible Button
→ Type
→ Parameter Selection (for TRS Level Change)

使用说明书（功能手册）参考

2.21.2  灵活键

使用说明书（用户手册）参考

2.1.3  限制等级控制（拨号音转移）

138 使用说明书（功能手册）
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2.7.5  流动COS
说明

用户可以在另一台分机上输入自己的分机号码和分机个人识别号码（PIN）（® 2.24.1  分机个人识别号码

（PIN）），以使用他本人的服务等级进行下列类型的呼叫，包括TRS级、占优插入另一台分机的服务等级。

• 中继线呼叫

• TIE线路呼叫

• 内线电话

• 外部继电器控制（® 2.18.4  外部继电器控制）

在执行流动COS后，指定的分机也可以使用以下功能：

• 呼叫转送（FWD）/免打扰（DND）设定（® 2.3  呼叫转送（FWD）/免打扰（DND）功能）

• 来电呼叫分配群注册/注销（® 2.2.2.8  注册/注销）

• 缺席留言设定（® 2.20.2  缺席留言）

• 分机锁定（® 2.7.3  分机锁定）

• 定时服务—更改时间方式（白天/午餐/休息/夜间）（® 5.1.4  定时服务）

条件

• 当使用流动COS进行中继线呼叫时：

– 适用于指定分机的服务等级（® 5.1.1  服务等级（COS））
– 适用于指定分机的预算（® 2.7.2  预算管理）

– 适用于指定分机的分项计费码（® 2.8.1  自动路由选择（ARS））
– 指定分机的号码作为呼叫发起人记录于SMDR上，并取代实际使用分机的分机号码（® 2.22.1.1  电话

通信详细记录（SMDR））。

• 也可通过DISA使用流动COS。（® 2.16.1  直接拨入系统接入（DISA））
• 分机PIN

使用此功能需要分机个人识别号码（PIN）。（® 2.24.1  分机个人识别号码（PIN））如果三次输入错误的

PIN，线路将被断开。

• 通过内部通话阻止功能被阻止呼叫的分机无法使用此功能。（® 2.1.2.2  内部通话阻止）

使用说明书（PC编程手册）参考

10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features— User Remote Operation /
Walking COS / Verification Code
10.7.1  PBX Configuration—[2-7-1] System—Class of Service—COS Settings—Optional Device & Other
Extensions— Remote Operation by Other Extension
12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Main— Extension
PIN

使用说明书（PT编程手册）参考

[005]分机个人识别号码（PIN）

使用说明书（功能手册）参考

2.16.1  直接拨入系统接入（DISA）
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5.1.1  服务等级（COS）

使用说明书（用户手册）参考

1.2.7  无限制的呼叫

1.2.9  从另一部分机或通过DISA设定您的电话（远程设定）

140 使用说明书（功能手册）
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2.7.6  验证码输入

说明

当用自己的分机或其它分机拨打电话时，用户可以输入验证代码以更改TRS/限制级（® 2.7.1  长途限制

（TRS）/呼叫限制（限制））或识别电话进行计费和记帐。要使用此功能，需要验证代码个人识别号码（PIN）。

条件

注意

如果第三方发现了集团电话的个人识别号码（PIN）（验证代码PIN或分机PIN），便有可能发生欺诈呼叫的

危险。

此类呼叫将向集团电话的所有者/租用者收费。

为保护集团电话免受此类欺诈使用，我们强烈建议：

a. 对PIN进行保密。

b. 选择不容易猜到的复杂、随机PIN。

c. 定期更改PIN。

• 当使用验证码输入进行中继线呼叫时：

– 适用于指定分机的服务等级（® 5.1.1  服务等级（COS））
– 适用于指定分机的预算（® 2.7.2  预算管理）

– 适用于指定分机的分项计费码（® 2.8.1  自动路由选择（ARS））
–  + 作为呼叫发起人记录于SMDR上的验证代码，取代实际分机的分机号码（® 2.22.1.1  电话通信详

细记录（SMDR））。

• 通过DISA的验证码输入

通过DISA也可使用该功能。（® 2.16.1  直接拨入系统接入（DISA））
• 验证代码PIN

必须通过系统编程或管理员编程，为每个验证代码指定一个验证代码PIN。

• 验证代码PIN锁定

如果三次输入错误的PIN，线路将被断开。如果连续输入错误的PIN次数达到预编程设定的次数，该验证代

码的PIN将被锁定。只有被指定为管理员的分机才能解除锁定。这种情况下，PIN将被解除锁定并被清除。

• 验证电话的预算管理

可以为每个验证代码的所有话费的总额指定限额。

[验证代码及其编程的示例]

位置 代码*1 姓名*2 PIN*3 COS*4
ARS的分项计费

码*5 预算*6

0001 1111 Tom Smith 1234 1 2323 5000欧元

0002 2222 John White 987654321
0

3 4545 3000欧元
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位置 代码*1 姓名*2 PIN*3 COS*4
ARS的分项计费

码*5 预算*6

: : : : : : :

*1 ® 14.3  PBX Configuration—[6-3] Feature—Verification Code— Verification Code
*2 ® 14.3  PBX Configuration—[6-3] Feature—Verification Code— User Name
*3 ® 14.3  PBX Configuration—[6-3] Feature—Verification Code— Verification Code PIN
*4 ® 14.3  PBX Configuration—[6-3] Feature—Verification Code— COS Number
*5 ® 14.3  PBX Configuration—[6-3] Feature—Verification Code— Itemised Billing Code for ARS
*6 ® 14.3  PBX Configuration—[6-3] Feature—Verification Code— Budget Management

使用说明书（PC编程手册）参考

10.3  PBX Configuration—[2-3] System—Timers & Counters—Miscellaneous— Extension PIN—Lock
Counter
10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features— User Remote Operation /
Walking COS / Verification Code
12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings

→Option 1— ARS Itemised Code
→Option 3— Charge Limit

14.3  PBX Configuration—[6-3] Feature—Verification Code

使用说明书（PT编程手册）参考

[120]验证代码

[121]验证代码名称

[122]验证代码个人识别号码（PIN）

[123]验证代码COS号码

使用说明书（功能手册）参考

2.7.2  预算管理

2.8.1  自动路由选择（ARS）
5.1.1  服务等级（COS）
5.1.6  管理员功能

6.1  系统资源的容量

使用说明书（用户手册）参考

1.2.7  无限制的呼叫

4.1.2  管理员编程

142 使用说明书（功能手册）
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2.8  自动路由选择（ARS）功能

2.8.1  自动路由选择（ARS）
说明

ARS根据预编程设定自动选择拨打的中继线呼叫去电时可用的运营商。将对所拨号码进行检查和修改，以便连

接合适的运营商。

[运营商选择程序流程图]
流程图上的号码 X  相当于以下各页上的[编程程序]。

No

No

No

No

Yes

ARS      

     

     

     

Yes

No

     

     

Yes

     

No

Yes

Yes

1

Yes

     

5

6

No

     

Yes

11

12

9

2

4

3

[编程程序]
1. ARS方式 1  分配
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当分机用户用任何空闲线路接入方法打电话时，或当分机用户用任何中继线接入方法打电话时，可以选择

ARS是否工作。（® 2.5.5.3  中继线接入）

® 16.1  PBX Configuration—[8-1] ARS—System Setting— ARS Mode
2. 前置号码特殊表 2  分配

存储将避免使用ARS功能的电话号码。

® 16.6  PBX Configuration—[8-6] ARS—Leading Number Exception

ARS

Location 

No.

 001

 002

   :

Leading No. 

Exception

033555

06456

     :

2

3. 前置号码表 3  分配

存储区域代码和/或电话号码作为将由ARS功能路由的前置号码。该表中，为各号码选择了路由计划（请参

考"4. 路由计划表 4  分配"）。
例如，只有在拨号号码后需要"#"时，才必须指定附加的（保留）位数。"#"号添加在指定的拨号号码位数之

后（前置号码除外）。

® 16.2  PBX Configuration—[8-2] ARS—Leading Number— Leading Number
® 16.2  PBX Configuration—[8-2] ARS—Leading Number— Additional Number of Digits
® 16.2  PBX Configuration—[8-2] ARS—Leading Number— Routing Plan Number

ARS

Location 

No.

0001

0002

0003

:

Routing Plan 

Table No.

1

4

5

:

Additional (Remain) 

No. of Digits

7

0

5

:

3

Leading

No.

039

03

0444

:

如果所拨号码与前置号码相匹配，就将根据相应的路由计划表对该号码进行修改，当拨打指定的附加（保

留）位数时，修改后的号码将被发送到中继线。

如果所拨号码与多个前置号码项相匹配，位置编号最低的前置号码项具有优先权。

[示例]

所拨号码 相应的路由计划表号码 说明

039-123-4567 1 在位置0001上找到了"039"并且拨了七位数（位置

0001上指定的附加[保留]位数）。拨完第七位数后立

即选择路由计划表1。
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所拨号码 相应的路由计划表号码 说明

039-654-321 1 在位置0001上找到了"039"，并且在收到第七位数之

前数字码间时间到期。

在数字码间时间到期后选择路由计划表1。

® 10.3  PBX Configuration—[2-3] System—Timers
& Counters—Dial / IRNA / Recall / Tone—
Dial—Extension Inter-digit (s)

038 4 在两个位置（位置0001和0002）上找到了"03"，因

此集团电话等待下一个数字"8"。
在任何位置上都找不到"038"，于是就选择"03"（位

置0002）。选择路由计划表4。

4. 路由计划表 4  分配

根据需要安排时间计划并存储运营商优先权。

时间表 5

由于在一周的每天里和在每天的不同时间里最佳运营商可能不同，一周的每天都能编程设定4个时段（时间

A至D）。

® 16.3.1  PBX Configuration—[8-3] ARS—Routing Plan Time—Time Setting

运营商优先权 6

指定每个时段中的合适运营商（参考"5.运营商表 7  分配"）及其优先权。按项目顺序（项目的列示顺序）

选择运营商。

® 16.4  PBX Configuration—[8-4] ARS—Routing Plan Priority

ARS

9:00

12:00

15:00

21:00

     :

9:00

12:00

15:00

21:00

Time-A

Time-B

Time-C

Time-D

    :

Time-A

Time-B

Time-C

Time-D

SUN

    :

SAT

Time Table

Routing Plan Table 1

Carrier

Priority 1 Priority 2 ...
5

6

...

...

...

...

...

...

...

...

...

ARS

0001

:

Location 

No.

Routing Plan 

Table No.

1

:

Leading 

No.

03

:

Additional 

(Remain) 

No. of Digits

8

:

3

4

1 A

1 A

1 A

3 C

:

3 C  

3 C

3 C  

3 C

4 D

2 B

2 B

1 A

:

2 B  

1 A

1 A  

2 B

5. 运营商表 7  分配

可以编程设定特定数目的运营商。为每个运营商表指定以下各项：

® 16.5  PBX Configuration—[8-5] ARS—Carrier—Carrier
运营商名称 8  ：指定运营商名称。

® 16.5  PBX Configuration—[8-5] ARS—Carrier—Carrier— Carrier Name
删除的位数 9  ：指定从用户所拨号码开始处要删除的位数。
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® 16.5  PBX Configuration—[8-5] ARS—Carrier—Carrier— Removed Number of Digits
运营商接入代码 10  ：指定用来接入运营商的代码。

® 16.5  PBX Configuration—[8-5] ARS—Carrier—Carrier— Carrier Access Code
中继线群 11：指定连接到每个运营商的中继线群和选择优先权。

当使用Web维护控制台时，可通过每个中继线群的开/关设定将中继线群分配给一个运营商。还可以提供它

们决定在获取线路时搜索顺序的优先权设定（1–4）。如果中继线群中没有线路设定为优先1–4，则设定为

开的其它中继线群会首先以最小号码的顺序搜索。

[示例]

运营商
优先权设定 中继线群设定为

开
搜索顺序

1 2 3 4

ABC 9 3 1 7 5, 7, 9, 11 9 ® 3 ® 1 ® 7 ® 5 ® 11

XYZ 12 4 无 无 6, 10 12 ® 4 ® 6 ® 10

® 16.5  PBX Configuration—[8-5] ARS—Carrier—TRG Priority
® 16.5  PBX Configuration—[8-5] ARS—Carrier—TRG 01–TRG 64
修改命令 12  ：指定用来修改接入运营商的拨号号码的命令。

® 16.5  PBX Configuration—[8-5] ARS—Carrier—Carrier— Modify Command
CLIP Table No. 16：为运营商分配CLIP号码。根据为运营商分配的CLIP Table No.分配CLIP号码。

® 16.5  PBX Configuration—[8-5] ARS—Carrier—Carrier— CLIP Table No.

[命令说明]

命令 说明

Number 增加号码。

C 增加运营商接入代码。

P 模拟线路：插入暂停。

ISDN/E1线路：插入暂停并更改为音频（DTMF）信号。

A 增加租户的特许码（13）。

G 增加中继线群的特许码（14）。

I 增加分项计费码（15）。

H 在删除数字后增加拨号号码（初始位置）。
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[编程示例]

A

6

0077

1, 2, 3

CH#12

2

Carrier Name

Removed Number of Digits

Carrier Access Code

Trunk Group

Modify Command

Carrier Table 7

CLIP Table No.16

9

10

11

8

12

B

0

0088

1, 2

CH

1

1 2

0123456789

0234567861

0356894526

          :

0856325889

1

2

3

8

CLIP

 1001

CLIP

[ ]

0123456789

   

     

  012345  6789            0077 6789 #12

69

CLIP 023456786116

12

(     )C

H

#12

10

注

• 如果用ARS将ARS分项代码设为作为CLIP发送，则以下设定占优并用作CLIP。
12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Option
1— ARS Itemised Code

• 根据以下设定自动设定CLIP Table No.1。
12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—CLIP—
CLIP ID

6. 任选分配

租户的特许码 13
可以为每个运营商和每个租户指定一个特许码。

® 16.5  PBX Configuration—[8-5] ARS—Carrier—Authorisation Code for Tenant

中继线群的特许码 14
可以为每个中继线群和每个运营商指定一个特许码。

® 16.7  PBX Configuration—[8-7] ARS—Authorisation Code for TRG

分项计费码 15
可以为每部分机和每个验证代码指定一个分项计费码。

如果不是从分机（例如：DISA或TIE）打电话，并且没有使用验证代码，则将使用在验证代码的位置1上指

定的分项计费码。

® 12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Option 1—
ARS Itemised Code
® 14.3  PBX Configuration—[6-3] Feature—Verification Code— Itemised Billing Code for ARS
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条件

注意

允许用户接入网络的ARS功能中所含软件必须升级，以便辩认新建立并投入使用的网络区域代码和交换代

码。

如果没有升级集团电话系统内部设置或外围设备，导致不能识别新建立的代码，将会限制集团电话的客户

和用户接入网络和这些代码。

请保持软件与最新数据同步更新。

• SMDR上的所拨号码

通过系统编程，可以选择打印SMDR上的用户所拨号码或经修改的号码。（® 2.22.1.1  电话通信详细记录

（SMDR））

® 19.1  PBX Configuration—[11-1] Maintenance—Main—SMDR Options— Option—ARS Dial
• ARS数据下载/上传

使用PC编程能够将以下ARS数据下载或上传到集团电话：

– 2  ARS前置号码特殊表

– 3  ARS前置号码表

– 4  ARS路由计划表

® 6.6  Tool—Import
® 6.7  Tool—Export

这在运营商改变话费时会很有用，并且可以将最新数据用于多个客户。

• 应用ARS前进行TRS/限制检查。（® 2.7.1  长途限制（TRS）/呼叫限制（限制））

使用说明书（PC编程手册）参考

6.6  Tool—Import
→ARS - Leading Digit
→ARS - Except Code
→ARS - Routing Plan

6.7  Tool—Export
10.3  PBX Configuration—[2-3] System—Timers & Counters—Dial / IRNA / Recall / Tone— Dial—Extension
Inter-digit (s)
10.9  PBX Configuration—[2-9] System—System Options—Option 3— Dial Tone—Dial Tone for ARS
12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Option 1— ARS
Itemised Code
14.3  PBX Configuration—[6-3] Feature—Verification Code— Itemised Billing Code for ARS
Section  16  PBX Configuration—[8] ARS
19.1  PBX Configuration—[11-1] Maintenance—Main—SMDR Options— Option—ARS Dial

使用说明书（PT编程手册）参考

[320] ARS方式

[321] ARS前置号码

[322] ARS路由计划表号码

[325] ARS特殊号码

[330] ARS路由计划时间表
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[331–346] ARS路由计划表（1–16）
[347] ARS路由计划表（1–48）
[350] ARS运营商名称

[351]运营商接入的ARS中继线群

[352]运营商接入的ARS删除的位数

[353] ARS运营商接入代码

使用说明书（功能手册）参考

6.1  系统资源的容量
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2.9  主要号码簿号码（PDN）/次要号码簿号码（SDN）
功能

2.9.1  主要号码簿号码（PDN）/次要号码簿号码（SDN）分机

说明

主要号码簿号码（PDN）键和次要号码簿号码（SDN）键非常适合在老板和秘书之间使用。当呼叫（内线或中

继线）到达老板分机上的PDN键时，呼叫将在秘书的分机上振铃，同时SDN键的发光二极管将闪烁，表示有来

电到达了老板的分机。此外，来电的来电者信息（如来电显示）将显示在秘书的分机上。秘书只需按SDN键即

可为老板应答呼叫。可以为PDN或SDN键设定延迟振铃。

秘书可以保留在SDN键应答的呼叫，老板只需按PDN键即可恢复保留的呼叫，类似通过S-CO键应答呼叫。此

外，秘书可以采用简单的操作将SDN键或其它键（如S-CO键）的呼叫转移到老板的分机，类似使用DSS键。

一部分机可以具有数个SDN键，每一个键分别注册到不同老板的分机。但是，对于一个老板，每部分机只能注

册一个SDN键。一部分机最多可以拥有八个PDN键。PDN键可以简化分机的使用，因为内线和中继线呼叫均可

以通过PDN键拨出和接收。

通过SDN键拨打电话

通过COS编程为SDN分机（秘书）指定了标准的SDN键方式时，SDN分机（秘书）可以通过SDN键为PDN分

机（老板）拨打电话。例如，老板可以吩咐秘书拨打电话并保留呼叫，之后老板可以恢复保留的呼叫。

通过COS编程，可以让SDN分机使用PDN分机的COS拨打电话。使用流动COS功能时可用的所有其它设定也

会被应用（® 2.7.5  流动COS）。
SDN直接拨号

SDN分机可以使用SDN键呼叫PDN分机或将呼叫转移到PDN分机。

在这种情况下：

– 只有PDN分机会振铃（也就是说其它SDN分机不会振铃）。

– PDN分机的延迟振铃和免打扰设定会被忽略。

根据通过COS编程选择的方式，SDN直接拨号会以下列两种方式之一执行：

– 加强DSS键方式：按一次SDN键。

– 标准SDN键方式：按两次SDN键（第一次按SDN键时会听到拨号音）。

无论何种方式，均可以通过按一次SDN键将使用SDN键应答的呼叫转移到PDN分机。

发光二极管提示

发光二极管类型及其对应的PDN和SDN键的状态如下所示：

指示灯类型 PDN键的状态 SDN键的状态

关闭 该分机空闲。 对应的PDN分机空闲。

绿灯亮 分机正在使用PDN键打电话。 分机正在使用SDN键打电话。

绿灯慢闪 正在使用PDN键保留呼叫。 正在使用SDN键保留呼叫。

绿灯中速闪烁 • 通过PDN键接打的电话正处于专用呼

叫保留或协商保留。

• PDN分机正在通过PDN键向会议添加

成员或将该线路用于无人值守会议。

• 使用SDN键应答的电话正处于专用呼叫

保留或协商保留。

• SDN分机正在向会议添加成员或将该线

路用于无人值守会议。
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指示灯类型 PDN键的状态 SDN键的状态

绿灯快速闪烁 有来电到达此分机。 从使用SDN键应答的呼叫收到保留重呼或自

动回叫振铃。

红灯亮 对应的SDN分机正在：

• 打电话。

• 使用专用呼叫保留或协商保留保留线

路。

• 向会议添加成员。

• 将该线路用于无人值守会议。

• 收到保留重呼或自动回叫振铃。

对应的PDN分机或其它对应的SDN分机正

在：

• 打电话。

• 使用专用呼叫保留或协商保留保留线路。

• 向会议添加成员。

• 将该线路用于无人值守会议。

• 收到仅接到PDN分机的来电（如回叫振

铃）。

红灯慢闪 对应的SDN分机正在保留呼叫。 对应的PDN分机或其它对应的SDN分机正在

保留呼叫。

红灯快闪 呼叫到达该分机所属的使用振铃分配方法

的来电呼叫分配（ICD）群。

对应的PDN分机正在接收来电。

当PDN分机上有多个呼叫时，对应的SDN键上显示的发光二极管类型将按以下优先级显示：

接收来电 ® 保留呼叫 ® 打电话 ® 空闲

例如，如果PDN分机在打电话时收到来电，对应SDN分机上的发光二极管将显示来电。

但是，如果SDN正在使用SDN键处理呼叫（如打电话、保留电话等等），该呼叫的状态将显示在SDN键上，无

论PDN分机的呼叫处于何种状态。

秘书为多个老板处理呼叫的示例

以下示例演示每部分机的PDN和SDN键的发光二极管类型以及如何处理呼叫。

1. 来自111-1111的呼叫到达分机101

SDN

103

102

101

PDN

102

PDN PDN

103

SDN

103

101

SDN 

102

101

2. 分机103应答来自111-1111的呼叫

PDN SDN

103

102

101

PDN

102

PDN

103

SDN

103

101

SDN

102

101
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3. 分机103保留来自111-1111的呼叫

SDN

103

102

101

SDN

103

101

102

PDN SDN

102

103

PDN

101

PDN

4. 分机101应答分机103保留的呼叫

SDN

103

102

101

PDN

102

PDN SDN

102

103

PDNSDN

103

101 101

5. 来自222-2222的呼叫到达分机101

SDN

103

102

101 102

PDN

103

PDNPDN SDN

102

101

SDN

103

101

6. 来自333-3333的呼叫到达分机102

SDN

103

102

101

SDN

103

101

102 103

PDNPDN PDN SDN

102

101

7. 分机103应答来自333-3333的呼叫

SDN

103

102

101

SDN

103

101

102

PDN

103 

PDNPDN SDN

102

101

152 使用说明书（功能手册）

2.9.1 主要号码簿号码（PDN）/次要号码簿号码（SDN）分机



8. 分机103将来自333-3333的呼叫转移到分机102

SDN

103

102

101 102 103

PDNPDN SDN

103

101

PDN SDN

102

101

条件

[一般]
• 可以将PT的一个灵活键定制为PDN或SDN键。可以将DSS话务台的一个灵活键定制为SDN键。

• 一部分机最多可以拥有八个PDN键。

• 如果分机没有空闲的PDN键，该分机将不会接收来电，包括呼叫等待。因此，我们极力建议PDN分机最少

有三个PDN键。

• 通过COS编程，可以选择分机是否可以使用PT编程在自己的分机上创建SDN键。

• 相同的PDN分机最多可以有八部与其对应的分机分配到SDN键。

• 当PDN分机具有空闲CO键或ICD群键时，呼叫将按照以下优先级到达以下键：

– 到达ICD群的内线电话来电：ICD群键 ® PDN键

– 中继线呼叫来电：S-CO键 ® G-CO键 ® L-CO键 ® PDN键

– 到达ICD群的中继线呼叫来电：ICD群键 ® S-CO键 ® G-CO键 ® L-CO键 ® PDN键

• 当PDN分机上有多个相同状态（如保留）的呼叫时，对应的SDN分机上将显示最早呼叫的状态。例如，如

果PDN分机有两个呼叫振铃，按SDN键时SDN分机将应答最先到达PDN分机的呼叫。

• 如果PDN分机是使用振铃分配方法的ICD群的成员，当来电到达ICD群时，来电状态不会显示在对应的SDN
分机的发光二极管上（® 2.2.2.1  来电呼叫分配群功能—概要）。

• 如果分机的PDN键均不空闲，注册到PDN分机的其它分机的DSS键将呈红色亮起。

• 振铃音类型

通过系统编程，每部分机可以为PDN键设定振铃音类型。可以分别为每个SDN键指定振铃音类型。

• 去电线路优先

当选择了"PDN"作为去电线路优先时，去电将在第一个可用的PDN键发起（® 2.5.5.2  线路优先─去电）。

• 来电线路优先

通过系统编程，可选择"PDN"作为来电线路优先，以便摘机只会应答到达PDN键的来电（® 2.4.2  线路优

先─来电）。这可以防止摘机时应答到达非PDN键（如SDN键）的呼叫。

• 可移动分机

对于PDN分机，可移动分机功能只有在所有PDN键均空闲时才能使用（® 2.24.3  可移动分机功能）。

• 一个编号分机

如果分机具有PDN或SDN键，无法将一个编号分机的子分机分配至该分机（® 2.11.11  一个编号分机）。

• OHCA/耳语OHCA
除非使用对应的SDN键拨打电话，否则PDN分机无法接收OHCA或耳语OHCA（® 2.10.4.3  摘机呼叫通知

（OHCA），® 2.10.4.4  耳语OHCA）。
• 交替呼叫—振铃/话音

除非使用对应的SDN键拨打电话，否则呼叫PDN分机时无法暂时改变被叫方的预设呼叫接收方法（振铃音

或话语）（® 2.5.3  内线电话）。

• 当使用PDN/SDN键的免提扬声器呼叫使用CTI保留时，通过系统编程可以强制某一分机变为空闲（免提键

的灯将熄灭）。
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[延迟振铃]
• 一部分机上的所有PDN键会应用相同的延迟振铃设定。可以分别为每个SDN键指定延迟振铃。

• 设定了延迟振铃时如果接收到呼叫，不会立即在PT上显示来电者信息（如来电显示）。

• 可将SDN键设定为来电不振铃（仅闪烁）。但是，PDN键不能使用此设定。

• PDN分机开始振铃时，转送无应答定时器开始计时。

使用说明书（PC编程手册）参考

10.7.1  PBX Configuration—[2-7-1] System—Class of Service—COS Settings—PDN/SDN
10.8.3  PBX Configuration—[2-8-3] System—Ring Tone Patterns—Call from Others— Extension—Ring Tone
Pattern Plan 1–8
10.9  PBX Configuration—[2-9] System—System Options—Option 4— System Wireless—SDN Delayed
Ringing with LCD
10.9  PBX Configuration—[2-9] System—System Options—Option 6 (CTI)— CTI Hold—Forced Idle when
Hold by PDN/SDN Key
12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Option 1— Wireless
XDP / Shared Extension
12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Option 9— PDN
Delayed Ringing
12.1.4  PBX Configuration—[4-1-4] Extension—Wired Extension—Flexible Button

→ Type
→ Parameter Selection (for SDN)
→ Extension Number (for SDN)
→ Optional Parameter (Ringing Tone Type Number) (for Loop CO, Single CO, Group CO, ICD Group,
SDN)

12.3  PBX Configuration—[4-3] Extension—DSS Console

使用说明书（功能手册）参考

2.2.2.2  群呼叫分配

2.21.3  发光二极管提示

5.1.1  服务等级（COS）
6.1  系统资源的容量

使用说明书（用户手册）参考

1.4.2  保留一个呼叫

1.5.1  主要号码簿号码（PDN）/次要号码簿号码（SDN）分机

 使用您在另一部分机的呼叫权限（远程COS接入）
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2.10  占线线路/占线用户功能

2.10.1  占线自动回叫（预占线）

说明

如果拨打电话时目的地或线路占线，分机用户可以设定占线自动回叫功能。集团电话会监听目的地或中继线的

状态，一旦可用，将向主叫分机发送回叫振铃通知用户。分机应答回叫振铃后，将自动重拨先前拨打的分机号

码，或自动取得中继线。

条件

• 如果在10秒种内没有应答回叫振铃，回叫就被取消。

• 如果分机在拨电话号码前听到忙音，则只有中继线或中继线群被保留。在应答回叫振铃后，分机应拨电话

号码。

• 一部分机只能设定一个占线自动回叫。最后设定是有效设定。

• 多个分机用户可以将此功能同时设定到一条中继线。

然而，最多4个分机用户可以将此功能设定到一部分机。

回叫振铃将按设定该功能的先后顺序发送至分机。换言之，首先设定该功能的分机将首先收到回叫振铃。

• 此功能不能用于对VPS、统一消息系统、SIP分机或ISDN分机的呼叫。

使用说明书（PC编程手册）参考

10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features— Automatic Callback Busy
Cancel
10.6.3  PBX Configuration—[2-6-3] System—Numbering Plan—B/NA DND Call Feature— Automatic
Callback Busy

使用说明书（用户手册）参考

1.2.4  当被拨线路占线或没有应答时
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2.10.2  主管遇忙优先插入

说明

允许分机用户中断现有呼叫以建立三方会议电话。

主管遇忙优先插入拒绝：

分机用户能够防止其电话被另一个分机用户截取。

单键主管遇忙优先插入：

分机用户只需按下进行中的S-CO按钮便可执行主管遇忙优先插入，而无需输入功能号码。该功能可以通过系

统编程启用。

主管遇忙优先插入之前的来电信息：

老板等PT用户可在执行主管遇忙优先插入之前使用DSS键确认呼叫另一部分机的来电信息。

在按了对应的DSS键之后，且当听到忙音时，用户可在LCD上检查来电信息。然后，如有需要，用户可中断呼

叫（主管遇忙优先插入）。

条件

[一般]
• COS编程决定了可以使用主管遇忙优先插入和设定主管遇忙优先插入拒绝的分机用户。

• 当占线分机处于以下情况之一时，此功能不起作用：

a. 已设定了主管遇忙优先插入拒绝或数据线路安全（® 2.11.5  数据线路安全）功能。

b. 当被另一部分机监听时（® 2.10.3  呼叫监听）。

c. 当接收OHCA时（® 2.10.4.3  摘机呼叫通知（OHCA）、® 2.10.4.4  耳语OHCA）。
d. 在会议电话期间（® 2.14  会议功能）。

e. 在门电话呼叫期间（® 2.18.1  门电话呼叫）。

f. 当现场呼叫屏蔽（LCS）或双向录音启动时（® 3.2.2.16  现场呼叫屏蔽（LCS）和3.2.2.30  双向录音/
双向转移）。

g. 在协商保留期间。

• 此功能不能用于经DISA的中继线到中继线呼叫。

[主管遇忙优先插入]
• 无法在启用了该功能的中继线上使用占线自动回叫（® 2.10.1  占线自动回叫（预占线））。

使用说明书（PC编程手册）参考

10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features— Executive Override Deny
Set / Cancel
10.6.3  PBX Configuration—[2-6-3] System—Numbering Plan—B/NA DND Call Feature— Executive Busy
Override
10.7.1  PBX Configuration—[2-7-1] System—Class of Service—COS Settings—Executive

→ Executive Busy Override
→ Executive Busy Override Deny

10.9  PBX Configuration—[2-9] System—System Options—Option 1— PT Operation—One-touch Busy
Override by SCO key
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12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Option 3— Executive
Override Deny

使用说明书（PT编程手册）参考

[505]主管遇忙优先插入

[506]主管遇忙优先插入拒绝

使用说明书（功能手册）参考

5.1.1  服务等级（COS）

使用说明书（用户手册）参考

1.2.4  当被拨线路占线或没有应答时

1.9.7  防止其它人加入您的通话（主管遇忙优先插入拒绝）
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2.10.3  呼叫监听

说明

允许一个分机用户听取占线分机用户的当前通话。用户可以听取通话，但用户的语音不会被听到。如果需要，

可以中断呼叫建立三方会议电话。

呼叫监听之前的来电信息：

老板等PT用户可在执行呼叫监听之前使用DSS键确认呼叫另一部分机的来电信息。

在按了对应的DSS键之后，且当听到忙音时，用户可在LCD上检查来电信息。然后，如有需要，用户可监听呼

叫。

条件

• COS编程决定了可以使用此功能的分机用户。

• 此功能只有在占线分机正在与另一部分机或外线用户通话时才能使用。

• 当占线分机处于以下情况之一时，此功能不起作用：

a. 已设定了主管遇忙优先插入拒绝（® 2.10.2  主管遇忙优先插入）或数据线路安全（® 2.11.5  数据线

路安全）功能。

b. 当接收OHCA时（® 2.10.4.3  摘机呼叫通知（OHCA），® 2.10.4.4  耳语OHCA）。
c. 在有4位或更多与会者的会议电话期间（® 2.14  会议功能）。

d. 在门电话呼叫期间（® 2.18.1  门电话呼叫）。

e. 当现场呼叫屏蔽（LCS）启动时（® 3.2.2.16  现场呼叫屏蔽（LCS））。
f. 在协商保留期间。

• 当占线分机用户在通话期间按以下键时，此功能停止（® 2.21.1  固定键和2.21.2  灵活键）：

– 闪断键

– 保留键

– 转移键

– 会议键

– DSS键
– EFA键
– 双向录音键

– 双向转移键

– 单键双向转移键

– 语音信箱（VM）转移键

• 监听正在录音的呼叫

当用户监听正在录音的呼叫时，不会录制该用户的语音。对内线电话录音时，可以在其中任一分机上执行

呼叫监听。

也可以对正在录音的呼叫执行主管遇忙优先插入。在这种情况下，将录制该用户的语音。

当原呼叫成员离开主管遇忙优先插入所创建的会议时，录音将停止，其余分机按如下方式操作：

– 如果已设置管理员自动双向录音，将根据这些设置重新开始录音。

– 如果未设置管理员自动双向录音，其中一方可以按下双向录音键开始新录音。

如果执行呼叫监听的用户是通过QSIG (TIE)连接的，则无法监听在2个分机之间录制的呼叫。

• 监听会议

当用户监听三方会议时，可以听到全部的3位参与者的语音。

也可以对三方会议执行主管遇忙优先插入。在这种情况下，将建立四方会议。

不能对保留的会议执行呼叫监听。
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不能对会议发起人在外线（例如，从手机呼入）的三方会议执行呼叫监听。

如果执行呼叫监听的用户是通过QSIG (TIE)连接的，将无法监听3方会议电话。

使用说明书（PC编程手册）参考

10.6.3  PBX Configuration—[2-6-3] System—Numbering Plan—B/NA DND Call Feature— Call Monitor
10.7.1  PBX Configuration—[2-7-1] System—Class of Service—COS Settings—Executive— Call Monitor
12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings

→Option 2— Data Mode
→Option 3— Executive Override Deny

使用说明书（功能手册）参考

2.14  会议功能

3.2.1.4  管理员自动双向录音

3.2.2.30  双向录音/双向转移

5.1.1  服务等级（COS）

使用说明书（用户手册）参考

1.2.4  当被拨线路占线或没有应答时

1.15.1  移动电话功能
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2.10.4  给占线分机第二个呼叫的通知

2.10.4.1  给占线分机第二个呼叫的通知—概要

说明

当试图呼叫一部占线分机（正在振铃或在通话中）时，分机用户可以给占线分机发送呼叫等待提示（呼叫等

待）。通知接收方法取决于被叫分机的个人设定和电话类型：

通知接收方法 说明与参考

呼叫等待音 给占线分机发送呼叫等待音。

® 2.10.4.2  呼叫等待音

摘机呼叫通知（OHCA） 在用话筒进行当前通话的同时，用被叫分机的内置扬声器和麦克风

与占线分机交谈。

® 2.10.4.3  摘机呼叫通知（OHCA）

耳语OHCA 通过话筒向占线分机发送口头留言，只有被叫分机用户可以直接听

到，而不中断正在进行的通话。

® 2.10.4.4  耳语OHCA

条件

• 每个分机用户都可以选择接收呼叫等待音、OHCA、耳语OHCA或一个都不接收。

• 通过主叫分机的COS允许或停用OHCA和耳语OHCA。
• OHCA和耳语OHCA对某些类型的电话不起作用。在这些情况下，将给被叫分机发送呼叫等待音。

主叫分机的OH-
CA COS方式

被叫分机的呼叫等待方式

关闭 开启

取消 呼叫等待音 OHCA 耳语OHCA

停用 呼叫等待停用 呼叫等待音 呼叫等待音 呼叫等待音

允许 呼叫等待停用 呼叫等待音 OHCA（或呼叫等

待音）

耳语OHCA（或呼

叫等待音）

• 只有当被叫分机正在与另一方通话时，才能使用通知接收方法（呼叫等待音、OHCA和耳语OHCA）。如果

被叫方尚未与另一方连接（例如：仍在振铃，处于保留等），主叫分机将听到回铃音并处于等待状态，直到

被叫分机可以接收呼叫等待通知。

• 如果被叫方分机没有设定任何一种通知接收方法（呼叫等待音、OHCA或耳语OHCA），主叫方将听到挂机

重拨音。
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使用说明书（功能手册）参考

2.1.3.3  呼叫等待

使用说明书（用户手册）参考

1.2.4  当被拨线路占线或没有应答时

1.9.3  接收呼叫等待（呼叫等待/摘机呼叫通知[OHCA]/耳语OHCA）
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2.10.4.2  呼叫等待音

说明

当一个分机用户试图呼叫一部占线分机（正在振铃或在通话中）时，可以给被叫分机发送呼叫等待音，让他知

道另一个呼叫正在等候。

条件

• 此功能只有在被叫分机已启动呼叫等待时才起作用。如果呼叫等待已启动，主叫分机将听到回铃音。

• 可以通过个人编程选择呼叫等待音（音频1或2）（呼叫等待音类型选择）。

• 当头戴式耳机方式打开时，您可以选择从电话的扬声器还是从头戴式耳机的听筒收听呼叫等待音。但是，

此设定仅可在支持呼叫等待音路径切换的终端进行（KX-DT521、KX-DT543和KX-DT546）。

使用说明书（PC编程手册）参考

9.14  PBX Configuration—[1-1] Configuration—Slot—Port Property—V-IPEXT—Option— C.Waiting with 
Headset
9.22  PBX Configuration—[1-1] Configuration—Slot—Port Property—Extension Type— C.Waiting with 
Headset
10.3  PBX Configuration—[2-3] System—Timers & Counters—Miscellaneous— Caller ID—Visual Caller ID
Display (s)
10.6.3  PBX Configuration—[2-6-3] System—Numbering Plan—B/NA DND Call Feature

→ BSS / OHCA / Whisper OHCA / DND Override
→ BSS / OHCA / Whisper OHCA / DND Override-2

12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings
→Option 2— Manual C. Waiting for Extension Call
→Option 2— Automatic C. Waiting
→Option 4— Call Waiting Tone Type

使用说明书（用户手册）参考

1.9.3  接收呼叫等待（呼叫等待/摘机呼叫通知[OHCA]/耳语OHCA）
3.1.2  编程方式设定
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2.10.4.3  摘机呼叫通知（OHCA）

说明

分机用户可以通过被叫方PT的内置扬声器和麦克风与占线分机通话。如果当前通话正在使用话筒，使用免提扬

声器和麦克风可以进行第二个通话，这样，被叫分机就能与双方通话。

条件

• COS编程决定了哪些分机可以使用此功能。

• 当被叫分机使用以下电话之一时，该功能可用：

– KX-T7625, KX-T7630, KX-T7633, KX-T7636, KX-DT333, KX-DT343, KX-DT346, KX-DT521,
KX-DT543, KX-DT546

– KX-T7536
– KX-T7436

• 在下列情况下不能使用OHCA功能：

a. COS或被叫分机的电话类型不适用于此功能。

b. 被叫分机（DPT）处于DXDP连接中。

呼叫等待音被发送到被叫分机。（® 2.10.4.2  呼叫等待音）

• 当一部分机正在接收OHCA时，如果分机用户置当前的中继线呼叫于保留或转移当前的内线电话或中继线

呼叫，OHCA将变成停用，主叫分机将开始听到回铃音。

• 当一部分机正在接收OHCA时，如果分机用户置当前的内线电话于保留，被叫分机可以通过话筒与主叫分

机通话。

使用说明书（PC编程手册）参考

10.6.3  PBX Configuration—[2-6-3] System—Numbering Plan—B/NA DND Call Feature
→ BSS / OHCA / Whisper OHCA / DND Override
→ BSS / OHCA / Whisper OHCA / DND Override-2

10.7.1  PBX Configuration—[2-7-1] System—Class of Service—COS Settings—Assistant— OHCA / Whisper
OHCA

使用说明书（功能手册）参考

5.1.1  服务等级（COS）

使用说明书（用户手册）参考

1.9.3  接收呼叫等待（呼叫等待/摘机呼叫通知[OHCA]/耳语OHCA）
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2.10.4.4  耳语OHCA
说明

分机用户可以通过话筒向占线分机发送口头留言，只有被叫分机用户可以直接听到，而不中断正在进行的通

话。主叫方不能听到正在进行的通话，也不会听到被叫分机用户的回答，除非被叫分机用户将当前通话方置于

保留状态并切换至等待中的主叫方。

条件

• COS编程决定了哪些分机可以使用此功能。

• 当主叫分机和被叫分机使用以下电话之一时，可以使用此功能：

– KX-DT300系列

– KX-DT500系列

– KX-T7600系列

– KX-T7500系列

– KX-T7400系列（KX-T7451除外）

– IP-PT
• 如果由于COS或电话类型原因而不能使用耳语OHCA功能，将会给被叫分机发送呼叫等待音。（®

2.10.4.2  呼叫等待音）

• 要在IP-PT上接收耳语OHCA，首选的编解码器必须是G.711或G.729A。如果分机用户使用G.722编解码器

打电话并接收耳语OHCA，则他会听到呼叫等待音。（® 2.10.4.2  呼叫等待音）

• 如果被叫分机没有使用KX-DT300、KX-DT500、KX-T7600、KX-T7500或KX-T7400系列电话或IP-PT，但

强制使用了耳语OHCA，对方可以听到此通知。

• 可以允许任何电话使用耳语OHCA。但是，它可能工作不正常。（例如：话音可能被对方听到。）

• 当非IP分机连接至非IP中继线且分机接收耳语OHCA时，耳语OHCA将无效。分机用户只能听到呼叫等待

音。（® 2.10.4.2  呼叫等待音）

• 当一部分机正在接收耳语OHCA时，如果分机用户置当前的中继线电话于保留或转移当前的内线电话或中

继线呼叫，耳语OHCA将变成停用，主叫分机将开始听到回铃音。

• 当一部分机正在接收耳语OHCA时，如果分机用户置当前的内线电话于保留，被叫分机可以通过话筒与主

叫分机通话。

使用说明书（PC编程手册）参考

9.14  PBX Configuration—[1-1] Configuration—Slot—Port Property—V-IPEXT—Option— IP Codec Priority
10.6.3  PBX Configuration—[2-6-3] System—Numbering Plan—B/NA DND Call Feature

→ BSS / OHCA / Whisper OHCA / DND Override
→ BSS / OHCA / Whisper OHCA / DND Override-2

10.7.1  PBX Configuration—[2-7-1] System—Class of Service—COS Settings—Assistant— OHCA / Whisper
OHCA

使用说明书（功能手册）参考

5.1.1  服务等级（COS）
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使用说明书（用户手册）参考

1.9.3  接收呼叫等待（呼叫等待/摘机呼叫通知[OHCA]/耳语OHCA）
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2.11  通话功能

2.11.1  免提操作

说明

PT用户不用拿起话筒就能与另一方通话。接特定键（例如：重拨）可自动启动免提方式。

条件

• 带有监听键的PT
带有监听键的PT只能用免提方式拨号，而不能用于免提通话。

使用说明书（PC编程手册）参考

10.3  PBX Configuration—[2-3] System—Timers & Counters—Dial / IRNA / Recall / Tone— Tone
Length—Reorder Tone for PT Hands-free (s)
12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Option 4— LCS
Answer Mode
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2.11.2  摘机监听

说明

PT用户在使用话筒进行通话过程中，可以让其他人通过内置扬声器听到用户通话。

条件

• 可用电话

– KX-DT300系列

– KX-DT500系列

– KX-T7600系列

– KX-T7500系列（仅显示PT）
– KX-T7400系列（仅显示PT）
– KX-NT系列

• 若要允许此功能，需要进行系统编程。如果停用，就进行免提通话。

使用说明书（用户手册）参考

1.4.7  让其它人听到通话（摘机监听）
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2.11.3  静音

说明

在通话过程中，PT用户可以停用扬声器麦克风或话筒麦克风，以与其他人私下商谈，同时通过内置扬声器或话

筒接收器听取电话对方的谈话。静音时，用户可以听到对方的声音，但是不会被对方听到。

条件

• 此功能适用于所有具有自动应答/静音键的PT。

使用说明书（用户手册）参考

1.4.6  静音
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2.11.4  头戴式耳机操作

说明

本集团电话允许使用兼容头戴式耳机的PT。PT用户不用拿起话筒就能与另一方通话。此功能也称为话筒/头戴

式耳机选择。

关于连接和操作，请参考头戴式耳机的操作说明。

条件

• 硬件要求：任选的头戴式耳机

• 如果头戴式耳机方式已经打开，按免提键会启动头戴式耳机，而不是内置扬声器。

• 若要在DPT或IP-PT上设定头戴式耳机方式，请使用个人编程（头戴式耳机操作）或按头戴式耳机键。若要

在APT上设定头戴式耳机方式，请使用电话机上和/或头戴式耳机上提供的话筒/头戴式耳机选择器。

• 头戴式耳机键

可以将DPT或IP-PT上的灵活键定制为头戴式耳机键。可以将头戴式耳机键指定给APT上的灵活键，但是该

键将不起作用。

• 应答/释放键

可以将一个灵活键定制为应答键或释放键。这种键对头戴式耳机操作很有用。通过按应答键可以应答来电。

而在通话过程中听到呼叫等待音时，按应答键可以置当前的呼叫于保留而应答第二个呼叫。在通话中或通

话后按释放键可以断开线路，或完成呼叫转移。

• 在通话过程中，按头戴式耳机键可以将头戴式耳机方式切换到免提方式或相反。

• 头戴式耳机用户不能使用下列功能：

– 自动重拨（® 2.6.3  最后号码重拨）

– 接收OHCA
– 接收耳语OHCA（® 2.10.4.4  耳语OHCA）

使用说明书（PC编程手册）参考

9.14  PBX Configuration—[1-1] Configuration—Slot—Port Property—V-IPEXT—Option— Headset OFF/ON
9.22  PBX Configuration—[1-1] Configuration—Slot—Port Property—Extension Type— Headset OFF/ON
12.1.4  PBX Configuration—[4-1-4] Extension—Wired Extension—Flexible Button— Type
12.3  PBX Configuration—[4-3] Extension—DSS Console— Type

使用说明书（功能手册）参考

2.21.2  灵活键

使用说明书（用户手册）参考

1.3.5  使用ANSWER/RELEASE（应答/释放）键

1.4.8  使用头戴式耳机（头戴式耳机操作）

3.1.2  编程方式设定
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2.11.5  数据线路安全

说明

在分机上设定数据线路安全可以保护分机与对方之间的通信，免受各种信号如呼叫等待、保留重呼和主管遇忙

优先插入等的干扰。使用相连的数据设备（例如：传真机）的分机可以设定此功能，以便在通信过程中保持数

据安全传送，免受其它分机的信号音干扰或中断。

使用说明书（PC编程手册）参考

10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features— Data Line Security Set /
Cancel
12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Option 2— Data
Mode

使用说明书（用户手册）参考

1.9.9  保护您的线路免受通知音干扰（数据线路安全）
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2.11.6  闪断/重呼/终止

说明

当PT用户断开当前呼叫并在不先挂机的情况下打另一个电话时，使用闪断键（闪断/重呼方式或终止方式）或

终止键（终止方式）。它执行与挂机然后又摘机相同的功能。

[每种方式的说明]
闪断/重呼方式：断开线路。分机用户听到来自最后使用线路的拨号音。例如，如果断开的是中继线呼叫，分机

用户将听到来自电话公司的新拨号音。

终止方式：断开线路。分机用户听到由线路优先─去电设定所决定的拨号音。（® 2.5.5.2  线路优先─去电）

条件

• 闪断键方式

通过系统编程可以为每部分机选择以下其中一种方式：

– 闪断/重呼方式

– 终止方式

– 外部功能接入（EFA）方式。（® 2.11.7  外部功能接入（EFA））
• 终止键

可以将一个灵活键定制为终止键。

• 断开时间（仅用于闪断/重呼方式）

对于每个中继线端口，对同一中继线的相继接入之间的时间量是可以编程设定的。

• 此功能输出SMDR呼叫记录（® 2.22.1.1  电话通信详细记录（SMDR）），重新起动呼叫定时器，插入自动

暂停，并再次检查TRS/限制级（® 2.7.1  长途限制（TRS）/呼叫限制（限制））。

• 在下列情况下，按闪断键时将执行终止功能，而不管闪断键已被设定成何种方式：

– 当使用ARS进行呼叫时。（® 2.8.1  自动路由选择（ARS））
– 当使用内线键进行中继线呼叫时。

– 当使用ICD群键进行中继线呼叫时。

• 对于一般SIP电话，闪断键的功能会因电话而不同，且其功能不取决于集团电话中指定的设定。

使用说明书（PC编程手册）参考

9.24  PBX Configuration—[1-1] Configuration—Slot—Port Property - LCO Port— Disconnect Time
12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Option 7— Flash
Mode during CO Conversation
12.1.4  PBX Configuration—[4-1-4] Extension—Wired Extension—Flexible Button— Type

使用说明书（PT编程手册）参考

[418] LCOT断开时间

使用说明书（功能手册）参考

2.21.2  灵活键
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2.11.7  外部功能接入（EFA）

说明

一般来说，分机用户只能接入集团电话内的功能。但是，如果执行外部功能接入（EFA），分机用户就可以执

行集团电话之外的功能，如使用电话公司或集团电话主机的转移服务等。执行EFA时，集团电话会向电话公司

或集团电话主机发送闪断/重呼信号（® 2.5.4.8  集团电话主机接入代码（从集团电话主机接入电话公司的接入

代码））。

此功能只适用于中继线呼叫。

按EFA键或按已设定成EFA方式的闪断键可以执行此功能（® 2.11.6  闪断/重呼/终止）。

条件

• 闪断/重呼时间

可以为每个中继线端口指定闪断/重呼时间。

• EFA键

可以将一个灵活键定制为EFA键。

• 在当前通话被置于协商保留时（例如：将要被转移到集团电话主机的分机），通过输入功能号码可以执行此

功能。

协商保持：当分机呼叫其它用户以执行呼叫转移、会议或呼叫分离时，一方用户所处的状况。

协商保留中，原来的呼叫被当作处于保留中一样处理，从而允许分机在同一条线路上呼叫第三方。呼叫保

留中，处于保留的一方与第三方是使用不同的线路连接到分机的。

使用说明书（PC编程手册）参考

9.24  PBX Configuration—[1-1] Configuration—Slot—Port Property - LCO Port— Flash Time
10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features— External Feature Access
12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Option 7— Flash
Mode during CO Conversation
12.1.4  PBX Configuration—[4-1-4] Extension—Wired Extension—Flexible Button— Type
15.5  PBX Configuration—[7-5] TRS—Miscellaneous— TRS Check after EFA

使用说明书（PT编程手册）参考

[417] LCOT 闪断/重呼时间

使用说明书（功能手册）参考

2.21.2  灵活键

使用说明书（用户手册）参考

1.11.4  如果连接一部集团电话主机
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2.11.8  中继线呼叫限制

说明

中继线呼叫受以下功能限制：

功能 说明

分机至中继线通话时间 如果在一个分机用户和一个外线用户之间建立通话，为每个中继线群

选择的系统定时器可以限制通话时间。从时间到期前的15秒钟开始，

双方每隔5秒钟就会听到警告音。*1时间到期时，线路将被断开。COS
编程决定是否允许或停用此功能。此功能是只适用于去电呼叫，还是

对去电呼叫与来电呼叫均适用，要通过系统编程来确定。

中继线间通话（无人值守会议电

话除外）时间

如果在两个外线用户之间建立通话，为每个中继线群选择的系统定时

器可以限制通话时间。从时间到期前的15秒钟开始，双方每隔5秒钟

就会听到警告音。*1时间到期时，线路将被断开。

如果中继线间通话所涉及的双方都是通过分机建立的（例如：分机拨

打中继线呼叫，然后将其转移到外线用户），将使用首先建立的中继线

呼叫所适用的时间限制。

预算管理 当达到预编程设定的话费限额时，分机用户会听到3声间隔5秒钟的警

告音。在第三次警告音后线路是否断开是可编程的。呼叫结束后，分

机用户就不能再拨打中继线电话，除非指定为管理员的分机增加或清

除了话费限额（® 2.7.2  预算管理）。

在通话过程中的拨号位数限制 在接听中继线呼叫来电时，可以限制拨号位数。如果拨号位数超出限

制，线路就被断开。

逻辑分区功能 可以使用以下逻辑分区设置限制某些类型的中继线呼叫：

9.2.2  PBX Configuration—[1-1] Configuration—Slot—System Prop-
erty—Site—Main— Area ID for logical partition
10.9  PBX Configuration—[2-9] System—System Options—Option
2— Applying logical partitioning
有关详情，请参阅使用说明书（PC编程手册）中的"10.9  PBX Con-
figuration—[2-9] System—System Options—Option 2— Applying
logical partitioning"。
可以通过PC编程收集并显示以下通话记录数据。请参阅使用说明书

（PC编程手册）中的"7.3.5  Utility—Log—Call Control Log"。

1. 当您更改任何逻辑分区设置时，将记录通话记录数据（条件）。

2. 当呼叫被逻辑分区功能限制时，将记录通话记录数据（状态）。

*1 通过IP中继线或SIP中继线连接的一方不会听到警告音。

条件

• 在无人值守会议电话期间，适用无人值守会议重呼时间。（® 2.14.2  会议）

• 使用不支持呼叫方控制（CPC）信号检测（® 2.11.9  呼叫方控制（CPC）信号检测）的LCO中继线时，

由于无法执行自动通话结束检测，因此不应该禁用中继线间通话时长定时器。
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• 对于SIP分机用户，中继线呼叫限制到期时，线路将断开而不会听到警告音。

[逻辑分区]
• 允许逻辑分区时，下列呼叫类型会受到限制。

1. 传统中继线和IP中继线呼叫

2. TIE至中继线呼叫

TIE CO

/

IP

3. 中继线至TIE呼叫

CO TIE

/

IP

174 使用说明书（功能手册）
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4. 包含传统中继线和IP中继线的会议电话

IP

5. 向跨一体化网络的外线（传统中继线或IP中继线）发起的呼叫，且每个集团电话的区域ID不相同。

B

( ID 2)

A

( ID 1)

/

IP

如果一体化网络中的两个集团电话具有相同的区域ID，将像一个集团电话一样适用限制（上述限制类型

1至4）。
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→ 9.2.2  PBX Configuration—[1-1] Configuration—Slot—System Property—Site—Main— Area ID 
for logical partition

B

( ID 1)

IP

A

( ID 1)

IP

• 应用逻辑分区后，TIE线路和中继线（案例3和4）上的呼叫受限制。来自TIE线路上的分机的呼叫以及充当

中继的TIE线路上的呼叫不受限制。但使用PRI中继适配器的QSIG受限制。

使用说明书（PC编程手册）参考

7.3.5  Utility—Log—Call Control Log
9.2.2  PBX Configuration—[1-1] Configuration—Slot—System Property—Site—Main— Area ID for logical 
partition
10.7.1  PBX Configuration—[2-7-1] System—Class of Service—COS Settings—CO & SMDR— Extension-CO
Line Call Duration Limit
10.9  PBX Configuration—[2-9] System—System Options—Option 2— Extension - CO Call Limitation—For
Incoming Call
10.9  PBX Configuration—[2-9] System—System Options—Option 2— Applying logical partitioning
11.1.1  PBX Configuration—[3-1-1] Group—Trunk Group—TRG Settings—Main

→ CO-CO Duration Time (*60s)
→ Extension-CO Duration Time (*60s)

15.5  PBX Configuration—[7-5] TRS—Miscellaneous— Dial Digits Limitation After Answering—Dial Digits

使用说明书（PT编程手册）参考

[472]分机至中继线通话时间

[473]中继线间通话时长

[502]中继线呼叫通话时间限制

使用说明书（功能手册）参考

5.1.1  服务等级（COS）
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2.11.9  呼叫方控制（CPC）信号检测

说明

呼叫方控制（CPC）信号是当对方挂机时从模拟中继线发送的挂机指示（断开信号）。为使各中继线得到有效

地利用，本集团电话会监听其状态，当从一条线路上检测到CPC信号时，就断开线路并用挂机重拨音提示分

机。

条件

• 对于中继线呼叫来电和中继线呼叫去电，CPC信号检测是可以编程的。

• 假如电话公司发送与CPC类似的其它信号，建议不要对中继线呼叫去电启用CPC信号检测。

• 如果在会议电话期间检测到CPC信号（® 2.14.2  会议），该线路将被断开，但是其它方仍保持连接。

• 如果在使用DISA功能（® 2.16.1  直接拨入系统接入（DISA））的主叫方与一部分机或一个外线用户之间

的通话过程中检测到CPC信号，该线路就被断开。

使用说明书（PC编程手册）参考

9.24  PBX Configuration—[1-1] Configuration—Slot—Port Property - LCO Port— CPC Signal Detection
Time—Outgoing, Incoming

使用说明书（PT编程手册）参考

[413] LCOT CPC信号检测时间—去电

[414] LCOT CPC信号检测时间—来电
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2.11.10  并联电话

说明

可以将多部电话连接到同一端口。这对在没有附加分机卡的情况下增加电话数量很有用。并联电话的组合和功

能介绍如下。

功能 说明 连接

并联方式 并联方式是将SLT与已连接到超级混合端口的APT
或DPT相连接。

允许并联方式后，两部电话按如下方式发挥作用：

• 两部电话共享直接连接到集团电话（主电话）

的电话的分机号码。

• 每部电话都能拨打或应答电话。

APT/DPT + SLT

SLTDPT

101 101

APT 102

102SLT

附加设备端口

（XDP）方式

XDP方式是将SLT与已连接到超级混合端口的DPT
相连接。

不同于并联方式，每部电话都可用作完全不同的分

机，有其自己的分机号码。（® 5.2.6  分机端口配

置）

DPT + SLT

SLTDPT

101 105

DXDP DXDP是将一部DPT与一部连接到DPT端口或超级

混合端口的DPT相连接。直接连接到集团电话的

DPT称为"主DPT"，而连接到主DPT的DPT称为"从
DPT"。
和XDP方式类似，每部电话都可用作完全不同的分

机，有自己的分机号码。

如果主DPT是通过超级混合端口（而不是DPT端
口）连接到集团电话的，则还可以将第三部电话

（SLT）与主DPT并联连接或以XDP方式连接。

DXDP连接能够使集团电话支持的DPT数量得到增

加。

DPT + DPT

DPT

101 201

DPT

DPT

101 201

SLT

101

     

105 XDP

DPT

DPT + DPT + SLT
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条件

[APT + SLT]
• 如果一部电话摘机而另一部电话正在通话，即建立三方通话。如果一个用户挂机，另一个用户可以继续通

话。

• 如果APT处于以下状态，分机用户就不能从SLT打电话：

– 播放背景音乐（BGM）

– 通过内置扬声器接收广播通知。

• 仅适用于德国和奥地利用户

虽然有来电呼叫时APT会振铃，但SLT不会振铃。

适用于其它国家/地区的用户

有来电呼叫时，APT和SLT两者都会振铃，以及集团电话不能拒绝到达SLT的呼叫。

[DPT + SLT]
• 可以编程设定DPT与SLT是处于并联方式还是XDP方式。不论为何种方式，SLT都可以直接连接到DPT的

XDP端口，或与DPT一起连接到模块T型适配器。

• 处于并联方式时，可以编程设定SLT是否在来电时振铃。

振铃开启：两部电话都振铃，但当PT处于免提应答方式（® 2.4.4  免提应答）或语音呼叫方式（交替接收

振铃/话音）时除外（® 2.5.3  内线电话）。

振铃关闭：只有PT振铃。但是，SLT可以应答呼叫。

• 两部电话不能同时参与通话。如果一部电话摘机而另一部电话正在通话，呼叫就被切换到前者。在下列情

况下，电话不切换：

a. 当接收OHCA（® 2.10.4.3  摘机呼叫通知（OHCA））或耳语OHCA时。（® 2.10.4.4  耳语OHCA）
b. 在会议电话期间（® 2.14  会议功能）。

c. 当现场呼叫屏蔽（LCS）启动时（® 2.28.3  语音信箱DPT（数字）集成）。

[DPT + DPT]
• 可用电话

KX-DT300系列、KX-DT500系列和KX-T7600系列，KX-T7640系列除外。请注意，KX-T7667只能连接为

从DPT。
• 使用DXDP连接时，以下功能不能用于主或从DPT：

a. OHCA：即使设定了OHCA功能，也会听到呼叫等待音。

b. USB模块/Bluetooth模块：如果连接了USB模块或Bluetooth模块，DPT将不能正常工作。请勿将USB模
块或Bluetooth模块接到DPT上。

注

即使断开从DPT，OHCA功能和USB模块仍不能用于主DPT。为了使用它们，必须先断开主DPT与集团电

话的连接，然后重新进行连接。

[DPT + DPT + SLT]
• 当以并联方式连接SLT与从DPT时，SLT将用作主DPT的并联分机。

使用说明书（安装手册）参考

2.3.3  系统容量

4.8.2  并联连接分机

4.8.3  数字附加设备端口（数字XDP）连接

使用说明书（功能手册） 179

2.11.10 并联电话



使用说明书（PC编程手册）参考

9.22  PBX Configuration—[1-1] Configuration—Slot—Port Property—Extension Type
→ XDP Mode
→ Parallel Telephone Ringing

10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features— Parallel Telephone (Ring)
Mode Set / Cancel

使用说明书（PT编程手册）参考

[600]附加设备端口（XDP）方式

使用说明书（用户手册）参考

1.9.11  设定并联电话振铃（并联电话）

180 使用说明书（功能手册）
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2.11.11  一个编号分机

说明

可以在作为配对分机的主分机和子分机之间共享一个分机号码。通过主分机的分机号码（配对主分机号码）可

以同时呼叫与主分机配对的子分机。当主分机接到来电呼叫时，将作为配对主分机号码的呼叫处理且来电呼叫

会同时到达子分机。

用户通过输入相应的功能号码或按下相应的灵活键即可接听配对分机的呼叫。但是，如果某一分机在会议电话

中，则另一分机无法接听呼叫。

条件

• 可将以下分机分配为主/子分机。

PT、SLT、IP-PT、SIP分机（包括一般SIP电话）

• 电话空闲时，子分机上会显示配对主分机号码。但是，对于一般SIP电话，电话空闲时会在子分机上显示原

始分机号码。

• 如果主分机已与一个编号分机配对，则主分机无法与另一子分机配对。

• 子分机根据主分机的COS和分机设定操作（按键设定、来电线路优先和去电线路优先除外）。

• 从子分机进行呼叫时，会使用配对主分机号码的主叫方信息（分机号码、分机名称、CLIP/CNIP）。
• 一个编号分机接到来电呼叫时，行为会根据电话类型而不同，如下所述：

[KX-NT系列/DPT]
• 如果主分机占线而有灵活键可用于接听呼叫，则呼叫等待功能会起作用。

• 如果主分机无法接听来电呼叫，则呼叫等待功能不起作用。

[SLT]
• 如果主分机为SLT且占线，则子分机无法接听呼叫。

[一般SIP电话]
• 通话期间在配对分机收到新来电时，不会激活无振铃或延迟振铃功能。在此情况下，电话会正常振铃。

• 当使用语音呼叫向配对主分机号码拨打分机电话时，子分机会听到振铃音。

• 在免提方式下LCS中的配对主分机号码收到呼叫时，子分机不会收到该呼叫。

• 仅主分机可使用以下功能。

– OHCA（® 2.10.4.3  摘机呼叫通知（OHCA））
– 耳语OHCA（® 2.10.4.4  耳语OHCA）

• 当配对主分机号码被广播时，子分机不会被广播。（® 2.17.1  广播）

• 当呼叫配对主分机号码进行会议时，呼叫也会到达子分机。

• 主/子分机均无法使用以下功能。

– 可移动分机（® 2.24.3.1  可移动分机）

– 增强的可移动分机（® 2.24.3.2  增强的可移动分机）

• 当主分机或子分机占线时，配对分机无法拨打电话。

• 当子分机作为一个编号分机激活时，不会收到子分机原始分机号码的呼叫。

• 主分机和子分机可同时控制留言待取灯。

• 当注册为ICD群成员的分机配对为子分机时，子分机的来电呼叫（通过ICD群）不会振铃。同时，子分机会

从ICD群强制注销。

• 根据主/子分机的设定单独激活以下各电话类型的设定。

SLT MW方式

自动应答

ICM音

振铃类型表
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ISDN承载电路

BGM开/关
LCS开/关

• 对于可回叫分机的保留重呼等功能，可在分机上设定，只能在设定此功能的主分机或子分机接收回叫。

• 当转移重呼等功能将回叫转接至始发分机时，主分机的分机号码（配对主分机号码）能收到呼叫，且主分

机和子分机都会振铃。

• 定时提醒功能同时使主分机和子分机振铃。

使用说明书（PC编程手册）参考

10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features— Parallel Telephone (Ring)
Mode Set / Cancel
12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings

→Option 1— Wireless XDP / Shared Extension
→Option 1— Ring Pattern Table
→Option 5— Automatic Answer for CO Call
→Option 6— Forced Automatic Answer
→Option 7— ISDN Bearer
→Option 8— SLT MW Mode

使用说明书（用户手册）参考

1.9.12  与有线电话并联使用您的电话（一个编号分机）

使用说明书（功能手册）参考

2.9.1  主要号码簿号码（PDN）/次要号码簿号码（SDN）分机

2.24.3.1  可移动分机

2.24.3.2  增强的可移动分机

3.2.2.16  现场呼叫屏蔽（LCS）

182 使用说明书（功能手册）
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2.12  转移功能

2.12.1  呼叫转移

说明

分机用户可以将呼叫转移到另一部分机或外线用户。可以使用以下功能：

功能 转移方法

有通知 通知目的地用户后完成转移。

无通知
在没有通知的情况下完成转移。

给目的地拨号后，在听到回铃音时，拨号人可以将话筒放回原处。

有通知的呼叫转移也被称为呼叫转移—经屏蔽的。

无通知的呼叫转移也被称为呼叫转移—未经屏蔽的。
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无通知的呼叫转移的转移重呼

如果转移目的地在预编程设定的转移重呼时间内没有应答，呼叫将被转接到指定给转移呼叫的该分机的转移重

呼目的地。

如果转移目的地具有设为截取路由─无应答的目的地，呼叫将被路由到该目的地。

No

Yes

Yes

Yes

ICD

VM UM VM

?

?

?

ICD VM

UM VM

Yes

No

No

No No

Yes

ICD

UM VM

ICD UM

VM

[可用目的地]

目的地 可用性

有线分机（PT/SLT/SIP分机/ISDN分机） ü

来电呼叫分配群 ü

UM群 ü*1

语音信箱群（DTMF/DPT） ü（仅限DPT）*1

外部广播机（TAFAS）  

DISA  

模拟/ISDN远程维护  
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目的地 可用性

空闲线路接入号码 + 电话号码  

中继线群接入号码 + 中继线群号码 + 电话号码  

其它集团电话分机（无集团电话代码的TIE）  

其它集团电话分机（带集团电话代码的TIE）  

*1 如果转移目的地无应答，呼叫会被发送到语音信箱并且会在转移目的地的信箱中录制一条留言。

条件

• 当分机将通话方转移到另一目的地时，通话方将处于协商保留状态，直至到达转移目的地。

协商保持：当分机呼叫其它用户以执行呼叫转移、会议或呼叫分离时，一方用户所处的状况。

协商保留中，原来的呼叫被当作处于保留中一样处理，从而允许分机在同一条线路上呼叫第三方。呼叫保

留中，处于保留的一方与第三方是使用不同的线路连接到分机的。

• 如果允许待机音乐，当呼叫被转移时，可将音乐发送到被保留方。（® 2.13.4  待机音乐）可以编程设定是

发送回铃音还是发送音乐。

• 如果转移目的地分机对外线用户设定了FWD，呼叫将被转移至外线用户。（® 2.3.2  呼叫转送（FWD））

• COS编程决定了哪些分机能将呼叫转移给外线用户。COS还可以使用集团电话代码方法（用集团电话代码

接入）禁止经TIE线路业务转移至另一部集团电话的分机（® 4.3.1  TIE线路业务）。

• 单键转移

通过按已被指定TRANSFER（转移）命令和转移目的地电话号码的单键拨号键来执行单键转移。这对转移

呼叫至外线目的地很有用。（® 2.6  存储器拨号功能）

• 通过SDN键或DSS键自动转移

在与分机或外线用户通话的过程中按SDN键或DSS键可以将呼叫自动转移到指定目的地（® 2.9.1  主要号

码簿号码（PDN）/次要号码簿号码（SDN）分机）。可以通过系统编程阻止此功能对分机与分机之间的呼

叫进行操作。

• 使用排队转移到占线分机（预占线转移）

通过系统编程，可以根据转移方的COS设定将呼叫转移到占线分机，而不必发送呼叫等待通知。转移的呼

叫将被置于队列中。

SIP分机无法使用该功能。

• 当从模拟中继线转移呼叫时，强烈建议用户执行屏蔽转移，这样，当分机用户缺席时，外线来电者才不会

被自动连接到使用免提应答的分机上。

• 本集团电话支持某些SIP电话上的无条件转移功能。有关详情，请参阅电话的说明书。

使用说明书（PC编程手册）参考

10.2  PBX Configuration—[2-2] System—Operator & BGM— BGM and Music on Hold—Sound on Transfer
10.3  PBX Configuration—[2-3] System—Timers & Counters—Dial / IRNA / Recall / Tone— Recall—Transfer
Recall (s)
10.7.1  PBX Configuration—[2-7-1] System—Class of Service—COS Settings—CO & SMDR— Transfer to
CO
10.7.1  PBX Configuration—[2-7-1] System—Class of Service—COS Settings—Assistant— Transfer to busy
Extension w/o BSS Operation
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10.9  PBX Configuration—[2-9] System—System Options—Option 4— DSS Key—Automatic Transfer for
Extension Call
12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Option 1— Transfer
Recall Destination

使用说明书（PT编程手册）参考

[201]转移重呼时间

[503]呼叫转移到中继线

[712]转移音乐

使用说明书（功能手册）参考

5.1.1  服务等级（COS）

使用说明书（用户手册）参考

1.4.1  转移呼叫（呼叫转移）

186 使用说明书（功能手册）
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2.12.2  SIP参考转移

说明

如果通过系统编程启用，转移到SIP中继线的呼叫将使用SIP服务提供商的转移功能而不是使用集团电话的转移

功能进行转移。

有以下转移类型：

出席转移 通知转接方后即完成转移。从分机用户的角度上来看，这与有

通知的呼叫转移（® 2.12.1  呼叫转移）相同。

无条件转移 在拨打转移收件人号码后转移立即完成。

这与无通知的呼叫转移（® 2.12.1  呼叫转移）相似，除了转移

方甚至没有听到回铃音；被转移的呼叫被直接连接到目的地。

条件

[一般]
• 此功能的可用性取决于SIP服务提供商。

• 由于SIP服务提供商会对转移进行控制，因此转接的呼叫即使转移失败也无法返回到集团电话进行进一步的

处理。

[无条件转移]
• ISDN分机和SIP分机无法使用该功能。

• 通过DISA呼叫时该功能无法使用（® 2.16.1  直接拨入系统接入（DISA））。

使用说明书（安装手册）参考

4.4  虚拟卡

使用说明书（用户手册）参考

1.4.1  转移呼叫（呼叫转移）—  使用SIP服务转移至外线用户

使用说明书（PC编程手册）参考

9.10  PBX Configuration—[1-1] Configuration—Slot—Port Property—V-SIPGW—Supplementary Service
→ Blind Transfer(REFER)
→ Attended Transfer(REFER)
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2.13  保留功能

2.13.1  呼叫保留

说明

分机用户可以保留一个呼叫。根据结果可以使用以下功能。

功能 说明

正常保留 任何分机都能恢复保留的呼叫。

专用呼叫保留 只有保留呼叫的分机用户才能恢复呼叫。

保留操作的结果可以通过系统编程来确定。第一次按保留键后立即再次按该键可以切换正常方式与专用呼叫保

留方式。

条件

• 呼叫保留限制

PT用户一次可以保留一个内线电话和/或多个中继线呼叫。SLT用户一次可以保留一个内线电话或一个中继

线呼叫。使用呼叫寄存功能，PT和SLT用户可以同时保留多个中继线呼叫和内线电话。（® 2.13.2  呼叫寄

存）

• 待机音乐

如果可用的话，会把音乐发送到被保留方。（® 2.13.4  待机音乐）

• 保留重呼

如果在预编程设定的时间内没有恢复保留的呼叫，保留呼叫的分机上会听到保留重呼。如果分机正在通话，

将听到保留警报。

• 如果外线用户被置于保留并且在预编程设定的时间内没有恢复，呼叫将自动断开。当保留重呼启动时，此

定时器开始计时。

• 呼叫自动保留

通过系统编程，可以使PT用户通过按另一个CO/ICD群/内线/PDN键保留当前的呼叫。如果不允许此功能，

当前呼叫将被断开。

[示例]
可以通过按闪断ICD群键接听电话，这就把当前的内线电话（在内线键上）置于保留。若要返回到保留的

呼叫，请按内线键。

• 拒绝恢复呼叫保留

如果分机用户不能在COS基础上呼叫某些分机（® 2.1.2.2  内部通话阻止），则也不能恢复这些分机做出的

保留呼叫。

• SLT保留方式

通过系统编程，可以在下列方法中选择如何使用SLT保留线路并转移呼叫：
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 保留
保留

（从其它分机恢复）*1 转移到中继线 转移到分机

方式1

拍叉簧

+
挂机

拍叉簧

+
保留功能号码

+
挂机

拍叉簧

+
中继线接入号码

拍叉簧

+
分机号码

方式2
（默认）

拍叉簧

+
保留功能号码

+
挂机

拍叉簧

+
保留功能号码

+
挂机

拍叉簧

+
中继线接入号码

拍叉簧

+
分机号码

方式3

拍叉簧

+
保留功能号码

+
挂机

拍叉簧

+
保留功能号码

+
保留功能号码

+
挂机

拍叉簧

+
保留功能号码

+
中继线接入号码

拍叉簧

+
分机号码

方式4

拍叉簧

+
保留功能号码

+
挂机

拍叉簧

+
保留功能号码

+
保留功能号码

+
挂机

拍叉簧

+
保留功能号码

+
中继线接入号码

拍叉簧

+
保留功能号码

+
分机号码

*1 只有其它分机打算使用保留呼叫的分机号码恢复被保留的呼叫时才能执行这些操作。

如果使用SLT时经常出现以下情况，请选择"Mode 2"、"Mode 3"或"Mode 4"：
a. 当SLT用户接电话时，会听到挂机重拨音或无人应答呼叫。

b. 当SLT用户摘机时，会听到挂机重拨音而不是拨号音。

如果挂机后呼叫未被终止，就会出现上述情况。若要避免这些问题，请选择"Mode 2"、"Mode 3"或"Mode
4"。每个呼叫都会被终止，除非在方式2、方式3和方式4中拍叉簧后输入保留功能号码。

• 保持警报音类型有一个默认值。（® 6.2.1  音频/振铃音）。

使用说明书（PC编程手册）参考

10.3  PBX Configuration—[2-3] System—Timers & Counters—Dial / IRNA / Recall / Tone
→ Recall—Hold Recall (s)
→ Recall—Disconnect after Recall (x60s)

10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features
→ Call Hold / Call Hold Retrieve
→ Call Hold Retrieve : Specified with a Holding Extension Number
→ Hold Retrieve : Specified with a Held CO Line Number
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10.9  PBX Configuration—[2-9] System—System Options
→Option 1— PT Operation—Automatic Hold by ICM / CO / ICD Group Key
→Option 1— PT Operation—Hold key mode
→Option 5— SLT—SLT Hold Mode

使用说明书（PT编程手册）参考

[200]保留重呼时间

使用说明书（用户手册）参考

1.4.2  保留一个呼叫
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2.13.2  呼叫寄存

说明

分机用户可以将呼叫放入集团电话的普通寄存区。呼叫寄存功能可以用作转移功能；该功能使用户不必理会寄

存的呼叫而去执行其它操作。寄存的呼叫可以由任何分机用户恢复。

条件

• 呼叫自动寄存

可以自动选择一个空闲寄存区。

• 重试

如果指定的寄存区被占用或没有用于呼叫自动寄存的空置区，发起人将听到忙音。听到忙音后，可以选择

寄存区或空置区重试。

• 呼叫寄存重呼

如果在预编程设定的时间内没有恢复寄存的呼叫，在指定给寄存该呼叫的分机的转移重呼目的地上将听到

呼叫寄存重呼。如果目的地正在通话，将听到保留警报。

• 如果在预编程设定的时间内没有恢复寄存的中继线呼叫（默认：30 分钟），它就会自动断开。

• 呼叫寄存键

按呼叫寄存键寄存或恢复预定寄存区中的呼叫。

可以将一个灵活键定制为呼叫寄存键。它按如下方式显示预定寄存区的当前状态：

指示灯类型 状态

红灯慢闪 寄存在预定的寄存区中

关闭 无寄存呼叫

• 呼叫寄存（自动寄存区）键

按呼叫寄存（自动寄存区）键将呼叫自动寄存在一个空闲寄存区中。可以将一个灵活键定制为呼叫寄存（自

动寄存区）键。

• 拒绝恢复呼叫寄存

如果分机用户在COS基础上不能呼叫某些分机（® 2.1.2.2  内部通话阻止），则也不能恢复这些分机做出的

寄存呼叫。

使用说明书（PC编程手册）参考

10.3  PBX Configuration—[2-3] System—Timers & Counters
→ Recall—Call Park Recall (s)
→ Recall—Disconnect after Recall (x60s)

10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features— Call Park / Call Park
Retrieve
12.1.4  PBX Configuration—[4-1-4] Extension—Wired Extension—Flexible Button

→ Type
→ Parameter Selection (for Call Park)
→ Optional Parameter (Ringing Tone Type Number) (for Call Park)
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使用说明书（功能手册）参考

2.21.2  灵活键

6.1  系统资源的容量

使用说明书（用户手册）参考

1.4.2  保留一个呼叫
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2.13.3  呼叫分离

说明

通话过程中，分机用户可以将原通话方置于协商保留而呼叫另一部分机。然后，分机用户可以交替与另外两方

通话和/或将原通话方与第三方连接。

条件

• 协商保持：当分机呼叫其它用户以执行呼叫转移、会议或呼叫分离时，一方用户所处的状况。

协商保留中，原来的呼叫被当作处于保留中一样处理，从而允许分机在同一条线路上呼叫第三方。呼叫保

留中，处于保留的一方与第三方是使用不同的线路连接到分机的。

• 当分机用户与一方交谈时，另一方处于协商保留状态。

使用说明书（用户手册）参考

1.4.3  与两方交替通话（呼叫分离）
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2.13.4  待机音乐

说明

可以给已被置于保留的一方播放音乐。有以下声源可用：

a. 外部音乐源

b. 用户提供的音频文件

c. 信号音

从BGM号码（1至8）或内置音频选择待机音乐的音频源。BGM可以是外部音乐源或用户提供的音频文件。下

表所示为可以分配至各BGM号码的音频源：

[BGM号码和音乐源]

BGM号码 音乐源

1 用户音频数据

2 用户音频数据

3 外部音乐端口1

4 外部音乐端口2

5 外部音乐端口3

6 外部音乐端口4

7 外部音乐端口5

8 外部音乐端口6

对于租户用户，每个租户可以选择一种BGM或信号音用作待机音乐。

条件

[一般]
• 硬件要求：用户提供的音乐源（当分配了外部音乐源时）

• 音量控制

可以改变内部和/或外部音乐源的音量。

• 对于租户，呼叫的类型决定哪首租户的音乐源会被使用，如下：

类型 音乐源

内线来电/去电呼叫 按分机用户所属的租户设定选择。

中继线呼叫来电 按分配方法的租户设定选择 (DIL/DID/DDI/MSN)。

• 即使待机音乐选择外部音乐源或用户提供的音频文件，被另一分机置于保留状态的IP-PT或SIP分机用户仍

不会听到指定的待机音乐。

[用户提供的音频文件]
• 通过Web维护控制台上传用户提供的音频文件。音频文件必须满足以下规格：

– 格式：WAV
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– 大小：40 MB或以下

– 长度：4分钟或以下

• 最初，将预装的音频文件设为BGM 1的音频源。通过系统编程，可像任何其他BGM音频文件一样删除或替

换该文件。安装新音频文件前，如果准备在将来再次使用预装文件，请务必予以备份。

请参阅使用说明书（PC编程手册）中的"5.2.3  System Control—MOH—Status / Backup"。

使用说明书（安装手册）参考

4.10  连接外围设备

使用说明书（PC编程手册）参考

5.2  System Control—MOH
10.2  PBX Configuration—[2-2] System—Operator & BGM
10.11.1  PBX Configuration—[2-11-1] System—Audio Gain—Paging/MOH— Internal MOH—MOH1-2 (Music
On Hold 1-2)

使用说明书（PT编程手册）参考

[711]待机音乐

使用说明书（功能手册）参考

2.30.1  背景音乐（BGM）

5.1.3  租户业务
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2.14  会议功能

2.14.1  会议功能—概要

说明

会议电话允许三方或更多方同时交谈。可以使用以下功能建立会议电话：

功能 说明与参考

会议 在两方通话过程中，分机用户可增加其他方而建立多达8方参加的会

议电话。

® 2.14.2  会议

主管遇忙优先插入 分机用户可以中断现有呼叫而建立三方会议电话。

® 2.10.2  主管遇忙优先插入

保密释放 在用S-CO键与一个外线用户通话过程中，PT用户可以允许另一部分

机加入通话。

® 2.14.3  保密释放

条件

• 一个会议电话支持最多8个通话方。

• 当会议通话方是非IP分机（例如：DPT或SLT），并且在非IP中继线（例如：模拟线路、ISDN）上拨打会议

电话时，不需要DSP卡。

• 同时参加会议电话的最大通话方数量为32方（安装了DSP卡时，支持96方）。

• 可以选择在召开会议时使用以下哪个设备。

– 集团电话MPR
– 任选DSP卡
通过选择任选DSP而不是集团电话MPR可以实现更好的音质。但是，在此情况下会使用DSP资源。

• DSP资源占用

会议电话需要一定数量的DSP资源。如果所有DSP资源都在使用，则无法进行此操作。为确保最低的性能

水平，可为会议电话预留DSP资源。（® 5.5.4  DSP资源占用）

使用说明书（PC编程手册）参考

9.38  PBX Configuration—[1-5] Configuration—DSP Resource
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2.14.2  会议

说明

分机用户可以将其他用户添加到已经存在的两方通话中，从而建立会议电话。本集团电话能支持三至八方会议

电话。四方以上的会议只有PT用户才能发起。

无人值守会议：

会议发起人可以离开会议，让其他方继续交谈。建立无人值守会议允许发起人返回到会议。只有PT用户能建立

无人值守会议。

条件

• 当分机建立会议电话时，原通话方被置于保留状态。

• 会议键

对于没有会议键的PT，可以将一个灵活键定制为会议键。

• 无人值守会议通话时间

会议电话可以保持无人值守的时间长度受以下定时器的限制：

– 回叫开始定时器

– 警告音开始定时器

– 断开定时器

这些定时器根据以下事件链行动和运作：

1. 无人值守会议建立时，回叫开始定时器启动。

2. 回叫开始定时器到期时，无人值守会议发起人的分机开始收到集团电话的回叫振铃，并且警告音开始定

时器启动。

3. 警告音开始定时器到期时，留在会议中的各方开始听到警告音，无人值守会议发起人的分机上仍可以听

到回叫振铃，并且断开定时器启动。

4. 断开定时器到期时，会议线路断开。

如果无人值守会议发起人在线路断开前返回到会议，所有定时器都将被清除。

• 如果具有2条中继线的会议发起人离开会议，该呼叫将变为中继线到中继线呼叫（如果已通过系统编程启

用）。

– 当建立了中继线到中继线呼叫时，经过中继线间通话时长定时器的时间后，通话将结束（® 2.11.8  中
继线呼叫限制）。所应用的定时器为含有用于会议开始之前所进行通话的中继线的中继线群的定时器。

无法延长定时器。

– 如果两条中继线均为模拟中继线，可能无法检测到中继线到中继线呼叫的结束。因此，如果使用模拟中

继线，不建议在会议通话后通过系统编程来建立中继线到中继线呼叫。

使用说明书（PC编程手册）参考

10.3  PBX Configuration—[2-3] System—Timers & Counters—DISA / Door / Reminder / U. Conf
→ Unattended Conference—Recall Start Timer (x60s)
→ Unattended Conference—Warning Tone Start Timer (s)
→ Unattended Conference—Disconnect Timer (s)

10.7.1  PBX Configuration—[2-7-1] System—Class of Service—COS Settings—CO & SMDR— Transfer to
CO
10.9  PBX Configuration—[2-9] System—System Options—Option 2— CO - CO Call Limitation—After
Conference
10.9  PBX Configuration—[2-9] System—System Options—Option 3
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→ Confirmation Tone—Tone 4-1 : Start Conference
→ Confirmation Tone—Tone 4-2 : Finish Conference
→ Echo Cancel—Conference

10.9  PBX Configuration—[2-9] System—System Options—Option 8— Conference Group—Maximum
Number of Speakers During a Conference Group Call
12.1.4  PBX Configuration—[4-1-4] Extension—Wired Extension—Flexible Button— Type

使用说明书（功能手册）参考

2.21.2  灵活键

6.1  系统资源的容量

使用说明书（用户手册）参考

1.4.5  多方通话
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2.14.3  保密释放

说明

默认情况下，在中继线、分机线路和门电话线路上进行的全部通话都受保密保护（自动保密）。

保密释放允许PT用户中止S-CO键上现有中继线呼叫的自动保密，以便建立三方通话。

需要通过系统编程允许或停用此功能。

条件

• S-CO键

可以将一个灵活键定制为S-CO键。

• 保密释放时间

为了允许参加交谈，保密被释放5秒钟。

• 此功能占优插入数据线路安全（® 2.11.5  数据线路安全）和主管遇忙优先插入拒绝（® 2.10.2  主管遇忙

优先插入）。

使用说明书（PC编程手册）参考

10.9  PBX Configuration—[2-9] System—System Options—Option 1— PT Operation—Privacy Release by
SCO key
12.1.4  PBX Configuration—[4-1-4] Extension—Wired Extension—Flexible Button— Type

使用说明书（功能手册）参考

2.21.2  灵活键

使用说明书（用户手册）参考

1.4.5  多方通话
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2.15  会议组呼叫功能

2.15.1  会议组呼叫

说明

会议组呼叫可让您同时呼叫预设群（会议群）各方。应答电话的每一方参加会议。

分机用户最多可以呼叫包含31方的会议群建立会议电话，即最多32名与会者。会议组呼叫过程中，主叫者可以

限制其他成员发言的能力。

即使分机没有启用免提应答（® 2.4.4  免提应答），以下电话会自动应答并且通过电话的扬声器播放通知：

• PT

广播模式

通过系统编程启用广播通信模式时，分机用户可以呼叫最多包含31呼叫成员的会议群进行语音通知。成员应答

电话后可以听到通知。

发布通知过程中，不会听到成员的声音。但是，主叫方最多可以允许31名特定的成员发言，从而建立会议电

话。其他成员可以听到这个通话。

[适用于PT/SLT用户的一键通话功能]
作为广播模式呼叫成员的PT/SLT用户可以通过在广播模式通知期间按任意拨号键来进行发言。可以通过系统编

程来禁用此功能。

会议组呼叫控制

会议组呼叫过程中，主叫方可以限制或允许其他成员发言的能力，并且可以使用下列键将成员从电话中删除。

这些键无论是否在会议组呼叫模式下均可以使用。通话中按其它键将被忽略。

注

会议组呼叫过程中这些键的操作与会议功能的操作不同（® 2.14  会议功能）。

键 功能

DSS 禁用或启用相应成员的发言能力。

会议 按会议群中指定的顺序与当前成员建立通话。再按一下这个键将把群

中下一个可用成员加入到通话中。

转移 撤下最后加入通话的成员。该成员仍可以听取通知。

闪断（闪断/重呼方式） 撤下最后加入通话的成员。该成员将从会议组呼叫中断开，并听到挂

机重拨音。

免提 启用免提通话。

成员分机可以通过发送通知告知主叫方其希望发言或加入通话。主叫方会听到通知音，显示器上将显示请求分

机的信息5秒钟。

会议群

可以编程设定8个会议群，最多可以为每个群指定31个成员。作为会议群成员的可用目的地如下：

目的地 可用性

有线分机（PT/SLT/SIP分机/ISDN分机） ü
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目的地 可用性

来电呼叫分配群  

UM群  

语音信箱群（DTMF/DPT）

外部广播机（TAFAS）  

DISA  

模拟/ISDN远程维护  

空闲线路接入号码 + 电话号码 ü

中继线群接入号码 + 中继线群号码 + 电话号码 ü

其它集团电话分机（无集团电话代码的TIE） ü*1

其它集团电话分机（带集团电话代码的TIE） ü*1

*1 仅当中继线的网络类型被指定为专用时才可用。

超时后加入

当在预编程时间限制内会议群成员无法应答会议组呼叫时，成员电话将停止振铃。但是，即使超过时间限制

后，成员仍可以加入会议。

此外，未在被叫会议群中注册的分机用户可以在会议开始后加入。使用DISA的外线来电者和TIE线路用户在访

问使用流动COS的分机后，仍可以加入会议。

也可以指定接入代码来限制访问呼叫。可以在呼叫者启动会议组呼叫时设置接入代码。如果设置了接入代码，

通常主叫方将事先通知呼叫与会者。

[使用免提应答启动会议组呼叫]
可以为会议组成员分机启用免提应答。通过与包含启用了免提应答（® 2.4.4  免提应答）的分机（如软电话）

的会议组发起会议组通话，则可以自动应答呼叫，而且会议将在只有一名参与者（会议组呼叫的发起人）的情

况下开始。然后，最多6个参与者可以使用超时后加入功能加入到此会议中。例如，经理可以组织一个所有成

员均使用移动电话呼叫并使用超时后加入功能进行加入的会议。

条件

• 只有COS编程允许的分机可以发起会议组呼叫。

• 如果使用SLT或SIP分机来发起呼叫，则无法使用会议组呼叫控制功能。

• 一个会议群成员应答电话后，便会建立起会议或语音通知。

• 如果在预编程时间限制内没有成员应答电话，主叫方会听到忙音。

• 每次有成员应答电话时，主叫方都会听到证实音。

• 会议组呼叫的发起方挂机时，电话结束并且所有与会成员将被断开。

• 不管诸如呼叫转送等设定如何（DND除外），会议组呼叫都会到达成员分机。

• 发出会议组呼叫时，如果成员分机占线并已启动中继线呼叫的呼叫等待，则将发送呼叫等待音到该分机。

• 主叫方（而不是成员）的呼叫信息将被记录在SMDR上。

• 主叫方无法利用保留的呼叫发出会议组呼叫。

• 呼叫接听不适用于会议组呼叫。（® 2.4.3  呼叫接听）

• 当成员分机以将内线电话设为免打扰时，会议群呼叫不会到达成员分机。

• 如果通话已达到最大数量与会者，则无法使用超时后加入功能加入通话。
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• 如果一个成员在广播模式呼叫期间使用一键通话功能来启用发言能力，则该成员将无法禁用自己的发言能

力。其可以手动静音麦克风，或者呼叫发起人可以使用会议组呼叫控制来禁用其发言能力。

使用说明书（PC编程手册）参考

10.3  PBX Configuration—[2-3] System—Timers & Counters—Miscellaneous— Conference Group
Call—Ring Duration (s)
10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features— Conference Group Call
Operation
10.7.1  PBX Configuration—[2-7-1] System—Class of Service—COS Settings—Miscellaneous— Conference
Group Call Operation
10.9  PBX Configuration—[2-9] System—System Options—Option 8— Conference Group—Maximum
Number of Speakers During a Conference Group Call
11.9  PBX Configuration—[3-9] Group—Conference Group

→ Broadcast Mode
→ Ability to Talk
→ Automatic Answer w/o Extension Setting

11.9.1  PBX Configuration—[3-9] Group—Conference Group—Member List

使用说明书（功能手册）参考

2.4.4  免提应答

6.1  系统资源的容量

使用说明书（用户手册）参考

1.7.3  进行会议组呼叫

202 使用说明书（功能手册）

2.15.1 会议组呼叫



2.16  直接拨入系统接入（DISA）功能

2.16.1  直接拨入系统接入（DISA）

说明

当来电目的地是一个指定给每个DISA留言的DISA浮动分机号码时，外线来电者可以接入特定的集团电话功能，

如同来电者是集团电话上的SLT分机用户一样。来电可以直接接入各种功能，例如：

• 打一个内线电话给分机、话务员或任何浮动分机（例如：TAFAS的外部广播机）。

• 通过集团电话呼叫外线用户。

• 操作一些集团电话远程功能（例如：FWD）

DISA截取路由—无拨号

听到外播留言（OGM）后，如果来电者在预编程设定的时间内（用于截接的DISA第一拨号时间）无法拨任何

数字，可以通过系统编程选择以下选项之一：

a. 停用：呼叫将终止。

b. 话务员：呼叫将转接给话务员。

c. AA-0，AA-9：呼叫将转接到分配给该AA号码的目的地。

→ 10.3  PBX Configuration—[2-3] System—Timers & Counters—DISA / Door / Reminder / U. Conf—
DISA—No Dial Intercept Timer (s)

→ 13.3.1  PBX Configuration—[5-3-1] Optional Device—Voice Message—DISA System—Option 1— DISA
Intercept—Intercept when No Dial after DISA answers

DISA内装自动值机员号码（DISA AA服务）

在听到外播留言（OGM）后，来电者可以拨一个数字（DISA AA号码）。可以为每条留言分配每个DISA AA号
码的目的地。也可以将其它DISA浮动分机号码指定为目的地（多步DISA AA服务）。

如果来电者在预编程设定的时间内拨第二个数字（用于AA的DISA第二拨号时间），就不会采用DISA AA服务。

→ 13.3.2  PBX Configuration—[5-3-2] Optional Device—Voice Message—DISA Message— 1 Digit AA
Destination (Extension Number)—Dial 0–9

→ 10.3  PBX Configuration—[2-3] System—Timers & Counters—DISA / Door / Reminder / U. Conf—
DISA—2nd Dial Timer for AA (s)

外播留言（OGM）

当呼叫到达DISA线路时，预先录制的DISA留言会问候并提示来电者。

任何被指定为管理员的分机都能录制外播留言（OGM）。（® 2.30.2  外播留言（OGM））

[编程示例]

外播留言

（OGM）号

码

浮动分机号

码*1

自动值机员号码*2
占线/免打扰

留言号码*3
0 1 2 3 4 5 6 7 8 9

01 501 100 301 200 103 202 101 102 400 104 205 04

02 502           05

: : : : : : : : : : : : :

*1 ® 13.3.2  PBX Configuration—[5-3-2] Optional Device—Voice Message—DISA Message— Floating Extension
Number
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默认浮动分机号码取决于简易设置中Numbering Plan指定的值。

® 5.4.1  简易设置指示
*2 ® 13.3.2  PBX Configuration—[5-3-2] Optional Device—Voice Message—DISA Message— 1 Digit AA Destination

(Extension Number)—Dial 0–9
*3 ® 13.3.2  PBX Configuration—[5-3-2] Optional Device—Voice Message—DISA Message— Busy / DND Message

No.

DISA安全方式和可用功能

如果不采用DISA AA服务，来电者可通过输入功能号码接入集团电话功能。为了防止其他人接入集团电话功

能，可以指定DISA安全。

→ 13.3.1  PBX Configuration—[5-3-1] Optional Device—Voice Message—DISA System— DISA
Security—DISA Security Mode

可用功能取决于预编程设定的DISA安全方式，如下所示：

安全方式 内线电话
TIE线路呼叫

中继线呼叫
无集团电话代码 有集团电话代码

全保密     

中继线保密 ü ü   

非保密 ü ü ü ü*1

ü：可用
*1 如果中继线呼叫可用，计费代码输入（® 2.5.4.3  计费代码输入）也可用。

注

DISA AA服务和话务员呼叫（® 5.1.5  话务员功能）可用于任何安全方式。

用验证码输入占优插入安全方式

当听到DISA留言时，如果来电者执行验证码输入（® 2.7.6  验证码输入），则安全方式可以暂时变更为非保密

方式。

输入方法：

验证码输入功能号码 +  + 验证代码 + 验证代码PIN
变更方式后，该新方式在呼叫持续时间内仍有效。

DISA截取路由—占线

如果外线用户呼叫的第一目的地占线，呼叫将按以下方式转接：

a. 呼叫被转接到分配给第一目的地的截取路由—占线目的地。

b. 如果未向第一目的地分配截取路由—占线目的地但指定了预先录制的DISA占线留言，来电者将听到DISA占
线留言。

c. 如果截取目的地和DISA占线留言均未指定，来电者将听到忙音。

→ 12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Intercept
Destination— Intercept Destination—When Called Party is Busy

DISA截取路由—免打扰

如果外线用户呼叫的目的地处于DND方式且空闲分机搜索不可用，可以通过系统编程选择以下选项：

a. 忙音：呼叫者将听到忙音。

b. 允许：免打扰会将呼叫转移到以分机为基础预编程的目的地。
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c. OGM：将给来电者发送外播留言（OGM）。可以为每个具有DISA浮动分机号码的外播留言（OGM）指定

DND方式的留言。

→ 13.3.1  PBX Configuration—[5-3-1] Optional Device—Voice Message—DISA System— DISA
Intercept—Intercept when destination through DISA sets DND

DISA截取路由—无应答

在呼叫到达后，如果目的地在预编程设定的时间内（DISA截接时间）未能应答DISA呼叫，该呼叫将被转接到

由截接功能设定的目的地。

在DISA截接时间到期后，如果截接目的地未能在预编程设定的时间内（截接后的DISA断开时间）应答呼叫，

该呼叫将被断开。

10.3  PBX Configuration—[2-3] System—Timers & Counters—DISA / Door / Reminder / U. Conf
→ DISA—Intercept Timer—Day (s), Lunch (s), Break (s), Night (s)
→ DISA—Disconnect Timer after Intercept (s)
® 12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Intercept
Destination— Intercept Destination—When called party does not answer—Day, Lunch, Break, Night

通过DISA的流动COS
当听到DISA留言时，如果来电者执行流动COS（分机号码和PIN输入），则安全方式可以暂时变更为非保密方

式（® 2.7.5  流动COS）。在执行流动COS后，使用指定分机的设定，可以使用以下功能：

• 内线电话

• TIE线路呼叫

• 中继线呼叫

• 呼叫转送（FWD）/免打扰（DND）设定（® 2.3  呼叫转送（FWD）/免打扰（DND）功能）

• 来电呼叫分配群注册/注销（® 2.2.2.8  注册/注销）

• 缺席留言设定（® 2.20.2  缺席留言）

• 分机锁定（® 2.7.3  分机锁定）

• 定时服务切换方式（® 5.1.4  定时服务）

注

使用通过DISA的流动COS进行中继线呼叫时，该次呼叫的CLIP号码将是流动COS获得的分机号码。（®
4.1.2.2  呼叫/连接线路识别显示（CLIP/COLP））

DISA自动流动COS
当通过DISA呼叫时，已注册的外线目的地，例如移动电话，可以自动地识别为集团电话的分机。当已接听的中

继线呼叫的来电显示与系统速拨表中的某条目匹配时，呼叫电话将给予流动COS特许，指定其作为对应的CLI
目的地分机。因此，系统速拨表中的"CLI目的地"设定在此处用于指定目标分机，该呼叫电话将被识别为流动

COS的目标分机。

[DIL表的编程示例]

中继线号

码

CLI 目的地

白天 午餐 ... 白天 午餐 ...

01 停用 停用 ...
5801

（DISA）
5801

（DISA）
...

: : : : : : :

若要使DISA能够接收来电，则"CLI"必须设定为停用。
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[系统速拨表编程示例]

位置 姓名 中继线接入 + 电话号码 CLI目的地

000 J. Smith 912341115678 200

001 : : :

: : : :

在本示例中，中继线01接收的呼叫被路由到DISA OGM，浮动分机号码为5801。如果所接收呼叫的号码（根据

来电显示表修改后）是"12341115678"，呼叫发起人被识别为分机200，则流动COS功能自动启动。

要允许此功能需要进行系统编程。

SMDR
DISA的呼叫信息被记录为DISA浮动分机号码之一。（® 2.22.1.1  电话通信详细记录（SMDR））
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注意

DISA的中继线间呼叫功能可能会被利用来进行欺诈呼叫。

此类呼叫将向集团电话的所有者/租用者收费。

为保护集团电话免受此类欺诈使用，我们强烈建议：

a. 启用DISA保密（中继线保密或全保密）。

b. 对密码（验证代码PIN/分机PIN）进行保密。

c. 选择不容易猜到的复杂、随机PIN。

d. 定期更改PIN。

• 最多同时OGM信道

如果未安装任何DSP卡，则最多同时OGM信道数为2。如果安装了DSP卡，则最多同时OGM信道数为64。
但是，在此情况下会使用DSP资源。

• DSP资源占用

DISA电话需要一定数量的DSP资源。如果所有DSP资源都在使用，则无法进行此操作。为确保最低的性能

水平，可为会议电话预留DSP资源。（® 5.5.4  DSP资源占用）

• DISA延迟应答时间

可以设定延迟应答时间，这样，来电者在预编程设定的时间内首先会听到回铃音，然后才听到外播留言

（OGM）。

→ 10.3  PBX Configuration—[2-3] System—Timers & Counters—DISA / Door / Reminder / U. Conf—
DISA—Delayed Answer Timer (s)

使用说明书（功能手册） 209

2.16.1 直接拨入系统接入（DISA）



• 呼叫重试

当听到回铃音、挂机重拨音或忙音时，通过按" "可以重试该呼叫。由系统编程选择在中继线通话期间

按" "是返回到DISA顶级菜单还是发送DTMF音。

• DISA静音时间

可以在来电到达DISA线路后设定静音时间，直到播放外播留言（OGM）并且集团电话开始接收DTMF信
令。

→ 10.3  PBX Configuration—[2-3] System—Timers & Counters—DISA / Door / Reminder / U. Conf—
DISA—Mute & OGM Start Timer after answering (s)

• 通话结束检测

如果呼叫通过DISA路由到中继线，则DISA可以用于通话结束检测。可以通过系统编程停用此功能。如果此

功能被停用，当中继线间的连接建立后，DISA将被释放。

可以为每个中继线群启用以下三种类型的信号音检测，以便通过DISA断开中继线间呼叫。

– 静音检测

→ 11.1.1  PBX Configuration—[3-1-1] Group—Trunk Group—TRG Settings—Tone Detection—
DISA Tone Detection—Silence

– 连续信号检测

→ 11.1.1  PBX Configuration—[3-1-1] Group—Trunk Group—TRG Settings—Tone Detection—
DISA Tone Detection—Continuous

– 循环信号检测

→ 11.1.1  PBX Configuration—[3-1-1] Group—Trunk Group—TRG Settings—Tone Detection—
DISA Tone Detection—Cyclic

• 中继线间通话时长限制

对于两个外线用户之间的通话，即使通话结束检测无法执行，还是可以通过系统定时器断开通话。（®
2.11.8  中继线呼叫限制）如果该定时器到期，线路将被断开，除非原来电者通过发送DTMF信令来延长时

间。来电者可以在预编程设定的时间内和预编程设定的次数内延长通话时长。

10.3  PBX Configuration—[2-3] System—Timers & Counters—DISA / Door / Reminder / U. Conf
→ DISA—CO-to-CO Call Prolong Counter
→ DISA—CO-to-CO Call Prolong Time (x60s)

• 自动启动DISA
对于以下类型的中继线间呼叫，可以通过系统编程将DISA设定为自动启动，以允许对通话结束的检测。

– 当一个中继线呼叫被转送到另一个中继线时

– 当一个中继线呼叫被转移到另一个中继线时

– 当一个到达来电呼叫分配群的中继线呼叫由外线目的地成员应答时

在电话拨出前，集团电话确认是否有DISA端口可用。如果没有DISA端口可用，该呼叫不会被路由到中继

线。对于被转移的呼叫或到达ICD群的呼叫，如果DISA端口在中继线间通话实际建立时已变为不可用，那

么该呼叫将不通过DISA建立。

当使用此功能时，应该启用中继线间通话限制定时器。另外，不能通过DTMF信令延长通话。

• 来自外线目的地的DISA呼叫转移

如果DISA通过自动启动DISA功能进行连接，那么外线用户，例如移动电话，可以通过按"#" + 分机号码（包

括TIE）或外线用户的号码将中继线呼叫转移到分机（包括TIE）或外线用户上。此功能可以通过系统编程

启用或停用。

也可以建立起会议电话（® 2.14  会议功能），进行呼叫分离（® 2.13.3  呼叫分离），并使用保留的呼叫进

行广播从而将呼叫转移（® 2.17.1  广播）。

– DISA安全方式应该设定为非保密。

– 如果被呼叫的分机无应答、占线或处于DND方式，则DISA截接功能将会执行。

– 保留方可以使用呼叫重试功能。
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– 如果目的地中继线支持通话结束检测，则可在拨"#"后进行广播呼叫。

– 如果转移的呼叫被转发到外线目的地，COS设置则会被忽略。

• 如果在系统速拨中注册了移动电话号码，则其COS会是指定为CLI目的地的分机的COS。
• 如果未在系统速拨中注册了移动电话号码，则其COS会是转移方正在使用的中继线的COS。
• 根据"10.7.1  PBX Configuration—[2-7-1] System—Class of Service—COS Settings—CO &

SMDR— Transfer to CO"设定和目的地中继线上通话结束检测的可用性，操作如下：

– 例1：启用Transfer to CO
可进行转移。

– 例2：禁用Transfer to CO且目的地中继线支持通话结束检测

听到挂机重拨音。（通过按"#"可以释放协商保持 。）
– 例3：禁用Transfer to CO且目的地中继线不支持通话结束检测

取消转移，且通话返回至保留中继线。

– 如果呼叫被转移到ICD群，呼叫会在队列中等待直至被应答，但排队时间表将不起作用。

– 使用此功能时，切勿使用主管遇忙优先插入功能将建立的呼叫中断。

在接到中继线呼叫时（转移目的地—移动电话—应答前）通过DTMF " "重拨。

• 转移目的地中继线（移动电话）应答前，可以使用DTMF音" "重拨。

• 如果转移目的地（移动电话）是不支持应答通知的线路，则将完成去电拨号视为应答。

• 如果目的地中继线支持通话结束检测，则可进行屏蔽转移。如果转移方在与被叫方通话时拨"#"，则通

话可返回协商保持。

• 如果目的地中继线不支持通话结束检测，则进行不屏蔽呼叫转移。

• DISA呼叫转移到外线用户

当通过DISA收到呼叫且接收分机设为将呼叫转送至分机（包括通过TIE连接）或外线目的地时，如果满足

以下条件，则可自动将呼叫转送至外线电话号码：

• 外线电话号码（例如，移动电话号码）注册为接收分机的转送目的地。

• 在接收分机的系统速拨中注册了转送目的地的电话号码。

• 在接收分机的CLI目的地中设定了转送目的地的电话号码。

• 接收分机启用自动流动COS。
与转送目的地（例如，移动电话号码）建立通话后，可以建立会议电话、进行呼叫分离以及用保留呼叫进

行广播来转移呼叫。这与来自外线目的地的DISA呼叫转移相同。有关详情，请参阅"来自外线目的地的DISA
呼叫转移"。

[示例]
a. 外线来电者通过DISA呼叫分机101。
b. 分机101将呼叫转送至移动电话-1。

外线来电者与移动电话-1建立通话。

c. 移动电话-1按"#"将通话置于保留状态，然后将呼叫转移到移动电话-2。
此时，移动电话-2上显示的CLIP信息可能为以下之一：

例1：当分机101转送呼叫时，用移动电话-1的电话号码进行自动流动COS。
– 显示的CLIP：如同分机101进行中继线呼叫。

例2：当分机101转送呼叫时，不进行自动流动COS，并将 Send CLIP of CO Caller—when call is
transferred to CO (CLIP of Held Party)设为Enable。
– 显示的CLIP：外线来电者的电话号码和姓名。
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例3：当分机101转送呼叫时，不进行自动流动COS，并将 Send CLIP of CO Caller—when call is
transferred to CO (CLIP of Held Party)设为Disable。
– 显示的CLIP：移动电话-1用于转移呼叫的线路所设定的CLIP。
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• DISA挂机重拨音持续时间

可以设定DISA挂机重拨音持续时间。它规定给主叫方发送挂机重拨音的时间长度。当定时器到期时，呼叫

将被断开。在DISA挂机重拨音持续时间内可以使用呼叫重试。

→ 10.3  PBX Configuration—[2-3] System—Timers & Counters—DISA / Door / Reminder / U. Conf—
DISA—Reorder Tone Duration (s)

• 拒绝呼叫

分机可以在COS基础上拒绝DISA呼叫。

→ 10.7.1  PBX Configuration—[2-7-1] System—Class of Service—COS Settings—Optional Device &
Other Extensions— Accept the Call from DISA

• 验证代码PIN锁定/分机PIN锁

如果三次输入错误的PIN，线路将被断开。如果连续输入错误的PIN达到预编程设定的次数，该分机或验证

代码将被锁定，即使输入正确的PIN也无法解锁。只有被指定为管理员的分机才能解除锁定。这种情况下，

PIN将被解除锁定并被清除。

→ 10.3  PBX Configuration—[2-3] System—Timers & Counters—Miscellaneous— Extension
PIN—Lock Counter

• DISA自动流动COS
使用此功能需要KX-NSE101或KX-NSE110（移动分机的激活密钥）。每个使用此功能的分机都需要一个激

活密钥。

• 通过系统编程，可以为每条外播留言（OGM）指定一个名称，以便编程引用。

→ 13.3.2  PBX Configuration—[5-3-2] Optional Device—Voice Message—DISA Message— Name
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使用说明书（安装手册）参考

5.4.1  简易设置指示

使用说明书（PC编程手册）参考

10.3  PBX Configuration—[2-3] System—Timers & Counters—DISA / Door / Reminder / U. Conf
→ DISA—Delayed Answer Timer (s)
→ DISA—Mute & OGM Start Timer after answering (s)
→ DISA—No Dial Intercept Timer (s)
→ DISA—2nd Dial Timer for AA (s)
→ DISA—Intercept Timer—Day (s), Lunch (s), Break (s), Night (s)
→ DISA—Disconnect Timer after Intercept (s)
→ DISA—CO-to-CO Call Prolong Counter
→ DISA—CO-to-CO Call Prolong Time (x60s)
→ DISA—Progress Tone Continuation Time before Recording Message (s)
→ DISA—Reorder Tone Duration (s)

10.3  PBX Configuration—[2-3] System—Timers & Counters—Miscellaneous— Extension PIN—Lock
Counter
10.7.1  PBX Configuration—[2-7-1] System—Class of Service—COS Settings—Optional Device & Other
Extensions— Accept the Call from DISA
11.1.1  PBX Configuration—[3-1-1] Group—Trunk Group—TRG Settings

→Tone Detection— DISA Tone Detection—Silence
→Tone Detection— DISA Tone Detection—Continuous
→Tone Detection— DISA Tone Detection—Cyclic

12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Intercept
Destination— Intercept Destination—When called party does not answer—Day, Lunch, Break, Night
13.3.1  PBX Configuration—[5-3-1] Optional Device—Voice Message—DISA System
13.3.2  PBX Configuration—[5-3-2] Optional Device—Voice Message—DISA Message

使用说明书（PT编程手册）参考

[209] DISA延迟应答时间

[210] DISA中继线间呼叫延长时间

[211] DISA截接时间

[475] DISA静音检测

[476] DISA连续信号检测

[477] DISA循环信号检测

[604]分机截接目的地

[730]外播留言（OGM）浮动分机号码

[731]外播留言（OGM）名称

[732] DISA安全方式

使用说明书（功能手册）参考

2.1.1.6  截取路由

2.1.1.7  截取路由—无目的地
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2.3  呼叫转送（FWD）/免打扰（DND）功能

5.1.1  服务等级（COS）
5.5.8  浮动分机

使用说明书（用户手册）参考

1.2.8  直接从外线接入另一个用户（直接拨入系统接入[DISA]）
1.2.9  从另一部分机或通过DISA设定您的电话（远程设定）
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2.16.2  传真自动转移

说明

集团电话可以区分到达DISA线路的传真呼叫与其它类型的呼叫，并自动将传真呼叫转移到预编程设定的目的

地。当呼叫到达DISA线路时，会播放OGM（® 2.30.2  外播留言（OGM））。与此同时，集团电话开始进行传

真信号检测。如果检测到传真信号，集团电话就把呼叫辨认为传真呼叫，并将该呼叫转移到通过系统编程指定

给该OGM的传真目的地。这使得语音呼叫与传真呼叫均可无缝地使用单一中继线，只有语音呼叫会到达用户分

机。

[可用传真自动转移目的地]

目的地 可用性

有线分机（PT/SLT/ISDN分机） ü

虚拟PS ü*1

来电呼叫分配群 ü

SIP分机  

UM群 ü

语音信箱群（DTMF/DPT）

外部广播机（TAFAS）

DISA

模拟/ISDN远程维护

空闲线路接入号码 + 电话号码

中继线群接入号码 + 中继线群号码 + 电话号码

其它集团电话分机（无集团电话代码的TIE）

其它集团电话分机（带集团电话代码的TIE）

*1 可以将虚拟PS指定为传真呼叫的目的地。然后，可以将其它集团电话中的传真机的分机号码指定为到达该虚拟PS的呼

叫的FWD—全部呼叫目的地。（® 5.2.4.1  虚拟PS）

条件

• 此功能只对到达DISA线路的呼叫有效。

• 如果在DISA截取路由─无拨号定时器到期前没有检测到传真信号，呼叫将被转接至话务员分机，传真检测

结束。

• 如果传真音（CNG信号）检测因传真机类型或线路状态而延迟，则DISA截接定时器可能超时且无法接收传

真。在此情况下，将DISA截接定时器增加5至10秒会帮助避免此问题。

使用说明书（PC编程手册）参考

10.3  PBX Configuration—[2-3] System—Timers & Counters—DISA / Door / Reminder / U. Conf—
DISA—Intercept Timer—Day (s), Lunch (s), Break (s), Night (s)
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13.3.2  PBX Configuration—[5-3-2] Optional Device—Voice Message—DISA Message— Fax Extension

使用说明书（功能手册）参考

2.16.1  直接拨入系统接入（DISA）
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2.16.3  内装简化语音留言（SVM）

说明

此功能为分机提供简单的应答机功能。

适用于有留言箱的分机用户的功能：

分机用户可以录制个人外播留言，以便问候来电者并请他留下语音留言。用户还可以播放并清除外播留言以及

来电者留下的语音留言。

适用于来电者的功能：

来电者在听到外播留言后可以留下语音留言。

MPR卡上的SVM/OGM数据块

MPR卡具有内置的SVM/OGM数据块。可以将此数据块用于SVM功能和OGM功能（® 2.30.2  外播留言

（OGM））。

用于SVM功能时，此数据块被分配了浮动分机号码（默认：591）。有两个信道可用，允许两个用户同时使用此

功能。

当通过系统编程将一部分机指定给此功能时，就为该分机创建了一个留言箱。该留言箱用于存储该分机的外播

留言和语音留言。每部PT和SLT都可以有其自己的留言箱。

[示例]

MPR

SVM 591

101 102 103 210

2

系统内存最多可以录制125（MPR）条留言（外播留言及分机的语音留言），总录音时间最长120分钟。该内存

在指定给该内存的所有分机的留言箱之间分享。

利用MPR卡上的SVM/OGM数据块可同时使用SVM功能和OGM功能。SVM功能和OGM功能有2条信道。仅当

两个信道都空置时才可记录外播留言（OGM）。可保存125条留言（外播留言及分机的语音留言）（总共120分
钟）供SVM使用，可保存64条留言（总共20分钟）供OGM使用，如下所示。

在主机的系统内存中

OGM SVM

64  125

20 120

2

如果录制的全部语音留言的总长度超过了记录空间的90 %，显示器将告知所有分机用户总容量就要用完。用户

在摘机时会听到拨号音3。

浮动分机号码和目的地

当分机用户不能应答来电时，可以设定来电转接到他的留言箱。用户可以将此功能的浮动分机号码设定为转接

呼叫的目的地。这样，此功能将应答转接的呼叫，播放有关外播留言，并录制语音留言。可以通过下列方法将

来电转接到此功能：

– 呼叫转送（FWD）（® 2.3.2  呼叫转送（FWD））
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– 截取路由—无应答/占线/免打扰（® 2.1.1.6  截取路由）

[截取路由的编程示例]

分机号码 截接目的地

白天 午餐 休息 夜间

101 102 591 591 591

102 103 591 591 591

301
（话务员）

– – – 591

在本示例中：

如果分机101接到电话而无法应答：

a. 白天方式：呼叫将被转接到分机102。
b. 午餐/休息/夜间方式：呼叫将被转接到此功能，语音留言将被录制到留言箱中。

如果分机301（话务员）接到电话，呼叫只会在夜间方式中被转接到此功能。

如果分机同时设定了FWD功能和截取路由功能，FWD设定具有优先权。因此，即使处在白天方式，分机101也
可以从其分机暂时设定FWD设定，将呼叫转送到此功能。

每种时间方式的外播留言

当呼叫被转接到此功能时，来电者会听到指定的外播留言。除了一般外播留言以外，分机用户还可以为每种时

间方式（白天/午餐/休息/夜间）录制不同的外播留言（® 5.1.4  定时服务）。

[录音示例]
• 一般外播留言："您已到达John的电话。很抱歉，我现在不能接听您的电话。请留言。"
• 午餐方式的外播留言："您已到达John的电话。很抱歉，我现在正在外用膳。请留言。"
如果某时间方式下的外播留言和一般外播留言均已录制，来电者将会听到该时间方式下的外播留言。但是，如

果没有录制某时间方式下的外播留言，则会播放一般外播留言。

如果一般外播留言与用于某种时间方式的外播留言均没有录制，则该时间方式下来电不会被转接到此功能。例

如，如果仅为夜间方式录制了外播留言，而没有录制一般外播留言，则仅在夜间方式下来电才能被转接到此功

能。白天/午餐/休息方式下则不会将来电转接到此功能。

直接录音

分机用户可以直接在分机的留言箱中留下语音留言。这种情况下，目标分机不会振铃。也可以直接将呼叫转移

到分机的留言箱。

留言通知

如果留言箱中留下了新语音留言，并且启用了特殊拨号音，用户在摘机时将听到拨号音4。如果留言箱中只含

有先前已听过的语音留言，则将听到拨号音2。此外，如果用户电话有留言键或留言/振铃灯，则当留有语音留

言时，相应的键和灯会亮起。在挂机时按亮起的键将显示来电信息。

SVM记录

当来电者留下语音留言时，同时还会记录下列信息（如果有）：

a. 来电者名称

b. 来电者电话号码

c. 录制开始时间

d. 语音留言状态
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– 对于先前未听过的语音留言显示"New"。
– 对于先前已听过的语音留言显示"Old"。

该信息可以用PT的显示器查看。

请注意根据接收信息和所用电话类型的不同，显示器上显示的信息可能不同。只有使用6行显示PT的用户才能

查看上述全部信息。

检查来电者留下的语音留言

当分机用户接入其留言箱时，首先将播放最新未播放的语音留言。播放完一条语音留言后，下一条最新的语音

留言自动开始播放。播放完留言箱中的最后一条语音留言后，将再次从最新的语音留言开始播放。这次当播放

完全部语音留言后，分机用户会听到拨号音4，然后线路自动断开。

从中继线远程接入SVM
通过呼叫其自己的分机并使用流动COS功能，分机用户可以通过中继线远程接入其留言箱。这使得用户，例

如，可以在办公室之外检查其留言箱中的语音留言。

接入另一部分机的留言箱

分机用户可以使用流动COS功能接入另一部分机的留言箱，例如，以便在留言箱中为来电呼叫分配（ICD）群

录制外播留言等，如下所述。

此外，如果用户电话有用于另一部分机的留言键，则用户可以轻易地接入该分机的留言箱，听取来电者留下的

语音留言。

来电呼叫分配（ICD）群的留言箱

当使用截取路由—溢出（® 2.2.2.7  溢出功能）或呼叫转送（FWD）将呼叫从ICD群转接到此功能时，将播放

用于指定给ICD群的第一部分机的外播留言，来电者的语音留言将记录在该分机的留言箱中。

可以将虚拟PS指定为ICD群的第一部分机。这将为该ICD群提供一个专用的留言箱，而不与实际的分机共享。

（® 5.2.4.1  虚拟PS）

SLT拨"*"号操作方式

根据环境，SVM设备可能错误检测到来自SLT用户的DTMF信号。可以通过系统编程设定SLT拨号方式以使SLT
用户能够在收听语音留言时避免检测到错误的DTMF信号。当启用此设定时，分机用户必须在拨打其他号码前

拨"*"号。

实例：

SLT拨"*"号操作方式设定 从头开始播放语音留言

停用（默认） 拨"1"

允许 先拨"*"号再拨"1"

扩展SVM功能

SVM功能受限（例如：仅可使用2条信道；总记录时间为120分钟）。要使用更丰富的语音留言功能（例如：更

长的记录时间），请使用统一消息系统。（® 章节  3  统一消息系统）您可以同时使用SVM功能和统一消息系

统。

条件

[一般]
• 使用预装的MPR卡时该功能可用。
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• 对于一部分机，可以录制的语音留言最大数目（不包括外播留言）可以通过系统编程设定，其范围是1到
100。（默认：10）

• 通过此功能应答来电时，留言键或留言/振铃灯会亮起。但是，如果来电者未留下留言，呼叫结束后灯会熄

灭。

• 无法备份SVM记录、录制的语音留言或外播留言。如果集团电话初始化，所有此类信息都会被清除。

• 使用MPR卡时，可以通过系统编程为每个分机停用此功能。仅允许某些用户（例如：老板、管理人员等）

使用此功能的有限容量语音留言时会非常有用。停用此功能时，分机所有的录制语音留言和外播留言都将

被清除。

• 使用友好功能检查分机时，分机的语音留言也会被清除（® 2.23.1  友好功能—概要）。但是，不会清除外

播留言。

• 即使分机的留言箱中正在录制语音留言，该分机也能够接电话。

• 如果两个用户已在使用此功能时有其它分机用户试图使用此功能，该用户将听到忙音。

• 如果留言箱已在使用中，而此时分机用户试图清除显示器上显示的语音留言，该分机用户将听到通知音。

• 在下列情况下，语音留言录制停止：

a. 来电者挂机。

b. 语音留言的录制时间达到预编程设定的限制。（120秒）

c. 记录空间已达到限值。

在情况b和c下，来电者将听到通知音，然后线路断开。

• 在下列情况下，新语音留言无法录制到留言箱中：

a. 总录音时间或语音留言数目超过限值。

b. 分机的语音留言数目超过限值。

c. 呼叫的目的地多次改变。

d. 另一个用户正在使用所需的留言箱。

e. ICD群接到呼叫，而指定给该群的第一部分机的留言箱不可用，或没有指定任何分机作为该群的第一个

成员。

• 录制外播留言

总录音时间或留言数目达到限值时，如果分机用户试图将新外播留言录制到其留言箱中，用户将听到挂机

重拨音。

• 显示锁定

显示PT用户可以通过个人编程（显示锁定）锁定SVM记录显示，防止在任何分机上查看用户信息和播放语

音留言。这种情况下，来电/去电呼叫记录显示和个人速拨号码显示也被锁定。锁定/解锁显示需要使用分机

个人识别号码（PIN）（® 2.24.1  分机个人识别号码（PIN））。

• 从SVM变为DISA
如果SVM应答了呼叫，但是来电者想要呼叫另一部分机而不是留言，通过拨打话务员呼叫功能号码就可以

接入DISA（DISA OGM 01将播放）。这样允许来电者通过DISA呼叫另一部分机或接入DISA AA服务。

必须通过系统编程允许SVM信箱所属卡/数据块的OGM功能。

[从中继线远程接入SVM]
• 可以通过系统编程设定是否可以使用流动COS。

如果集团电话使用模拟中继线，强烈建议禁止使用流动COS接入。如果通过模拟线路接入其留言箱的分机

用户挂机，同时语音留言正在播放，则该线路仍保持连接，直到所有语音留言播放完毕。这是因为在播放

语音留言时无法从模拟线路上检测到挂机重拨音。

• 流动COS功能号码的第一位数必须在外播留言播放完毕前输入。

• 通过中继线接入SVM时，可以更改留言箱（例如：听取自己的留言后，在另一个用户的留言箱中留言。）

• 接入另一部分机的留言箱

只有当留言箱中已经留有语音留言时，才能使用用于另一部分机的留言键听取来电者留下的语音留言。

• 创建外播留言时，不推荐录制音乐。
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• 此功能不会应答使用呼叫转送用QSIG功能（4.3.4.4  呼叫转移（CT）—用QSIG）转送的呼叫。
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6.16.1  Tool—SVM (Simplified Voice Message)—Delete All Recording
6.16.2  Tool—SVM (Simplified Voice Message)—Check Current Usage
10.3  PBX Configuration—[2-3] System—Timers & Counters—Miscellaneous

→ SVM—Recording Time (s)
→ SVM—Dial Tone Continuous Time (s)

10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features— Simplified Voice Message
Access
11.1.1  PBX Configuration—[3-1-1] Group—Trunk Group—TRG Settings

→Tone Detection— Simplified Voice Message Tone Detection—Silence
→Tone Detection— Simplified Voice Message Tone Detection—Continuous
→Tone Detection— Simplified Voice Message Tone Detection—Cyclic

12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Option 6— Display
Lock/SVM Lock
12.1.8  PBX Configuration—[4-1-8] Extension—Wired Extension—Simplified Voice Message
13.3.3  PBX Configuration—[5-3-3] Optional Device—Voice Message—SVM

使用说明书（功能手册）参考

2.7.5  流动COS
2.30.2  外播留言（OGM）

2.25.1  拨号音

6.1  系统资源的容量

使用说明书（用户手册）参考

1.6.4  使用语音留言（内装简化语音留言[SVM]）
3.1.2  编程方式设定
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2.17  广播功能

2.17.1  广播

说明

分机用户可以同时向许多目的地发出语音通知。

信息通过PT的内置扬声器和/或属于广播群的外部扬声器（外部广播机）播放。集团电话可以连接至六个外部

广播机。

被广播人可以从就近的电话上应答广播。

为了转移呼叫，可以用保留的呼叫进行广播。

拒绝广播：

分机用户可以选择不接收广播通知。

广播群

每个广播群都由分机用户群和外部广播机组成。一个分机用户群或外部广播机可以属于数个广播群。

(® 5.1.2  群)

[示例]

1

01

 100  101

2

 102  103

3

 104  105  1

02 03

 2

[编程示例]

广播群号码
分机用户群号码*1 外部广播机*2

001 002 003 ... 1 2 3 ...

01 ü   ...  ...

02  ü ü ... ü ...

03   ü ... ü ü ...

04    ...  ...

05 ü ü ü ... ü ü ü ...

: : : : ... : : : ...

ü：组成成分
*1 ® 11.4  PBX Configuration—[3-4] Group—Paging Group

或

11.4.1  PBX Configuration—[3-4] Group—Paging Group—All Setting
*2 ® 11.4.2  PBX Configuration—[3-4] Group—Paging Group—External Pager
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条件

• 以下类型的分机无法听到广播通知：

– SLT
– 振铃或占线的PT
– 处于拒绝广播方式的PT
– 处于广播DND方式的PT
– 被分配到用户群31（默认）的IP-PT*1

– 一般SIP电话

虽然这些类型的分机无法听到广播通知，但是可以应答广播通知。当一个编号分机的分机号码被广播时，

仅广播主分机；不会广播子分机。（® 2.11.11  一个编号分机）
*1 更改分机的一个用户群，允许其接收广播。但是，这样做可能会影响主板可以同时进行的IP分机和IP中继线呼叫的

数量。

• 外部广播机优先权

可以按以下优先权使用外部广播机：

TAFAS ® 广播 ® BGM
(® 2.17.2  从任意用户电话应答中继线上的呼叫（TAFAS）, 2.30.1  背景音乐（BGM）)

• 音量控制

通过系统编程可以改变PT和外部广播机的广播音量。

• 广播免打扰

当对来电设定了DND（® 2.3.3  免打扰（DND））时，可以通过系统编程设定分机是否接收广播。

使用说明书（PC编程手册）参考

10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features
→ Group Paging
→ Group Paging Answer
→ Paging Deny Set / Cancel

10.9  PBX Configuration—[2-9] System—System Options
→Option 1— PT Fwd / DND—Paging to DND Extension
→Option 3— Confirmation Tone—Tone 2 : Paged / Automatic Answer

10.11.1  PBX Configuration—[2-11-1] System—Audio Gain—Paging/MOH
→ Paging—EPG 1-6 (External Pager 1-6)
→ Paging—Paging Level from PT Speaker

11.4  PBX Configuration—[3-4] Group—Paging Group
11.4.1  PBX Configuration—[3-4] Group—Paging Group—All Setting
11.4.2  PBX Configuration—[3-4] Group—Paging Group—External Pager
12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Option 6— Paging
Deny

使用说明书（PT编程手册）参考

[640]广播群的分机用户群

[641]广播群的外部广播机
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使用说明书（功能手册）参考

6.1  系统资源的容量

使用说明书（用户手册）参考

1.7.1  广播

1.7.2  应答/拒绝广播通知

224 使用说明书（功能手册）

2.17.1 广播



2.17.2  从任意用户电话应答中继线上的呼叫（TAFAS）
说明

当分配给外部广播机的浮动分机号码接到呼叫时，将通过广播机发送振铃音。任何分机用户都可应答该呼叫。

条件

• 硬件要求：用户提供的外部广播机

• 浮动分机号码

必须为外部广播机分配浮动分机号码（默认：600或6000*1）。通过拨浮动分机号码可以接入外部广播机。

• 广播机音量

通过系统编程可以改变外部广播机的音量。
*1 默认浮动分机号码取决于简易设置中Numbering Plan指定的值。请参阅使用说明书（安装手册）中的"5.4.1  简易设置

指示"。

使用说明书（安装手册）参考

4.10  连接外围设备

5.4.1  简易设置指示

使用说明书（PC编程手册）参考

10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features— TAFAS Answer
10.11.1  PBX Configuration—[2-11-1] System—Audio Gain—Paging/MOH— Paging—EPG 1-6 (External
Pager 1-6)
13.2  PBX Configuration—[5-2] Optional Device—External Pager

使用说明书（PT编程手册）参考

[700]外部广播机浮动分机号码

使用说明书（功能手册）参考

5.5.8  浮动分机

使用说明书（用户手册）参考

1.3.4  通过一个外部扬声器应答呼叫（从任意用户电话应答中继线上的呼叫[TAFAS]）
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2.18  外部设备功能

2.18.1  门电话呼叫

说明

可以将门电话直接连接到集团电话。当来访者按门电话上的呼叫鍵时，门电话会呼叫预编程设定的目的地（分

机或外线用户）。此外，分机用户可以拨打门电话的预定号码呼叫该门电话。

条件

• 硬件要求：

任选门电话和DPH2卡
• 每个门电话端口只能被分配给一个租户。租户的时间表（白天/午餐/休息/夜间）适用。（® 5.1.4  定时服

务）

• 呼叫目的地

对于每个门电话端口，可以为每种时间方式（白天/午餐/休息/夜间）指定门电话来电呼叫目的地。可以选

择目的地。（® 2.1.2.1  内部通话功能—概要）

• COS编程决定了能够拨打中继线呼叫去电的门电话端口。

• 内部通话阻止决定了哪些分机可以呼叫门电话。（® 2.1.2.2  内部通话阻止）

• 振铃时间

如果来电在预编程设定的时间内没有被应答，振铃将停止，呼叫被取消。

• 通话时间

通话时间可以受系统定时器的限制。如果定时器到期，电话将被切断。

• 开门

进行门电话呼叫时，分机用户可以给门开锁让来访者进来。（® 2.18.2  开门）

• 门电话号码可供各门电话端口参考。

使用说明书（安装手册）参考

4.7.1  DPH2卡（KX-NS5162）
4.9  连接至门电话、开门器和/或外部传感器

使用说明书（PC编程手册）参考

10.3  PBX Configuration—[2-3] System—Timers & Counters—DISA / Door / Reminder / U. Conf
→ Doorphone—Call Ring Duration (x10s)
→ Doorphone—Call Duration (x10s)

10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features— DOORPHONE Call
10.7.1  PBX Configuration—[2-7-1] System—Class of Service—COS Settings—TRS— TRS Level—Day,
Lunch, Break, Night
10.8.2  PBX Configuration—[2-8-2] System—Ring Tone Patterns—Call from DOORPHONE
10.9  PBX Configuration—[2-9] System—System Options—Option 3— Confirmation Tone—Tone 1 : Called
by Voice
13.1  PBX Configuration—[5-1] Optional Device—Doorphone
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使用说明书（PT编程手册）参考

[720]门电话呼叫目的地

[729]门电话号码参考

使用说明书（用户手册）参考

1.11.1  如果连接一个门电话/开门器

使用说明书（功能手册） 227

2.18.1 门电话呼叫



2.18.2  开门

说明

分机用户可以使用其自己的电话为来访者打开门锁。

通过COS编程设定的能够打开门锁的分机用户可以开锁。但是，在进行门电话呼叫时，任何分机用户都能打开

门锁让来访者进来（® 2.18.1  门电话呼叫）。

条件

• 硬件要求：

用户为每个门提供的开门器和DPH2卡
• 即使没有安装门电话，开门器也能打开门锁。

• 开门时间

门可以在预编程设定的时间内保持打开。

如果开门器的类型为门关闭时自动锁定，则建议将开门时间设为2秒。

使用说明书（安装手册）参考

4.7.1  DPH2卡（KX-NS5162）
4.9  连接至门电话、开门器和/或外部传感器

使用说明书（PC编程手册）参考

9.34  PBX Configuration—[1-1] Configuration—Slot—Card Property—DOORPHONE Card— For Output -
Device Type
10.3  PBX Configuration—[2-3] System—Timers & Counters—DISA / Door / Reminder / U. Conf—
Doorphone—Open Duration (s)
10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features— Door Open
10.7.1  PBX Configuration—[2-7-1] System—Class of Service—COS Settings—Optional Device & Other
Extensions— Door Unlock

使用说明书（PT编程手册）参考

[207]门解锁时间

[512]允许开门接入

使用说明书（功能手册）参考

5.1.1  服务等级（COS）

使用说明书（用户手册）参考

1.11.1  如果连接一个门电话/开门器
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2.18.3  外部传感器

说明

外部传感设备，如安全警报或烟雾探测器等，可以连接到集团电话。当集团电话收到来自传感器的输入时，将

呼叫预定的目的地，提醒分机用户。

传感器呼叫的可用目的地如下：

[可用目的地]

目的地 可用性

有线分机（PT/SLT/ISDN分机） ü

SIP分机 ü

来电呼叫分配群  

UM群  

语音信箱群（DTMF/DPT）

外部广播机（TAFAS）  

DISA  

模拟/ISDN远程维护

空闲线路接入号码 + 电话号码  

中继线群接入号码 + 中继线群号码 + 电话号码  

其它集团电话分机（无集团电话代码的TIE）  

其它集团电话分机（带集团电话代码的TIE）  

应答该呼叫后，如果启用了特殊拨号音，会持续听到拨号音3，直到用户挂机。如果在指定时间内没有应答传

感器呼叫，该呼叫将取消。可以为来自每个外部传感器的呼叫设定不同的振铃音类型，以便区分。

当外部传感器检测到警报时，还可以向指定的电子邮件地址发送电子邮件。

更多详情，请参阅5.4.3  传感器警报的电子邮件通知。

条件

• 硬件要求：

外部传感器和DPH2卡
• 某些设备可能无法与集团电话正确通信。安装设备前，请先向该设备制造商确认兼容性。

• 启动传感器后，在定时器确定的时间内，集团电话将忽略来自同一传感器的其它警告。可以分别为每个传

感器设定定时器。

• 只要前一个传感器呼叫仍在进行，来自同一传感器的其它警告就会被忽略。

• 接到传感器呼叫时，PT显示器上会显示所指定的传感器名称和/或号码。

• 如果传感器呼叫的目的地已经设定FWD，该传感器呼叫将被转接到FWD目的地。但是，如果不支持FWD
目的地作为传感器呼叫的目的地（例如：外线用户），将会在原目的地接收该呼叫。（® 2.3.2  呼叫转送

（FWD））

• 接到传感器呼叫时，无法使用以下功能：

– 交替接收—话音（® 2.5.3  内线电话）
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– 免提应答（® 2.4.4  免提应答）

– 协商保留/呼叫保留（® 2.13.1  呼叫保留）

– 呼叫转移（® 2.12.1  呼叫转移）

– 主管遇忙优先插入（® 2.10.2  主管遇忙优先插入）

• 传感器呼叫信息输出在SMDR上。

使用说明书（安装手册）参考

4.7.1  DPH2卡（KX-NS5162）
4.9  连接至门电话、开门器和/或外部传感器

使用说明书（PC编程手册）参考

9.34  PBX Configuration—[1-1] Configuration—Slot—Card Property—DOORPHONE Card
→ For Sensor - Input Signal Decision Time
→ For Sensor - Input Signal Detection Reopening Time

10.3  PBX Configuration—[2-3] System—Timers & Counters—Miscellaneous— External Sensor—Ring
Duration (s)
10.8.3  PBX Configuration—[2-8-3] System—Ring Tone Patterns—Call from Others— External
Sensor—Ring Tone Pattern Plan 1–8
13.5  PBX Configuration—[5-5] Optional Device—External Sensor

使用说明书（功能手册）参考

5.4.3  传感器警报的电子邮件通知
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2.18.4  外部继电器控制

说明

通过打开和关闭外部设备继电器，集团电话可以控制外部设备，如警报等。

当分机用户输入外部继电器控制功能号码，指定的继电器将打开并持续预编程设定的时间长度。当该定时器到

期，继电器将自动关闭。这样，集团电话可以轻松控制其它设备，允许分机用户从自己的分机启动警报等。

如果无法接入继电器（例如：由于COS不允许使用，或端口不在服务中），分机处会听到挂机重拨音。

条件

• 硬件要求：

外部继电器设备和DPH2卡
• 连接继电器的DPH2卡端口必须通过系统编程指定为继电器端口（而不是开门器端口）。

• 某些设备可能无法与集团电话正确通信。安装设备前，请先向该设备制造商确认兼容性。

• 每个外部继电器端口都分配有一个COS。这与分机的COS一起决定了可以使用外部继电器控制的分机用

户。

• 通过系统编程，可以分别设定每个继电器打开的时间长度。

• 如果同一分机或另一部分机试图接入已经打开的外部继电器，该继电器的定时器将复位。

使用说明书（安装手册）参考

4.7.1  DPH2卡（KX-NS5162）
4.9  连接至门电话、开门器和/或外部传感器

使用说明书（PC编程手册）参考

9.34  PBX Configuration—[1-1] Configuration—Slot—Card Property—DOORPHONE Card— For Output -
Device Type
10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features— External Relay Access
10.7.1  PBX Configuration—[2-7-1] System—Class of Service—COS Settings—Optional Device & Other
Extensions— External Relay Access
13.4  PBX Configuration—[5-4] Optional Device—External Relay

使用说明书（功能手册）参考

5.1.1  服务等级（COS）

使用说明书（用户手册）参考

1.11.2  如果连接了外部继电器
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2.19  来电显示功能

2.19.1  来电显示

说明

集团电话通过中继线接收来电信息，如主叫方名称和电话号码等。这些信息会在支持FSK-型来电显示的PT或
SLT的显示器上显示。

集团电话可以根据预编程表格修改接收到的号码，以方便分机用户使用接收到的号码回叫来电者。例如：如果

呼叫某地区的外线目的地不需要地区代码，但从该地区收到的来电显示号码包含地区代码，则可以将该地区代

码存储在修改表中，以便将其从收到的号码中自动删除（自动修改来电显示号码）。

1. 功能

来电显示包括以下功能：

功能 说明与参考

来电显示 从模拟中继线发送的来电信息。

支持以下类型的来电显示信令：FSK和DTMF。

呼叫线路识别显示（CLIP） 从ISDN线路发送的来电信息。

® 4.1.2.2  呼叫/连接线路识别显示（CLIP/COLP）

号码自动识别（ANI） 从E1线路发送的来电信息。

®2.29.1  E1线路业务

2. 服务功能

功能 说明与参考

呼叫线路识别（CLI）分配 如果已将DIL/DID/DDI/MSN呼叫的来电识别（来电显示/CLIP/ANI）
分配到来电显示表，则将呼叫接到CLI目的地。

® 2.1.1.5  呼叫线路识别（CLI）分配

来电记录 来电信息被自动记录在被叫分机的呼叫记录上。此信息用于证实来

电、回叫来电和/或在个人速拨中存储号码和姓名。

® 2.19.2  来电记录

3. 号码/姓名分配

自动修改来电显示号码

本集团电话按照预编程表格自动修改来电号码。修改过的号码将被记录下来以便回叫。

本集团电话支持4个修改表，每个修改表均可用于任何数量的中继线群。每个表都有10个供市话/国际电话

用的位置，以及一个供长途电话用的位置。集团电话首先检查市话/国际电话数据。如果找不到相匹配的数

据，就应用长途电话数据。
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通过数位长度修改表或CLIP修改表修改来电号码后，集团电话会对照分配至中继线群的来电显示修改表中

编程的区域代码检查所修改号码的前几位数。有关详情，请参阅使用说明书（PC编程手册）中的11.1.3  PBX
Configuration—[3-1-3] Group—Trunk Group—Caller ID Modification—Leading Digits。

[示例]

012
Local/International 

Call Data 1

Local/International 

Call Data 2

          :

Local/International 

Call Data 10

Long Distance Call 

Data 

Area Code Removed No. of Digits Added No.

Trunk 

Group No.

1

2

:

Modification 

Table

1

3

:

Modification Table 1

00

:

3

2

0

:

001

:

0

< >

< >

注

当通过一条ISDN线路发送来电信息并且呼叫类型是用户、国内或国际时，使用下面的修改表而不是上

表：

Subscriber Call Data

National Call Data

International Call Data

Removed No. of Digits Added No.

< >

0

0

0

0

00

使用说明书（功能手册） 233

2.19.1 来电显示



<修改流程图>

No

 3344556677

Yes

 00987654321

001987654321

03344556677

( 0 0)

 ( 2)

1

2

001

00987654321

00987654321 = 001987654321

1) 2) "001"

来电显示表分配

系统速拨表也被用作来电显示表。

在表的每个位置上都能分配以下项目：

a. 电话号码（中继线接入号码 + 来电者的电话号码）

b. 系统速拨名称（来电者名称）

（在显示器上或SMDR上显示）

c. CLI目的地

（用于CLI功能）

当修改后的来电者电话号码与表上的电话号码（不考虑中继线接入号码。）相匹配时，呼叫就被发送到指定

的CLI目的地。

[示例]

位置（系统速拨号码） 电话号码*1 系统速拨名称*2 CLI目的地*3

000 90123456789 ABC公司 200

001 : : :
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位置（系统速拨号码） 电话号码*1 系统速拨名称*2 CLI目的地*3

: : : :

*1 ® 14.1  PBX Configuration—[6-1] Feature—System Speed Dial— CO Line Access Number + Telephone
Number

*2 ® 14.1  PBX Configuration—[6-1] Feature—System Speed Dial— Name
*3 ® 14.1  PBX Configuration—[6-1] Feature—System Speed Dial— CLI Destination

主叫方名称参考

名称也可以在显示器上或SMDR上显示。集团电话按以下顺序搜索名称：

1. 原被叫分机的个人速拨数据

2. 系统速拨（来电显示）表

3. 从公共线路上收到的来电显示名称（来电显示名称参考）

如果找不到名称，则不会显示名称。

条件

[一般]
• 通过系统编程可以选择来电显示信令类型。

• 只有来自公共网络的呼叫才能使用来电显示名称参考。

[来电显示至SLT端口]
• 硬件要求：

MCSLC8卡、MCSLC16卡或DHLC4卡
• 此功能符合ETSI（欧洲电信标准协会）-型FSK和Bellcore-型FSK。
• 对于SLC型卡或DHLC4卡，您可以按如下所示设置"Ringing Start Mode of Extension Caller ID"设置。

– 方式1：允许预振铃。当收到包含来电显示信息的呼叫时，将执行预振铃控制。即使允许预振铃，FSK
信号也是在第一次和第二次振铃之间发送。

– 方式2：停用预振铃（来电显示信息在第一次振铃后发送）。

对此设置的更改会立即生效。

• 当来电号码被发送至SLT时，通过系统编程可以自动把中继线接入号码添加到电话号码上以方便回叫。

• 当来电号码超过16位数时，SLT仅接收前16位数，不计加在前面的中继线接入号码（如果编程设定添加）。

• 如果呼叫被转移到SLT，SLT上将显示转移分机的信息。如果在呼叫被应答前转移分机挂机，将显示原来电

信息。

• 当来电显示有诸如专有、地区以外或长途等信息时，将显示这些信息而不显示来电号码和名称。

• 即使发送了来电名称，根据SLT的类型，名称也可能不显示。

• SLT上不会显示来电记录信息。

• 来电显示会指示出呼叫是内线呼叫还是默认情况下的中继线呼叫。可以通过系统编程禁用该设定。

使用说明书（PC编程手册）参考

10.3  PBX Configuration—[2-3] System—Timers & Counters—Miscellaneous
→ Caller ID—Waiting to receive (s)
→ Caller ID—Visual Caller ID Display (s)

10.9  PBX Configuration—[2-9] System—System Options—Option 4— Private Network—Public Call through
Private Network—Minimum Public Caller ID Digits
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10.10  PBX Configuration—[2-10] System—Extension CID Settings
11.1.1  PBX Configuration—[3-1-1] Group—Trunk Group—TRG Settings—Main— Caller ID Modification
Table
12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Option 8

→ Extension Caller ID Sending
→ Incoming Call Wait Timer for Extension Caller ID

14.1  PBX Configuration—[6-1] Feature—System Speed Dial
11.1.3  PBX Configuration—[3-1-3] Group—Trunk Group—Caller ID Modification

使用说明书（PT编程手册）参考

[001]系统速拨号码

[002]系统速拨名称

[490]来电显示信号类型

使用说明书（功能手册）参考

2.6.4  速拨—个人/系统

2.22.1.1  电话通信详细记录（SMDR）
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2.19.2  来电记录

说明

当带有来电信息（例如：来电显示）的公共中继线来电呼叫被接到一部分机时，该信息被自动记录在被叫分机

的呼叫记录上。另外，根据系统编程，会在来电记录中记录进来的内线电话（包括通过TIE连接）。电话显示器

上显示该信息，用于证实来电、回叫或在个人速拨中存储其号码和名称。

[示例]

John White

DEC.12 10:00AM MON

NEW:Not Answered

123456789

--- 20 1

--- 

--- 2

--- 16

*1

*2 "NEW"

"OLD"

条件

• 呼叫记录键

可以把一个灵活键定制为分机或来电呼叫分配群的呼叫记录键。该键的灯以如下方式显示当前状态：

指示灯类型 状态

红灯亮 有未经检查的信息。

关闭 全部信息都已得到检查。

• 如果应答目的地不是原分机（FWD—无应答、截取路由—无应答、溢出和呼叫接听）：

如果呼叫由于未应答或被其它分机接听而被转送，该资料会记录在原目的地及应答目的地的呼叫记录中。

如果呼叫在得到应答前被转送至几部分机，信息将被记录在所有转送目的地分机的呼叫记录中。如果呼叫

被转送至来电呼叫分配群并且未被应答，信息不会记录在来电呼叫分配群的呼叫记录中。

• 以下类型的呼叫在原目的地的来电记录中会被记录为"未应答"：
– 正在使用分机时接收到的呼叫（来电者听到忙音）。

– 使用截取路由—占线、FWD—全部电话，或FWD—占线功能路由到的呼叫。

如果通过系统编程禁用，这些类型的呼叫不会在来电记录中留下记录。

如果使用呼叫接听应答的呼叫在原目的地的来电记录中被记录为"未应答"或"已应答"，则也可以通过系统编

程进行指定。

• 显示锁定

通过个人编程（显示锁定），分机用户可以锁定来电记录显示，防止任何分机看到呼叫信息。这种情况下，

去电呼叫记录显示和个人速拨号码显示也会被锁定。使用此功能需要分机个人识别号码（PIN）。（®
2.24.1  分机个人识别号码（PIN））
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• 在个人速拨中存储呼叫记录信息

当将来自呼叫记录信息的号码和名称存储到个人速拨中时，空闲线路接入号码或TIE线路接入号码被自动附

加到电话号码上。

• 从分机储存呼叫记录信息

根据系统编程，可以在个人速拨中储存来电记录中记录的分机（包括通过TIE连接）相关信息。

• 来电记录存储器

集团电话决定了来电记录的总存储器空间。也可以通过系统编程确定每部分机和每个来电呼叫分配群所能

记录的最大数目。如果存储器已满，新的呼叫记录将覆盖最旧的记录。

• 来电呼叫分配群呼叫的呼叫记录

如果呼叫的原目的地是来电呼叫分配群，并且该呼叫未被应答，信息将被记录在该群的呼叫记录中。如果

呼叫被应答，信息将被记录在应答分机的呼叫记录中。

• 通过系统编程，可以选择当呼叫到来电呼叫分配群时哪些来电记录来记录呼叫信息被该群成员应答：

– 仅限应答呼叫的分机的来电记录。

– 应答呼叫的分机和来电分配群的来电记录。

• 通过系统编程，可以选择当呼叫到来电呼叫分配群时哪些来电记录来记录呼叫信息被该群的溢出目的地应

答：

– 只有溢出目的地的来电记录。

– 溢出目的地和来电呼叫分配群的来电记录。

• 未接电话的电子邮件通知

分机用户可在错过中继线呼叫时收到电子邮件通知。

→ Contact—8.2  Users—Add User中的Email 1–3
→ 8.2  Users—Add User中的Email notification

• 当启用Incoming Call Log—Extension / TIE Call设定时，会在应答呼叫的分机的来电记录中记录的来电

信息（例如：分机号码）。

使用说明书（PC编程手册）参考

10.9  PBX Configuration—[2-9] System—System Options
→Option 7— Incoming Call Log—Extension / TIE Call
→Option 7— Outgoing Call Log—Extension Call

11.5.1  PBX Configuration—[3-5-1] Group—Incoming Call Distribution Group—Group
Settings—Miscellaneous— Supervisor Extension Number
11.5.3  PBX Configuration—[3-5-3] Group—Incoming Call Distribution Group—Miscellaneous—
Options—Call Log to ICD Group when ICD Member Answered
12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings

→Option 5— Incoming Call Display
→Option 6— Display Lock/SVM Lock
→Option 7— Incoming Call Log Memory

12.1.4  PBX Configuration—[4-1-4] Extension—Wired Extension—Flexible Button— Type

使用说明书（功能手册）参考

2.6.4  速拨—个人/系统

2.21.2  灵活键

5.4.1  分机用户的电子邮件通知

6.1  系统资源的容量
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使用说明书（用户手册）参考

1.14.1  使用呼叫记录

3.1.2  编程方式设定

使用说明书（功能手册） 239

2.19.2 来电记录



2.20  留言功能

2.20.1  留言待取

说明

分机用户可以通知另一部分机用户他想与之通话。受通知的分机用户可以返回呼叫或听取统一消息系统、语音

处理系统（VPS）或内装简化语音留言功能录制的留言。

如果PT上有留言，留言键会亮起或留言/振铃灯呈红色亮起，并且显示PT的显示器上会显示消息。挂机时按亮

起的留言键将显示如下来电信息：

[示例]

105:Tom Smith --- 

*

*

条件

• 留言键

可以把一个灵活键定制为分机、其它分机或来电呼叫分配群的留言键。

• 留言待取的特殊拨号音

如果允许特殊拨号方式，当分机上有留言时，将给分机发送拨号音4。（® 2.25.1  拨号音）

• 可以在听到回铃音、忙音或DND音时设定留言待取。

• 留言始终是留在原目的地分机上，不管该分机的FWD设定如何。

• 发送和接收留言待取通知的分机均可以取消留言。

• 如果接收通知的分机回叫发送通知的分机，并且该呼叫得到应答，则通知会被自动清除。但是，如果已在

信箱中留有语音留言，通知是否清除将取决于统一消息设定或VPS设定。

• 带留言待取灯的SLT
该灯与PT上的留言键的启动方式相同。可从12种类型中选择一种留言待取灯点亮类型。有关详情，请参阅

分机所连接集团电话的说明书。

• 仅标准型或主动型一般SIP分机可以控制留言待取指示灯。有关详情，请参阅9.16  PBX
Configuration—[1-1] Configuration—Slot—Port Property—V-SIPEXT— MWI Method。

使用说明书（PC编程手册）参考

9.16  PBX Configuration—[1-1] Configuration—Slot—Port Property—V-SIPEXT

240 使用说明书（功能手册）

2.20.1 留言待取



10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features— Message Waiting Set /
Cancel / Call Back
10.6.3  PBX Configuration—[2-6-3] System—Numbering Plan—B/NA DND Call Feature— Message Waiting
Set
10.9  PBX Configuration—[2-9] System—System Options—Option 3— Dial Tone—Distinctive Dial Tone
10.9  PBX Configuration—[2-9] System—System Options—Option 5— SLT—Message Waiting Lamp Pattern
12.1.4  PBX Configuration—[4-1-4] Extension—Wired Extension—Flexible Button— Type

使用说明书（功能手册）参考

2.21.2  灵活键

3.2  系统和用户功能

6.1  系统资源的容量

使用说明书（用户手册）参考

1.2.4  当被拨线路占线或没有应答时

1.8  使用统一消息功能
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2.20.2  缺席留言

说明

分机用户可以设定或选择显示在自己的电话上的留言（例如：缺席理由）。当显示PT用户呼叫该分机时，该留

言就会显示在来电者的电话上。可以根据需要编程设定以下留言：

类型 留言号码 留言（实例） 说明

系统留言 1 Will Return Soon 可以通过系统编程来编辑留言。

这些留言普遍用于每个分机用户。2 Gone Home

3 At Ext %%%%（分机号码）

4 Back at %%:%%（小时：分钟）

5 Out until %%/%%（月/日）

6 In a Meeting

7  

8  

个人留言 9  通过个人编程可以在每部分机上

编程设定留言（个人缺席留言），

此留言只适用于该分机用户。

注

"%"指在个别分机上指定一条留言时所要输入的参数。

每条留言最多可存储7个"%"。

条件

• 分机用户一次只能选择一条留言。挂机时分机上会显示所选留言。

• 有统一消息信箱的分机用户还可以按照语音向导远程设定缺席留言（® 3.2.2.25  远程缺席留言）。

使用说明书（PC编程手册）参考

10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features— Absent Message Set /
Cancel
12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Option 3— Absent
Message
14.5  PBX Configuration—[6-5] Feature—Absent Message

使用说明书（PT编程手册）参考

[008]缺席留言
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使用说明书（功能手册）参考

6.1  系统资源的容量

使用说明书（用户手册）参考

1.6.2  在主叫方的电话显示器上显示留言（缺席留言）

3.1.2  编程方式设定
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2.21  集团电话专用话机 （PT）硬件功能

2.21.1  固定键

说明

PT、DSS话务台和附加键模块具有以下功能/线路接入键：

根据设备类型不同，某些键可能没有提供。

[PT和附加键模块]

键 用途

导航键、微旋拨号盘、

音量键

用于调整振铃器、扬声器、话筒和头戴式耳机的音量和

显示对比度。导航键和微旋拨号盘还能用于从电话号码

簿和显示器上的系统功能接入菜单中选择数据。

VOL

ENTER（输入） 用于确认选择的项目。

取消 用于取消选择的项目。

编程 用于进入和退出编程方式。

闪断

用于断开当前呼叫并在不挂机的情况下打另一个电话（闪

断/重呼方式或终止方式），或用于给电话公司或集团电

话主机发送闪断/重呼信号，以便接入其功能（外部功能

接入方式）。当挂机时，该键也可用作取消键。

保留 用于进行呼叫保留。

免提（免提扬声器）
用于免提操作。也用于在话筒和免提操作之间切换。
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键 用途

监听 用于免提拨号。也用于在免提方式下监听通话。

留言
用于留下留言待取指示，或回叫留下留言待取指示的一

方。

重拨 用于重拨最后拨打的号码。

转移 用于将呼叫转移至另一方。

灵活CO（中继线）
用于拨打或接收中继线呼叫，或可以被重新指定为不同

的中继线接入键（默认：S-CO）或另一功能键。

内线 用于拨打或接听内线电话。

自动应答/静音
用于以免提方式接听来电，或在通话过程中使麦克风或

话筒静音。（双重功能键）

语音呼叫/静音
用于自动监听内线电话（不能进行免提通话）。也用于通

话过程中使话筒麦克风静音。

自动拨号/存储 用于系统/个人速拨或存储程序中的变更。

会议 用于建立多方通话。

呼叫转送/免打扰 用于执行FWD或DND。（双重功能键）

暂停 用于在存储的号码中插入暂停。对于APT，用作编程键。

软键 用于选择显示器底部显示的项目。

SELECT（选择） 用于选择显示的项目或呼叫显示的电话号码。

SHIFT（转换） 用于接入第二级软键项目。

MODE（方式） 用于转换显示，以使用各种功能。

下一页 用于切换自行标签功能的页面（仅KX-NT366）。

[DSS话务台]

键 用途

ANSWER（应答） 用于应答来电或保留当前呼叫并用单键应答另一个呼叫。

RELEASE（释放） 用于在通话过程中或之后断开线路，或完成呼叫转移。

灵活CO（中继线）
用于拨打或接收中继线呼叫，或可以被重新指定为不同

的中继线键或另一功能键。

灵活DSS（直接分机选择）
用于通过单键接入一部分机。为了与分机一致，应给每

个键编程。DSS键也可以被重新指定为其他功能键。
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键 用途

PF（可编程功能） 用于通过单键接入预编程设定的功能。（未默认）

条件

• 某些键配有显示线路或功能状态的指示灯。
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2.21.2  灵活键

说明

您可以通过系统或个人编程在PT和附加键模块上订制灵活键和/或可编程功能（PF）键。然后这些键可用来拨

打或接收内线或中继线呼叫，或者用作功能键，如下所示：

[键用途]

键 用途

单-CO（S-CO） 用于接入特定的中继线以便拨打或接听电话。

群-CO（G-CO） 用于接入指定中继线群中的空闲中继线以便拨打电话。来自指定中继

线群中的中继线的来电到达此键。

环路-CO（L-CO） 用于接入空闲中继线以便拨打电话。来自任何中继线的来电都到达此

键。

直接分机选择（DSS） 用于通过单键接入一部分机。

网络直接分机选择（NDSS） 用于接入同一网络中的另一部集团电话的分机。

单键拨号 用于通过单键接入编程设定的通话方或功能。

来电呼叫分配（ICD）群 用于接入特定的来电呼叫分配群，以拨打或接听电话。

留言 用于留下留言待取指示，或回叫留下留言待取指示的一方。

FWD/DND（外线/内线/两者）*1 用于执行分机的FWD或DND功能。此功能适用于中继线呼叫、内线

电话或以上两者。

群FWD（外线/内线/两者） 用于执行指定来电呼叫分配群的FWD功能。此功能适用于中继线呼

叫、内线电话或以上两者。

计费代码输入（计费） 用于输入计费代码。

会议 用于建立多方通话。

终止 用于在不挂机情况下，断开当前电话，拨打另一个电话。

外部功能接入（EFA） 用于将闪断/重呼信号发送到电话公司或集团电话主机以便接入其功

能。

话费参考 用于检查本人分机的总话费。

呼叫寄存 用于将呼叫寄存在预定的集团电话寄存区中或从中恢复呼叫。

呼叫寄存（自动寄存区） 用于将呼叫自动寄存在空闲的集团电话寄存区中。

呼叫记录 用于显示来电信息。

注册/注销*1 用于在注册和注销方式之间切换。

快速 用于将来电呼叫分配群队列中等待时间最长的呼叫转接至溢出目的

地。

收转*1 用于切换收转/未准备及准备方式。

系统警报 用于确认集团电话错误。
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键 用途

定时服务*1 用于切换分配的时间方式：白天、午餐、休息或夜间。也用于检查当

前的时间方式状态。

应答 用于应答来电。

释放 用于在通话过程中或之后断开线路，或完成呼叫转移。

长途限制/呼叫限制 用于暂时改变其他分机用户的TRS/限制级。

ISDN服务 用于接入ISDN服务。

呼叫线路识别限制（CLIR）*1 用于切换CLIP和CLIR服务。

连接线路识别限制（COLR）*1 用于切换COLP和COLR服务。

ISDN保留 用于通过电话公司转移呼叫。

头戴式耳机 用于打开/关闭空闲时的头戴式耳机方式。

用于在通话过程中切换免提方式和头戴式耳机方式。

定时服务转换方式（自动/人工）*1 用于在自动切换和人工切换方式之间切换。

双向录音 用于将通话记录到本人信箱中。

双向转移 用于将通话记录到特定分机的信箱中。

单键双向转移 用于通过单键将通话记录到特定分机的信箱中。

现场呼叫屏蔽（LCS） 当来电主叫方留言时，用于监听您自己的语音信箱，如果需要，可以

截取电话。

语音信箱（VM）转移 用于将来电转移到指定分机的信箱中。也用于接入统一消息系统

（® 3.2  系统和用户功能）或VPS的语音信箱功能（® 2.28.3  语音

信箱DPT（数字）集成）。

登记 用于将分机的状态从结帐切换为登记。

结帐 用于将分机的状态从登记切换为结帐。

整理 用于在准备及未准备间切换分机的房间状态。

CTI 用于接入CTI功能。

主要号码簿号码（PDN） 用于接打外线和内线电话。

(® 2.9.1  主要号码簿号码（PDN）/次要号码簿号码（SDN）分机)

次要号码簿号码（SDN） 用于显示其它分机的当前状态、呼叫该分机、接听呼叫或将呼叫转移

到该分机。

(® 2.9.1  主要号码簿号码（PDN）/次要号码簿号码（SDN）分机)

*1 单键功能设定键：挂机时按这些键可更改功能设定。新方式将显示预编程设定的时间。
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自行标签（仅KX-NT366）
KX-NT366IP-PT在其灵活键旁有一个LCD屏幕。通过个人/系统编程可以设定各键的标签以反映键的功能。另

外，可将灵活键分为多个"页"。按下一页键可以在页间切换，如下所示：

Bank 

Home

Sales

LCS

PDN

CO 6 

CO 5

CO 4

CO 3

CO 2

注

下一页键的外观会因电话型号而不同。

条件

[自行标签]
• 通过个人/系统编程最多可以将12个字符分配到每个灵活键的LCD。

® 12.1.4  PBX Configuration—[4-1-4] Extension—Wired Extension—Flexible Button— Label Name
• 应答了中继线呼叫来电或取得了一条中继线时，相应的CO键会变绿，而且LCD显示屏会切换到相应CO键

所注册的页。

• 当使用此功能时不推荐分配系统警报键，因为如果系统警报键不在可见页面上时发生警报，则警报不会被

通知。

使用说明书（PC编程手册）参考

10.3  PBX Configuration—[2-3] System—Timers & Counters—Miscellaneous— PT Display—PT Last Display
Duration in Idle Mode (s)
12.1.4  PBX Configuration—[4-1-4] Extension—Wired Extension—Flexible Button
12.1.4.1  PBX Configuration—[4-1-4] Extension—Wired Extension—Flexible Button—Flexible button data copy
12.1.5  PBX Configuration—[4-1-5] Extension—Wired Extension—PF Button

使用说明书（用户手册）参考

1.14.4  自行标签（仅KX-NT366）
3.1.3  订制按键
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2.21.3  发光二极管提示

说明

留言/振铃灯的LED（发光二极管）以及下列键（线路状态键和相应分机状态键）以各种指示灯类型显示线路状

态。

线路状态键：S-CO、G-CO、L-CO、内线、ICD群、PDN
相应分机状态键：DSS、SDN
1. 留言/振铃灯的指示灯类型

[IP-PT和DPT]
• 中继线来电：红灯闪烁

• 来自另一部分机的来电：绿灯闪烁

• 有留言（无来电）：红灯亮

• 无留言（无来电）：关闭

[APT]
• 来电：红灯闪烁

• 有留言（无来电）：红灯亮

• 无留言（无来电）：关闭

2. 线路状态键的指示灯类型

指示灯类型

线路状态键

中继线状态 内线线路状态
来电呼叫分配

群线路状态

S-CO G-CO L-CO 内线 ICD群

关闭 空闲

绿灯亮 本分机正使用该线路。

绿灯慢闪 本分机正保留该线路。

绿灯中速闪烁 本分机正使用专用保留保留该线路或将该线路用于无人值守会议。

绿灯快速闪烁 来电/保密释放 来电

红灯亮 另一部分机有

来电/另一部分

机正在使用该

线路/另一部分

机将该线路置

于专用保留。

其它分机正在

使用中继线群

中的全部中继

线。

— 该分机已从来

电呼叫分配群

中注销。

红灯慢闪 另一部分机正

保留该线路。

—

红灯快闪 来电以振铃分配方法到达来电呼叫分配群 —

有关PDN和SDN键的指示灯类型，请参考2.9.1  主要号码簿号码（PDN）/次要号码簿号码（SDN）分机。

3. 相应分机状态键的指示灯类型
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指示灯类型 相应分机状态键（DSS）

关闭 空闲

红灯亮 占线/来电*1/中继线呼叫免打扰

红灯快闪 来电*2

*1 仅当用DSS键的呼叫接听功能停用时。
*2 仅当用DSS键的呼叫接听功能启用时。

4. 闪光指示灯类型

1

条件

• 来电按以下优先权在各键上显示：

ICD群®S-CO®G-CO®L-CO®PDN®内线

• 可以通过系统编程把用于来电呼叫的DSS键的指示灯类型设定为"关闭"。这样，DSS键指示灯将不指示相

应分机的状态。

使用说明书（PC编程手册）参考

10.9  PBX Configuration—[2-9] System—System Options
→Option 1— PT Fwd / DND—Fwd LED
→Option 1— PT Fwd / DND—DND LED
→Option 4— DSS Key—DSS key mode for Incoming Call

使用说明书（功能手册）参考

2.2.2.2  群呼叫分配

2.2.2.8  注册/注销

2.3  呼叫转送（FWD）/免打扰（DND）功能

2.13.1  呼叫保留

2.14.2  会议

2.14.3  保密释放
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2.21.4  显示信息

说明

在打电话或接电话时，显示PT向用户显示以下信息（如果可用）：

显示项目 显示示例 条件

主叫或被叫分机、或来电呼叫分配群的分机号

码和名称

123: Tom Smith –

被叫分机的状态 123: Busy –

选配件的号码和名称 D02: 1st Door –

所拨电话号码 1234567890 –

接收到的呼叫信息

a. 主叫方名称

b. 主叫方号码

c. 中继线号码/名称

d. 原目的地，如果呼叫是被转送而来的

e. DDI/DID/MSN名称

ABC Company
12345678
Line 001: Sales
®102:Mike
Panasonic

通过系统编程，每部分机

上的第一行消息可以是

（a）、（c）或（e）。
呼叫期间，按转移键或

DISP软键可以轮流显示这

些内容。

中继线呼叫过程中的电话费。 12.35€ 货币、货币符号的位置以

及小数点是可以编程设定

的。

中继线呼叫过程中的通话时间。 Line 001 11:02'28 –

条件

• 多语言显示

每部分机都能通过个人编程选择其显示语言（显示语言选择）。

• 显示对比度

通过个人编程可以调整显示对比度（显示对比度选择）。

此功能只适用于DPT和IP-PT。
• 显示背光

通过个人编程，某些分机可以选择其显示背光是打开还是关闭（显示背光选择）。有关详情，请参阅电话手

册。

• 超过显示器尺寸限制的字符（名称）或数字（号码）不会被显示。这种情况下，已被编程的信息处于隐藏

状态，但不会被改动。

使用说明书（PC编程手册）参考

10.9  PBX Configuration—[2-9] System—System Options—Option 5— PT Feature Access—No. 1–8
12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings

→Option 5— Display Language
→Option 5— Incoming Call Display
→Option 5— Automatic LCD Switch when Start Talking

14.2  PBX Configuration—[6-2] Feature—Hotel & Charge—Charge
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→ Charge Options—Digits After Decimal Point
→ Charge Options—Currency
→ Charge Options—Currency Display Position

18.1  PBX Configuration—[10-1] CO & Incoming Call—CO Line Settings— CO Name

使用说明书（PT编程手册）参考

[130]货币的小数点位置

[131]货币

使用说明书（用户手册）参考

3.1.2  编程方式设定
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2.22  管理信息功能

2.22.1  记录日志功能

2.22.1.1  电话通信详细记录（SMDR）

说明

自动记录每部分机上的详细信息。

1. SMDR输出端口

通过系统编程可以选择以下输出方法：

® 19.1  PBX Configuration—[11-1] Maintenance—Main—SMDR— SMDR Format—Port

输出方法 说明

Telnet兼容的终端仿真程序 SMDR信息通过LAN发送到Telnet兼容的终端仿真程序。

2. SMDR输出数据

将记录以下数据并将数据发送到SMDR输出端口：

a. 中继线呼叫信息（来电/去电）

b. 内线电话信息（去电）

c. 注册/注销信息

d. 集团电话错误记录（® 5.6.4  本机告警信息）

e. 友好功能信息（® 2.23.1  友好功能—概要）

f. 打印留言信息（® 2.22.2  打印留言）

SMDR的存储器：集团电话中可以存储指定数目的呼叫记录。如果打出或接到更多的电话，最旧的记录就

被最新的记录覆盖。

3. SMDR格式类型和内容

通过系统编程可以选择以下三种类型的输出格式：
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类型A：无话费信息情况下的80位数

(1) (2) (3) (4) (5) (6) (7) (8) (9)

Duration

(8)

00:00'00

00:01'05

00:01'05

00:01'05

00:01'05

00:01'05

00:01'05

00:01'05

00:12'05

Ring

(4)

5'15

0'05

0'05

0'05

Time

(7)

10:03AM

10:07AM

10:15AM

10:30AM

01:07PM

01:07PM

01:07PM

01:07PM

01:07PM

08:33AM

01:07PM

03:35PM

03:45PM

03:50PM

03:55PM

04:00PM

04:01PM

04:01PM

04:05PM

Date

(8 digits)

01/02/02

01/02/02

01/02/02

01/02/02

01/02/02

01/02/02

01/02/02

01/02/02

01/02/02

01/02/02

01/02/02

01/02/02

01/02/02

01/02/02

01/02/02

01/02/02

01/02/02

01/02/02

01/02/02 

Dial Number

(25)

<I>12345678901234567890

<I>

1234567890123456

1234567890123456

<I>ABC COMPANY12345678

<D>CDE9876<I>Q COMPANY

ABC COMPANY12345678

123..............

123456XX

In the office

LOG IN 

LOG OUT

EXT1235

Check in

Check out

Timed Reminder/Start

Timed Reminder/No Answer

Timed Reminder/Answer

<I>S003

ACC Code

(10)

9876543210

9876543210

9876543210

9876543210

9876543210

98765

CD

(3)

NA

TR

RC

CO

(2)

01

01

01

01

01

01

01

01

01

  Ext

  (5)

1200

1200

1200

*123

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

1234

类型B：有话费信息情况下的80位数

(1) (2) (3) (4) (5) (7) (8) (9)(10)

Cost

(8+2)

00560.00EU

Duration

(8)

00:00'05

Time

(7)

10:03AM

10:07AM

Date

(8 digits)

01/02/02

01/02/02

Dial Number

(20)

<I>

1234567890123456789

ACC Code

(10)

9876543210

CD

(3)

NA

CO

(2)

01

01

   Ext

   (5)

1210

 2005

类型C：120位数

(1) (2) (3) (4) (5) (6) (7) (8) (9)(10)

Cost

(8+3)

00560.00EUR

Duration

(8)

00:00'05

00:00'05

Time

(7)

10:03AM

10:07AM

Date

(8 digits)

01/02/02

01/02/02

Dial Number

(50)

123456789012345678901234567890

<I>ABC COMPANY123456789012345

ACC Code

(10)

9876543210

9876543210

CD

(3)

TR

TR

CO

(4)

0001

0001

Ext

(5)

1230

1230

Ring

(4)

0'05

[解释]
下表说明基于以上类型示例中的号码的SMDR内容。有关可编程项目，请参考下面的[编程项目]。
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类型中的编号 项目 说明

(1) 日期 显示呼叫日期。

(2) 时间 显示呼叫结束时间：小时/分钟/上午或下午。

(3) Ext（分机） 显示通话中使用的分机号码、浮动分机号码等。

还显示以下代码：

Dxxx：来自门电话的中继线呼叫去电（xxx=门电话号码）（®
2.18.1  门电话呼叫）

Txxx：使用TIE线路业务的中继线呼叫去电（xxx=中继线群号码）

*xxx：验证电话（xxx=验证代码）（® 2.7.6  验证码输入）

(4) CO（中继线） 显示用于呼叫的中继线号码。

关于类型A和B，大于100的中继线号码将显示"00"。
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类型中的编号 项目 说明

(5) 拨号号码 [中继线呼叫]
中继线呼叫去电

显示拨过的电话号码。

有效数字如下：

0至9、 、#
P：暂停

F：EFA信号

=：集团电话主机接入代码（® 2.5.4.8  集团电话主机接入代码

（从集团电话主机接入电话公司的接入代码））

.（dot）：保密拨号

X：隐秘拨号

–：被转移的呼叫

如果转移目的地分机输入一些数字，所输入的数字将被添加

在"–"后面。

中继线呼叫来电

显示<I> + 来电识别名称/号码。

还可以显示DDI/DID/MSN呼叫信息。在此情况下，<I>前面添加

<D> + DDI/DID/MSN名称/号码。

[内线电话去电]
显示所拨分机号码，后跟"EXT"。

[注册/注销]
显示注册或注销状态。

[登记/结帐]
显示登记或结帐状态。（® 2.23.2  房间状态控制）

[定时提醒]
显示定时提醒状态："Start（开始）"、"No Answer（无应

答）"或"Answer（应答）"。（® 2.24.4  定时提醒）

[打印留言]
显示所选留言。（® 2.22.2  打印留言）

[传感器呼叫]
按如下方式显示来自外部传感器的呼叫：

<I> S + 传感器号码。（® 2.18.3  外部传感器）

(6) 振铃 以分/秒方式显示应答呼叫前的振铃持续时间。

(7) 持续时间 以小时/分/秒方式显示中继线呼叫的通话时长。

(8) Acc Code（计

费代码）

显示附加在电话上的计费代码。（® 2.5.4.3  计费代码输入）
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类型中的编号 项目 说明

(9) CD（条件代码） 用以下代码显示其它呼叫信息：

CL：受话人付费电话

TR：转移

FW：FWD到中继线

D0：使用DISA或TIE线路业务的电话

RM：远程维护（调制解调器）（® 5.5.2  PC编程）

NA：无应答呼叫

RC：已接电话

AN：已应答呼叫

VR：带有呼叫等待来电显示的已接电话（可视来电显示）

VA：带有呼叫等待来电显示的已应答电话（可视来电显示）

(10) 话费 显示话费。

[可编程项目]

项目 说明

中继线呼叫去电 控制是否显示中继线呼叫去电。此设定对整个集团电话通用。还

需要COS编程。

® 19.1  PBX Configuration—[11-1]
Maintenance—Main—SMDR— Print Information—Outgoing
Call

中继线呼叫来电 控制是否显示中继线呼叫来电。

® 19.1  PBX Configuration—[11-1]
Maintenance—Main—SMDR— Print Information—Incoming
Call

内线电话去电 控制是否对内线电话去电录音。

® 19.1  PBX Configuration—[11-1]
Maintenance—Main—SMDR— Print Information—Intercom
Call

注册/注销状态 控制是否记录登陆/注销状态。

® 19.1  PBX Configuration—[11-1]
Maintenance—Main—SMDR— Print Information—Log-in /
Log-out

ARS拨号 控制是否显示用户所拨号码或修改后的号码。

只有当在该设定中选择修改后的号码时，才能显示集团电话主机

接入代码（"="后跟接入代码）（作为补充信息）。（® 2.8.1  自动

路由选择（ARS））
® 19.1  PBX Configuration—[11-1] Maintenance—Main—SMDR
Options— Option—ARS Dial

258 使用说明书（功能手册）

2.22.1 记录日志功能



项目 说明

来电者识别 控制是否显示来电者的识别号码、名称、号码和姓名，或什么都

不显示。如果选择"none"，将不显示<I>。
® 19.1  PBX Configuration—[11-1] Maintenance—Main—SMDR
Options— Option—Caller ID Number & Name

DID/DDI号码 控制是否显示DID/DDI号码、名称、号码和姓名，或什么都不显

示。如果选择"none"，将不显示<D>。
® 19.1  PBX Configuration—[11-1] Maintenance—Main—SMDR
Options— Option—DDI/DID Number & Name

保密拨号 控制保密拨号。如果允许的话，所拨号码将显示为点。

只有在以上的ARS拨号设定中选择修改后的号码，此设定才有效。

如果在ARS拨号设定中选择用户所拨号码，所拨号码将显示为与

此设定无关的点。

® 19.1  PBX Configuration—[11-1] Maintenance—Main—SMDR
Options— Option—Secret Dial

隐秘拨号 允许或停用隐秘拨号。如果允许，所拨电话号码的最后四位数和

连接后的任何附加数字将显示为"X"。（例如：123-456-XXXX）
® 19.1  PBX Configuration—[11-1] Maintenance—Main—SMDR
Options— Option—Privacy Mode

日期顺序 日期顺序是可以改变的：月/日/年，日/月/年，年/月/日，年/日/月。

® 19.1  PBX Configuration—[11-1]
Maintenance—Main—SMDR— SMDR Format—Date Format

已接电话 控制是否显示中继线呼叫来电的接收时间。

® 19.1  PBX Configuration—[11-1] Maintenance—Main—SMDR
Options— Option—Condition Code "RC"

已应答呼叫 控制是否显示中继线呼叫来电的应答时间。

® 19.1  PBX Configuration—[11-1] Maintenance—Main—SMDR
Options— Option—Condition Code "AN"

房间状态 控制是否显示房间状态更改。

® 14.2  PBX Configuration—[6-2] Feature—Hotel &
Charge—Main— SMDR for External Hotel Application 1—Room
Status Control

定时提醒呼叫 控制是否显示定时提醒呼叫（® 2.24.4  定时提醒）。

® 14.2  PBX Configuration—[6-2] Feature—Hotel &
Charge—Main— SMDR for External Hotel Application
1—Timed Reminder (Wake-up Call)

打印留言 指定可以从分机选择的留言（® 2.22.2  打印留言）。

® 14.2  PBX Configuration—[6-2] Feature—Hotel &
Charge—Main— SMDR for External Hotel Application 2—Print-
ing Message 1–8
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项目 说明

时间格式 控制时间以12小时格式还是24小时格式显示。

® 19.1  PBX Configuration—[11-1]
Maintenance—Main—SMDR— SMDR Format—Time Format
(12H / 24H)

条件

[一般]
• SMDR格式

为了与打印机中使用的纸张尺寸相符合，可以通过系统编程设定以下SMDR格式：

a. 页长：决定每页的行数。

® 19.1  PBX Configuration—[11-1] Maintenance—Main—SMDR— SMDR Format—Page Length
(Number of Lines)

b. 跳越穿孔：决定在每页末尾处跳越的行数。

® 19.1  PBX Configuration—[11-1] Maintenance—Main—SMDR— SMDR Format—Blank Footer
Length (Number of Lines)

页长至少应比跳越穿孔长度长4行。

解释：

• 即使集团电话复位，SMDR数据也不会被删除。

• 如果在通话过程中集团电话复位，该呼叫不会记录在SMDR中。

• 从分机向紧急拨号表（® 2.5.4.2  紧急呼叫）中的号码拨打电话时，可以将集团电话预设为拨号号码后以

及通话结束后立即在SMDR上记录呼叫信息。（一般来说，集团电话仅在呼叫结束后记录呼叫信息。）

® 19.1  PBX Configuration—[11-1] Maintenance—Main—SMDR Options— Emergency Call Notification
• 以下呼叫被视为SMDR中的两个单独的呼叫：

– 在通话过程中人工发送闪断/重呼/EFA信号前后的呼叫。

– 用呼叫转移、FWD或DISA进行的中继线间呼叫（每个都记录为"来电"和"去电"呼叫）。

– PDN或SDN分机的来电呼叫。

• 集团电话在中继线呼叫去电的拨号结束和SMDR定时器开始之间等待预编程设定的时间。当集团电话向电

话公司发送了全部拨号数字而且该定时器到期时，集团电话开始给电话计时。显示PT会显示通话的经过时

间。通话的开始时间和总的通话时间记录在SMDR上。
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® 10.3  PBX Configuration—[2-3] System—Timers & Counters—Dial / IRNA / Recall / Tone—
Dial—Analogue CO Call Duration Start (s)
如果已设定反向信号检测（® 2.5.4.5  反向电路），该集团电话将在检测来自电话公司的反向信号后开始给

通话计时，不管上述定时器如何。

• 如果使用自动转移将呼叫转移到ICD群，SMDR上不会记录条件代码"TR"（® 2.12.1  呼叫转移）。

[集团电话主机接入代码]
• 仅当在SMDR的ARS设定中选择修改后的号码设定时，SMDR上才会记录包括集团电话主机接入代码的所

拨号码。

• 如果为中继线群指定了集团电话主机接入代码，SMDR上就不会记录到达集团电话主机的分机的呼叫。

• 当中继线端口直接连接到电话公司（而不是集团电话主机）时，可以使用集团电话主机接入代码以只将长

途电话记录在SMDR上。当将长途代码（例如："0"）指定为集团电话主机接入代码时，就可以这样做。所

有市话（例如：不需要首先拨"0"的电话）都将被当作电话公司的分机来处理，而不会记录在SMDR上，因

为在这种情况下，本集团电话将电话公司识别为集团电话主机。因此，只有长途电话会记录在SMDR上。

[输出到Telnet兼容的终端仿真程序]
• 要启动与终端仿真程序的连接，必须输入主板的IP地址、端口号码、用户ID（"SMDR"）和密码。

• 如果终端仿真程序用户连续3次错误输入了用户ID或密码，警报将被发送而且10分钟内不能进行连接。

• 通过系统编程，可以分配集团电话端口号码和密码。

• 必须持续运行终端仿真应用程序。如果应用程序被终止，终止之后发生的呼叫记录将被记录在集团电话的

存储器中。但是，如果呼叫记录的数目超过了集团电话的容量，较旧的记录将被删除。另外，应用程序重

新启动或重新连接时，可能会输出重复的呼叫记录。

使用说明书（安装手册）参考

4.10  连接外围设备

使用说明书（PC编程手册）参考

10.3  PBX Configuration—[2-3] System—Timers & Counters—Dial / IRNA / Recall / Tone— Dial—Analogue
CO Call Duration Start (s)
10.7.1  PBX Configuration—[2-7-1] System—Class of Service—COS Settings—CO & SMDR— Outgoing
CO Call Printout (SMDR)
14.2  PBX Configuration—[6-2] Feature—Hotel & Charge

→Main— SMDR for External Hotel Application 2—Printing Message 1–8
→Charge— Charge Options—Currency

19.1  PBX Configuration—[11-1] Maintenance—Main
→SMDR
→SMDR Options

使用说明书（PT编程手册）参考

[802] SMDR页长

[803] SMDR跳越穿孔

[804] SMDR打印去电呼叫

[805] SMDR打印来电呼叫
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使用说明书（功能手册）参考

2.1.1.3  直接向内拨号（DID）/直接拨入（DDI）
2.1.1.4  多个用户号码（MSN）振铃服务

2.2.2.8  注册/注销

2.5.4.8  集团电话主机接入代码（从集团电话主机接入电话公司的接入代码）

2.12.1  呼叫转移

2.16.1  直接拨入系统接入（DISA）
4.3.1  TIE线路业务

5.1.1  服务等级（COS）
6.1  系统资源的容量
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2.22.1.2  系统日志记录管理

说明

将本集团电话通过LAN连接到系统日志服务器，就可以将本机告警信息（主要告警/次要告警）输出到外部PC。

条件

• 要使用此功能，需要通过系统编程允许此功能并注册系统日志服务器的IP地址。

使用说明书（PC编程手册）参考

7.3.2  Utility—Log—Syslog
27.3.2  Network Service—[3-2] Client Feature—Syslog

使用说明书（功能手册）参考

5.6.4  本机告警信息
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2.22.2  打印留言

说明

分机用户可以选择要在SMDR上输出的留言。打印留言表中最多可以预编程设定8 条留言，并所有连接到集团

电话的分机都可以使用这些留言。留言如果包含"%"符号，表示如果一部分机选择了该留言，就需要在"%"位置

输入数字。

根据预编程设定的留言内容的不同，该功能可以用于录制各种信息，这些信息可以在SMDR上输出，例如输出

到连接的PC。

[示例]
如果预编程设定留言1为"Started work（已开始工作）"，留言2为"Finished work（已完成工作）"，员工即可在

开始工作时选择留言1签到，在结束工作时选择留言2签出。然后可以使用连接的PC来产生员工工作记录。

条件

• 每条留言最多可存储7个"%"。

使用说明书（PC编程手册）参考

10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features— Printing Message
14.2  PBX Configuration—[6-2] Feature—Hotel & Charge—Main— SMDR for External Hotel Application
2—Printing Message 1–8

使用说明书（功能手册）参考

2.22.1.1  电话通信详细记录（SMDR）

6.1  系统资源的容量

使用说明书（用户手册）参考

1.12.1  在宾馆类环境中使用电话（友好功能）
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2.22.3  话费服务

说明

在与外线用户进行通话过程中或之后，集团电话会收到话费信号。话费信息显示在电话显示器和SMDR上。

1. 话费信号服务

集团电话使用的话费服务类型由从电话公司接收到的信号类型决定。从电话公司接收到的话费信号类型取

决于去电呼叫的中继线。用于每种可用类型中继线的服务如下：

中继线 服务

ISDN线路 话费通知（AOC）（® 4.1.2.3  话费通知（AOC））

E1线路 计费脉冲

2. 话费显示

– 最多八位数，包括小数部分（例如：12345.78）
– 货币的小数点位置（重要的小数位数）是可以编程设定的。

– 最多可以编程设定三个货币字符。（例如：表示欧元的EUR或€）。

– 通过PC编程，可以选择将货币字符或符号放在话费前面还是后面。（例如：€ 45.12或45.12 €）

3. 指定利润率/税率

可以在话费基础上加算利润和税额。每个表头指示的话费率可以在中继线群基础上编程设定。

[计算方法]
利润率或税率必须由四位数字组成，小数点前后各两位数字（xx.xx%）。根据电话公司是发送表头指示还是

发送实际的话费，集团电话所用的计算方法也不同。

a. 用表头指示计算含税和利润的话费：

[ ]     [ ]    [1    ] 

[1– ]

b. 用实际话费计算含税和利润的话费：

[ ]     [1   ]

[1– ]

计算结果四舍五入至最不重要的小数位。

4. 总话费

– PT用户可以在显示器上显示总话费。

– 话费在分机、中继线或验证代码基础上进行总计。

– 使用验证代码时，将以验证代码为基础计算费用，而不是以拨打电话的分机为基础计算费用。

5. 预算管理

可以每部分机或每个验证代码为基础，将电话使用限制于预编程设定的预算范围内。例如，租用办公室中

的分机有一个关于电话使用的预付限额。如果话费总额达到该限额，分机用户就不能再打中继线电话。指

定为管理员的分机可以增加该限额或清除原先的话费（® 2.7.2  预算管理）。

6. 话费管理

指定为管理员的分机可以进行下列管理活动：

a. 清除每部分机和每个验证代码的话费。

b. 清除全部分机和验证代码的话费。

c. 查看每条中继线、每部分机或每个验证代码的话费（呼叫话费参考）。
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d. 设定每个中继线群的话费率。

e. 打印全部分机和验证代码的总话费。

f. 设定每部分机和每个验证代码的预算。

[呼叫话费参考示例]

Total Charge:      00175.95

******************************************************

*    Charge Meter Print Out - Total & All CO      *

******************************************************

CO Line

    001:      00194.00   002:      00073.00   003:      00161.00   004:      00033.00

*******************************************************

*    Charge Meter Print Out - All Extensions       *

*******************************************************

 *775:      00194.00 *102:      00073.00 *776:      00161.00

    107:      00033.00104:      00194.00 105:      00073.00 106:      00161.00

注

*：分机或验证代码号码

条件

[一般]
• 用呼叫话费参考键检查呼叫话费参考

显示电话用户可以使用呼叫话费参考键来检查其自己分机的总话费。可以把一个灵活键改制成呼叫话费参

考键。

[付费音服务]
• 可以选择集团电话是否从集团电话检测到来自电话公司的应答信号时开始计算话费。

使用说明书（PC编程手册）参考

11.1.5  PBX Configuration—[3-1-5] Group—Trunk Group—Charge Rate
12.1.4  PBX Configuration—[4-1-4] Extension—Wired Extension—Flexible Button— Type
14.2  PBX Configuration—[6-2] Feature—Hotel & Charge—Charge

→ Margin & Tax—Margin Rate for "Telephone" (%)
→ Margin & Tax—Tax Rate for "Telephone" (%)
→ Charge Options—Digits After Decimal Point
→ Charge Options—Currency
→ Charge Options—Currency Display Position
→ Charge Options—Action at Charge Limit
→ Charge Options—Meter Start on Answer Detection
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使用说明书（PT编程手册）参考

[010]收费边限

[011]计费税

[012]每台机的费率

[130]货币的小数点位置

[131]货币

使用说明书（功能手册）参考

2.7.6  验证码输入

2.21.2  灵活键

6.1  系统资源的容量

使用说明书（用户手册）参考

1.12.1  在宾馆类环境中使用电话（友好功能）

4.1.2  管理员编程
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2.23  友好功能

2.23.1  友好功能—概要

说明

本集团电话的一些功能支持在宾馆类环境下使用集团电话，宾馆中的分机与客房相对应。

功能 说明与参考

房间状态控制 指定为宾馆话务员的分机可以远程设定房间的登记状态。

® 2.23.2  房间状态控制

客房呼叫计费 可以记录客房拨出呼叫的话费，并输出为房客帐单。

® 2.23.3  客房呼叫计费

远程唤醒电话 指定为宾馆话务员的分机可以为一个房间远程设定定时提醒。

® 2.24.4  定时提醒

外部酒店应用程序SMDR 友好功能数据，包括登记*1、结帐*1及定时提醒次数，都可以输出至

SMDR，用于以PC为基础的宾馆应用程序。

® 2.22.1.1  电话通信详细记录（SMDR）

统一消息的宾馆服务模式 可以限制统一消息信箱设为宾馆服务模式的分机只使用特定功能，如

收听留言和更改信箱拥有者姓名。

® 3.2.1.21  宾馆服务模式

*1 根据系统设置，可能不会输出登记和结帐信息。有关详细，请参阅2.23.2  房间状态控制。
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2.23.2  房间状态控制

说明

可以使用被指定为宾馆话务员分机的6行显示PT来查看和设定与分机关联的客房的登记/结帐/整理（准备或未准

备）状态。

任何有线分机不需特别编程就可以用作客房分机。

可以将宾馆话务员分机上的灵活键设定为房间状态控制键。3种类型的房间状态控制键如下所述：

• 登记

用于将所选客房分机的状态从结帐切换为登记。

话费被清除，远程分机锁定也被关闭，从而允许从该分机拨出电话。

• 结帐

用于将所选客房分机的状态从登记切换为结帐。

诸如定时提醒或最后号码重拨数据等客房分机数据被清除，远程分机锁定打开，从而限制某些电话。这样

可以防止没有客人住进的房间内的分机被使用。

给客房分机结帐时，话务员可以输入小酒吧费用等顾客费用。可以打印显示这些费用以及话费的房客帐单。

如有必要，输入的房客费用数据可以以后再编辑，并重新打印帐单。

• 整理

在准备及未准备间切换所选房间分机的状态。

客人结帐后，房间状态变为结帐但未准备。打扫房间后，使用该键可以将状态更改为结帐并准备。如果必

要，还可以将状态更改回结帐但未准备。

房间状态控制方式

当PT空闲时，按房间状态控制键可以使宾馆话务员分机进入房间状态控制方式。当处于房间状态控制方式时，

相应的房间状态控制键闪烁红灯。所按的房间状态控制键决定了每部客房分机可以切换到何种房间状态。例

如，如果按下了登记键，登记键闪烁红灯，宾馆话务员可以选择登记哪些客房分机。

此外，宾馆话务员分机或配对DSS话务台上的DSS键以如下方式显示每部分机的房间状态：

指示灯类型 状态

关闭 结帐并准备

红灯闪烁 结帐但未准备

红灯亮 登记

[使用示例：登记方式]

101

DSS

102

103

104

105

101 103
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当处于房间状态控制方式时，宾馆话务员分机被当作占线分机，类似于执行PT编程时。呼叫该分机将听到忙

音。

任何其它操作都将被忽略，包括按其它房间状态控制键。此外，固定键和灵活键的灯并不显示一般的显示类

型。为了执行其它操作，宾馆话务员必须退出房间状态控制方式。

条件

注意

如果通过系统编程允许管理监听（ACD）控制功能的内置ACD报表呼叫记录设置，此功能无法使用。有关

详情，请参阅使用说明书（PC编程手册）中的相关章节或咨询您的系统管理员。

• SVM语音留言和分机语音信箱（VM）中的留言将在结帐时被清除。

• 可指定最多四个宾馆话务员。

• 每种类型的房间状态控制键中只能指定一个。

• 客房分机必须是以下类型之一：

PT、一般SIP、SLT、ISDN分机

• 为方便起见，建议使用与房间号相同或相似的客房分机号码。

• 只有当一部分机被重新设定为登记状态时，前一个房客的帐单数据才会被清除。因此，可以在任何时候编

辑房客的费用数据并重新打印帐单，直到另一位房客登记住进该房间。

• 如果通过系统编程允许的话，登记和结帐信息将记录在SMDR上。

使用说明书（PC编程手册）参考

11.5.3  PBX Configuration—[3-5-3] Group—Incoming Call Distribution Group—Miscellaneous—
Options—Call Log for Built-in ACD Report
12.1.4  PBX Configuration—[4-1-4] Extension—Wired Extension—Flexible Button— Type
14.2  PBX Configuration—[6-2] Feature—Hotel & Charge

→Main— Hotel Operator—Extension 1–4
→Bill— Checkout Billing—Billing for Guest

使用说明书（功能手册）参考

2.2.2.10  监控功能（ACD）

2.6.3  最后号码重拨

2.7.3  分机锁定

2.22.1.1  电话通信详细记录（SMDR）

2.24.4  定时提醒

使用说明书（用户手册）参考

1.12.1  在宾馆类环境中使用电话（友好功能）

4.1.3  监控监听（ACD）控制
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2.23.3  客房呼叫计费

说明

与SMDR不同，可以输出呼叫以及费用（例如：电话费用、小酒吧费用等）记录，以用于对房客计费。

收费项目

该功能提供三种类型的可编程收费项目（收费项目1、收费项目2和收费项目3），这些项目用于向客户计收各种

服务费用（例如：电话费用）。每种收费项目可以采用以下方式定制设定：

– 出现在呼叫计费打印输出上的名称。

14.2  PBX Configuration—[6-2] Feature—Hotel & Charge—Bill
® Checkout Billing—Bill (SMDR) for "Telephone"
® Checkout Billing—Bill (SMDR) for "Minibar"
® Checkout Billing—Bill (SMDR) for "Others"

– 出现在宾馆话务员显示电话上的名称。

14.2  PBX Configuration—[6-2] Feature—Hotel & Charge—Bill
® Checkout Billing—LCD for "Telephone"
® Checkout Billing—LCD for "Minibar"
® Checkout Billing—LCD for "Others"

– 税率。

14.2  PBX Configuration—[6-2] Feature—Hotel & Charge—Charge
® Margin & Tax—Tax Rate for "Telephone" (%)
® Margin & Tax—Tax Rate for "Minibar" (%)
® Margin & Tax—Tax Rate for "Others" (%)

还可以给收费项目1指定一个利润率，这可用于对房客使用电话服务收取额外费用。

® 14.2  PBX Configuration—[6-2] Feature—Hotel & Charge—Charge— Margin & Tax—Margin Rate for
"Telephone" (%)
可以为房客打印帐单。帐单显示以下项目：
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[电话帐单示例]

****************************************

****************************************

Hotel

Check in  : 01.JAN.00 06:31PM

Check out : 03.JAN.00 07:03AM

Room      :  202 : Mr. Smith

Telephone        104.30 (Tax   10.000% =    9.48)

Minibar          4.00 (Tax   10.000% =    0.36)

Others          0.00 (Tax   15.000% =    0.00)

Total    FR    108.30 (Tax Total     =    9.84)

Sheet : 002

======= Hotel PBX =======

Tel: +41 3 12 34 56 78  Fax: +41 3 12 34 56 78

E-Mail: 12345678  hotelpbx.ch

01/01/00 06:52PM  202 01 Call amount:0012

02/01/00 06:07PM  202 01 123456789

02/01/00 07:30PM  202 01 012345678901234

02/01/00 08:45PM  202 01 0011234567890123

01:24'30 00084.50 001

00:10'12 00010.20 1234567890

00:06'36 00006.60 12345

00:03'00 00003.00 12345

**(1)

(2)

(3)

(4)

(5)

(6)

(7)

(8)

(9)

1. 可编程的标题（例如：宾馆名称）。

® 14.2  PBX Configuration—[6-2] Feature—Hotel & Charge—Bill— SMDR for External Hotel
Application—Header 1–3

2. 登记时间。

3. 结帐时间。

如果客人已结帐，将显示结帐时间。如果尚未结帐，将显示帐单打印时间。

4. 分机号码和名称。

5. 全部所拨电话和电话收费的列表（使用与SMDR输出类型B相同的格式 [® 2.22.1.1  电话通信详细记录

（SMDR）]）。
6. 每种收费项目的总计费用和税额，包括预编程设定的税率。

7. 所有三种收费项目的合计费用、计费货币和税额。

8. 页号（当前房客的费用数据打印、清除的次数）。

9. 可编程的页脚（例如：宾馆的联系信息）。

® 14.2  PBX Configuration—[6-2] Feature—Hotel & Charge—Bill— SMDR for External Hotel
Application—Footer 1–3

可以选择房客帐单上使用的语言。

® 14.2  PBX Configuration—[6-2] Feature—Hotel & Charge—Bill— SMDR for External Hotel
Application—Language for Bill (SMDR)

流动COS
如果给房客提供了分机个人识别号码（PIN），则通过流动COS功能（® 2.7.5  流动COS），可以把在另一部分

机（例如：宾馆餐厅中的分机）上打电话产生的费用计算在房客自己的房间分机上。
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® 12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Main— Extension
PIN

条件

注意

如果通过系统编程允许管理监听（ACD）控制功能的内置ACD报表呼叫记录设置，此功能无法使用。有关

详情，请参阅使用说明书（PC编程手册）中的相关章节或咨询您的系统管理员。

• 如果呼叫记录总数超过可用存储器的90 %，呼叫记录数目最多的分机的呼叫记录将自动打印，已打印的记

录将在存储器中合并成一个总计记录，以节约空间。

使用说明书（PC编程手册）参考

11.5.3  PBX Configuration—[3-5-3] Group—Incoming Call Distribution Group—Miscellaneous—
Options—Call Log for Built-in ACD Report
12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Main— Extension
PIN
14.2  PBX Configuration—[6-2] Feature—Hotel & Charge—Bill— Checkout Billing—LCD for "Telephone"
14.2  PBX Configuration—[6-2] Feature—Hotel & Charge—Charge

→ Margin & Tax—Margin Rate for "Telephone" (%)
→ Margin & Tax—Tax Rate for "Telephone" (%)
→ Margin & Tax—Tax Rate for "Minibar" (%)
→ Margin & Tax—Tax Rate for "Others" (%)

使用说明书（功能手册）参考

2.2.2.10  监控功能（ACD）

2.6.3  最后号码重拨

2.7.3  分机锁定

2.22.1.1  电话通信详细记录（SMDR）

2.24.4  定时提醒

6.1  系统资源的容量

使用说明书（用户手册）参考

1.12.1  在宾馆类环境中使用电话（友好功能）

4.1.3  监控监听（ACD）控制
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2.24  分机控制功能

2.24.1  分机个人识别号码（PIN）

说明

通过系统编程或个人编程，每个分机用户都可以有其自己的PIN（分机PIN [个人识别号码]），用来设定功能或

远程接入自己的电话。

在没有PIN的情况下不能使用以下功能：

a. 现场呼叫屏蔽（LCS）*1（® 3.2.2.16  现场呼叫屏蔽（LCS））
b. 显示锁定（® 2.6.4  速拨—个人/系统，2.16.3  内装简化语音留言（SVM），2.19.2  来电记录）

c. 可移动分机（® 2.24.3  可移动分机功能）

d. 分机锁定（® 2.7.3  分机锁定）

e. 流动COS（® 2.7.5  流动COS）
f. 通过DISA的流动COS（® 2.16.1  直接拨入系统接入（DISA））
*1 如果分机用户已指定了分机PIN，在没有PIN的情况下，不能使用此功能。

条件

注意

如果第三方发现了集团电话的个人识别号码（PIN）（验证代码PIN或分机PIN），便有可能发生欺诈呼叫的

危险。

此类呼叫将向集团电话的所有者/租用者收费。

为保护集团电话免受此类欺诈使用，我们强烈建议：

a. 对PIN进行保密。

b. 选择不容易猜到的复杂、随机PIN。

c. 定期更改PIN。

• 分机PIN锁

如果三次输入错误的PIN，线路将被断开。如果连续输入错误的PIN达到预编程设定的次数，该分机将被锁

定，即使输入正确的PIN也无法解除锁定。只有被指定为管理员的分机才能解除锁定。这种情况下，PIN将

被解除锁定并被清除。此功能也称为分机密码锁。

• 清除远程分机PIN
如果分机用户忘记了PIN，管理员可以清除PIN。然后分机用户可以指定一个新的PIN。

• 分机PIN显示

通过系统编程，可以选择是否在显示器上显示分机PIN。预设情况下是显示为点。

使用说明书（PC编程手册）参考

10.3  PBX Configuration—[2-3] System—Timers & Counters—Miscellaneous— Extension PIN—Lock
Counter
10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features— Extension PIN Set /
Cancel
10.9  PBX Configuration—[2-9] System—System Options—Option 1— PT LCD—Password / PIN Display
12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Main— Extension
PIN
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使用说明书（PT编程手册）参考

[005]分机个人识别号码（PIN）

使用说明书（用户手册）参考

3.1.2  编程方式设定

4.1.2  管理员编程
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2.24.2  清除分机功能

说明

分机用户可以一次清除在其自己的电话上设定的下列全部功能。此功能也称为话机程序清除。

功能 设定后

缺席留言 关闭

BGM 关闭

FWD*/DND* 关闭

拒绝呼叫接听 允许

呼叫等待* 停用（在加拿大，默认设定为"允许" [呼叫等待音]。）

数据线路安全 关闭

主管遇忙优先插入拒绝 允许

注册/注销 注册

留言待取 其他分机所留下的全部留言将被清除。

拒绝广播 允许

并联电话 配对SLT将振铃

热线* 关闭

定时提醒 清除

注

可以对带"*"的功能进行编程以不被此功能取消。

条件

• 分机锁定（® 2.7.3  分机锁定）和分机个人识别号码（PIN）（® 2.24.1  分机个人识别号码（PIN））不会

被该功能清除。

• 仅对加拿大用户

如果在清除分机功能后听到拨号音2：
在完成清除分机功能后，如果通过系统编程将"Extension Clear: Call Waiting"设置为"Clear"，将允许呼

叫等待。这种情况下，摘机时会听到拨号音2。（® 2.25.1  拨号音）

使用说明书（PC编程手册）参考

10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features— Extension Feature Clear
10.9  PBX Configuration—[2-9] System—System Options—Option 2

→ Extension Clear—Call Waiting
→ Extension Clear—Fwd/DND
→ Extension Clear—Hot Line (Pick-up Dial)

276 使用说明书（功能手册）

2.24.2 清除分机功能



使用说明书（用户手册）参考

1.9.13  清除在您分机上设定的功能（清除分机功能）
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2.24.3  可移动分机功能

2.24.3.1  可移动分机

说明

可以使用任何分机并且使用您自己的分机设定。诸如分机号码、单键拨号存储器以及COS等设定都可以在新位

置上为您所用。此功能也称为可移动话机。

[示例]在以下情况下此功能很有用：

• 位置不断移动

• 没有专用办公桌。

条件

• 此功能允许分机设定可在PT和SLT之间转换。还可以在租户之间移动。

• 打到您分机的来电也会到达您所在的新位置。

• 使用此功能需要分机个人识别号码（PIN）。（® 2.24.1  分机个人识别号码（PIN））

• 如果DSS话务台与一部PT连接，而且在启动可移动分机后DSS话务台继续与PT一起使用，则必须通过系统

编程将PT的新分机号码分配为配对分机。

• 如果在分机设定正由可移动分机功能转移时对分机执行PC编程，可移动分机功能可能工作不正常（®
5.5.2  PC编程）。

• 如果使用连接了Bluetooth®无线头戴式耳机的分机执行该功能，则Bluetooth设备无法用于新分机。若要使

用Bluetooth无线头戴式耳机，将其注册到新分机。

• SIP分机无法使用该功能。

使用说明书（PC编程手册）参考

10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features— Walking Extension
12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Main— Extension
PIN

使用说明书（PT编程手册）参考

[007] DSS话务台成对电话

使用说明书（用户手册）参考

1.13.1  可移动分机
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2.24.3.2  增强的可移动分机

说明

可以通过工作中（正常运行）和停用（无法拨打中继线呼叫或接听电话）方式的分机来使用可移动分机功能，

允许更有效地利用分机（即：电话）和地点。分机用户不使用分机或要防止无人值守位置时拨打或接听电话

时，可以将分机设定为停用方式。分机用户想要使用分机时，可以再将分机更改为工作中方式。

可以如下利用增强的可移动分机：

– 单一分机用户使用多个电话时

分机用户可以使用停用分机来切换位置。这样在以前的位置处于停用方式时，允许分机用户在其它位置使

用其设定。这非常适合需要在多个位置工作的分机客户，例如：其它部门、分公司或家里。

– 多个分机用户使用同一部电话时

分机用户可以将其停用分机的工作状态更改为工作中方式，然后通过简单的操作切换到有其它分机的位置。

这非常适合使用同一部电话轮班工作的多个分机用户。

停用方式

分机处于停用方式时，会在分机上设定免打扰和分机锁定功能，防止分机拨打中继线呼叫和接听电话。

[示例]

分机设定可以在其它位置如下使用：

102 101

101 102101

102

解释：

分机101的分机用户在总公司中更改为停用方式。然后，他可以在分公司中将分机更改为工作中方式并切换分

机设定。

虚拟位置

可以在预装的分机卡上存储不用的（即：停用方式）分机（即：进行设定但是并没有利用物理位置），而不用

将所有分机分配到电话。需要使用分机时，分机可以用在物理位置的分机切换位置和工作状态（即：一个位置

有一部电话）。

[示例]
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可以切换分机设定以允许多个分机用户使用同一部电话，如下所示：

102

101 101101

102 102

解释：

分机101的分机用户更改为停用方式。分机102的分机用户切换分机设定并将其分机更改为工作中方式。

条件

• ISDN分机或SIP分机无法使用该功能。

• 使用此功能需要分机个人识别号码（PIN）。（® 2.24.1  分机个人识别号码（PIN））

使用说明书（PC编程手册）参考

10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features— Walking Extension

使用说明书（功能手册）参考

2.24.3.1  可移动分机

使用说明书（用户手册）参考

1.13.2  增强的可移动分机
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2.24.3.3  可移动分机-初始位置控制

说明

可移动分机和增强的可移动分机功能包含可通过系统编程设置的初始位置控制功能。

初始位置控制的允许/停用设置适用于可移动分机和增强的可移动分机两种功能。

停用：位置交换

交换分机的位置。

允许：返回初始位置

通过可移动分机或增强的可移动分机交换分机位置后，它们将返回原来的位置（初始位置）。

在允许可移动分机功能的情况下执行此功能时，如果想要永久地移动位置，必须在移动前将分机返回其初始位

置。

在允许增强的可移动分机功能的情况下执行此功能时，分机将在状态更改为停用模式时返回其初始位置。

[示例]

停用 工作中

<停用：位置交换>

 101  102  102

 1

Extn. 101 Service-in 101  101 

 102  101  101

 2

解释：

当分机用户在初始位置以外的位置进入工作中模式时，将交换分机的位置。

这对被交换分机的用户而言可能有点容易混淆，因为他/她的分机的位置可能是未知的。

<允许：返回初始位置>

 101  102  101

 1

 101  101 

 102  101  102

 2
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解释：

当分机用户在初始位置以外的位置进入工作中模式时，分机的位置将暂时交换，并在分机进入停用模式时返回

其初始位置。这样使两个分机的用户都能更容易找到他们的分机。

条件

• 使用条件取决于可移动分机和增强的可移动分机功能各自的条件。

• 允许此设置时分机的位置成为其初始位置。

使用说明书（PC编程手册）参考

10.9  PBX Configuration—[2-9] System—System Options—Option 9— Walking Extension Option—Home
position control

使用说明书（功能手册）参考

2.24.3.1  可移动分机

2.24.3.2  增强的可移动分机

使用说明书（用户手册）参考

1.13.1  可移动分机

1.13.2  增强的可移动分机
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2.24.4  定时提醒

说明

可以预先设定分机在某一时间振铃，以用作唤醒电话或提醒。该功能可以编程设定为只启动一次或每天启动。

如果用户应答警报呼叫，将听到预先录制的语音留言。如果没有指定留言，则将听到特殊拨号音（拨号音3）。
定时提醒可以通过以下两种方式进行设定：

• 由分机用户从自己的分机设定。

• 由宾馆话务员远程设定（远程唤醒电话）

条件

• 请确保集团电话时钟正常。

• 一次只能为一部分机设定一个定时提醒。设定新提醒会清除以前的提醒。如果分机用户和宾馆话务员均为

同一部分机设定了定时提醒，则最新设定的定时提醒有效。

• 可编程时间

可以通过系统编程设定警报振铃持续时间、警报重复次数和间隔时间。

• 使用语音留言功能：

指定为管理员的分机可以录制留言（® 2.30.2  外播留言（OGM））。 可以为每种时间方式（白天/午餐/休
息/夜间）指定不同的留言（® 5.1.4  定时服务）。

使用说明书（PC编程手册）参考

10.3  PBX Configuration—[2-3] System—Timers & Counters—DISA / Door / Reminder / U. Conf
→ Timed Reminder—Repeat Counter
→ Timed Reminder—Interval Time (x10s)
→ Timed Reminder—Alarm Ringing Duration (x10s)

10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features
→ Remote Timed Reminder (Remote Wakeup Call)
→ Timed Reminder Set / Cancel

10.8.3  PBX Configuration—[2-8-3] System—Ring Tone Patterns—Call from Others— Timed
Reminder—Ring Tone Pattern Plan 1–8
10.9  PBX Configuration—[2-9] System—System Options—Option 1— PT LCD—Time Display
13.3.1  PBX Configuration—[5-3-1] Optional Device—Voice Message—DISA System—Option 2— Timed
Reminder Message—Day, Lunch, Break, Night
14.2  PBX Configuration—[6-2] Feature—Hotel & Charge—Main— SMDR for External Hotel Application
1—Timed Reminder (Wake-up Call)
19.1  PBX Configuration—[11-1] Maintenance—Main—SMDR— Print Information—Timed Reminder
(Wake-up Call)

使用说明书（功能手册）参考

2.23.2  房间状态控制

使用说明书（用户手册）参考

1.9.1  设定警报（定时提醒）
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1.12.1  在宾馆类环境中使用电话（友好功能）
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2.25  可听信号音功能

2.25.1  拨号音

说明

以下特殊拨号音通知分机用户有关在其分机上启动的功能。

每个拨号音类型有两个频率（例如：拨号音1A和拨号音1B）。

类型 说明

信号音1A/1B 在以下情况下会听到正常拨号音：

a. 尚未设定需使用拨号音2至4的功能，或

b. 使用了ARS。

信号音2A/2B 在以下情况下会听到该信号音：

• 内装简化语音留言（SVM）有留言功能，所有留言以前

均听过，没有新留言。*1

• 设定了下面任何一种功能。

• 缺席留言

• BGM
• FWD
• 拒绝呼叫接听

• 呼叫等待

• DND
• 分机锁定

• 主管遇忙优先插入拒绝

• 热线

• 定时提醒

信号音3A/3B 在以下情况下会听到该信号音：

• 内装简化语音留言（SVM）功能所用的录音时间达到限

制。*2

• 执行了下面任何一种功能。

• 计费代码输入

• 协商保留

• 应答没有留言的定时提醒电话

• 应答传感器呼叫

信号音4A/4B 分机有新留言时会听到该信号音。

*1 启用特殊拨号音时启动。停用特殊拨号音时会听到TONE 1。
*2 即使停用特殊拨号音也会启动。

条件

• 拨号音类型A/B
对于拨号音1至4，可以选择拨号音类型A或B。如果选择"Type A"，全部拨号音1至4都将变成拨号音类型

A。
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可以单独选择ARS功能的拨号音类型。如果为ARS选择"Type A"，将听到拨号音1A。如果选择"Type B"，
将听到拨号音1B。

• 拨号音类型

全部拨号音类型都有默认值（® 6.2.1  音频/振铃音）。

• 对于VM（DPT/DTMF）群中的分机，只发送拨号音1（2.28.1  语音信箱（VM）群）。

使用说明书（PC编程手册）参考

10.9  PBX Configuration—[2-9] System—System Options—Option 3
→ Dial Tone—Distinctive Dial Tone
→ Dial Tone—Dial Tone for Extension
→ Dial Tone—Dial Tone for ARS
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2.25.2  证实音

说明

功能操作结束时，集团电话通过向分机用户发送证实音来确认操作成功。

类型 说明

信号音1 a. 当设定被接受时发送。

b. 当以语音呼叫方式（交替接收—振铃/话音）接电话

时发送。在该信号音后将听到来电者的声音。

信号音2 a. 从外部广播设备或被广播前的分机发送。

b. 当以免提应答方式接电话时发送。

信号音3-1 a. 当使用广播功能时在建立通话前发送。

b. 在打电话操作后，当以下列方式与分机建立通话时发

送：

• 免提应答方式

• 语音呼叫方式（交替接收—振铃/话音）

c. 当打电话到门电话或从门电话拨打时发送。

信号音3-2 当通过功能号码接入以下功能时，在建立通话前一刻发

送：

• 呼叫寄存恢复

• 呼叫接听

• 保留恢复

• 广播应答

• TAFAS

信号音4-1 当从两方通话变成三方通话时发送。（例如：主管遇忙优

先插入、会议、保密释放、双向录音。）

信号音4-2 当从三方通话变成两方通话时发送。（例如：主管遇忙优

先插入、会议、保密释放、双向录音。）

信号音5 当呼叫被置于保留时发送（包括协商保留）。

条件

• 证实音类型

全部证实音类型都有一个默认值（® 6.2.1  音频/振铃音）。

• 可以消除每个信号音。

使用说明书（PC编程手册）参考

10.9  PBX Configuration—[2-9] System—System Options—Option 3
→ Confirmation Tone—Tone 1 : Called by Voice
→ Confirmation Tone—Tone 2 : Paged / Automatic Answer
→ Confirmation Tone—Tone 3-1 : Start Talking after Making Call / Call from DOORPHONE
→ Confirmation Tone—Tone 3-2 : Start Talking after Answering Call
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→ Confirmation Tone—Tone 4-1 : Start Conference
→ Confirmation Tone—Tone 4-2 : Finish Conference
→ Confirmation Tone—Tone 5 : Hold
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2.26  电脑电话集成（CTI）功能

2.26.1  电脑电话集成（CTI）
说明

集团电话支持使用主板LAN端口的CTI接口。CTI接口允许分机用户使用高级功能拨打或接听电话：

– 分机用户可以从PC中的电话簿轻松拨打电话。

– 当分机用户收到来电，可以自动在PC上显示详细的来电者信息。

使用CTI功能需要PC和CTI服务器应用程序软件。运行应用程序的PC会监听集团电话的状态并通过CTI服务器

控制集团电话。

PC PC

LAN

LAN

CTI

条件

• 必须在连接的PC中安装CTI应用软件。此外，使用CTI应用需要KX-NSF101（CTI接口的激活密钥）。

• 应用程序编程接口（API）/协议

类型 API/协议

第三方呼叫控制 • ECMA CSTA相位3
• TAPI 2.1

• 一次仅可以将一台CTI服务器连接到集团电话。

• 有关特定CTI功能的详情，请参阅CTI应用软件手册。

• 使用Panasonic TSP时，请参阅KX系列TSP使用说明书（安装手册）中的"安装之前"。

使用说明书（安装手册）参考

4.10  连接外围设备

使用说明书（PC编程手册）参考

10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features— Dial Information (CTI)
10.9  PBX Configuration—[2-9] System—System Options—Option 6 (CTI)
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2.27  移动电话功能

2.27.1  移动电话功能—概要

说明

本集团电话提供支持使用移动电话以及使用集团电话拨打其它外线目的地的功能。呼叫可以从虚拟PS转送到外

线目的地，例如移动电话，然后，用户就可以像在集团电话的分机旁一样应答。另外，当接收分机将呼叫直接

转送至移动电话时，移动电话可以像直接呼叫集团电话一样使用集团电话分机功能。

以下功能可与移动电话和其它外线分机一同使用：

功能 说明与参考

来电呼叫分配群中的外线目的地 可以将最多4个移动电话指定为来电呼叫分配（ICD）群的成员，

并用其接收拨打到该群的呼叫。

® 2.2.2.3  来电呼叫分配群中的外线目的地

移动电话XDP并联方式 处于并联方式时，PT用户最多可设定4个移动电话在来电时振铃。

® 2.2.2.3  来电呼叫分配群中的外线目的地

转送到中继线时并联振铃 未应答呼叫被转送到外线（如移动电话）时，转送分机的电话将持

续振铃直到任意电话应答转送的呼叫。

® 2.3.2  呼叫转送（FWD）

DISA自动流动COS 当通过DISA呼叫时，已注册的移动电话被自动识别为集团电话的

分机。

® 2.16.1  直接拨入系统接入（DISA）

来自外线目的地的DISA呼叫转移 应答使用DISA从集团电话转送的中继线呼叫的移动电话用户可以

转移该呼叫到分机（包括通过TIE连接）或到外线用户。也可以建

立起会议电话，进行呼叫分离，并使用保留的呼叫进行广播从而将

呼叫转移。

® 2.16.1  直接拨入系统接入（DISA）

DISA呼叫转移到外线用户 从转移目的地（包括外线用户），可以建立会议电话、进行呼叫分

离以及使用保留的呼叫进行广播从而将呼叫转移。

® 2.16.1  直接拨入系统接入（DISA）

条件

• 使用这些功能需要KX-NSE101或KX-NSE110（移动分机的激活密钥）。每个使用这些功能的分机都需要一

个激活密钥。

另外，每个分机的Mobile Extension设定必须设为Enable。
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• 呼叫断开检测

当中继线使用LCOT时，系统无法检测到呼叫断开。因此，系统会在转移呼叫后断开中继线侧（未屏蔽转

移）。

使用说明书（PC编程手册）参考

12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Option 9— Mobile
Extension

使用说明书（功能手册）参考

5.2.4.1  虚拟PS
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2.28  语音信箱功能

2.28.1  语音信箱（VM）群

说明

可以把VPS连接到集团电话的分机端口。这些分机端口组成一个群，称为VM群。该群有一个浮动分机号码。

VM群可以是转接呼叫和来电呼叫的目的地。当收到呼叫时，VPS可以问候来电者，提示他们留言或拨号接入

所需用户。如果被叫分机不能应答呼叫，VPS可以为每部分机录制留言，并在相应的分机上留下通知。

1. VM群类型

类型 说明

VM（DTMF）群
一组使用语音信箱DTMF集成功能的SLT端口。

能最多分配2个群。

VM（DPT）群

一组使用语音信箱DPT（数字）集成功能的DPT端口。

• 最多可以将2个KX-TVM系统连接到集团电话。

• 对于每个KX-TVM，最多可以指定一个VM（DPT）群。

• 每个群最多可以用VPS的12个端口（24个信道）来形成。

[示例]

SLT SLT SLT SLT 

VPS

DPT[ ]

VPS

DTMF

DPT DPT DPT DPT DPT 

VM DPT

500

VM DTMF

250

101 102 103 104 117 118 119 120

SLT 

VM（DTMF）群分配：

VPS被连接到集团电话的SLT端口。这些SLT端口和VM（DTMF）群设定都必须加以配置以允许DTMF集
成，如以下[分机端口编程示例]和[VM（DTMF）群编程示例]所示。

VM（DPT）群分配：

VPS被连接到集团电话的DPT端口。这些DPT端口和VM（DPT）群设定都必须加以配置以允许DPT（数

字）集成，如以下[分机端口编程示例]和[VM（DPT）群编程示例]所示。
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[分机端口编程示例]

对于VM (DPT)群

DPT Property

VM (DPT) 

 1

Slot

6

6

:

7

7

Port

1

2

:

1

2

Extn. No.

101

102

:

201

202

Type*
1

VM (DPT)

VM (DPT)

:

VM (DPT)

VM (DPT)

Unit No.

of VPS

1

1

:

2

2

Port No.

of VPS

1

2

:

1

2

Port Type

DPT

DPT

:

S-Hybrid

S-Hybrid

VM (DPT) 

2

 

*
2

*
3

对于VM (DTMF)群

DPT Property

tSlo

6

6

:

7

7

Port

1

2

:

1

2

Extn. No.

301

302

:

401

402

Type*
1

:

Unit No.

of VPS

:

Port No.

of VPS

:

Port Type

SLT

SLT

:

SLT

SLT

VM (DTMF)

1

VM (DTMF)

2

*
2

*
3

*1 ®9.22  PBX Configuration—[1-1] Configuration—Slot—Port Property—Extension Type— DPT Type—Type
®[601]终端设备分配

*2 ®9.22  PBX Configuration—[1-1] Configuration—Slot—Port Property—Extension Type— DPT Type—VM Unit
No.

*3 ®9.22  PBX Configuration—[1-1] Configuration—Slot—Port Property—Extension Type— DPT Type—VM Port
No.

[VM（DTMF）群编程示例]

VM (DTMF)

Group No.

1

2

Group

Name

Company C

Company D

Service

Mode

AA

VM

Floating

Extension

No.

300

400

1

301

401

…

…

…

Extension No. of

Port Connected to

VPS Port

2

302

402

→ 11.12.2  PBX Configuration—[3-12-2] Group—VM(DTMF) Group—Group Settings

[VM（DPT）群编程示例]

VM (DPT) Group No.

1

2

Floating Extension No.*1

500

200

Group Name*2

Company A

Company B

*1 ®11.11.2  PBX Configuration—[3-11-2] Group—VM(DPT) Group—Unit Settings— Floating Extension No.
®[660]UM群浮动分机号码

*2 ®11.11.2  PBX Configuration—[3-11-2] Group—VM(DPT) Group—Unit Settings— Group Name
2. 至VM群的来电

当在VM群的浮动分机号码上收到来电时，来电将从最小VM端口号码开始搜索。这样，就不考虑每个分机

端口的FWD和DND设定（® 2.3.1  呼叫转送（FWD）/免打扰（DND）—概要）。
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可以通过系统编程设定当群中的全部分机端口都占线时呼叫是否排队。如果通过系统编程停用排队，呼叫

将被转接到VM（DPT）群主成员分机的截取目的地。

条件

• 可以直接呼叫VM群的分机（分机端口）。如果呼叫被直接路由到群中的分机，可以允许该群中的分机上的

一些功能（例如：FWD，空闲分机搜索）。

语音信箱DTMF/DPT（数字）集成（例如：命令传送）在分机上也是可用的。

• 单键语音信箱功能接入

可以为直接接入语音信箱功能指定一个单键拨号键。（® 2.6.2  单键拨号）例如，要直接接入VPS（分机号

码165）的信箱（信箱号码123），可将"165#6123"指定给一个单键拨号键。当按此键时，会听到信箱的外

播留言（OGM）。

• 必须把VM（DPT）群中的全部端口连接到单个DHLC卡或DLC卡。

使用说明书（PC编程手册）参考

9.22  PBX Configuration—[1-1] Configuration—Slot—Port Property—Extension Type
→ DPT Type—Type
→ DPT Type—VM Unit No.
→ DPT Type—VM Port No.

11.11.1  PBX Configuration—[3-11-1] Group—VM(DPT) Group—System Settings
11.11.2  PBX Configuration—[3-11-2] Group—VM(DPT) Group—Unit Settings
11.12.1  PBX Configuration—[3-12-1] Group—VM(DTMF) Group—System Settings
11.12.2  PBX Configuration—[3-12-2] Group—VM(DTMF) Group—Group Settings

使用说明书（PT编程手册）参考

[601]终端设备分配

[660]UM群浮动分机号码

使用说明书（功能手册）参考

2.28.2  语音信箱DTMF集成

2.28.3  语音信箱DPT（数字）集成

6.1  系统资源的容量
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2.28.2  语音信箱DTMF集成

说明

集团电话与连接到集团电话的VPS可以相互传送使用DTMF信号的命令。

集团电话自动向VPS发送预编程设定的使用DTMF的命令，以将应答服务在语音信箱（VM）服务方式和自动值

机员（AA）服务方式之间切换，或告知分机状态（如占线）。VPS像SLT一样向集团电话发送命令。

可以使用以下应答服务和功能：

1. 语音信箱（VM）服务方式

当来电到达VPS时，VPS会给予问候并提示来电者给指定语音信箱留下语音留言。

[示例]

VPS给来电者发送留言："感谢您致电Panasonic公司。请输入您想给他留言的人的信箱号码。"

¯  

来电者拨信箱号码。然后，所拨号码被通过集团电话发送到VPS。

¯  

VPS将个人问候发送给来电者："您已到达Mike的语音信箱。很抱歉，我现在不能接听您的电话。请留言，

我将给您回电。"

¯  

来电者留下留言。

如果该呼叫通过FWD等功能重新路由到VM（DTMF）群的浮动分机号码或VM（DTMF）群中的分机，当

VPS应答此呼叫时，集团电话将使用来电者所拨号码自动拨叫相应群或分机的信箱号码以及VPS所需的任

何其他数字（跟随ID）。这样，来电者可以在不知道信箱号码的情况下到达一个信箱。

[跟随ID的可用功能]
a. 呼叫转送到一个信箱

b. 截取路由到一个信箱

c. 呼叫转移到一个信箱

d. 听取一个信箱中的留言

2. 自动值机员（AA）服务方式

VPS会问候来电者并在没有话务员帮助的情况下直接引导来电到达所需的分机。

3. VM ® AA服务，AA  ® VM服务

可以将VPS端口上分配的服务方式从VM服务切换到AA服务，反之亦然。

系统解释

1. 服务方式分配

将服务方式、VM服务或AA服务分配到VM（DTMF）群，以与VPS配置相对应。

® 11.12.2  PBX Configuration—[3-12-2] Group—VM(DTMF) Group—Group Settings— Type
2. DTMF命令分配

分配适合VPS设定的DTMF命令。

11.12.2  PBX Configuration—[3-12-2] Group—VM(DTMF) Group—Group Settings
→ VM DTMF Command—Recording Message
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→ VM DTMF Command—Listening Message
→ VM DTMF Command—Switching to AA
→ VM DTMF Command—Switching to VM

 命令（默认）

切换到VM #6

切换到AA #8

录制留言 H

听取留言 H

注

H = 信箱号码

3. VM服务

a. 呼叫转送到VPS的一个信箱

当呼叫从一部分机被转送到VPS时，集团电话把相应分机的信箱号码发送到VPS。因此，来电者可以在

不知道信箱号码的情况下给被叫分机留言。

[FWD到VPS顺序选择]
如果分机用户设定FWD到VPS，任何来电都将被转送到VPS。当呼叫被转送时，甚至在VM服务方式

下，也能发送AA命令，以便来电能被接到一部分机，而不是一个信箱。这可以通过系统编程选择"AA"来
执行。

® 11.12.1  PBX Configuration—[3-12-1] Group—VM(DTMF) Group—System Settings—
Others—FWD to the VPS Sequence

参数
传送的命令

AA服务方式 VM服务方式

Answer by Mailbox（默

认）

切换到VM命令 + 录制留言命令

（#6 + H [H = 信箱号码]）
录制留言命令（H [H = 信箱号

码]）

AA 切换到AA命令（#8） 切换到AA命令（#8）

无 （未发送DTMF命令。用VPS的默认值工作。）

b. 截取路由到VPS的一个信箱

当一个中继线呼叫从一部分机上被截接到VPS时，集团电话就把相应分机的信箱号码发送到VPS。因

此，来电者可以在不知道信箱号码的情况下给被叫分机留言。

[截取路由到VPS顺序选择]
如果分机用户设定截取路由到VPS，被截取的中继线呼叫将被转接到VPS。
当呼叫被截取时，也能发送AA命令，甚至在VM服务方式，以便来电者可到达一部分机，而不是一个信

箱。这可以通过系统编程选择"AA"来执行。

® 11.12.1  PBX Configuration—[3-12-1] Group—VM(DTMF) Group—System Settings—
Others—Intercept Routing to the VPS Sequence
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参数
传送的命令

AA服务方式 VM服务方式

Answer by Mailbox 切换到VM命令 + 录制留言命令

（#6 + H [H = 信箱号码]）
录制留言命令（H [H = 信箱号

码]）

AA 切换到AA命令（#8） 切换到AA命令（#8）

None（默认） （未发送DTMF命令。用VPS的默认值工作。）

[ a) 和 b) 的示例]

102 VM 1 VM 2

VM X VM 3

VM DTMF

VPS AA

FWD

"#6" + "102"

 VM

c. 语音信箱（VM）转移键

通过在呼叫期间按语音信箱（VM）转移键，分机用户可以把一个呼叫转移到VPS的一个信箱，这样，

来电者就可以在所需分机的信箱中留言。当分机用户按此键并输入所需分机号码时，集团电话将呼叫转

移到VM群并用所需命令拨所需分机号码的信箱号码（在VPS应答呼叫后）。因此，来电者可以在不知道

信箱号码的情况下留言。

12.1.4  PBX Configuration—[4-1-4] Extension—Wired Extension—Flexible Button
→ Type
→ Extension Number (for Voice Mail Transfer)
12.3  PBX Configuration—[4-3] Extension—DSS Console
→ Type
→ Extension Number (for Voice Mail Transfer)
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[按VM转移键并输入分机号码的行为]

传送的命令

AA服务方式 VM服务方式

切换到VM命令 + 录制留言命令（#6 + H [H =
信箱号码]）

录制留言命令（H [H = 信箱号码]）

[示例]

VM 1 VM 2

VM X VM 3

VM (DTMF)

VPS ( AA )

( )

VM +  (103)

"#6" + "103"

VM

d. 听取录制的留言

如果VPS收到留言，VPS会设定相应电话上的留言待取功能，通知分机用户其信箱中有留言待取。分机

上的留言键的灯会亮起（® 2.20.1  留言待取），通知分机用户其信箱中有留言待取。当留言键灯亮起

时，按该键允许分机用户在不用拨诸如信箱号码等的情况下播放信箱中存储的留言。可以编程设定是集

团电话还是VPS来取消留言待取功能（例如：关闭留言键灯）。

® 11.12.1  PBX Configuration—[3-12-1] Group—VM(DTMF) Group—System Settings—
Others—Message Waiting Lamp Control

当选择集团电话时，在分机用户接入VPS后取消留言待取功能。当选择VPS时，在分机用户听取了存储

在信箱中的留言后取消留言待取功能。

[按留言键的行为]

传送的命令

AA服务方式 VM服务方式

切换到VM命令 + 听取留言命令

（#6 + H [H = 信箱号码]）
听取留言命令（ H [H = 信箱号码]）
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[示例]

VPS AA

"#6" + "   " "102"

102

VM

102

4. AA服务

如果VPS用AA服务转移呼叫，集团电话将利用预编程设定的DTMF状态信号把被叫目的地的状态告知VPS，
这样，VPS在没有听到系统信号音（例如：回铃音）的情况下就能确认分机的状态。

分配适合VPS设定的DTMF状态信号。

[DTMF状态信号和条件]

状态 条件 默认命令

RBT（回铃音） 集团电话正在使相应分机振铃。 1

BT（忙音） 被叫分机占线。 2

ROT（挂机重拨音） 所拨号码无效。 3

DND（DND音） 被叫分机已设定DND。（® 2.3.3  免打扰（DND）） 4

应答 被叫分机已应答呼叫。 5

FWD VM RBT（呼叫转

送到语音信箱回铃音）

被叫分机已设定FWD到VPS，并且集团电话正在呼

叫VPS的另一个端口。

6

FWD VM BT（呼叫转送

到语音信箱忙音）

被叫分机已设定FWD到VPS，并且VPS的全部端口

都忙。

7

FWD EXT RBT（呼叫转

送到分机回铃音）

集团电话正在呼叫所拨分机之外的分机。被叫分机

可以指定FWD或空闲分机搜索（® 2.2.1  空闲分机

搜索）。

8

确认（证实音） 集团电话收到证实，已在分机上成功地设定或取消

该功能（例如：留言待取）。

9

断开连接 来电已挂机。 #9

11.12.1  PBX Configuration—[3-12-1] Group—VM(DTMF) Group—System Settings
® VM DTMF Status Signal—Ringback Tone
® VM DTMF Status Signal—Busy Tone
® VM DTMF Status Signal—Reorder Tone
® VM DTMF Status Signal—DND Tone
® VM DTMF Status Signal—Answer
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® VM DTMF Status Signal—Confirm
® VM DTMF Status Signal—Disconnect
® VM DTMF Status Signal—FWD to VM Ringback Tone
® VM DTMF Status Signal—FWD to VM Busy Tone
® VM DTMF Status Signal—FWD to Extension Ringback Tone

[示例]

VPS 
 

102

1

3

4

"2"

2

A 一个来电到达VPS。VPS问候来电者："感谢

您致电Panasonic公司。如果您知道所要找的

人的分机号码…"。

B 来电拨分机号码（分机102）。
VPS将通过集团电话将呼叫转移到该分机。

C 如果无法接入该分机，集团电话将把分机的

DTMF状态信号（占线状态）发送到VPS。

D VPS收到DTMF状态信号并给来电者发送相应

的留言："对不起。分机正忙。请留言…"。

条件

• 语音信箱（VM）转移键

用VM群的浮动分机号码作为参数，可以把一个灵活键定制为语音信箱（VM）转移键。

• 可以指定VPS应答呼叫与集团电话将跟随ID发送到VPS之间的时间长度。

® 11.12.1  PBX Configuration—[3-12-1] Group—VM(DTMF) Group—System Settings— Timing—Waiting
Time before Sending Follow on ID

• 可以指定VPS使用AA服务将呼叫转移到集团电话与集团电话将DTMF状态信号发送到VPS之间的时间长度。

® 11.12.1  PBX Configuration—[3-12-1] Group—VM(DTMF) Group—System Settings— Timing—DTMF
Length for VM

• 可以选择信箱号码与分机号码相同，或信箱号码对每个分机号码和来电呼叫分配群（信箱接入ID）是可编

程的。

® 11.5.1  PBX Configuration—[3-5-1] Group—Incoming Call Distribution Group—Group
Settings—Miscellaneous— Programmed Mailbox No. (16 Digits)
® 12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Option 1—
Programmed Mailbox No.

• DTMF命令和DTMF状态信号的数字码间时间是可编程设定的。

11.12.1  PBX Configuration—[3-12-1] Group—VM(DTMF) Group—System Settings
® Timing—Inter-digit Time
® Timing—Waiting Time before Sending VM DTMF Status Signal

• 为了获得正常录音效果，在VM（DTMF）群的分机上自动设定数据线路安全。（® 2.11.5  数据线路安全）
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使用说明书（PC编程手册）参考

10.3  PBX Configuration—[2-3] System—Timers & Counters—Miscellaneous— Voice Mail (Caller from VM
to CO)—On-hook Wait Time (s)
11.5.1  PBX Configuration—[3-5-1] Group—Incoming Call Distribution Group—Group Settings—
Programmed Mailbox No. (16 Digits)
11.12.1  PBX Configuration—[3-12-1] Group—VM(DTMF) Group—System Settings
11.12.2  PBX Configuration—[3-12-2] Group—VM(DTMF) Group—Group Settings
12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Option 1—
Programmed Mailbox No.
12.1.4  PBX Configuration—[4-1-4] Extension—Wired Extension—Flexible Button

→ Type
→ Extension Number (for Voice Mail Transfer)

12.3  PBX Configuration—[4-3] Extension—DSS Console
→ Type
→ Extension Number (for Two-way Record)

使用说明书（功能手册）参考

2.1.1.6  截取路由

2.3.2  呼叫转送（FWD）

2.12.1  呼叫转移

2.21.2  灵活键

2.28.1  语音信箱（VM）群

使用说明书（用户手册）参考

1.11.5  如果连接一个语音处理系统
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2.28.3  语音信箱DPT（数字）集成

说明

支持DPT（数字）集成的Panasonic VPS（例如：KX-TVM200）可以紧密集成方式连接到本集团电话。

当通过集团电话的DPT端口连接VPS时，可以使用DPT（数字）集成功能。

功能说明

1. 自动配置—Quick Setup
集团电话将其分机号码和来电呼叫分配群的浮动分机号码告知VPS，以便VPS能用这些数据自动创建信箱。

2. 呼叫转送到VPS的一个信箱

如果分机用户设定FWD到VPS，来电就被转送到VPS。（® 2.3.2  呼叫转送（FWD））集团电话将转送分机

的信箱号码发送至VPS。
因此，来电者可以在不知道信箱号码的情况下在分机的信箱中留言。

3. 截取路由到VPS的一个信箱

如果分机用户设定截取路由到VPS，被截取的中继线呼叫将被转接到VPS。（® 2.1.1.6  截取路由）如果通

过系统编程允许"Intercept to Mailbox for Call to Extension"设定，集团电话将把被截取分

机的信箱号码发送至VPS。
如果VPS被设置为来电呼叫分配（ICD）群并且通过系统编程启用"Overflow to Mailbox for Call
to ICD Group"设置，集团电话会将ICD群的信箱号码发送到VPS。
因此，来电者可以在不知道信箱号码的情况下在相应的信箱中留言。

如果任何一个设置被禁用，相应类型的呼叫会被VPS中的中继线服务（例如，自动值机员）处理。

→ 11.11.1  PBX Configuration—[3-11-1] Group—VM(DPT) Group—System Settings— Intercept to
Mailbox for Call to Extension

→ 11.11.1  PBX Configuration—[3-11-1] Group—VM(DPT) Group—System Settings— Overflow to
Mailbox for Call to ICD Group

4. 语音信箱（VM）转移键

通过按VM转移键并输入分机的号码，分机用户可以将呼叫转移到分机的信箱中。转移的主叫方随后可以在

信箱中留言。分机用户还可以在其他时候使用VM转移键，如下所示：

a. 可以在分机空闲时按VM转移键呼叫分机的信箱并聆听语音信箱留言。即使留言待取灯没有亮起也可以

使用此功能。

b. 在呼叫呼入时按VM转移键会将该呼叫转接到被叫分机的信箱。此功能在被叫分机用户不想应答呼叫时

非常有用。

c. 如果您呼叫分机时另一方没有应答，按VM转移键会将呼叫转移到被叫分机的信箱以留言。当被叫分机

占线或设为免打扰时也可以使用此功能。

5. 转移重呼到VPS的一个信箱

如果呼叫通过VPS的自动值机员（AA）服务被转移至某一分机，而且呼叫在预编程设定的转移重呼时间内

未得到应答，集团电话会将转移目的地分机的信箱号码发送给VPS。因此，来电者可以在不知道信箱号码

的情况下在分机的信箱中留言。要使用此功能，应通过系统编程允许"Transfer Recall to Mailbox
（转移重呼至信箱）"设定。

® 10.3  PBX Configuration—[2-3] System—Timers & Counters—Dial / IRNA / Recall / Tone—
Recall—Transfer Recall (s)
® 11.11.1  PBX Configuration—[3-11-1] Group—VM(DPT) Group—System Settings— Transfer Recall
to Mailbox
® [201]转移重呼时间

6. 听取录制的留言（信箱直接接入）
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如果VPS收到留言，VPS将在相应电话上设定留言待取功能（例如：点亮留言键的灯，以及在6行显示PT
的显示器上显示留言待取数目）作为通知。（® 2.20.1  留言待取）因此，VPS通知分机用户其信箱中有留

言待取。当留言键灯亮起时，按此键允许分机用户在没有拨诸如信箱号码等的情况下播放信箱中存储的留

言。

当分机用户在其分机上拨VM（DPT）分机端口的分机号码或VM（DPT）群的浮动分机号码时，可以不拨

信箱号码就听取信箱中存储的留言（信箱直接接入）。可以通过VPS上的信箱设定停用此功能。

7. VPS中继线服务和来电的自动时间方式通知*1

多个租户可以共享一个VPS；每个租户都不需要专用VPS端口。如果中继线呼叫来电的目的地是一个VM
（DPT）群，集团电话将把VM中继线群号码和分配给该呼叫的租户的时间方式（白天/午餐/休息/夜间）

（® 5.1.4  定时服务）发送给VPS。因此，VPS可以把指定留言（公司问候）发送给来电者。

相应的VM中继线群号码和租户号码通过如下中继线呼叫来电的设定来确定：

a. DIL/TIE：各中继线端口的设定（® 2.1.1.2  外线直接到分机振铃的功能（DIL），4.3.1  TIE线路业务）

18.2  PBX Configuration—[10-2] CO & Incoming Call—DIL Table & Port Settings
® Tenant Number
® VM Trunk Group No.

b. DID/DDI：各DID/DDI位置号码的设定（® 2.1.1.3  直接向内拨号（DID）/直接拨入（DDI））
18.3  PBX Configuration—[10-3] CO & Incoming Call—DDI / DID Table
® Tenant Number
® VM Trunk Group No.

[示例]
对于DID呼叫：
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每个位置号码都可以有其自己的VM中继线群号码（留言号码）和租户号码。

1

2

:

105

102
        

:

123-4567

123-2468

:

0001

0002

:

DID Destination

Day Lunch Break Night

Location

No.
DID No. DID Name

John White

Tom Smith

:

1

3

:

Tenant

No.

1 

2 

3

4        

5 

6

7

8

 :

Day

Lunch

Break

Night

Day

Lunch

Break

Night

    :

1

2

Trunk Group No. Company Greeting No. Incoming Call Service

Custom Service 11

Custom Service 29

Custom Service 31

Custom Service 12

Custom Service 21

Custom Service 15

Custom Service 42

Custom Service 30

                  ::

· ·

· · 

· ·

· ·      

· ·

· ·

· ·

· ·

· ·

· ·

100

100
        

:

105

102
        

:

100

100
        

:

VM Trunk 

Group No.

[DID ]

[VPS — ]

解释：

DID呼叫直接到达VM（DPT）群或通过截取路由功能到达。根据[DID编程示例]和[VPS编程—中继线群分

配的编程示例]，来电者将听到VPS的相应公司问候。
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预编程设定的租户的时间方式（白天/午餐/休息/夜间）被应用于DID目的地和公司问候号码。

1

123-4567

A

3

B

105 102

VPS

500

123-2468

 · VM 1

 · 

 · VPS 2

 · 

8. 至VPS的来电识别通知

当收到中继线呼叫时，集团电话将来电识别号码/名称发送到VPS。
9. 至VPS的DID号码通知

当收到带有DDI/DID号码的中继线呼叫时，集团电话会把DDI/DID号码发送到VPS。即使呼叫是被截取路由

等功能转接后到达VPS的，该号码也会被发送到VPS。
10.至VPS的状态通知

在呼叫被VPS转接后，集团电话就把被转接分机的状态（例如：占线）发送到VPS。
11.用VPS广播

VPS可以使用已录制的留言执行广播功能。（® 2.17.1  广播）

12.现场呼叫屏蔽（LCS）
当来电者正在留言时，PT用户可以监听其自己的信箱，而且如有需要，还可以按LCS键应答呼叫。当来电

者正在信箱中留言时，可以用两种方法监听。每个PT用户可以通过个人编程选择其中一种（现场呼叫屏蔽

方式设定）。

免提方式：用户可以通过内置扬声器自动监听呼叫。

专用方式：用户将听到警告音。若要监听电话，用户可以用话筒摘机、按监听键或免提键。

→ 12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Option 4—
LCS Answer Mode

13.双向录音到VPS
通过电话交谈时，PT用户可以将通话录制到其自己的信箱或另一个信箱中。

使用双向录音键可录制到自己的信箱中。使用双向转移键可录制到他人的信箱中。
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注

对双向电话通话进行录音前，应当通知对方通话将被录音。

14.由集团电话控制的VPS数据*1

集团电话控制VPS的日期和时间设定。

15.由VM设定远程FWD*1

可以使用VPS对分机的FWD设定进行编程。
*1 取决于VPS的软件版本，此功能可能不受支持。

条件

[现场呼叫屏蔽（LCS）]
• ISDN分机和SIP分机无法使用该功能。

• 如果将一部SLT并联连接到一部PT，并且以专用方式启动PT的LCS，则PT和SLT两者在空闲状态时均可以

用来监听呼叫。SLT将振铃以表示有留言正在录制。摘机后SLT就可以监听呼叫。若要截取呼叫，可以按闪

断键或拍叉簧。（® 2.11.10  并联电话）

• LCS键
可以将一个灵活键定制为LCS键。

• 分机个人识别号码（PIN）

为了防止未经授权的监听，建议LCS用户指定一个分机PIN。设定LCS时将需要此PIN。（® 2.24.1  分机个

人识别号码（PIN））如果用户忘记了PIN，被指定为管理员的分机可以清除它。

• 通过个人编程（设定LCS方式 [在应答后]），可以编程设定每部分机在呼叫被截取后结束录音或继续录制通

话。

® 12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Option 4—
LCS Recording Mode

[双向录音到VPS]
• 双向录音/双向转移键

可以把一个灵活键定制为双向录音键或双向转移键。可以给双向转移键分配一个分机号码，这样，可以把

它用作指定分机信箱的单键录音键。（单键双向转移键）。

• 当全部VPS端口都忙时：

a. 按双向录音键将发送警告音。

b. 按双向转移键后再按分机号码将发送警告音。

[VM转移键]
• 用VM群的浮动分机号码作为参数，可以把一个灵活键定制为VM转移键。

• 如果将两个或更多VPS连接到集团电话，VM转移键将访问指定为VM转移键参数的VM组的VPS。

使用说明书（PC编程手册）参考

10.3  PBX Configuration—[2-3] System—Timers & Counters—Dial / IRNA / Recall / Tone— Recall—Hold
Recall (s)
11.11.1  PBX Configuration—[3-11-1] Group—VM(DPT) Group—System Settings
11.11.2  PBX Configuration—[3-11-2] Group—VM(DPT) Group—Unit Settings
12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Option 1

→ Programmed Mailbox No.
12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Option 4
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→ LCS Recording Mode
→ LCS Answer Mode

12.1.4  PBX Configuration—[4-1-4] Extension—Wired Extension—Flexible Button
→ Type
→ Extension Number (for Two-way Record)
→ Extension Number (for Two-way Transfer)
→ Extension Number (for Voice Mail Transfer)
→ Ext No. of Mailbox (for Two-way Transfer)

12.3  PBX Configuration—[4-3] Extension—DSS Console
→ Type
→ Extension Number (for Two-way Record)
→ Extension Number (for Two-way Transfer)
→ Extension Number (for Voice Mail Transfer)
→ Ext No. of Mailbox (for Two-way Transfer)

13.1  PBX Configuration—[5-1] Optional Device—Doorphone— VM Trunk Group No.
18.2  PBX Configuration—[10-2] CO & Incoming Call—DIL Table & Port Settings—DIL

→ Tenant Number
→ VM Trunk Group No.

18.3  PBX Configuration—[10-3] CO & Incoming Call—DDI / DID Table
→ Tenant Number
→ VM Trunk Group No.

使用说明书（PT编程手册）参考

[201]转移重呼时间

使用说明书（功能手册）参考

2.21.2  灵活键

2.28.1  语音信箱（VM）群

5.5.7  灵活编号/固定编号

使用说明书（用户手册）参考

1.11.5  如果连接一个语音处理系统

3.1.2  编程方式设定

4.1.2  管理员编程
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2.29  E1线路业务功能

2.29.1  E1线路业务

说明

E1线路作为中继线或专用线路以2.048 Mbps传输速度载送30个64 kbps语音信道。语音通过脉冲代码调制

（PCM）而数字化。

1. 信道类型

E1卡仅支持DR2（数字系统R2）。仅可将DR2分配给E1卡的30个信道。

2. E1功能

下表显示每个信道类型的可用功能：

[功能表]

信道类型
(1) (2) (3) (4) (5)

TIE DID DIL ANI 话费资料

DR2  ü ü ü*1 ü

ü：可用
*1 接收拨号方式应该是MFC-R2。

[解释]

表中的编号 功能 说明

(1) 直接向内拨号（DID） 参考DID功能。（® 2.1.1.3  直接向内拨号（DID）/直接

拨入（DDI））

(2) 外线直接到分机振铃的功

能（DIL）
参考DIL功能。（® 2.1.1.2  外线直接到分机振铃的功能

（DIL））

(3) 号码自动识别（ANI） 去电ANI：
将来电号码发送到E1线路上。发送方法与ISDN CLIP服
务相同。（® 4.1.2.2  呼叫/连接线路识别显示（CLIP/
COLP））

来电ANI：
接收来自E1线路的来电号码。当收到ANI号码时，可以

像处理来电显示号码一样处理该号码。（® 2.19.1  来电

显示）

(4) 话费资料 在通话过程中可以接收话费计费表脉冲。（® 2.22.3  话
费服务）

条件

• 如果将E1线路用作中继线，则信道类型取决于与电话公司签订的合同。
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• 如果选择"MFC-R2"作为拨号方式，当使用E1线路进行中继线呼叫时，总是由集团电话而不是电话公司发

送拨号音。

使用说明书（PC编程手册）参考

9.32  PBX Configuration—[1-1] Configuration—Slot—Port Property—E1 Port
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2.30  其他功能

2.30.1  背景音乐（BGM）

说明

在挂机和空闲时，PT用户可以通过内置扬声器听取BGM。BGM有以下声源可用：

• 外部音乐源

• 内部音乐源

BGM—外部：

BGM也可以在办公室通过外部广播机播放，指定为管理员的分机可以打开和关闭BGM。

条件

[BGM]
• 硬件要求：用户提供的音乐源（当分配了外部音乐源时）

• 摘机时，通过PT播放的音乐中断。

• 各用户可以设定/取消BGM，也可以选择音乐源。

• 通过系统编程，可以指定能够同时执行BGM功能的IP-PT的最大数目。更改此设定可能会影响主板可以同

时进行的IP分机和IP中继线呼叫的数量。

[BGM—外部]
• 硬件要求：用户提供的外部广播机

• 可以按以下优先权使用外部广播机：

TAFAS ® 广播 ® BGM
(® 2.17.1  广播，2.17.2  从任意用户电话应答中继线上的呼叫（TAFAS）)

使用说明书（安装手册）参考

4.10  连接外围设备

使用说明书（PC编程手册）参考

9.2.2  PBX Configuration—[1-1] Configuration—Slot—System Property—Site—VoIP-DSP Options— IP
Extension Count of BGM
10.2  PBX Configuration—[2-2] System—Operator & BGM
10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features

→ External BGM On / Off
→ BGM Set / Cancel

10.11.1  PBX Configuration—[2-11-1] System—Audio Gain—Paging/MOH
→ Internal MOH—MOH1-2 (Music On Hold 1-2)

13.2  PBX Configuration—[5-2] Optional Device—External Pager
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使用说明书（用户手册）参考

1.9.8  接通背景音乐（BGM）

2.1.4  接通外部背景音乐（BGM）
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2.30.2  外播留言（OGM）

说明

指定为管理员的分机（管理员分机）可以为以下功能录制外播留言（OGM）：

功能 用途与参考

直接拨入系统接入（DISA） 当呼叫到达DISA线路时，来电将听到留言。

® 2.16.1  直接拨入系统接入（DISA）

排队功能 如果在来电呼叫分配群的排队时间表上做了指定，任何正在排队等候

的来电都会听到留言。

® 2.2.2.4  排队功能

定时提醒 当应答定时提醒警报时，用户将听到留言。

® 2.24.4  定时提醒

条件

• 硬件要求

– 如果未安装任何DSP卡：

OGM功能和SVM功能共用2条信道。如果OGM功能或SVM功能使用2条信道，则无法记录或播放

OGM。可以为OGM保存总共64条留言（总用大约20分钟）。

– 如果装有任选DSP卡：

为OGM功能保留64条信道。可以为OGM保存总共64条留言（总共大约20分钟）。

VoIP-DSP卡 OGM的可用信道 OGM留言的最大数量 总记录时间

未安装 2 64 大约20分钟

安装 64 64 大约20分钟

– 即使您在未安装任何DSP卡时记录OGM，在集团电话中安装DSP卡后仍可使用记录的OGM。

• DSP资源占用

播放OGM需要一定数量的DSP资源。如果所有DSP资源都在使用，则无法进行此操作。为确保最低的性能

水平，可为OGM播放预留DSP资源。（® 5.5.4  DSP资源占用）

• 单个留言的长度没有限制，但是最长录制时间（所有留言组合）约为20分钟。

• 可以给多个来电同时播放相同的留言。

• 录音方法

a. 通过分机电话录制语音留言

b. 通过外部音乐端口将预先录制的语音留言从外部声音源转移到集团电话。

• 录制留言后，管理员分机也可以播放留言进行确认。

• 在预编程设定的时间中录制留言之前，或在清除存有所需留言的浮动分机号码上存储的预录留言过程中，

会给管理员分机发送进展音。会应用较长的一个。

• 当管理员试图录制留言时，如果留言通道在使用中，他会听到回铃音。当所有留言端口都变得空闲时，他

会听到进展音，持续预编程设定的时间。

之后，集团电话就会自动进入录音方式。
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• 将留言复制到PC和从PC复制留言

通过Web维护控制台，可以将留言复制到PC以及从PC复制留言。

– 以WAV（G.711a/µ）格式将留言下载至PC。

– 从PC上传的留言必须为以下格式之一：WAV（线性PCM）或WAV（G.711a/µ）。

使用说明书（安装手册）参考

4.3.3  DSP S卡（KX-NS5110）、DSP M卡（KX-NS5111）、DSP L卡（KX-NS5112）
5.4.1  简易设置指示

使用说明书（PC编程手册）参考

7.2.5  Utility—File—Message File Transfer PC to PBX
7.2.6  Utility—File—Message File Transfer PBX to PC
10.3  PBX Configuration—[2-3] System—Timers & Counters—DISA / Door / Reminder / U. Conf—
DISA—Progress Tone Continuation Time before Recording Message (s)
10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features— OGM Record / Clear /
Playback
11.5.2  PBX Configuration—[3-5-2] Group—Incoming Call Distribution Group—Queuing Time Table—
Queuing Sequence—Sequence 01–16
13.3.2  PBX Configuration—[5-3-2] Optional Device—Voice Message—DISA Message— Floating Extension
Number

使用说明书（PT编程手册）参考

[631]排队时间表顺序

[730]外播留言（OGM）浮动分机号码

使用说明书（功能手册）参考

2.16.3  内装简化语音留言（SVM）

5.5.8  浮动分机

6.1  系统资源的容量

使用说明书（用户手册）参考

2.1.5  录制外播留言（OGM）
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章节  3
统一消息系统
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3.1  统一消息系统管理

3.1.1  统一消息系统概述

说明

集团电话具有内置消息系统，可为其分机提供语音信箱。统一消息系统还可为外线来电者提供语音向导，将他

们带到所需目的地或用户的信箱，他们可在此留下语音留言。

用户

统一消息系统中存在以下三种类型的用户：

• 用户（最多：500）
用户为其分机分配了信箱的分机用户。用户可播放其信箱中保存的留言、为其他用户留言、录制发送至多

位用户（包括外线用户）的留言、录制外播留言等。

• 消息管理员（最多：1）
消息管理员负责一般传送信箱以及进行某些设置，如录制提示和改变通知设定。通过系统编程，还可将消

息管理员权限分配给用户。

• 系统管理员（最多：1）
系统管理员负责整个统一消息系统并可访问众多设定。系统管理员的职责包括设置信箱、分配COS设定和

改变服务方式。

UM端口和UM群

集团电话初始*1提供两个端口（称为UM端口）供统一消息系统使用。一个端口作为统一消息系统的通路，这样

当呼叫被带到统一消息系统时，需要一个可用UM端口。集团电话的端口数可以扩展至最多24个。

集团电话的UM端口属于集团电话的UM群。此群具有浮动分机号码，可以用作来电呼叫、转接呼叫、转移呼叫

等的目的地。当UM群的浮动分机号码收到来电呼叫时，呼叫会从最小的UM端口号码开始搜索。一旦找到可用

的端口，分配至端口的服务、中继线等就会确定如何处理呼叫（® 3.2.1.39  服务群）。服务功能包括允许来电

者在用户信箱中留下语音留言的语音信箱服务（® 3.2.1.45  语音信箱服务）和将来电者带到用户分机的自动

值机员（® 3.2.1.3  自动值机员（AA））。
*1 安装VoIP DSP卡等任选设备时，即使未扩展端口数量，仅有2条信道可用。

UM

UM

1

UM

2

UM

3

UM

4

UM

5

× × ×

条件

• 由于统一消息系统与集团电话同属一个系统，所以统一消息系统的数据与集团电话设定相配。有关详情，

请参阅使用说明书（安装手册）中的"5.9  用户配置"。
• 要使用统一消息系统，需要以下任选设备：
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– 激活密钥：KX-NSF990
– VoIP DSP卡：KX-NS5110 (S)
– SD存储卡：取决于留言记录时间。

KX-NS3134 (XS)、KX-NS3135 (S)、KX-NS3136 (M)
• 要扩展端口数量或UM功能，各功能和信箱都需要激活密钥（依照信箱数量）。有关详情，请参阅使用说明

书（安装手册）中的"3.1.1  激活密钥的类型和最大数目"。
• 每个端口分配一个分机号码。

® 9.6  PBX Configuration—[1-1] Configuration—Slot—UM Port Property— Extension Number
• 当搜索可用UM端口时，集团电话会忽视任何适用于端口的呼叫转送或免打扰设定（® 2.3  呼叫转送

（FWD）/免打扰（DND）功能）。

可以直接呼叫UM群的端口。如果将呼叫直接送到群内端口，则可以将特定功能（例如，呼叫转送）应用至

该端口。

• 可以通过系统编程设定当群中的全部端口都占线时呼叫是否排队。如果通过系统编程停用排队，呼叫将被

转接到UM群的第一个成员分机的截取目的地。

• DSP资源占用

连接至统一消息系统（包括使用双向录音等功能）需要一定数量的DSP资源。如果所有DSP资源都在使用，

则无法进行此操作。为确保最低的性能水平，可为统一消息操作预留DSP资源。（® 5.5.4  DSP资源占用）

小心

双向录音（® 3.2.1.4  管理员自动双向录音，® 3.2.2.30  双向录音/双向转移）的预留资源会预留必要

数量的双向录音专用UM端口。例如，如果2个UM端口（默认）可用且您为2个双向录音会话预留资源，

则会为双向录音预留两个UM端口，且统一消息系统无法用于其他用途。

UM

UM

1

UM

2

为在此例中提供统一消息系统的接入，必须增加UM端口数或减少为双向录音预留的资源数。

• 安装KX-NSU104（统一消息激活密钥）可增加集团电话可用的UM端口数量（最多：24）。

使用说明书（安装手册）参考

4.3.2  SD存储XS卡（KX-NS3134）、SD存储S卡（KX-NS3135）、SD存储M卡（KX-NS3136）
5.9  用户配置

使用说明书（PC编程手册）参考

9.6  PBX Configuration—[1-1] Configuration—Slot—UM Port Property
10.5  PBX Configuration—[2-5] System—Holiday Table
10.9  PBX Configuration—[2-9] System—System Options—Option 9
11.7  PBX Configuration—[3-7] Group—UM Group
23.4  UM Configuration—[4-4] Service Settings—Holiday Table
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使用说明书（用户手册）参考

1.8  使用统一消息功能
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3.1.2  系统管理

说明

系统管理员可以使用Web维护控制台进行系统管理（编程、诊断、系统提示管理等）。有关详情，请参阅使用

说明书（PC编程手册）。

3.1.2.1  自动配置信箱

说明

自动批量关联分机号码、信箱和用户配置文件。如果不存在号码与分机号码相同的信箱，则会自动创建一个。

共有2种方式可用于自动创建信箱。

使用说明书（PC编程手册）参考

20.1.3  UM Configuration—[1-3] Mailbox Settings—Auto Configuration

使用说明书（安装手册）参考

5.11  自动配置信箱

3.1.2.2  客户服务生成器

说明

允许系统管理员使用Web维护控制台直观地创建客户服务。使用此功能可以编辑和安排每个客户服务及其功

能。

使用说明书（PC编程手册）参考

23.3  UM Configuration—[4-3] Service Settings—Custom Service

使用说明书（功能手册）参考

3.2.1.15  客户服务

3.1.2.3  默认信箱模板

说明

在系统管理员创建连续信箱时用作模板。能使系统管理员将基本设定（信箱参数、留言待取通知、外部留言传

送、自动转送）同时应用至多个信箱。

使用说明书（PC编程手册）参考

20.1  UM Configuration—[1] Mailbox Settings

使用说明书（功能手册） 319

3.1.2 系统管理



3.1.2.4  密码管理

说明

允许系统管理员清除用户密码（从而可以分配新的密码）。

使用说明书（用户手册）参考

管理员操作

2.2.1  系统管理员功能—  设置信箱

3.1.2.5  系统备份/恢复

说明

允许系统管理员备份或恢复以下数据作为单独文件：系统提示、信箱提示和信箱留言。可以2种方式备份数据：

• 手动备份：手动备份指定的数据。

备份数据可保存至以下目的地：

– 外部USB存储设备

– NAS
– 您运行Web维护控制台的本地PC

• 计划备份：在指定的时间自动备份指定的数据。备份数据可保存至外部USB存储设备或NAS。当启用计划

备份时，可以设定以下参数：

– 设定是否备份仅在指定时间内收到的留言。

– 设定是否仅在信箱的剩余容量达到一定水平时备份留言。

– 设定是否在备份后从信箱删除留言。

– 设定是否备份所有留言或仅备份旧留言。

备份历史记录中可以查看备份信息（说明、完成状态、日期和时间、以及总经过时间）。

条件

• 使用计划备份功能需要KX-NSU003（留言备份激活密钥）。

• 如果将数据备份至本地PC，则无法备份大于100 MB（长约3.5小时）的个别留言。但是，即使无法备份某

些留言，仍会正常备份所有其他数据。

• 如果将数据保存至USB存储设备，请务必在从集团电话拔出设备前将其卸载以免数据丢失或损坏。

® 4.1.5  Status—Equipment Status—USB
• KX-TVM数据恢复

此功能可用于将KX-TVM VPS语音数据导入集团电话的统一消息系统语音数据。

使用说明书（安装手册）参考

5.3  启动Web维护控制台—转换KX-TDA100 KX-TDA200或KX-TE系列系统数据以便使用KX-NS300

使用说明书（PC编程手册）参考

6.9  Tool—UM Data Backup
6.10  Tool—UM Data Restore
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3.1.2.6  系统报告

说明

系统管理员可使用多种系统报告监控操作状态。系统管理员可以打印或导出系统报告。某些报告可以表格形式

或图表形式打印。

可以生成以下报告：

• 信箱信息报告

• 呼叫帐户报告（UM分机的群呼叫）*1*2

• 呼叫帐户报告（信箱的群呼叫）*1*2

• UM分机使用报告*1*2

• 内存使用报告*1*2

• 信箱使用报告*1*2

• 传真转移报告*2

• 呼叫处理统计报告*2

• 客户服务报告*2

• 留言状态报告

• 用户设置报告

• 安全信息报告

• 每小时统计报告*2

*1 可以表格形式或图表形式打印此报告。
*2 此报告可以设为自动删除。

使用说明书（PC编程手册）参考

7.5  Utility—Report

3.1.2.7  系统安全

说明

保护统一消息系统免遭未经授权编程和/或使用。默认情况下，在系统管理员启用相关设定并设定密码前，系统

管理员和消息管理员无法从其电话接入系统。系统管理员还可选择设定用户信箱的默认密码。如果启用此设

定，则信箱创建时会自动分配默认密码。

使用说明书（PC编程手册）参考

26.1  UM Configuration—[7] System Security
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3.2  系统和用户功能

3.2.1  系统功能

说明

系统管理员和消息管理员使用分机电话，或系统管理员使用Web维护控制台，可以进行系统管理。

由系统管理员编程的项目示例包括：

• 创建、编辑、删除和复位信箱

• 服务等级（COS）设定

• 更改公司问候语

由信息管理员编程的项目示例包括：

• 一般传送信箱维护

• 留言通知设定

• 录制/删除留言（系统提示、公司问候语、客户服务菜单、系统来电者姓名等）

3.2.1.1  交替分机群

说明

是需要与其他分机不同的呼叫转移序列的分机群并因此被分入单独的群。

使用说明书（PC编程手册）参考

23.1  UM Configuration—[4-1] Service Settings—Caller ID / PIN Call Routing—23.2  UM Configuration—[4-2]
Service Settings—Parameters— Alternate Extension

3.2.1.2  自动转送

说明

经过指定时间后将未播放的留言从一个信箱移动或复制到另一个信箱。一条留言最多可以转送9次，转送会停

止在第9个指定信箱。注意，您无法将留言自动转送至信箱群，且无法转送标记为"私人"的留言。另外，留言永

远不会转送至原始的留言发送者。

使用说明书（PC编程手册）参考

20.1.2  UM Configuration—[1-2] Mailbox Settings—Full Setting—External MSG Delivery/Auto FWD/Personal
Custom Serv

3.2.1.3  自动值机员（AA）

说明

允许您转接来电呼叫而不使用话务员。可按以下方式之一将来电者转接至所需分机：

a. 直接拨打分机号码
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b. 使用电话上的拨号键拼写所需用户的姓名（® 3.2.1.16  按姓名拨号）

c. 收听所有用户姓名并选择所需分机（® 3.2.1.25  列表所有姓名）

自动值机员（AA）会应答来电呼叫并基于来电者拨打的号码将其转接至所需分机。

当将来自分机的呼叫转移至其他用户时，呼叫转移前来电者会听到"正在将您转接（姓名）"。当未录制被叫方

姓名时，无法使用此功能。

可按白天、夜间、午餐和休息时间方式编程设定服务，且端口和中继线服务均适用。

来电者会在以下情况下转到自动值机员服务：

a. 中继线或端口的来电呼叫服务设为"自动值机员服务"（® 22.1  UM Configuration—[3-1] UM Extension /
Trunk Service—Service Group— Day, Night, Lunch, and Break Mode - Incoming Call Service）。

b. 假日的呼叫服务设为"自动值机员服务"
® 23.4  UM Configuration—[4-4] Service Settings—Holiday Table— Service

c. 他们在呼叫期间按下[#8]（自动值机员服务接入命令）。

d. 客户服务或个人客户服务选项设为将来电者转移至自动值机员服务。

® 20.1.2  UM Configuration—[1-2] Mailbox Settings—Full Setting—External MSG Delivery/Auto FWD/
Personal Custom Serv
® 23.3  UM Configuration—[4-3] Service Settings—Custom Service

e. 用户将来电者转移到自动值机员服务。

使用说明书（PC编程手册）参考

23.2  UM Configuration—[4-2] Service Settings—Parameters

3.2.1.4  管理员自动双向录音

说明

可以将呼至指定分机的呼叫和来自指定分机的呼叫自动记录至信箱。分机会分配一位监控员，他可通过Web维
护控制台收听记录的留言。对于各目标分机，可记录以下类型的呼叫：

• 内线（内部）电话

• 中继线（外部）电话

• 仅来电ICD群电话（即，当记录中继线电话时，记录仅限于来电ICD群电话）

已记录通话视为专用信箱的新留言。

通过系统编程可以设定记录电话的时间。

使用自动双向录音，管理员可以接收电子邮件通知。有关详情，请参阅"5.4.4  管理员的电子邮件通知"。

注

• 您应当通知对方通话将被录音。

• 无论Default Password for New Mailboxes设置如何，自动双向录音信箱都没有默认密码。建议设置密

码。

条件

• 使用此功能需要KX-NSU002（双向录音控制激活密钥）。

• 指定为录音目的地的信箱变为专用的自动双向录音信箱。无法通过其他方式将留言记录至这些信箱，且用

户无法登录这些信箱。

• 还会自动记录转送的呼叫和从保留状态恢复的呼叫。但是，不会记录会议电话。
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• 通过QSIG（TIE）连接的2个分机之间的通话作为外部电话处理（无论KX-NSN002 [QSIG网络激活密钥]是
否安装）。要记录这些类型的电话，必须将中继线（外部）电话选为可记录电话类型之一。

• 信箱达到其容量时，录音会自动停止。请删除较旧的留言以重新使用此功能。

• 如果已将双向录音键分配至启用的分机，则该键会在录音期间闪烁。但是，该键无法用于取消本功能。

• 通话正在被录音的分机无法成为以下功能的目标：

– 主管遇忙优先插入（® 2.10.2  主管遇忙优先插入）

– 耳语OHCA（® 2.10.4.4  耳语OHCA）
• 当目标分机和对方均为ISDN分机时，不会进行自动录音。

• 可通过系统备份/恢复（® 3.1.2.5  系统备份/恢复）备份使用此功能记录的通话。

使用说明书（PC编程手册）参考

7.10  Utility—Automatic Two-way Recording
8.3  Users—Automatic Two-way Recording
12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—UM— Two-way
Recording

使用说明书（功能手册）参考

5.4.4  管理员的电子邮件通知

使用说明书（用户手册）参考

管理员操作

3.2.1  用户编程—  管理员自动双向录音

3.2.1.5  广播留言

说明

允许系统管理员将相同的留言同时传送至所有用户的信箱。播放过程中，广播留言的优先级高于其他常规或紧

急留言，但是其他留言作为常规留言处理。不会将它们作为"紧急"留言处理；如果在通知计划中将通知类型选

为"仅紧急留言"，则收到广播留言时不会激活留言待取通知。

条件

• 仅系统管理员可使用此功能。

使用说明书（用户手册）参考

管理员操作

2.2.1  系统管理员功能—  广播留言
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3.2.1.6  呼叫服务

说明

包括一系列来电和去电呼叫服务。

来电呼叫服务：自动值机员服务、语音信箱服务、面试服务、客户服务。

去电呼叫服务：留言待取通知和外部留言传送。

使用说明书（PC编程手册）参考

22.1  UM Configuration—[3-1] UM Extension / Trunk Service—Service Group
→ Day, Night, Lunch, and Break Mode - Incoming Call Service
→ Day, Night, Lunch, and Break Mode - Incoming Call Service Parameter
→ Day, Night, Lunch, and Break Mode - Incoming Call Service Prompt

3.2.1.7  呼叫转移到外线

说明

从以下服务启用统一消息系统以将呼叫转移到中继线：

• 客户服务

• 呼叫转移服务

• 个人客户服务

• 来电号码回叫

• 接通服务

条件

• 当COS编程不允许将中继线来电呼叫转移到中继线时，无法使用此功能。

使用说明书（PC编程手册）参考

21.1  UM Configuration—[2] Class of Service—Call Transfer— Call Transfer to Outside
24.4  UM Configuration—[5-4] System Parameters—Parameters—Transfer to Outside

使用说明书（用户手册）参考

用户操作

1.8.5  转移呼叫—  分配和取消呼叫转移到外线的电话号码

3.2.1.8  来电号码呼叫路由选择

说明

允许系统管理员储存最多200个电话号码并为每个时间方式（白天、夜间、午餐和休息）将特定的目的地（分

机、信箱、信箱群或客户服务）分配至各电话号码。当收到与已储存电话号码相匹配的来电显示信息时，自动
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将呼叫转接到其目的地。还会将"私人"（未收到来电者号码时）、"区域外"（来电者从不支持来电显示的区域呼

叫时）和"长距离"（来电者进行长距离呼叫时）的呼叫转接到特定的分机、信箱或客户服务。

条件

• 通过此功能传送呼叫时，不会为来电者播放公司问候语。

使用说明书（PC编程手册）参考

23.1  UM Configuration—[4-1] Service Settings—Caller ID / PIN Call Routing

3.2.1.9  来电显示屏蔽

说明

当将呼叫从预编程来电者转移到分机时，允许统一消息系统通知来电者的姓名（例如，"您有来自[来电者姓名]
的电话。"）。必须事先记录来电者姓名。可按各用户（来电者姓名通知—个人）或为整个系统（来电者姓名通

知—系统）录制来电者姓名。

使用说明书（PC编程手册）参考

21.1  UM Configuration—[2] Class of Service—Call Transfer— Caller ID Screen

使用说明书（功能手册）参考

3.2.1.10  来电者姓名宣布

使用说明书（用户手册）参考

管理员操作

2.2.1  系统管理员功能—  设定服务等级（COS）参数

3.2.1.10  来电者姓名宣布

说明

允许您储存电话号码并录制各电话号码的来电者姓名。当从一个预编程来电者播放其信箱中的留言时、当系统

将呼叫从一个预编程来电者转接到分机时（来电显示屏蔽）、以及当系统通过内线广播分机时（内线广播），会

通知来电者姓名。

有2种类型的来电者姓名通知。

• 来电者姓名通知—个人

允许用户使用电话储存最多30个电话号码。

• 来电者姓名通知—系统

允许系统管理员使用PC储存最多200个电话号码。
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条件

• 如果对系统和个人来电者姓名通知编程设定了相同的电话号码，则会通知个人来电者姓名。

使用说明书（PC编程手册）参考

21.1  UM Configuration—[2] Class of Service—Mailbox— Number of CIDs for Caller Name Announcement
(Selection)
24.3  UM Configuration—[5-3] System Parameters—System Caller Name Announcement

使用说明书（用户手册）参考

用户操作

1.8.6  其他功能—  个人主叫方姓名通告

管理员操作

2.2.1  系统管理员功能—  设定服务等级（COS）参数

2.2.2  留言管理员功能—  录制留言—录制系统主叫方姓名

3.2.1.11  服务等级（COS）
说明

每个信箱都分配有一个服务等级（COS），确定其用户可使用的服务。

可根据需要为信箱分配独特的或相同的COS。COS号码65和66默认分别分配给消息管理员和系统管理员。不

可将其他信箱分配为COS号码65和66。

条件

• 系统管理员（使用PC）和消息系统管理员（使用电话）可以改变COS分配。

使用说明书（PC编程手册）参考

20.1.2  UM Configuration—[1-2] Mailbox Settings—Full Setting— Class of Service (Mailbox)
Section  21  UM Configuration—[2] Class of Service

3.2.1.12  公司问候语

说明

这是一条预录留言，用于问候所有来电者并提供相关信息。最多可以录制32条公司问候语，并可为每个服务群

的每个时间方式（白天、夜间、午餐和休息）和假日分配公司问候语。可以设定上午问候语、下午问候语和晚

间问候语的开始时间。

条件

• 消息系统管理员只需呼叫统一消息系统即可远程改变公司问候语设定。
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• 系统管理员可以为假日分配特定的问候语。

使用说明书（PC编程手册）参考

22.1  UM Configuration—[3-1] UM Extension / Trunk Service—Service Group— Day, Night, Lunch, and
Break Mode - Company Greeting No. (Selection)
23.4  UM Configuration—[4-4] Service Settings—Holiday Table— Company Greeting No.
24.4  UM Configuration—[5-4] System Parameters—Parameters—Daily Hours Setting

使用说明书（用户手册）参考

用户操作

1.8.4  发送留言—  接收外部传送留言

管理员操作

2.2.1  系统管理员功能—  更改公司问候语和来电服务设定

2.2.2  留言管理员功能—  录制留言

3.2.1.13  公司名称

说明

目标接收者输入错误密码3次时由外部留言传送服务使用。统一消息系统会告知公司名称以使接收者明白是哪

家公司打电话给他或她。

使用说明书（用户手册）参考

管理员操作

2.2.2  留言管理员功能—  录制留言

3.2.1.14  转换分机

说明

当第一部分机的用户无法接听电话时将呼叫转送至第二部分机。来电者也可以在个人问候语播放时或留言时按

[0]以接入转换分机。

使用说明书（PC编程手册）参考

20.1.2  UM Configuration—[1-2] Mailbox Settings—Full Setting— Covering Extension

使用说明书（用户手册）参考

用户操作

1.8.5  转移呼叫—  分配您的转换分机
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3.2.1.15  客户服务

说明

有以下客户服务类型可用：

• 菜单和转移

允许来电者在收听语音向导（客户服务留言）时按其电话上的拨号键执行特定功能。可将来电者导向分机、

信箱、外线目的地（包括移动电话）、话务员、传真机、其他客户服务等，而无需话务员的协助。

• 日期控制

允许为按日期定义的最多5个时间段分配不同的操作。来电者无需做出选择且不会告知任何菜单。

• 时间控制

允许为按当天时间定义的最多5个时间段分配不同的操作。来电者无需做出选择且不会告知任何菜单。

• 每周各天控制

允许为按每周各天定义的最多5个时间段分配不同的操作。来电者无需做出选择且不会告知任何菜单。

• 密码

需要来电者输入密码。每个密码分配一个操作。如果密码输入正确，则用该密码编程的操作处理来电者。

客户服务留言（"按1转销售，按2转服务…"等）可以由系统管理员或消息管理员录制，且可根据需要以多种语

言录制。总共最多可以创建200条客户服务。

客户服务可通过以下方式处理呼叫：

• 将中继线或端口的来电呼叫服务设定为"客户服务菜单"并指定客户服务号码。

® 22.1  UM Configuration—[3-1] UM Extension / Trunk Service—Service Group— Day, Night, Lunch,
and Break Mode - Incoming Call Service

• 将假日的呼叫服务设定为"客户服务菜单"并指定客户服务号码。

® 23.4  UM Configuration—[4-4] Service Settings—Holiday Table— Service
• 使用客户服务或个人客户服务。可将客户服务分配至另一客户服务或个人客户服务提供的某一可用选项。

按下相应的拨号键后，会将来电者送到分配的客户服务。

使用Web维护控制台的客户服务创建工具可以创建和编辑客户服务。

使用说明书（PC编程手册）参考

7.5.3  Utility—Report—UM View Reports
23.3  UM Configuration—[4-3] Service Settings—Custom Service

使用说明书（用户手册）参考

管理员操作

2.2.2  留言管理员功能—  录制留言

3.2.1.16  按姓名拨号

说明

允许来电者通过按姓名搜索用户的方式连接至所需的用户信箱或分机。使用拨号键，来电者可输入用户名和/或
姓的最初几个字母。统一消息系统会搜索可能的匹配并提供来电者与用户的连接。根据用户的服务等级

（COS）在电话簿列表中包括或排除用户姓名。
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条件

• 系统管理员可在服务设定中改变姓名输入方式（名、姓或全名输入）。

使用说明书（PC编程手册）参考

20.1.2  UM Configuration—[1-2] Mailbox Settings—Full Setting— First Name
20.1.2  UM Configuration—[1-2] Mailbox Settings—Full Setting— Last Name
21.1  UM Configuration—[2] Class of Service— Directory Listing

3.2.1.17  紧急问候语

说明

可以将紧急问候语录制为一种公司问候语。当公司因糟糕天气而必须关闭时可以使用紧急问候语。

使用说明书（用户手册）参考

管理员操作

2.2.2  留言管理员功能—  录制紧急问候语

3.2.1.18  分机群

说明

分机群是共用一个公共信箱的分机群。分机群由系统管理员创建。每个群有一个分机群号码。共有20个群列表

可用，且每个群列表可以有最多100个成员。

使用说明书（PC编程手册）参考

24.2  UM Configuration—[5-2] System Parameters—Extension Group

3.2.1.19  保留

说明

当被叫分机占线时为来电者提供暂时保留的选项。统一消息系统会在指定时间段过后自动重拨分机。当为相同

分机保留多位来电者时，会按原始呼叫顺序将来电者连接至该分机。

使用说明书（PC编程手册）参考

23.1  UM Configuration—[4-1] Service Settings—Caller ID / PIN Call Routing—23.2  UM Configuration—[4-2]
Service Settings—Parameters— Call Hold Mode
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3.2.1.20  假日服务

说明

允许系统通过播放特殊假日问候语取消为相应中继线服务或端口服务分配的普通设定。（例如，"新年好！我们

办事处今天休息。如果您要留言，现在请按1"。）最多可以编程24个假日。假日可以是一个特定的日子或连续

多个日子。

条件

• 假日无法相互重叠。

• 储存在统一消息假日表中的假日与用于定时服务（® 5.1.4  定时服务）的假日表中的假日分开进行管理。

但是，可以将定时服务假日表中指定的假日复制到统一消息假日表。

使用说明书（PC编程手册）参考

23.4  UM Configuration—[4-4] Service Settings—Holiday Table

3.2.1.21  宾馆服务模式

说明

允许用户以专用的'宾馆服务'模式接入特定的用户服务。宾馆服务模式中的用户可以收听留言、更改密码、更改

个人问候语和更改所有者姓名，前提是通过系统编程启用这些操作。另外，可以设定是否在结帐时删除密码、

个人问候语和所有者姓名设定。

使用说明书（PC编程手册）参考

21.1  UM Configuration—[2] Class of Service—Hospitality Mode

使用说明书（功能手册）参考

2.23  友好功能

3.2.1.22  截取路由到一个信箱

说明

如果将截取路由目的地设为UM群的浮动分机号码，则通过系统编程启用"Intercept to Mailbox for Call to
Extension"设定，将截取的中继线呼叫转接到该分机的信箱。因此，来电者可以在不知道信箱号码的情况下在

分机的信箱中留言。

使用说明书（PC编程手册）参考

11.7.1  PBX Configuration—[3-7-1] Group—UM Group—System Settings— Intercept to Mailbox for Call to
Extension
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使用说明书（功能手册）参考

2.1.1.6  截取路由

3.2.1.23  内部寻呼

说明

当用户为呼叫转移设定了内部寻呼，或当用户为未完成呼叫处理设定了内部寻呼时，允许来电者寻呼用户。系

统播送寻呼时直到用户应答寻呼为止，会暂时保留来电者。用户可以使用寻呼应答功能号码从任意分机应答寻

呼。如果收到来电显示信息且来电者姓名通知功能已记录来电者的姓名，则寻呼结束时会告知姓名。

要使用此功能，需要进行以下设定：

1. 将内线广播群分配至所需的服务等级。

® 21.1  UM Configuration—[2] Class of Service—Call Transfer— Intercom Paging Group
2. 将"内线广播的无应答时间"设为所需的设定。

® 24.4  UM Configuration—[5-4] System Parameters—Parameters— No Answer Time for Intercom
Paging (1-30 s)

使用说明书（PC编程手册）参考

21.1  UM Configuration—[2] Class of Service—Call Transfer— Intercom Paging Group
24.4  UM Configuration—[5-4] System Parameters—Parameters—Intercom Paging Parameters

使用说明书（功能手册）参考

2.17.1  广播

3.2.1.24  面试服务

说明

允许统一消息系统通过播放一系列预录的问题并记录来电者的回答，对来电者进行"面试"。
来电者回答的问题会被记录到面试信箱中。

• 来电者记录答案后，面试信箱会在面试信箱拥有者的分机上点亮留言待取灯。

• 取回留言时，用户只能听到问题的答案。

为了使用面试服务，系统中必须创建至少一个面试信箱。

® 20.1  UM Configuration—[1] Mailbox Settings
来电者会在以下情况下转到面试信箱：

a. 中继线或端口的来电呼叫服务设为"面试信箱"。
® 22.1  UM Configuration—[3-1] UM Extension / Trunk Service—Service Group— Day, Night, Lunch,
and Break Mode - Incoming Call Service

b. 假日的呼叫服务设为"面试信箱"。
® 23.4  UM Configuration—[4-4] Service Settings—Holiday Table— Service

c. 客户服务或个人客户服务选项设为将来电者转移到面试信箱。

® 23.3  UM Configuration—[4-3] Service Settings—Custom Service
® 20.1.2  UM Configuration—[1-2] Mailbox Settings—Full Setting—External MSG Delivery/Auto FWD/
Personal Custom Serv— Personal Custom Service
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d. 用户已将他或她的信箱配置为通过未完成呼叫处理将未应答的呼叫转接到信箱的面试信箱，并已将留言接

收模式设为"面试模式"。
® 1.8.6  其他功能—  面试信箱—留言接收模式

e. 具有逻辑分机的用户已将留言接收模式设为"面试模式"。
® 1.8.6  其他功能—  面试信箱—留言接收模式

f. 用户将来电者转移到面试信箱。

使用说明书（PC编程手册）参考

20.1.2  UM Configuration—[1-2] Mailbox Settings—Full Setting— Interview Mailbox

使用说明书（用户手册）参考

用户操作

1.8.6  其他功能—  面试信箱

管理员操作

2.2.1  系统管理员功能—  设置信箱

3.2.1.25  列表所有姓名

说明

允许来电者在自动值机员服务或客户服务中收听所有用户姓名和分机号码的列表。

条件

• 此功能仅在以下条件下可用：

a. 已记录用户的姓名。

b. 已设定用户的分机号码。

c. 用户服务等级的"电话簿列表"参数设为"是"。
• 要在自动值机员服务或客户服务中返回前一菜单，请按 。

使用说明书（功能手册）参考

3.2.1.3  自动值机员（AA）
3.2.1.15  客户服务

3.2.1.26  逻辑分机（所有来电转移到信箱）

说明

始终在其信箱中直接接收呼叫的分机。此功能供电话经常不可用或没有电话的用户使用。

使用说明书（PC编程手册）参考

20.1.2  UM Configuration—[1-2] Mailbox Settings—Full Setting— All Calls Transfer to Mailbox
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使用说明书（用户手册）参考

管理员操作

2.2.1  系统管理员功能—  设置信箱

3.2.1.27  留言接收模式

说明

确定将来电呼叫转接到用户常规信箱还是面试信箱。此模式对未完成呼叫处理服务（当用户线路占线时、当用

户无法接听电话时、或当用户启用呼叫阻塞时）有效，且在呼叫的转移目的地设为逻辑分机时有效。

使用说明书（PC编程手册）参考

20.1.2  UM Configuration—[1-2] Mailbox Settings—Full Setting— All Calls Transfer to Mailbox

使用说明书（功能手册）参考

3.2.1.24  面试服务

3.2.1.26  逻辑分机（所有来电转移到信箱）

使用说明书（用户手册）参考

用户操作

1.8.6  其他功能—  面试信箱—留言接收模式

3.2.1.28  留言待取通知—电子邮件装置

说明

当用户有新留言（语音）时通过电子邮件通知用户（包括消息管理员）。通知会包含留言发送者信息、留言长

度、留言（新/旧）数量和回拨号码（如果已编程）。用户可选择将语音留言数据附在通知上，并且还可选择在

留言发送后将其删除。最多可以配置3个设备用于接收通知。

注

要接收有关未接电话的通知，分机用户应在其用户设定中指定电子邮件地址。（® 5.4.1  分机用户的电子邮

件通知）

条件

• 使用此功能需要KX-NSU201、KX-NSU210或KX-NSU299（统一消息电子邮件通知激活密钥）。每个使用

此功能的信箱都需要一个激活密钥。

• 系统管理员可以启用或禁用每个信箱的此功能，并可定制发送通知的时间范围。例如，如果系统管理员将

时间范围设为周一至周五的9 AM和5 PM之间，则只会在这几个小时内发送通知。

• 当发送长语音留言通知时，请注意以下事项并确认设定信息。

– 如果语音留言长于"最大留言长度"指定的时间，则通知发送时可能会丢弃留言的超出部分。
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® 24.4  UM Configuration—[5-4] System Parameters—Parameters—E-mail Option— Maximum
Message Length (Selection)

– 根据发送者和接收者的设定，可能无法正确发送或接收语音留言。

– 当统一消息系统编程为留言发送后将其删除时，即使发生错误且无法发送通知，仍会删除留言。

• 如果系统尝试发送通知时发生任何错误，则会将错误信息发送至预设的地址。

® 24.4  UM Configuration—[5-4] System Parameters—Parameters—E-mail Option— Mail Address (Up
to 128 ASCII characters)

使用说明书（PC编程手册）参考

7.5.3  Utility—Report—UM View Reports
20.1.2  UM Configuration—[1-2] Mailbox Settings—Full Setting—Notification Parameters

→ E-mail/Text Message Device—Device No. 1, 2, 3—User Name
→ E-mail/Text Message Device—Device No. 1, 2, 3—E-mail Address
→ E-mail/Text Message Device—Device No. 1, 2, 3—Only Urgent Messages
→ E-mail/Text Message Device—Device No. 1, 2, 3—Title Order
→ E-mail/Text Message Device—Device No. 1, 2, 3—Title String
→ E-mail/Text Message Device—Device No. 1, 2, 3—Callback Number
→ E-mail/Text Message Device—Device No. 1, 2, 3—Send Wait Time [0-120 min]
→ E-mail/Text Message Device—Device No. 1, 2, 3—Attach Voice File
→ E-mail/Text Message Device—Device No. 1, 2, 3—Use Mode

21.1  UM Configuration—[2] Class of Service—General
→ E-mail Option

24.4  UM Configuration—[5-4] System Parameters—Parameters—E-mail Option

使用说明书（功能手册）参考

5.4.1  分机用户的电子邮件通知

使用说明书（用户手册）参考

用户操作

1.8.6  其他功能—  留言待取通知

→设备通知：

→打开/关闭设备通知

3.2.1.29  留言待取通知—灯

说明

当用户有新留言时自动点亮用户电话上的留言待取灯。当使用带显示器的集团电话专用话机时，留言待取灯点

亮时会显示未播放留言的数量。当留言键灯点亮时，按该键会允许用户播放其信箱中储存的留言而无需拨打信

箱号码。
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条件

• 为了在显示器上显示未播放留言的数量：

– 必须使用带6行显示的兼容Panasonic集团电话专用话机。

– 用户必须有他或她自己的分机。

– 必须将消息管理员的分机号码分配为白天方式的话务员1。
• 通过拨[0]可以呼叫分配为话务员的分机，但是，设定此功能时必须指定分机号码（不为"0"）。

使用说明书（PC编程手册）参考

20.1.2  UM Configuration—[1-2] Mailbox Settings—Full Setting—Notification Parameters— Message Waiting
Lamp

使用说明书（用户手册）参考

用户操作

1.8.6  其他功能—  留言待取通知

管理员操作

2.2.2  留言管理员功能—  设置留言待取通知

3.2.1.30  留言待取通知—电话装置

说明

当用户有新留言（语音）时自动呼叫预编程的电话号码。用户应答呼叫时会自动播放新留言。

通知可以计划预定。系统管理员可以为每周各天单独编程2种不同的时间范围（例如，9 AM至12 PM和8 PM至

10 PM）。留言待取通知会在已编程时间范围内的所选日子发送。通知还可"连续"发送，即每天24小时收到新留

言时就发送通知。

条件

• 根据"Only Urgent Messages"设定是否启用，可以为所有留言或仅为紧急留言发送通知。当启用时，仅当

用户信箱中留有紧急留言时才会发送通知（如果已编程，根据通知计划）。

• 系统管理员或用户最多可以编程3个设备用于使用此功能。当统一消息系统呼叫设备而呼叫无应答时，系统

会尝试再次呼叫设备。系统管理员可以编程重试次数和重试之间的延迟时间。首先呼叫最低编号的设备。

如果无法呼叫第一个设备，则会呼叫第二个（然后第三个）设备。

使用说明书（PC编程手册）参考

20.1.2  UM Configuration—[1-2] Mailbox Settings—Full Setting—Notification Parameters
→ Telephone Device
→ Telephone Device—Device No. 1, 2, 3—Only Urgent Messages
→ Telephone Device—Device No. 1, 2, 3—Dial Number [0-9 * # T X , ;]
→ Telephone Device—Device No. 1, 2, 3—No. of Retries
→ Telephone Device—Device No. 1, 2, 3—Busy Delay Time (min)
→ Telephone Device—Device No. 1, 2, 3—No Answer Delay Time (min)
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→ Telephone Device—Device No. 1, 2, 3—Use Mode
→ Telephone Device—Device Notification Timer—Device Start Delay Time (0-120 min)
→ Telephone Device—Device Notification Timer—Device Interval Time between Device 1, 2, 3 and Next
Device

24.4  UM Configuration—[5-4] System Parameters—Parameters—Dialling Parameters/MSW Notification

使用说明书（用户手册）参考

用户操作

1.8.6  其他功能—  留言待取通知

管理员操作

2.2.2  留言管理员功能—  设置留言待取通知

3.2.1.31  多语言服务

说明

允许系统提示使用最多8种语言。系统管理员可以为多语言选择菜单选择5种语言，并在菜单中为每种语言分配

一个键。来电者可以通过按所分配的键选择所需语言。用户听到的用于系统提示的语言由服务等级（COS）确

定。

使用说明书（PC编程手册）参考

24.4  UM Configuration—[5-4] System Parameters—Parameters—Prompt Setting

使用说明书（用户手册）参考

管理员操作

2.2.2  留言管理员功能—  录制留言

3.2.1.32  无DTMF输入操作

说明

当几秒钟过后来电者未输入任何内容时为来电者提供向导。

使用说明书（PC编程手册）参考

20.1.2  UM Configuration—[1-2] Mailbox Settings—Full Setting—External MSG Delivery/Auto FWD/Personal
Custom Serv— No DTMF Input Operation
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3.2.1.33  待机通知菜单

说明

允许队列中的来电者（第一个来电者除外）收听预录的通知或音乐。系统管理员在使用Web维护控制台时可通

过电话或通过导入WAV文件录制待机通知菜单，消息管理员也可以通过电话录制待机通知菜单。当待机通知菜

单录制后，会自动启用此功能。

使用说明书（PC编程手册）参考

7.9  Utility—UM – System Prompts Customisation

使用说明书（用户手册）参考

管理员操作

2.2.2  留言管理员功能—  录制留言

3.2.1.34  话务员服务

说明

允许将来电者连接至在线话务员。话务员然后会根据需要将来电者转移至相应的用户或服务。最多可以指定3
位话务员在白天、夜间、午餐和休息方式中接听电话，可以为每位话务员分配用于接受留言的信箱。

注

• 白天方式的话务员1自动指定为消息管理员并分配分机号码"0"或"9"。此话务员的信箱为一般传送信箱。

• 话务员2和3可以分配给已分配至振铃群（来电呼叫分配群）的浮动号码。

可在以下条件下将呼叫转接话务员：

a. 来电者没有或无法将任何DTMF信号发送给统一消息系统（即，来电者没有拨任何数字）。

b. 来电者在自动值机员服务正在处理呼叫时拨"0"。
c. 客户服务或个人客户服务选项设为将来电者转移至自动值机员服务。按下相应的拨号键后，将来电者转接

话务员。

® 23.3  UM Configuration—[4-3] Service Settings—Custom Service
® 20.1.2  UM Configuration—[1-2] Mailbox Settings—Full Setting—External MSG Delivery/Auto FWD/
Personal Custom Serv— Personal Custom Service

话务员服务可以构建成层叠结构，如果话务员1无法接听电话，则会转接话务员2。如果失败，则呼叫转接话务

员3。如果失败，则来电者可录制留言。在每个阶段，都有适用于占线情况和无应答情况的其他选项。

• 占线覆盖模式

确定线路占线时如何处理至话务员的呼叫。占线覆盖选项为：保留、无应答覆盖、呼叫等待和断开留言。

• 无应答覆盖模式

确定"话务员无应答时间"所指定时间内话务员无应答时如何处理呼叫。无应答覆盖选项为：来电者选择、

留下留言、断开留言和下一话务员。

使用说明书（PC编程手册）参考

23.1  UM Configuration—[4-1] Service Settings—Caller ID / PIN Call Routing—23.2  UM Configuration—[4-2]
Service Settings—Parameters
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→ Operator Service—Operator’s Extension
→ Operator Service—Busy Coverage Mode
→ Operator Service—No Answer Coverage Mode

使用说明书（用户手册）参考

管理员操作

2.2.2  留言管理员功能—  定制留言管理员的信箱

3.2.1.35  PIN呼叫路由选择

说明

允许系统管理员储存最多200个PIN（个人识别号码）（最多20位数）号码并为每个时间方式（白天、夜间、午

餐和休息）的每个PIN分配目的地（分机、信箱、信箱群或客户服务）。在客户服务中，可要求来电者输入PIN
号码以将其接至目的地。

使用说明书（PC编程手册）参考

20.1.2  UM Configuration—[1-2] Mailbox Settings—Full Setting—Mailbox Parameters— Call Transfer
Anytime in Incomplete Handling Menu
23.1  UM Configuration—[4-1] Service Settings—Caller ID / PIN Call Routing

3.2.1.36  在个人问候语之后播放系统提示音

说明

允许在个人问候语后为来电者播放留言录制向导。留言录制向导会指导来电者如何终止呼叫、访问更多功能以

及录制留言。

使用说明书（PC编程手册）参考

21.1  UM Configuration—[2] Class of Service—Mailbox— Play System Prompt after Personal Greeting

使用说明书（用户手册）参考

管理员操作

2.2.1  系统管理员功能—  设定服务等级（COS）参数

3.2.1.37  端口服务

说明

允许将呼叫服务分配至各端口。来电呼叫服务会确定应答来电呼叫时使用的服务。这些服务包括：语音信箱、

自动值机员、面试、客户服务和转移到信箱。客户服务是所有服务中最灵活的，因为其允许通过按一个键接入

其它服务。
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注

为方便来电者，我们建议将所有端口编程设定为使用客户服务作为来电呼叫服务（® 3.2.1.15  客户服务）。

使用说明书（PC编程手册）参考

Section  22  UM Configuration—[3] UM Extension / Trunk Service

使用说明书（功能手册）参考

3.2.1.3  自动值机员（AA）
3.2.1.15  客户服务

3.2.1.24  面试服务

3.2.1.43  转移到信箱

3.2.1.45  语音信箱服务

3.2.1.38  远程定时服务设定

说明

允许系统管理员远程对他或她的分机进行编程以改变集团电话的定时服务方式（白天/夜间/午餐/休息）。

使用说明书（用户手册）参考

管理员操作

2.2.1  系统管理员功能—  远程定时服务方式设定

3.2.1.39  服务群

说明

是确定如何处理来电呼叫的参数群。可以配置64个不同的服务群；每个端口和每个中继线群可以分配一个服务

群。

使用说明书（PC编程手册）参考

10.4  PBX Configuration—[2-4] System—Week Table
22.1  UM Configuration—[3-1] UM Extension / Trunk Service—Service Group

使用说明书（功能手册）参考

5.1.4  定时服务

使用说明书（用户手册）参考

管理员操作

2.1.2  定时服务方式控制
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3.2.1.40  简化教程

说明

如果在用户的COS设定中启用简化教程，则指导用户完成他或她的信箱设置的教程会更简单，比标准教程所花

的时间更少。

使用说明书（PC编程手册）参考

21.1  UM Configuration—[2] Class of Service— Tutorial

3.2.1.41  系统提示音

说明

是指导来电者的播音。最多可以储存8种语言作为系统提示。也可储存各语言的名称。当系统管理员选择系统

设定的语言时，使用此名称标签数据可以选择所需语言。通过选择一种已储存语言可以指定"主要"语言，并成

为默认设定，除非在系统设定中选择另一语言。

注

• 系统提示可以改变或打开/关闭，每种语言的系统提示可以作为WAV文件导入，或使用电话重新录制。

• 为了留出更多录制时间，系统管理员还可以删除特定的系统提示或一种用于系统提示的已安装语言。

使用说明书（PC编程手册）参考

7.9  Utility—UM – System Prompts Customisation
21.1  UM Configuration—[2] Class of Service— Prompt Mode
24.4  UM Configuration—[5-4] System Parameters—Parameters—Prompt Setting

使用说明书（用户手册）参考

管理员操作

2.2.1  系统管理员功能—  设定服务等级（COS）参数

2.2.2  留言管理员功能—  录制留言

3.2.1.42  转移重呼到信箱

说明

如果呼叫通过自动值机员（AA）服务被转移至某一分机，而且呼叫在预编程设定的转移重呼时间内未得到应

答，会将呼叫转接至转移目的地分机的信箱。因此，来电者可以在不知道信箱号码的情况下在分机的信箱中留

言。要使用此功能，必须通过系统编程允许"Transfer Recall to Mailbox"设定。

使用说明书（PC编程手册）参考

10.3  PBX Configuration—[2-3] System—Timers & Counters—Dial / IRNA / Recall / Tone— Recall—Transfer
Recall (s)
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11.7.1  PBX Configuration—[3-7-1] Group—UM Group—System Settings— Transfer Recall to Mailbox

使用说明书（功能手册）参考

3.2.1.3  自动值机员（AA）

3.2.1.43  转移到信箱

说明

将呼叫转移到指定的信箱。

当中继线群或端口的来电呼叫服务设为"转移到信箱"时呼叫会转接转移到信箱服务。

使用说明书（PC编程手册）参考

22.1  UM Configuration—[3-1] UM Extension / Trunk Service—Service Group— Day, Night, Lunch, and
Break Mode - Incoming Call Service

3.2.1.44  中继线服务（通用端口）

说明

允许呼叫处理功能根据接收呼叫的中继线群作出不同行为。

每个中继线群可以分配一种服务，包括：语音信箱、自动值机员、面试、客户服务和转移到信箱。客户服务是

所有服务中最灵活的，因为其允许通过按一个键接入其它服务。

注

为方便来电者，我们建议将所有中继线群编程设定为使用客户服务作为来电呼叫服务（® 3.2.1.15  客户服

务）。

使用说明书（PC编程手册）参考

Section  22  UM Configuration—[3] UM Extension / Trunk Service

使用说明书（功能手册）参考

3.2.1.3  自动值机员（AA）
3.2.1.15  客户服务

3.2.1.24  面试服务

3.2.1.43  转移到信箱

3.2.1.45  语音信箱服务

342 使用说明书（功能手册）

3.2.1 系统功能



3.2.1.45  语音信箱服务

说明

是允许来电者给用户留下留言的留言录制服务。他们可以直接拨打信箱号码或使用电话上的拨号键"拼出"所需

用户的姓名（® 3.2.1.16  按姓名拨号）。一旦来电者拨打相应的号码，统一消息系统就会将来电者转移至相应

方。

来电者会在以下条件下转接语音信箱服务：

a. 中继线群或端口的来电呼叫服务设为"语音信箱服务"。
® 22.1  UM Configuration—[3-1] UM Extension / Trunk Service—Service Group— Day, Night, Lunch,
and Break Mode - Incoming Call Service

b. 假日的呼叫服务设为"语音信箱服务"。
® 23.4  UM Configuration—[4-4] Service Settings—Holiday Table— Service

c. 他们在呼叫期间按下[#6]（语音信箱服务接入命令）。

d. 客户服务或个人客户服务选项设为将来电者转移到语音信箱服务。

® 20.1.2  UM Configuration—[1-2] Mailbox Settings—Full Setting—External MSG Delivery/Auto FWD/
Personal Custom Serv— Personal Custom Service
® 23.3  UM Configuration—[4-3] Service Settings—Custom Service

e. 用户将来电者转移到语音信箱服务。

使用说明书（PC编程手册）参考

Section  22  UM Configuration—[3] UM Extension / Trunk Service
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3.2.2  用户功能

说明

在统一消息系统中拥有信箱的集团电话用户称为用户。用户可以在以下方面定制其信箱：

• 设定密码

• 记录姓名

• 录制个人问候语

• 设定个人群发列表

• 设定个人客户服务

• 设定呼叫转移状态

• 设定转换分机

• 设定留言接收模式

• 设定未完成呼叫处理状态

• 设定留言待取通知

• 录制面试信箱的问题

3.2.2.1  自动接收通知

说明

允许用户或系统管理员接收留言以确认所发送的留言已被收到。当用户收到发送的留言时，发送者会受到一条

留言通知说"（信箱名称/号码）已收到您的留言"。用户需要在发送留言时请求自动接收通知。

条件

• 当系统管理员发送广播通信留言时，此功能不可用。

• 也可使用此功能确认外部传送留言的接收情况。用户可在将留言发送至外部传送留言列表中单个接收者或

所有成员时请求自动接收通知，并接收列表中每个成员的自动接收通知。

使用说明书（PC编程手册）参考

21.1  UM Configuration—[2] Class of Service—Mailbox— Auto Receipt

3.2.2.2  自动登录

说明

允许用户和管理员直接登录其信箱而无需输入信箱号码。用户/管理员可通过以下方式直接登录他或她的信箱：

• 从他或她的分机直接拨打统一消息分机号码。

• 从分配用于登录他或她信箱的电话号码呼叫统一消息系统。

• 拨打（从外线电话）分配用于登录他或她信箱的DID号码。

• 呼叫统一消息系统以使呼叫在分配用于登录他或她信箱的中继线群上收到。

用户和管理员还可以不用输入密码登录其信箱。

小心

当禁用密码要求时，确保禁止未经授权的第三方动用您的分机。
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条件

• 来电显示号码、DID号码或中继线群号码分配后，会自动启用从外线电话接入。仅系统管理员才可分配中

继线群号码或DID号码。

• 当此功能激活时，"节省费用"也可使用。

使用说明书（PC编程手册）参考

20.1.2  UM Configuration—[1-2] Mailbox Settings—Full Setting—Remote Call/Automatic Login/Direct Service
→ Auto Login Extension
→ Auto Login Extension Password Entry Requirement
→ Auto Login Caller ID 1, 2
→ Auto Login Caller ID Password Entry Requirement
→ Auto Login DDI/DID
→ Auto Login TRG No.
→ Auto Login DDI/DID, TRG No. Password Entry Requirement
→ Auto Login Toll Saver

使用说明书（功能手册）参考

3.2.2.29  节省费用

使用说明书（用户手册）参考

用户操作

1.8.6  其他功能—  为远程自动登录和节省费用分配您的电话号码

3.2.2.3  自动播放新留言

说明

当用户或系统管理员/消息管理员登录他或她的信箱时，可以自动播放新留言。无需按[1]检查新留言。

条件

• 如果信箱中存在多条新留言，则可设定是否在没有系统提示的情况下连续播放留言。

® 21.1  UM Configuration—[2] Class of Service—Mailbox— Play New Messages Sequentially

使用说明书（PC编程手册）参考

21.1  UM Configuration—[2] Class of Service—Mailbox— Autoplay New Message
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3.2.2.4  书签

说明

能使用户在暂停留言时设定留言的书签。设定书签后，用户可以暂停留言或待留言播放后按指定的键从书签处

收听留言。

使用说明书（用户手册）参考

用户操作

1.8.3  留言播放及相关功能—  书签（仅语音留言）

3.2.2.5  接通服务

说明

允许用户通过访问用户服务菜单（从外线电话）并拨通外线目的地来打外线电话。这会创建中继线到中继线呼

叫。

使用说明书（PC编程手册）参考

21.1  UM Configuration—[2] Class of Service— Call-through Service
24.4  UM Configuration—[5-4] System Parameters—Parameters—Transfer to Outside— Outside Transfer
Sequence—Call Transfer to Outside Sequence (Up to 16 digits / [0-9 * # D F R T , ; N])

使用说明书（功能手册）参考

2.16.1  直接拨入系统接入（DISA）

使用说明书（用户手册）参考

用户操作

1.8.6  其他功能—  接通服务

3.2.2.6  呼叫转移方案

说明

通过组合呼叫转移和未完成呼叫处理的设定，您可为您的分机创建呼叫处理"方案"。最多可以创建20个方案，

且每个缺席留言可以分配一个方案。

使用说明书（PC编程手册）参考

8.1.1  Users—User Profiles—Advanced setting—Advanced Call Transfer Setting
8.1.1  Users—User Profiles—Advanced setting—Scenario Setting
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使用说明书（功能手册）参考

2.20.2  缺席留言

3.2.2.7  呼叫转移状态

3.2.2.15  未完成呼叫处理服务

3.2.2.7  呼叫转移状态

说明

允许用户指定统一消息系统如何处理呼至其不同分机的呼叫。呼叫转移状态选项包括：呼叫阻塞、呼叫屏蔽、

内线广播、转移到信箱、转移到指定的电话号码和客户服务。

使用说明书（PC编程手册）参考

20.1.2  UM Configuration—[1-2] Mailbox Settings—Full Setting— Call Transfer Status

使用说明书（功能手册）参考

3.2.1.23  内部寻呼

3.2.2.8  回叫号码输入

说明

回叫号码可以显示在留言待取通知中。如果在录制留言时收到来电显示信息，则显示该号码。如果未收到来电

显示信息，则显示在System Callback No.中指定的号码。

使用说明书（PC编程手册）参考

20.1.2  UM Configuration—[1-2] Mailbox Settings—Full Setting—Notification Parameters
24.4  UM Configuration—[5-4] System Parameters—Parameters—Dialling Parameters/MSW Notification

使用说明书（用户手册）参考

管理员操作

2.2.2  留言管理员功能—  设置留言待取通知

3.2.2.9  来电号码回叫

说明

能使用户通过附在留言上的来电显示号码回叫留言发送者。

使用说明书（PC编程手册）参考

21.1  UM Configuration—[2] Class of Service—Mailbox— Caller ID Callback
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24.4  UM Configuration—[5-4] System Parameters—Parameters—Transfer to Outside— Trunk Group (1–
64)—Caller ID Callback

使用说明书（功能手册）参考

3.2.1.7  呼叫转移到外线

3.2.2.10  删除留言确认

说明

可以在删除信箱中的留言前请求用户予以确认。当删除留言时，会将其保留直至第二天System Maintenance
Start Time中指定的时间。

使用说明书（PC编程手册）参考

7.11  Utility—UM - System Maintenance—System Maintenance Start Time
21.1  UM Configuration—[2] Class of Service—Mailbox— Delete Message Confirmation

3.2.2.11  直接服务接入

说明

允许用户通过拨打统一消息分机号码直接接入功能。以下功能可以直接接入：

• 录制无应答问候语

• 录制占线问候语

• 录制下班问候语

• 录制临时问候语

• 更改白天主菜单*1

• 更改夜间主菜单*1

• 更改紧急问候语*1

*1 仅消息管理员和具有消息管理员权限的用户才可接入此功能。

条件

• 仅当自动登录功能启用时才可使用此功能。

使用说明书（PC编程手册）参考

20.1.2  UM Configuration—[1-2] Mailbox Settings—Full Setting—Remote Call/Automatic Login/Direct Service
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3.2.2.12  外部留言传送服务

说明

允许用户在指定时间（或立即）向多位用户和非用户（包括外线用户）发送留言。此功能还允许接收者回复留

言而无需指定信箱号码。

而且，外部留言传送列表允许用户通过单个操作向多位用户发送留言。一位用户可以持有最多2个列表，每个

列表最多有8个条目。

另外，可以要求接收者输入4位密码以接收发送者的留言。如果接收者输入错误密码3次，则统一消息系统会播

放：公司名称（如果已录制）、公司的电话号码（如果已注册）和发送者的分机（如果公司的电话号码和所有

者的分机均已注册）。通过此信息，即使接收者忘记密码，他或她仍可追踪留言。

使用说明书（PC编程手册）参考

20.1.2  UM Configuration—[1-2] Mailbox Settings—Full Setting— Extension
20.1.2  UM Configuration—[1-2] Mailbox Settings—Full Setting—External MSG Delivery/Auto FWD/Personal
Custom Serv

→ External Message Delivery Active
→ External Message Delivery Prompt Mode

24.4  UM Configuration—[5-4] System Parameters—Parameters—External Message Delivery

使用说明书（用户手册）参考

用户操作

1.8.4  发送留言

→  外部留言传送

→  外部留言传送列表

→  接收外部传送留言

3.2.2.13  转送到信箱

说明

用户可以设定将呼叫转送至UM群的浮动分机号码。在此情况下，会将呼叫直接转送至分机的信箱。因此，来

电者可以在不知道信箱号码的情况下留言。

使用说明书（功能手册）参考

2.3.2  呼叫转送（FWD）

3.2.2.14  群发列表

说明

共有2种类型的群发列表：

• 群发列表—个人
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允许用户同时将留言发送至多个信箱。系统管理员和用户可以创建或编辑这些列表。每个用户可以持有最

多4个列表，每个列表最多可有40个条目。

• 群发列表—系统

也称为"信箱群"。
允许用户和来电者立即将留言发送至属于列表的所有信箱。这些列表由系统管理员创建。共有20个群列表

可用，而每个群列表最多可以有200位成员。

使用说明书（PC编程手册）参考

20.1.2  UM Configuration—[1-2] Mailbox Settings—Full Setting—Personal Distribution List
24.1  UM Configuration—[5-1] System Parameters—Mailbox Group

使用说明书（用户手册）参考

用户操作

1.8.4  发送留言—  个人群发列表

管理员操作

2.2.1  系统管理员功能—  广播留言

3.2.2.15  未完成呼叫处理服务

说明

允许用户在分机占线或无应答时为来电者提供多个服务选项。占线或无应答的未完成呼叫处理的可用选项为：

• 留下留言

• 转移到转换分机

• 返回自动值机员顶层菜单

• 内部寻呼

• 客户服务

• 呼叫话务员

使用说明书（PC编程手册）参考

20.1.2  UM Configuration—[1-2] Mailbox Settings—Full Setting
→ Incomplete Call Handling for No Answer
→ Incomplete Call Handling for Busy

使用说明书（功能手册）参考

3.2.1.23  内部寻呼

使用说明书（用户手册）参考

用户操作

1.8.5  转移呼叫—  未完成呼叫处理
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3.2.2.16  现场呼叫屏蔽（LCS）
说明

允许用户在录制留言时监听来电呼叫。用户可以选择在监听时应答呼叫或允许录制留言而不中断。此功能有2
种方式：免提和专用。免提方式允许用户通过电话的扬声器听到来电者并拿起话筒应答呼叫。专用方式会通过

音频发出提醒并需要在监听留言前拿起电话话筒。用户可通过按下他或她集团电话专用话机上的LCS键与来电

者通话（如果已编程）。

条件

• ISDN分机和SIP分机无法使用该功能。有关支持此功能的电话类型的详细信息，请参阅使用说明书（用户

手册）。

• LCS键
可以将一个灵活键定制为LCS键。

• 分机个人识别号码（PIN）

为了防止未经授权的监听，建议LCS用户指定一个分机PIN。设定LCS时将需要此PIN（® 2.24.1  分机个

人识别号码（PIN））。如果用户忘记了PIN，被指定为管理员的分机可以清除它。

• 通过个人编程（设定LCS方式 [在应答后]），可以编程设定每部分机在呼叫被截取后结束录音或继续录制通

话。

• 一个编号分机的子分机无法进行LCS。（® 2.11.11  一个编号分机）。

使用说明书（PC编程手册）参考

12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Option 4
21.1  UM Configuration—[2] Class of Service—Mailbox— Message Cancel for Live Call Screening

使用说明书（功能手册）参考

2.21.2  灵活键

使用说明书（用户手册）参考

用户操作

1.8.6  其他功能—  现场呼叫屏蔽（LCS）

管理员操作

2.2.1  系统管理员功能—  设定服务等级（COS）参数

可用电话类型

5.1.1  电话类型及功能列表

3.2.2.17  信箱

说明

是储存用户所有留言的地方。存在多个信箱选项：用户信箱、面试信箱、系统管理员信箱和信息管理员信箱

（一般传送信箱）。
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使用说明书（安装手册）参考

5.11  自动配置信箱

使用说明书（PC编程手册）参考

7.5.3  Utility—Report—UM View Reports
Section  20  UM Configuration—[1] Mailbox Settings

使用说明书（功能手册）参考

3.1.2.1  自动配置信箱

使用说明书（用户手册）参考

用户操作

1.8.2  登录并配置您的信箱

管理员操作

2.2.1  系统管理员功能—  设置信箱

3.2.2.18  信箱容量警告

说明

允许统一消息系统在用户信箱录制时间不足时提醒用户。用户服务开始时会听到警告通知。

条件

• 如果设定长于信箱容量最大留言时间，则此功能不可用。

使用说明书（PC编程手册）参考

21.1  UM Configuration—[2] Class of Service—Mailbox
→ Mailbox Capacity Warning (Selection)
→ Mailbox Capacity Maximum Message Time (Limited) (min)

3.2.2.19  管理员服务切换

说明

允许用户访问系统管理员的信箱和消息管理员的信箱。通过服务等级（COS）编程设定启用此功能的用户只需

从用户服务菜单按[#]两次即可按以下顺序切换信箱：
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条件

• 如果另一用户已在使用管理员服务，则用户会听到错误音且无法接入该服务。

使用说明书（PC编程手册）参考

21.1  UM Configuration—[2] Class of Service— System Manager Authority
21.1  UM Configuration—[2] Class of Service— Message Manager Authority

3.2.2.20  留言转移

说明

允许用户在收听留言后将其转移至其他信箱。用户还可在留言转移前在留言的开头添加个人注释。可以指定一

个或多个不同信箱进行留言转移。也可使用系统或个人群发列表转移留言。

使用说明书（用户手册）参考

用户操作

1.8.3  留言播放及相关功能— 转移留言

管理员操作

2.2.2  留言管理员功能—  管理一般传送信箱

3.2.2.21  个人客户服务

说明

允许用户在他或她的个人问候语（个人客户服务）中使用以下客户服务：

• 转移到信箱

• 转移到分机

• 转移到语音信箱服务

• 转移到自动值机员服务

• 客户服务

• 转移到话务员

• 转移到外线

• 广播用户

• 重复问候语

来电者在收听个人问候语或录制留言时可以从上述服务选择所需服务。

您还可选择如果来电者在个人问候语后未拨任何号码（无DTMF输入操作）时的操作如下：

• 留言录制：指导来电者留下留言。

• 断开（全天）：全天均会断开线路。

• 断开（仅下班）：仅在下班时断开线路。
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使用说明书（PC编程手册）参考

20.1.2  UM Configuration—[1-2] Mailbox Settings—Full Setting—External MSG Delivery/Auto FWD/Personal
Custom Serv— Personal Custom Service

使用说明书（用户手册）参考

用户操作

1.8.6  其他功能—  个人客户服务

3.2.2.22  个人问候语

说明

来电者到达用户信箱时听到的问候语。用户可以录制6种类型的个人问候语。每种个人问候语的最大录制时间

由用户的COS确定。个人问候语的使用优先级如下：

1. 临时个人问候语

用于通知来电者用户不在（例如，"我今天不在办公室…"）。临时个人问候语占优插入其他个人问候语；无

论时间方式、无论线路是否占线等，始终会播放。用户录制临时个人问候语时会自动激活此功能。下次登

录信箱时会询问用户是否要关闭临时个人问候语。当临时个人问候语关闭时，会自动将其删除并照常播放

其他个人问候语。

2. 占线问候语

用户的分机占线时播放。

3. 来电显示的个人问候语

允许用户录制最多4条个人问候语，以从编程设定的电话号码接收到呼叫时播放。每条问候语可以分配最多

8个电话号码。

4. 缺席留言问候语

允许用户为每条集团电话的缺席留言分配个人问候语。

5. 下班问候语

系统处于夜间方式时播放。

6. 无应答问候语

工作时间（白天、午餐和休息方式）内以下条件下播放：

– 将来电者连接至用户的分机，但是呼叫无应答。

– 来电者直接登录信箱。

– 还未录制占线问候语或下班问候语。

使用说明书（PC编程手册）参考

Section  21  UM Configuration—[2] Class of Service
21.1  UM Configuration—[2] Class of Service—Mailbox— Personal Greeting for Caller ID

使用说明书（功能手册）参考

2.20.2  缺席留言
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使用说明书（用户手册）参考

用户操作

1.8.2  登录并配置您的信箱

→  更改或删除您的个人外播留言

→  用于来电显示的个人问候语

管理员操作

2.2.1  系统管理员功能—  设定服务等级（COS）参数

3.2.2.23  私人留言

说明

允许用户和系统管理员在将留言发送至其他用户、消息管理员和/或系统管理员时将其标记为"私人"。无法转移

私人留言。也可以将语音信箱服务中录制的留言标记为"私人"。

使用说明书（用户手册）参考

用户操作

1.8.4  发送留言—  留言传送

管理员操作

2.2.1  系统管理员功能—  广播留言

3.2.2.24  恢复留言

说明

能使用户恢复已删除的留言。删除留言后，它们会保留在已删除留言箱中直至第二天System Maintenance
Start Time中指定的时间。在此之前，用户可以从已删除留言箱中找回已删除的留言并将其移至旧留言箱。当

留言恢复时留言保留时间会重置。

使用说明书（PC编程手册）参考

7.11  Utility—UM - System Maintenance—System Maintenance Start Time

使用说明书（用户手册）参考

用户操作

1.8.3  留言播放及相关功能—  恢复删除的留言

3.2.2.25  远程缺席留言

说明

允许用户按照语音向导远程更改她的缺席留言。
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使用说明书（功能手册）参考

2.20.2  缺席留言

使用说明书（用户手册）参考

用户操作

1.8.6  其他功能—  远程设定缺席留言

3.2.2.26  远程呼叫转送设定

说明

允许用户和消息管理员远程对其分机进行编程以将呼叫转送至另一分机或外线电话。

共有6种转送设定可用：

• 转送所有来电：将所有来电呼叫转送至所需分机号码。

• 占线转送：线路占线时将所有来电呼叫转送至所需分机号码。

• 无应答转送：无应答时将所有来电呼叫转送至所需分机号码。

• 占线或无应答转送：线路占线或无应答时将所有来电呼叫转送至所需分机号码。

• 转送至CO：将所有来电呼叫转送至电话号码1或2（在信箱设定中编程），或任何其他号码。

• 取消转送：取消转送设定。

条件

• 为了使用FWD to CO选项，必须通过系统编程启用将呼叫转送至中继线的功能。

• 通过拨[0]可以呼叫分配为话务员的分机，但是，设定此功能时必须指定分机号码（不为"0"）。

使用说明书（PC编程手册）参考

10.7.1  PBX Configuration—[2-7-1] System—Class of Service—COS Settings
20.1.2  UM Configuration—[1-2] Mailbox Settings—Full Setting—Remote Call/Automatic Login/Direct Service
21.1  UM Configuration—[2] Class of Service

使用说明书（用户手册）参考

用户操作

1.8.5  转移呼叫—  远程呼叫转送

管理员操作

2.2.1  系统管理员功能—  设定服务等级（COS）参数

2.2.2  留言管理员功能—  远程呼叫转送设定

3.2.2.27  用户教程

说明

当用户首次登录其信箱时为其提供语音向导。按照向导，用户可以配置以下项目：
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• 密码

• 所有者的姓名

• 个人问候语（无应答问候语、占线问候语、下班问候语）

注

如果通过系统编程选择简化教程，则无法录制占线问候语和下班问候语。

使用说明书（PC编程手册）参考

21.1  UM Configuration—[2] Class of Service— Tutorial

使用说明书（用户手册）参考

用户操作

1.8.2  登录并配置您的信箱—  用户教程（简易信箱配置）

管理员操作

2.2.1  系统管理员功能—  设定服务等级（COS）参数

3.2.2.28  定时提醒设定

说明

允许用户按照统一消息系统提供的系统提示设定定时提醒。定时提醒功能类似闹钟；电话会在用户或消息管理

员设定的固定时间（一次或每天）振铃。

当摘机应答定时提醒时，用户会听到特殊的拨号音或预录的留言。

条件

• 设定定时提醒时使用的时间格式（12或24小时）由"时间戳中"AM/PM"的位置"设定确定。

® 24.4  UM Configuration—[5-4] System Parameters—Parameters—Prompt Setting— System
Guidance—Select Language—Position of "AM/PM" in Time Stamp

• 用户必须拥有他或她自己的分机才能使用此功能。

• 通过拨[0]可以呼叫分配为话务员的分机，但是，设定此功能时必须指定分机号码（不为"0"）。

使用说明书（PC编程手册）参考

24.4  UM Configuration—[5-4] System Parameters—Parameters

使用说明书（功能手册）参考

2.24.4  定时提醒

使用说明书（用户手册）参考

用户操作

1.8.6  其他功能—  设定警报（定时提醒）
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管理员操作

2.2.2  留言管理员功能—  设定定时提醒

3.2.2.29  节省费用

说明

允许用户通过预编程的来电显示号码、DID号码或指定给预编程中继线群号码的电话号码检查他或她的信箱而

不会产生电话费用。

使用说明书（PC编程手册）参考

20.1.2  UM Configuration—[1-2] Mailbox Settings—Full Setting—Remote Call/Automatic Login/Direct Service
→ Auto Login Extension
→ Auto Login Extension Password Entry Requirement
→ Auto Login Caller ID 1, 2
→ Auto Login Caller ID Password Entry Requirement
→ Auto Login DDI/DID
→ Auto Login TRG No.
→ Auto Login DDI/DID, TRG No. Password Entry Requirement
→ Auto Login Toll Saver

23.1  UM Configuration—[4-1] Service Settings—Caller ID / PIN Call Routing—23.2  UM Configuration—[4-2]
Service Settings—Parameters

→ Delayed Answer Time for New Message (5-60 s)
→ Delayed Answer Time for No New Message (5-60 s)

使用说明书（功能手册）参考

3.2.2.2  自动登录

使用说明书（用户手册）参考

用户操作

1.8.6  其他功能—  为远程自动登录和节省费用分配您的电话号码

3.2.2.30  双向录音/双向转移

说明

可以使用以下手动录音功能：

• 双向录音

允许用户记录他或她与来电者的通话。根据用户的COS，会将通话保存在用户的信箱中作为旧或新留言。

• 双向转移

允许用户记录他或她与来电者的通话。会将通话保存在另一用户的信箱中作为新留言。

• 单键双向转移

允许用户通过单键操作记录他或她与来电者的通话。会将通话保存在另一用户的信箱中作为新留言。

358 使用说明书（功能手册）
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无限制留言长度

允许用户在将双向通话记录至其自己或另一用户的信箱（双向录音或双向转移）时录制无限制的时间长度。其

他留言的最大录制长度会自动设为60分钟。

注

开始录制任何电话通话前，您应当通知对方通话将被录音。

条件

• 使用此功能需要KX-NSU301、KX-NSU310或KX-NSU399（双向录音激活密钥）。每个使用此功能的分机

都需要一个激活密钥。

另外，每个分机的Two-way Recording设定必须设为Enable。
• 双向录音/双向转移键

可以把一个灵活键定制为双向录音键或双向转移键。可以给双向转移键分配一个分机号码，这样，可以把

它用作指定分机信箱的单键录音键（单键双向转移键）。

• 当所有统一消息端口都占线时：

a. 按双向录音键会发送警告音。

b. 按双向转移键后再按分机号码将发送警告音。

• 要允许无限制录制时间，用户服务等级（COS）的"留言长度"参数必须设为"无限制"。
® 21.1  UM Configuration—[2] Class of Service—Mailbox— Message Length (Selection)

使用说明书（PC编程手册）参考

12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—UM— Two-way
Recording
12.1.4  PBX Configuration—[4-1-4] Extension—Wired Extension—Flexible Button

→ Extension Number (for Two-way Record)
→ Extension Number (for Two-way Transfer)
→ Extension Number (for Voice Mail Transfer)

21.1  UM Configuration—[2] Class of Service—Mailbox— Two-way Recorded Message Save Mode

使用说明书（功能手册）参考

2.21.2  灵活键

使用说明书（用户手册）参考

用户操作

1.8.6  其他功能—  录制您的通话

3.1.3  订制按键
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3.2.2.31  紧急留言

说明

允许用户、来电者和系统管理员将留言指定为"紧急"。当用户收听留言时，如果用户服务等级（COS）的"首先

播放紧急留言"参数设为"是"，则紧急留言的优先级会高于信箱中的其他留言（即首先播放）。如果用户信箱的

通知类型设为"仅紧急留言"，则仅当收到紧急留言时才会激活留言待取通知。

使用说明书（PC编程手册）参考

20.1.2  UM Configuration—[1-2] Mailbox Settings—Full Setting—Notification Parameters
→ Telephone Device—Device No. 1, 2, 3—Only Urgent Messages
→ E-mail/Text Message Device—Device No. 1, 2, 3—Only Urgent Messages

21.1  UM Configuration—[2] Class of Service—Mailbox— First Playback Urgent Message

3.2.2.32  语音信箱（VM）转移键

说明

通过按VM转移键并输入分机的号码，用户可以将呼叫转移到分机的信箱中。转移的主叫方随后可以在信箱中

留言。分机用户还可以在其他时候使用VM转移键，如下所示：

a. 可以在分机空闲时按VM转移键呼叫分机的信箱并收听留言。即使留言待取灯没有亮起也可以使用此功能。

b. 在呼叫呼入时按VM转移键会将该呼叫转接到被叫分机的信箱。此功能在被叫分机用户不想应答呼叫时非常

有用。

c. 如果您呼叫分机时另一方没有应答，按VM转移键会将呼叫转移到被叫分机的信箱以留言。当被叫分机占线

或设为免打扰时也可以使用此功能。

条件

• 用UM群的浮动分机号码作为参数，可以把一个灵活键定制为VM转移键。

使用说明书（PC编程手册）参考

12.1.4  PBX Configuration—[4-1-4] Extension—Wired Extension—Flexible Button— Extension Number (for
Voice Mail Transfer)

使用说明书（功能手册）参考

2.21.2  灵活键

3.2.2.33  Web编程

说明

用户可以通过Web维护控制台访问并更改各种设定。

用户

登录"User（用户）"帐户的用户可以访问以下项目：

360 使用说明书（功能手册）
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• 信箱设定

用户可以配置设定，如与其信箱关联的姓名、信箱密码和通知参数。

• 语音提示

用户可以播放、录制和删除其信箱中以下类型的语音提示：

– 信箱所有者姓名

– 个人问候语

– 个人来电显示姓名

– 个人分配列表语音标签

– 面试信箱问题

管理员

登录"User（管理员）"帐户的用户可以访问除"User（用户）"帐户可用设定以外的以下项目：

• 语音提示

– 客户服务

– 信箱群名称

– 系统来电者姓名

• 报告

管理员可以查看和清除各种类型的报告。

® 7.5.3  Utility—Report—UM View Reports

条件

• 用户必须拥有用户ID和密码才能登录Web维护控制台。

• 系统管理员和消息管理员无需拥有管理员权限。

使用说明书（PC编程手册）参考

Section  20  UM Configuration—[1] Mailbox Settings
22.1  UM Configuration—[3-1] UM Extension / Trunk Service—Service Group— Day, Night, Lunch, and
Break Mode - Incoming Call Service Prompt
24.3  UM Configuration—[5-3] System Parameters—System Caller Name Announcement
24.4  UM Configuration—[5-4] System Parameters—Parameters—Prompt Setting

使用说明书（功能手册）参考

5.5.2  PC编程

使用说明书（用户手册）参考

3.2  使用Web维护控制台进行系统编程
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3.3  电子邮件客户端集成功能

3.3.1  IMAP集成

说明

通过配置IMAP帐户，用户可通过电子邮件客户端访问其信箱的内容。需要的只是一个支撑IMAP4的电子邮件

客户端。

通过IMAP集成，用户可进行以下操作：

• 播放语音留言

• 将语音留言保存至其PC
• 删除语音留言

条件

• 使用此功能需要KX-NSU201、KX-NSU210或KX-NSU299（统一消息电子邮件通知激活密钥）。每个使用

此功能的信箱都需要一个激活密钥。

• 访问统一消息系统需要集团电话资源。要减少集团电话性能受影响的可能，设置为访问用户信箱的电子邮

件客户端中的帐户应设为离线模式。有关离线模式的详情，请参阅电子邮件客户端的说明书。

• 可将新语音留言作为电子邮件附件发送至独立的电子邮件帐户（® 3.2.1.28  留言待取通知—电子邮件装

置）。

• 可使用帮助用户管理IMAP连接的工具。Web维护控制台中提供了用户可以下载工具的链接。

→ 8.2.1  Users—Add User—Single User中的"Unified Message"—"Unified Messaging Plug in"

使用说明书（PC编程手册）参考

20.1.2  UM Configuration—[1-2] Mailbox Settings—Full Setting—Mailbox Parameters— Mailbox Password
(Message Client)
21.1  UM Configuration—[2] Class of Service—General

→ Desktop Messaging

使用说明书（用户手册）参考

用户操作

1.8.6  其他功能—  IMAP
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章节  4
网络功能
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4.1  公共网络功能

4.1.1  SIP（会话初始协议）中继线

说明

通过V-SIPGW卡，集团电话可以连接至ITSP（互联网电话服务提供商）提供的互联网电话服务。

ITSP通过传统电话网络（例如，ISDN和移动）提供部分收费电话服务。ISP（互联网服务提供商）也可以作为

SIP提供商，本身不提供电话连接。但是，如果其用户有互联网访问能力，则ISP可通过基于SIP协议的VoIP技
术在互联网上提供免费的语音通信，语音通信的成本大大低于传统的电话网络。

PC

LAN

WAN

IP-PT

ITSP

ISP

V-SIPGW

条件

• 互联网连接需要向ISP订购。

• 电话连接需要向ITSP订购。ISP和ITSP可能是同一家公司。

使用说明书（安装手册）参考

4.4  虚拟卡

8.4  SIP中继线
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使用说明书（PC编程手册）参考

9.8  PBX Configuration—[1-1] Configuration—Slot—Shelf Property—V-SIPGW
9.10  PBX Configuration—[1-1] Configuration—Slot—Port Property—V-SIPGW
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4.1.1.1  SIP服务器故障转移

说明

与SIP服务器通信时（例如，V-SIPGW卡处于INS状态、发送定期REGISTER请求时），如果SIP服务器在发送

REGISTER/INVITE请求后未回答，将使用下列方法之一再次发送REGISTER/INVITE请求。

• 如果注册了故障转移SIP服务器，将向该服务器发送REGISTER/INVITE请求。

• 如果未注册故障转移SIP服务器，将立即向从注册服务器名称的DNS解析获取的目的地发送REGISTER/
INVITE请求。

条件

• 故障转移目的地按以下顺序决定。

1. SIP服务器/注册服务器的故障转移目的地IP地址

2. DNS SRV记录/记录循环

• 如果上述故障转移操作失败，将通过公共中继线，而非SIP中继线来尝试通信。

将SIP中继线呼叫自动重新路由至公共中继线

当SIP中继线呼叫无法成功拨打时，集团电话会自动尝试改用公共中继线拨打该呼叫。当IP网络传送无法成功

完成时，这提供了拨打电话的后备方法。有关详情，请参阅"4.3.2  通过互联网传输语音协议（VoIP）网络—将

VoIP呼叫自动重新路由至公共中继线"。

[示例]

-1 -2

 1000  1011

(012-345-1011)

V-SIPGW V-SIPGW

"012-345-1011"

IP 

( 098) ( 012)

012-345-1011

使用说明书（安装手册）参考

4.4  虚拟卡

8.4  SIP中继线

使用说明书（PC编程手册）参考

9.10  PBX Configuration—[1-1] Configuration—Slot—Port Property—V-SIPGW—Main— SIP Server IP
Address for Failover
9.10  PBX Configuration—[1-1] Configuration—Slot—Port Property—V-SIPGW—Register — Registrar Server
IP Address for Failover
9.10  PBX Configuration—[1-1] Configuration—Slot—Port Property—V-SIPGW—Option— Failover
Timer(REGISTER)
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4.1.1.2  直接SIP连接

说明

如使用此功能，可以将集团电话用作网关，与外部SIP服务器提供的服务连接。

这样便可以将连接到集团电话的分机和中继线与外部服务的客户端连接。

V-SIPGW

IP 001

002

003

TCP SIP

条件

小心

• 如现场允许此功能，将使用基于TCP的SIP作为呼叫控制协议。在这种情况下，该现场的所有SIP线路

端口都将更改为TCP/IP固定操作，无法使用现有SIP线路（UDP/IP）所使用的协议。

• 如果现场允许此功能，请注意，该现场安装的所有V-IPGW和V-SIPGW卡都将被删除。

• 如果允许此功能，可使用的最大V-SIPGW信道数将被限制为每个现场64条信道，或每个系统256条信

道。

• 如果现场允许此功能，则该现场不能使用V-IPGW卡。

• 可以逐个现场允许或停用直接SIP连接。对此设置所作的更改将在对现场执行系统重置后反映出来。

有关详情，请参阅使用说明书（PC编程手册）中的"9.2.2  PBX Configuration—[1-1]
Configuration—Slot—System Property—Site—Main— SIP over TCP/IP (V-SIPGW) *)"。

• 如果允许此功能，支持的音频CODEC如下：

Codec 取样率

G.711 (μ-law) 8 kHz

G.711 (a-law) 8 kHz

命名电话活动 8 kHz

舒适噪音 8 kHz

RED/8000 8 kHz

• 从集团电话分机/中继线收到的带内DTMF信号（闪断除外）可以通过网关发送至外部服务客户端。

• 可以注册多个外部服务器并使用故障转移功能。有关详情，请参阅"4.1.1.1  SIP服务器故障转移"。
• 使用集团电话作为网关时，建议不要向外部服务客户端发送传真。
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使用说明书（安装手册）参考

4.4  虚拟卡

8.4  SIP中继线

使用说明书（PC编程手册）参考

9.2.2  PBX Configuration—[1-1] Configuration—Slot—System Property—Site
9.8  PBX Configuration—[1-1] Configuration—Slot—Shelf Property—V-SIPGW
9.10  PBX Configuration—[1-1] Configuration—Slot—Port Property—V-SIPGW
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4.1.2  综合业务数字网（ISDN）服务功能

4.1.2.1  综合业务数字网（ISDN）—概要

说明

ISDN是一个数字切换与传送网络。ISDN以数字格式传送语音、数据及图像。ISDN线路（如果可用）可以连接

到公共线路（中继线）、专用线路（QSIG）或ISDN终端设备（分机）。

1. ISDN接口和配置

接口类型 说明 端口方式 配置类型

主要速率接口（PRI） 提供三十个64 kbps B信道用于通

信，提供一个64 kbps D信道用于

信令（30B + D）。

中继线，QSIG
（主，从），分机*1

点到点

*1 ® 9.27  PBX Configuration—[1-1] Configuration—Slot—Port Property - PRI Port—Main— Port Type

注

点到点（P-P）：
可以将一个ISDN终端设备连接到一个ISDN端口。

点到多点（P-MP）：
最多可以将8个ISDN终端设备连接到一个ISDN端口。

2. 公共网络用ISDN补充服务表

服务 说明与参考

直接拨入（DDI） 将带DDI号码的呼叫接到预编程设定的目的地。（仅P-P）

® 2.1.1.3  直接向内拨号（DID）/直接拨入（DDI）

多个用户号码（MSN） 一个ISDN端口可以支持最多10个用于路由来电的MSN。（仅

P-MP）

® 2.1.1.4  多个用户号码（MSN）振铃服务

呼叫线路识别显示（CLIP） 打电话时，将来电电话号码发送到网络。被叫方在应答电话前可以

在其电话显示器上看到此号码。

® 4.1.2.2  呼叫/连接线路识别显示（CLIP/COLP）

连接线路识别显示（COLP） 接电话时，将应答方的电话号码发送到网络。线路接通后，主叫方

可以在其电话显示器上看到此号码。

® 4.1.2.2  呼叫/连接线路识别显示（CLIP/COLP）

呼叫线路识别限制（CLIR） 防止主叫方的CLI被主叫方显示给被叫方。

® 4.1.2.2  呼叫/连接线路识别显示（CLIP/COLP）
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服务 说明与参考

连接线路识别限制（COLR） 防止应答方发送COLP。

® 4.1.2.2  呼叫/连接线路识别显示（CLIP/COLP）

子地址（SUB） 可以在电话号码后面增加数字。这些数字将被传递给ISDN终端设

备。

话费通知（AOC） 集团电话可以从电话公司接收关于ISDN线路的话费信息。

® 4.1.2.3  话费通知（AOC）

呼叫转送（CF）—用ISDN 使用电话公司的ISDN服务将来电转送到另一个外线用户。

® 4.1.2.4  呼叫转送（CF）—用ISDN（P-MP）
® 4.1.2.5  呼叫转送（CF）—用ISDN（P-P）

呼叫保留（HOLD）—用ISDN 使一个ISDN呼叫处于保留状态。

® 4.1.2.6  呼叫保留（HOLD）—用ISDN

呼叫转移（CT）—用ISDN 将一个ISDN呼叫转移到一个外线用户。可以使用有通知的呼叫转

移和无通知的呼叫转移。

® 4.1.2.7  呼叫转移（CT）—用ISDN

三方会议（3PTY）－用ISDN 使用电话公司的ISDN服务建立三方会议电话。

® 4.1.2.8  三方会议（3PTY）－用ISDN

恶意电话识别（MCID） 分机用户可要求电话公司追查恶意来电。稍后将收到关于恶意电话

的信息。

® 4.1.2.9  恶意电话识别（MCID）

完成对占线用户的呼叫

（CCBS）
如果外线被叫方占线，当被叫方空闲时，分机可以收到回叫振铃。

® 4.1.2.10  完成对占线用户的呼叫（CCBS）

3. ISDN虚拟用户交换机服务

分机用户可以接入电话公司的ISDN虚拟用户交换机服务的功能（例如：呼叫转移）。通过发送闪断/重呼信

号使当前ISDN呼叫处于保留来使用该功能。每个ISDN端口可以允许或停用该功能。

® 9.27  PBX Configuration—[1-1] Configuration—Slot—Port Property - PRI Port—CO Setting— ISDN
Centrex

4. 专用网连接（QSIG）

可以使用ISDN线路进行与QSIG的专用连网。可以在ISDN端口基础上允许QSIG方式（主或从）。

5. ISDN分机（® 5.2.5.1  ISDN分机）

ISDN（PRI）端口可以用于分机连接。在允许分机连接时，可将ISDN终端设备（例如：ISDN电话、G4传
真机、PC）或一台后方集团电话连接到此端口。

当ISDN端口处于P-P配置时，可以将一个ISDN终端设备连接到该端口。
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当ISDN端口处于P-MP配置时，该端口最多能连接8个ISDN终端设备。然而，最多只能同时使用两台设备。

条件

• Overlap/En bloc
对于每个ISDN端口，可以选择Overlap或En bloc作为拨号方法，使集团电话将电话号码发送到电话公司。

所选拨号方法必须由电话公司提供。当选择"Overlap（重叠）"时，集团电话会单独发送每个拨号数字。

当选择"En bloc"时，集团电话一次发送全部拨号数字。

® 9.27  PBX Configuration—[1-1] Configuration—Slot—Port Property - PRI Port—CO Setting— ISDN
Outgoing Call Type

在En bloc方式下，当出现下列情况时，集团电话认为用户已完成拨号：

– 按下了#键（可编程设定）。

® 10.9  PBX Configuration—[2-9] System—System Options—Option 2— ISDN en Bloc Dial—[#] as
End of Dial for en Bloc mode

– 所拨号码是预编程设定的电话号码。

® 11.1.4  PBX Configuration—[3-1-4] Group—Trunk Group—Dialling Plan
– 数字码间定时器到期。

® 10.3  PBX Configuration—[2-3] System—Timers & Counters—Dial / IRNA / Recall / Tone—
Dial—Extension Inter-digit (s)

• 有些补充业务由主要协议提供（® 4.1.2.11  键盘接入ISDN服务协议）。

• 分机号码

可以将一个分机号码分配给每个ISDN端口。

® 12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Main—
Extension Number

• 承载电路方式

可以在分机基础上指定承载电路方式。

® 12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Option 7—
ISDN Bearer

使用说明书（PC编程手册）参考

9.25  PBX Configuration—[1-1] Configuration—Slot—Card Property - BRI type/PRI type
9.27  PBX Configuration—[1-1] Configuration—Slot—Port Property - PRI Port
10.3  PBX Configuration—[2-3] System—Timers & Counters—Dial / IRNA / Recall / Tone— Dial—Extension
Inter-digit (s)
10.9  PBX Configuration—[2-9] System—System Options—Option 2— ISDN en Bloc Dial—[#] as End of
Dial for en Bloc mode
11.1.4.1  PBX Configuration—[3-1-4] Group—Trunk Group—Dialling Plan—Auto Assign
12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings

→Main— Extension Number
→Option 7— ISDN Bearer

使用说明书（功能手册）参考

4.3.4  QSIG标准功能
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4.1.2.2  呼叫/连接线路识别显示（CLIP/COLP）
说明

呼叫线路识别显示（CLIP）：
当分机用户打电话时，集团电话可以把一个预编程设定的电话号码发送到网络。被叫方在应答电话前可以在其

电话显示器上看到此号码。

连接线路识别显示（COLP）：
当分机用户应答来电时，集团电话可以把一个预编程设定的电话号码发送到网络。当呼叫被应答时，来电者能

在其电话显示器上看到应答方的号码。

[CLIP示例]

ISDN

2) 

   "12345678"

1) 

   "87654321"

CLIP/COLP 12345678 CLIP/COLP 87654321

[COLP示例]

ISDN FWD IRNA

1) 

  "111222333"

2) 

3) 

  "111222444"

CLIP/COLP       

    111222333

 

CLIP/COLP 

    111222444

CLIP/COLP号码：

发送到网络用于CLIP/COLP的电话号码可以按如下方式指定：

• 每个ISDN端口的CLIP/COLP号码（用户的号码）。

• 每部分机的CLIP/COLP号码。

• 每个来电呼叫分配群的CLIP/COLP号码。

每部分机都能选择使用ISDN端口还是使用分机的CLIP/COLP号码。当通过按ICD群键打电话或接听到达ICD群

键的电话时，使用来电呼叫分配群的CLIP/COLP号码。

呼叫/连接线路识别限制（CLIR/COLR）：

通过按CLIR键、COLR键或输入功能号码，可以使每部分机限制将其电话号码发送到网络。

条件

• 此功能的可用性取决于与电话公司签订的合同。
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• CLIP/COLP功能符合以下欧洲电信标准（ETS）规范：

– ETS 300 092 呼叫线路识别显示（CLIP）补充业务。

– ETS 300 097 连接线路识别显示（COLP）补充业务。

• CLIR/COLR功能符合以下欧洲电信标准（ETS）规范：

– ETS 300 093 呼叫线路识别限制（CLIR）补充业务。

– ETS 300 098 连接线路识别限制（COLR）补充业务。

• 可以把已连接的ISDN端口的CLIP/COLP号码在那些不能指定有自己的CLIP/COLP号码的ISDN终端设备上

使用，例如门电话。

• 每个端口的COLP/CLIR/COLR分配

集团电话的每个ISDN端口都可以允许或停用每个服务。

• CLIR键和COLR键

通过按CLIR键可以在CLIP和CLIR之间切换，通过按COLR键可以在COLP和COLR之间切换。可以将一个

灵活键定制为CLIR或COLR键。

• CLIP/COLP号码必须与电话公司提供的电话号码相符。否则，它将被忽略或被另一个号码代替。

• 当使用专用网络时，通过系统编程分配给每部分机的分机号码会发送用于CLIP/COLP。（® 4.3.4.2  呼叫/
连接线路识别显示（CLIP/COLP）和呼叫/连接姓名识别显示（CNIP/CONP）—用QSIG）

• 当呼叫转送到公共中继线时，系统编程会选择是将主叫方还是转送分机的CLIP号码发送到转送目的地。

但是，如果通过来自VPS或UM的专用网络呼叫被转移到另一部集团电话，那么呼叫方的CLIP号码始终会

被发送，无论系统编程如何设置。

使用说明书（PC编程手册）参考

9.27  PBX Configuration—[1-1] Configuration—Slot—Port Property - PRI Port
→CO Setting— Subscriber Number
→Supplementary Service— COLP, CLIR, COLR, CNIP, CONP, CNIR, CONR, CF (Rerouting), CT,
CCBS, AOC-D, AOC-E, E911, 3PTY

10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features
→ COLR Set / Cancel
→ CLIR Set / Cancel
→ Switch CLIP of CO Line / Extension

10.9  PBX Configuration—[2-9] System—System Options—Option 4
→ Send CLIP of CO Caller—when call is transferred to CO (CLIP of Held Party)
→ Send CLIP of CO Caller—when call is forwarded to CO
→ Send CLIP of Extension Caller—when call is forwarded to CO

11.5.1  PBX Configuration—[3-5-1] Group—Incoming Call Distribution Group—Group Settings—Main—
CLIP on ICD Group Button
12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings

→Main— Extension Number
→CLIP— CLIP ID
→CLIP— CLIP on Extension/CO
→CLIP— CLIR
→CLIP— COLR

12.1.4  PBX Configuration—[4-1-4] Extension—Wired Extension—Flexible Button— Type
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使用说明书（功能手册）参考

2.21.2  灵活键

使用说明书（PT编程手册）参考

[003]分机号码

[606] CLIP/COLP号码

使用说明书（用户手册）参考

1.9.4  在被叫方和主叫方电话上显示您的电话号码（呼叫/连接线路识别显示[CLIP/COLP]）
1.9.5  防止您的电话号码显示在主叫方电话上（连接线路识别限制[COLR]）
1.9.6  防止您的号码显示在被叫方电话上（呼叫线路识别限制[CLIR]）
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4.1.2.3  话费通知（AOC）

说明

集团电话可以从电话公司接收关于ISDN线路的话费信息。

有以下类型：

类型 说明

呼叫过程中的话费通知

（AOC-D）

在呼叫过程中和结束通话时收到AOC。

话费通知

通话结束后（AOC-E）
在结束通话时收到AOC。

条件

• 该功能符合以下欧洲电信标准（ETS）规范：

– ETS 300 182 话费通知（AOC）补充业务数字用户信令系统一号（DSS1）协议。

• DPT用户可以在通话过程中在显示器上看到话费信息。

• 预算管理

如果话费总额达到预编程设定的限额，分机用户就不能再打电话。（® 2.7.2  预算管理）

• ISDN分机的AOC
ISDN分机也可以接收AOC。

使用说明书（PC编程手册）参考

9.27  PBX Configuration—[1-1] Configuration—Slot—Port Property - PRI Port—Supplementary Service—
COLP, CLIR, COLR, CNIP, CONP, CNIR, CONR, CF (Rerouting), CT, CCBS, AOC-D, AOC-E, E911, 3PTY
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4.1.2.4  呼叫转送（CF）—用ISDN（P-MP）
说明

当通过ISDN线路收到呼叫时，分机用户可以使用电话公司的ISDN服务，而不是集团电话功能，将ISDN来电呼

叫转送到另一个外线用户。

分机用户可以在MSN基础上设定至网络的转送目的地。此设定必须在使用此功能之前预先完成。有以下类型：

类型 说明

呼叫转送—无条件（CFU） 无条件地转送来电呼叫。

呼叫转送—占线（CFB） 当集团电话上的目的地占线时，转送来电呼叫。

呼叫转送—无应答（CFNR） 当集团电话上的目的地在预编程设定的时间内没有应答时，转送来电

呼叫。

当设定了CFB或CFNR时，在呼叫到达集团电话后，网络就决定将来电转送到预编程设定的目的地。当设定了

CFU时，网络将呼叫直接转送到预编程设定的目的地。

[示例]

MSN 123-4567

            987-6543

(01-23-4567)

1011

"123-4567"

MSN 123-4567

01-23-4567

(01-23-4567)

ISDN

<FWD>

1011

"123-4567"

< CF        ISDN P-MP >

ISDN

MSN 123-4567

CFU

01-23-4567

条件

• 该功能符合以下欧洲电信标准（ETS）规范：

– ETS 300 207 转移补充业务。

• 此功能的可用性取决于与电话公司签订的合同。

• 该功能需要MSN服务。（® 2.1.1.4  多个用户号码（MSN）振铃服务）
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• COS编程决定了能够使用此功能的分机。

使用说明书（PC编程手册）参考

10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features— ISDN-FWD (MSN) Set /
Cancel / Confirm
10.7.1  PBX Configuration—[2-7-1] System—Class of Service—COS Settings—CO & SMDR— CF (MSN)

使用说明书（功能手册）参考

2.3.2  呼叫转送（FWD）

5.1.1  服务等级（COS）

使用说明书（用户手册）参考

1.6.1  转送呼叫
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4.1.2.5  呼叫转送（CF）—用ISDN（P-P）
说明

当通过ISDN线路收到呼叫时，分机用户可以使用电话公司的ISDN服务，而不是集团电话功能，将ISDN来电呼

叫转送到另一个外线用户。

网络直接将呼叫转送至分机用户在集团电话上设定为中继线呼叫转送目的地的目的地；网络接受集团电话的指

令。只有当通过一个支持此功能的ISDN端口接收呼叫时此功能才可用。

呼叫转送—无条件（CFU）、呼叫转送—占线（CFB）、呼叫转送—无应答（CFNR）都适用于此功能。

[示例]

1011

"01-45-6789"

 01-23-4567

DDI 01-45-6789

01-23-4567

DDI  01-45-6789

01-23-4567

(01-23-4567)

ISDN

<FWD>

1011

"01-45-6789"

(01-23-4567)

< CF        ISDN P-P >

ISDN

条件

• 该功能符合以下欧洲电信标准（ETS）规范：

– ETS 300 207 转移补充业务。

• 此功能的可用性取决于与电话公司签订的合同。

• 可以在集团电话的每个ISDN端口上允许或不允许此功能。

• 当将同一个中继线群用于来电呼叫和被转送呼叫时，可使用此功能。

使用说明书（PC编程手册）参考

9.27  PBX Configuration—[1-1] Configuration—Slot—Port Property - PRI Port—Supplementary Service—
COLP, CLIR, COLR, CNIP, CONP, CNIR, CONR, CF (Rerouting), CT, CCBS, AOC-D, AOC-E, E911, 3PTY
10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features— ISDN-FWD (MSN) Set /
Cancel / Confirm
10.7.1  PBX Configuration—[2-7-1] System—Class of Service—COS Settings—CO & SMDR— CF (MSN)
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使用说明书（功能手册）参考

2.3.1  呼叫转送（FWD）/免打扰（DND）—概要

2.3.2  呼叫转送（FWD）

使用说明书（用户手册）参考

1.6.1  转送呼叫
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4.1.2.6  呼叫保留（HOLD）—用ISDN
说明

可以使用电话公司的ISDN服务，而不是集团电话功能，来保留ISDN呼叫。这可以是呼叫转移（CT）─用ISDN
（® 4.1.2.7  呼叫转移（CT）—用ISDN）和三方会议（3PTY）─用ISDN（® 4.1.2.8  三方会议（3PTY）－用

ISDN）的一部分。此功能允许保留ISDN呼叫，并且允许只使用一个ISDN通信信道给另一个外线用户打电话。

PT用户可通过按ISDN保留键来方便地使用此功能。

条件

• 该功能符合以下欧洲电信标准（ETS）规范：

– ETS 300 141 呼叫保留（保留）补充业务。

• ISDN保留键

可以将一个灵活键定制为ISDN保留键。

• 此功能的可用性取决于与电话公司签订的合同。

• 在启动此功能之后打电话时会应用TRS/限制功能。（® 2.7.1  长途限制（TRS）/呼叫限制（限制））

• ARS不能应用于启动此功能之后拨打的电话。（® 2.8.1  自动路由选择（ARS））
• 在使用该功能期间，不能取得任何其它中继线。

使用说明书（PC编程手册）参考

10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features— ISDN Hold
12.1.4  PBX Configuration—[4-1-4] Extension—Wired Extension—Flexible Button— Type

使用说明书（功能手册）参考

2.21.2  灵活键
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4.1.2.7  呼叫转移（CT）—用ISDN
说明

可以使用电话公司的ISDN服务，而不是集团电话功能，将ISDN呼叫转移到外线用户，而无需占用第二条ISDN
线。

条件

• 该功能符合以下欧洲电信标准（ETS）规范：

– ETS 300 369 显式呼叫转移（ECT）补充业务。

• 此功能的可用性取决于与电话公司签订的合同。

• 可以在ISDN端口基础上允许或停用此功能。

• 如果ISDN端口处于P-P配置，则只有当网络支持"显式链接"选项时才能使用此功能。

• 可以进行有通知的呼叫转移和无通知的呼叫转移。（® 2.12.1  呼叫转移）

• 集团电话将不会记录完成此功能之后的话费。

使用说明书（PC编程手册）参考

9.27  PBX Configuration—[1-1] Configuration—Slot—Port Property - PRI Port—Supplementary Service—
COLP, CLIR, COLR, CNIP, CONP, CNIR, CONR, CF (Rerouting), CT, CCBS, AOC-D, AOC-E, E911, 3PTY

使用说明书（用户手册）参考

1.4.1  转移呼叫（呼叫转移）
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4.1.2.8  三方会议（3PTY）－用ISDN
说明

在使用ISDN线路进行通话过程中，分机用户可以利用电话公司的ISDN服务增加另一方并建立三方会议电话，

而无需利用集团电话功能。

条件

• 该功能符合以下欧洲电信标准（ETS）规范：

– ETS 300 188 三方（3PTY）补充业务。

• 此功能的可用性取决于与电话公司签订的合同。

• 可以在ISDN端口基础上允许或停用此功能。

使用说明书（PC编程手册）参考

9.27  PBX Configuration—[1-1] Configuration—Slot—Port Property - PRI Port—Supplementary Service—
COLP, CLIR, COLR, CNIP, CONP, CNIR, CONR, CF (Rerouting), CT, CCBS, AOC-D, AOC-E, E911, 3PTY

使用说明书（用户手册）参考

1.4.5  多方通话
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4.1.2.9  恶意电话识别（MCID）

说明

在呼叫过程中或在来电者挂机后听到挂机重拨音时，分机用户可以要求电话公司追查打恶意电话的人。稍后将

收到关于恶意电话的信息。

条件

• 该功能符合以下欧洲电信标准（ETS）规范：

– ETS 300 130 恶意电话识别（MCID）补充业务。

使用说明书（PC编程手册）参考

10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features— MCID

使用说明书（用户手册）参考

1.3.6  识别恶意主叫方（恶意电话识别[MCID]）
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4.1.2.10  完成对占线用户的呼叫（CCBS）
说明

如果被叫方占线并且电话是使用ISDN线路拨打的，分机用户可以设定在被叫方空闲时接收回叫振铃。当用户应

答回叫振铃时，该被叫方的号码就被自动拨出。

条件

• 该功能符合以下欧洲电信标准（ETS）规范：

– ETS 300 359 完成对占线用户的呼叫（CCBS）补充业务。

• 在下列情况下可使用此功能：

a. 主叫方的集团电话能够使用CCBS并且该服务是由网络提供的。

b. 被叫方的集团电话能够接受CCBS。
• 若要接收和发送CCBS，必须通过系统编程在ISDN端口基础上分别允许接收和发送CCBS。
• 一个分机用户只能设定一个CCBS。最后设定是有效设定。

• 如果在60分钟内没有回叫振铃或在10秒钟内没有应答回叫振铃，CCBS设定就被取消。

• 在使用CCBS功能后，使用最后号码重拨不会恢复CCBS所拨的号码。（® 2.6.3  最后号码重拨）

• 已设定CCBS功能的分机用户如果正在保留一个呼叫，则不能接收回叫振铃。

使用说明书（PC编程手册）参考

9.27  PBX Configuration—[1-1] Configuration—Slot—Port Property - PRI Port—Supplementary Service
→ COLP, CLIR, COLR, CNIP, CONP, CNIR, CONR, CF (Rerouting), CT, CCBS, AOC-D, AOC-E, E911,
3PTY
→ CCBS Type
→ CCBS Delete Digits

使用说明书（用户手册）参考

1.2.4  当被拨线路占线或没有应答时

384 使用说明书（功能手册）
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4.1.2.11  键盘接入ISDN服务协议

说明

ISDN通过键盘协议提供一些补充业务，接入这些业务可能需要拨打服务接入代码。

条件

• 该功能符合以下欧洲电信标准（ETS）规范：

– ETS 300 122 支持补充业务的一般键盘协议（ISDN服务接入）。

• ISDN服务键

可以将一个灵活键定制为ISDN服务键。为了快速操作，也可以在此键上分配一个服务接入代码。

• 此功能不适用于单线电话（SLT）。

使用说明书（PC编程手册）参考

12.1.4  PBX Configuration—[4-1-4] Extension—Wired Extension—Flexible Button
→ Type
→ Dial (for ISDN Service)

使用说明书（功能手册）参考

2.21.2  灵活键

6.1  系统资源的容量

使用说明书（用户手册）参考

1.2.5  接入ISDN服务（ISDN服务接入）
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4.2  一体化网络

4.2.1  一体化网络概述

说明

一体化网络是一个连接KX-NS系列集团电话并通过专用IP网络进行管理的网络。 KX-NS1000集团电话作为主

设备来控制一部或多部集团电话（被称为从设备）。通过主设备可以进行几乎所有的编程和配置。该集团电话

可以在一体化网络中用作从设备。

虽然集团电话和分机可能实际位于不同的位置，但概念上整个系统作为一个集团电话运作。

无论集团电话是主设备还是从设备，一体化网络中的每部集团电话以及其下设备都被称为"现场"。每个现场的

集团电话通常被称为本地集团电话。

1 2 3

1

2

3

IP

(KX-NS1000)

有关设置和操作一体化网络的详情，请参阅KX-NS1000的说明书。

条件

• 必须安装DSP卡，才能在一体化网络中使用此该集团电话。

• 必须安装SD卡，才能在一体化网络中使用此该集团电话。

• 在一体化网络中使用该集团电话时，无法使用下列功能：

386 使用说明书（功能手册）
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– SVM（内装简化语音留言）

– PT系统编程

– 通过ISDN或模拟调制解调器进行远程维护

• 在一体化网络中使用该集团电话时，下列设备的最大容量将降低：

功能 独立操作 一体化网络

SMDR呼叫存储 40,000个电话 1000个电话

酒店收费记录 10,000个电话 4000个电话

使用说明书（安装手册）参考

2.1.1  系统配置

4.2.5  安装/拆下任选服务卡

4.2.6  安装/拆卸SD存储卡

4.3.2  SD存储XS卡（KX-NS3134）、SD存储S卡（KX-NS3135）、SD存储M卡（KX-NS3136）
4.3.3  DSP S卡（KX-NS5110）、DSP M卡（KX-NS5111）、DSP L卡（KX-NS5112）
8.2.1  使用NS-Net的一体化网络
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4.3  私人网络功能

4.3.1  TIE线路业务

说明

TIE线路是2部或多部集团电话之间的专门租用的通信线路，可以为处于不同地点的公司成员之间提供低成本、

高效率的通信。

接口

可以使用以下接口来建立专用网络：

接口 网络类型

VoIP（H.323） 互联网协议（IP）

PRI (QSIG) 数字（ISDN 30B+D）

→ 9.27  PBX Configuration—[1-1] Configuration—Slot—Port Property - PRI Port—Network Numbering
Plan— Trunk Property

注

使用PRI线路（QSIG）通过中继适配器可以建立TIE线路连接。

使用说明书（功能手册）参考

2.1.1.6  截取路由

2.3.2  呼叫转送（FWD）

2.7.1  长途限制（TRS）/呼叫限制（限制）

2.8.1  自动路由选择（ARS）
2.12.1  呼叫转移

2.16.1  直接拨入系统接入（DISA）
5.5.7  灵活编号/固定编号

6.1  系统资源的容量

使用说明书（用户手册）参考

1.2.1  基本呼叫
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4.3.1.1  拨打TIE线路电话

说明

可以使用以下两种方法来拨打TIE线路电话。

<分机号码方法（无集团电话代码接入）>
仅拨[分机号码]。

[示例]

-1

TIE

-2

2011

-3

30111011 1012

"3011" "2011"

TIE

解释：

若要使用此方法，必须更改任意一个集团电话的分机号码的首一或两位数（例如：集团电话-1为10XX，集团电

话-2为20XX），以便呼叫可以正常的路由。

例1：
集团电话-1的分机1012拨分机号码"2011"。
® 把集团电话-1的分机1012连接到集团电话-2的分机2011。
例2：
集团电话-1的分机1011拨分机号码"3011"。
® 把集团电话-1的分机1011连接到集团电话-3的分机3011。
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<集团电话代码方法（有集团电话代码接入）>
拨[TIE线路接入号码] + [集团电话代码] + [分机号码]。
® 10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features— TIE Line Access
® 17.1  PBX Configuration—[9-1] Private Network—TIE Table— Own PBX Code

[示例]

-1

951

-2

952

-3

953

TIE

1011

TIE

10111011 1012

"7-953-1011" "7-952-1011"

[TIE ]

[ ]

[ ]

解释：

若要使用此方法，必须知道每个集团电话代码以便识别分机的位置。

例1：
集团电话-1的分机1012拨TIE线路接入号码"7"、集团电话代码"952"和分机号码"1011"。
® 把集团电话-1的分机1012连接到集团电话-2的分机1011。
例2：
集团电话-1的分机1011拨TIE线路接入号码"7"、集团电话代码"953"和分机号码"1011"。
® 把集团电话-1的分机1011连接到集团电话-3的分机1011。
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4.3.1.2  TIE线路和中继线连接

说明

若要用中继线连接TIE线路，可使用以下模式：

1. 中继线至TIE接入

2. TIE至中继线接入

3. 中继线至TIE至中继线接入

中继线至TIE接入

可以把另一台集团电话的分机指定为打到自己集团电话的中继线呼叫来电的目的地。

也可以使用虚拟PS转送呼叫。使用此方法时，即使使用集团电话代码方法，集团电话-1收到的中继线呼叫还是

会直接的转送到集团电话-2的分机。

a. 中继线呼叫来电目的地分配

[示例]

TIE

TIE

-2

2011
"123-4567"

2011

DID 4567

1011

-1

解释：

外线来电者拨"123-4567"。根据集团电话-1的DID呼叫目的地的分配，呼叫通过TIE线路被发送到集团电

话-2的分机"2011"。（® 2.1.1.3  直接向内拨号（DID）/直接拨入（DDI））
® 18.3  PBX Configuration—[10-3] CO & Incoming Call—DDI / DID Table— DDI / DID
Destination—Day, Lunch, Break, Night
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b. FWD/呼叫转移/截取路由到TIE线路

[示例]

TIE

TIE

/

/ 7-952-2011

20111011

"123-4567"

-1 -2

951 952

解释：

外线来电者拨"123-4567"。呼叫到达目的地（集团电话-1的分机1011），该呼叫通过TIE线路被转送、转移

或截接到集团电话-2的分机"2011"。
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TIE至中继线接入

集团电话把TIE线路呼叫通过TIE线路发送到另一台集团电话的中继线。

a. 通过其它集团电话的中继线呼叫

[示例]
<分机号码方法（无集团电话代码接入）>

TIE

TIE

9-211-4567

211-4567

1011

"802-9-211-4567"

 (211-4567)

-1 -2

TRG 2 

2011

解释：

1. 集团电话-1的分机1011拨集团电话-1的中继线群接入号码"8"、中继线群号码"02"（TRG2）、集团电

话-2的空闲线路接入号码"9"和电话号码"211-4567"。
® 10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features— Trunk Group
Access

2. 集团电话-1通过中继线群（TRG）2（TIE线路）把呼叫发送到集团电话-2。
3. 集团电话-2把呼叫发送到外线用户"211-4567"。
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<集团电话代码方法（有集团电话代码接入）>

TIE

TIE

 952-9-211-4567

211-4567

1011

"7-952-9-211-4567"

"802-952-9-211-4567"

 (211-4567)

-1

951

-2

952

TRG 2 

1011

解释：

1. 集团电话-1的分机1011拨TIE线路接入号码"7"、集团电话代码"952"、集团电话-2的空闲线路接入号

码"9"和电话号码"211-4567"；或拨集团电话-1的中继线群接入号码"8"、中继线群号码"02"（TRG2）、
集团电话代码"952"、集团电话-2的空闲线路接入号码"9"和电话号码"211-4567"。

2. 该呼叫通过集团电话代码为"952"的集团电话-2连接到外线用户"211-4567"。
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通过其它集团电话的中继线呼叫—用ARS功能

[示例]
<使用ARS分机号码方法（无集团电话代码接入）>

TIE

TIE

9-211-4567

211-4567

1011

"9-211-4567"

 (211-4567)

-1 -2

TRG 2 

2011

解释：

1. 集团电话-1的分机1011拨集团电话-1的空闲线路接入号码"9"和电话号码"211-4567"。
2. 根据集团电话-1的ARS编程，集团电话-1修改该呼叫（加上集团电话-2的空闲线路接入号码"9"），并通

过TIE线路（中继线群[TRG] 2 ）发送呼叫至集团电话-2。
3. 集团电话-2把呼叫发送到外线用户"211-4567"。
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<使用ARS的集团电话代码方法（有集团电话代码接入）>

TIE

TIE

952-9-211-4567

211-4567

1011

"9-211-4567"

 (211-4567)

-1

951

-2

952

TRG 2 

1011

解释：

1. 集团电话-1的分机1011拨集团电话-1的空闲线路接入号码"9"和电话号码"211-4567"。
2. 根据集团电话-1的ARS编程，集团电话-1修改该呼叫（添加"952"和集团电话-2的空闲线路接入号

码"9"），并且通过TIE线路（中继线群[TRG] 2）发送呼叫至集团电话代码为"952"的集团电话-2。
3. 集团电话-2把呼叫发送到外线用户"211-4567"。

b. 阻止通过另一台集团电话拨打的中继线电话以及如何进行占优插入：

TIE线路呼叫来电能否通过此集团电话（即：集团电话-2）拨打中继线电话，取决于指定给呼入TIE线路所

连接的此集团电话的中继线群的COS。如果该中继线群的COS受长途限制/限制功能或外部通话阻止功能限

制而不能拨打去电呼叫，通过此集团电话拨打中继线呼叫将被禁止。

若要占优插入此限制，集团电话-1的分机必须输入分配给集团电话-2的验证代码才能暂时改变COS。或者

通过指定集团电话-2的一部分机使用流动COS功能以暂时切换到此分机的COS，这样也可以占优插入此限

制。

® 10.7.1  PBX Configuration—[2-7-1] System—Class of Service—COS Settings—TRS— TRS
Level—Day, Lunch, Break, Night
® 10.7.2  PBX Configuration—[2-7-2] System—Class of Service—External Call Block
® 11.1.1  PBX Configuration—[3-1-1] Group—Trunk Group—TRG Settings—Main— COS
® 14.3  PBX Configuration—[6-3] Feature—Verification Code
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[集团电话-2的编程示例]

Trunk Group No.

1

2

3

:

COS No.

3

2

2

:

:

COS 1

COS 2

COS 3

Outgoing Call

TRG 2 TRG 3 …

TRG of Incoming

 Call TRG 1

: : ::
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[示例]
<分机号码方法（无集团电话代码接入）>

TIE

TIE

9-211-4567

1011

-1

"8-02-9-

211-4567"

  (211-4567)

211-4567

1012

"8-02+ +    +

 + PIN+9-211-4567"

 +    + 

 +  PIN+9-211-4567

-2

-1

TRG 2

-2 TRG

1 COS 3

-2

TRG 3

2001

解释：

例1：
1. 集团电话-1的分机1011拨集团电话-1的中继线群接入号码"8"、TIE线路中继线群号码（TRG2）、集团电

话-2的空闲线路接入号码"9"和电话号码"211-4567"。
2. 该呼叫不会通过集团电话-2连接到外线用户，这是由于TRG1的COS（COS3）在接入集团电话-2的

TRG3时被阻止。

例2：
1. 集团电话-1的分机1012拨集团电话-1的中继线群接入号码"8"、TIE线路中继线群号码（TRG 2）、验证

码输入功能号码、 、验证代码、验证代码个人识别号码（PIN）、集团电话-2的空闲线路接入号码"9"和
电话号码"211-4567"。

2. 如果指定的验证代码适用于集团电话-2的COS2，那么该呼叫将通过集团电话-2连接到外线用户，这是

由于COS2在接入集团电话-2的TRG3时没有被阻止。
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<集团电话代码方法（有集团电话代码接入）>

TIE

TIE

952-9-211-4567

1011

-1
 - 951

"7-952-9-

211-4567"

(211-4567)

211-4567

1012 1001

-2
 - 952

-1

TRG 2

-2 TRG

1 COS 3

-2

TRG 3

952+ +   +

 + PIN+9-211-4567

"7-952+ +   +

+ PIN+9-211-4567"

解释：

例1：
1. 集团电话-1的分机1011拨TIE线路接入号码"7"、集团电话代码"952"、集团电话-2的空闲线路接入号

码"9"和电话号码"211-4567"。
2. 该呼叫不会通过集团电话-2连接到外线用户，这是由于TRG1的COS（COS3）在接入集团电话-2的

TRG3时被阻止。

例2：
1. 集团电话-1的分机1012拨TIE线路接入号码"7"、集团电话代码"952"、验证码输入功能号码、 、验证

代码、验证代码个人识别号码（PIN）、集团电话-2的空闲线路接入号码"9"和电话号码"211-4567"。
2. 如果指定的验证代码适用于集团电话-2的COS2，那么该呼叫将通过集团电话-2连接到外线用户，这是

由于COS2在接入集团电话-2的TRG3时没有被阻止。

c. 使用ARS的分项计费码优先插入

将ARS的分项计费码指定到集团电话-1时，分机的验证代码可自动被发送到集团电话-2，分机无需拨打验

证代码。

® 12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Option 1—
ARS Itemised Code
® 16.5  PBX Configuration—[8-5] ARS—Carrier
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[示例]
<分机号码方法（无集团电话代码接入）>

(211-4567)

211-4567

 

 

+    +  + PIN 

+9-211-4567   

1012

1013

11112222

33334444

2

0

CI9H

47  

COS

1111

3333

2222

4444

2

2

 

RingDate

06/04/18

06/04/18

Time

03:21PM

04:32PM

Ext

1001

*1111

CO

03

04

Dial Number

2114444

2114567

Duration

00:01'23

00:23'45

-1

-2

[SMDR ]

PIN

TIE

TIE

1

1011 1012

"9-211-4567"

2001

TIE

 

-1 TRG2

-2

TRG1(COS 3)

2

-2

TRG3

解释：

1. 集团电话-1012的分机1拨集团电话-1的空闲线路接入号码"9"和电话号码"211-4567"。
2. 根据集团电话-1的ARS编程，集团电话-1修改该呼叫（加上集团电话-2的验证代码接入功能号码、验证

代码和验证代码PIN，以及空闲线路接入号码"9"），并通过TIE线路（中继线群[TRG] 2 ）发送呼叫至集

团电话-2。
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<集团电话代码方法（有集团电话代码接入）>

 

2

0

CI9H

47952

RingDate

06/04/18

06/04/18

Time

03:21PM

04:32PM

Ext

1001

*1111

CO

03

04

Dial Number

2114444

2114567

Duration

00:01'23

00:23'45

1012

1013

11112222

33334444

-1

TIE

TIE

TIE

 

-1 TRG2

-2

TRG1(COS 3)

1
951 952

2

952+

+    +  + PIN 

+9-211-4567   

1011 1012

"9-211-4567"

1001

(211-4567)

211-4567

-2

TRG3

COS

1111

3333

2222

4444

2

2

-2

PIN

[SMDR ]

解释：

1. 集团电话-1012的分机1拨集团电话-1的空闲线路接入号码"9"和电话号码"211-4567"。
2. 根据集团电话-1的ARS编程，集团电话-1修改该呼叫（添加"952"、验证代码接入功能号码、验证代码、

验证代码PIN和集团电话-2"9"的空闲线路接入号码），并且通过TIE线路（中继线群[TRG] 2）发送呼叫

至集团电话代码为"952"的集团电话-2。
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d. FWD/呼叫转移/截取路由到中继线

[示例]

TIE

TIE

952-1011

/ / 211-4567

1011 1011

"7-952-1011"

 (211-4567)

-1

 -  951

-2
 - 952

解释：

1. 集团电话-1的分机1011拨TIE线路接入号码"7"、集团电话代码"952"和分机号码"1011"。
2. 该呼叫通过TIE线路到达目的地（集团电话-2的分机1011），并且该呼叫通过中继线被转送、转移或截

接到外线用户"211-4567"。

402 使用说明书（功能手册）
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中继线至TIE至中继线接入

使用DISA功能，外线来电者可以通过TIE线路连接到外线用户。

[示例]

0109

TIE

TIE

952-9-01-23-4567

1011 1011
" DISA

-9-01-23-4567"

(23-4567)

23-4567

TRG 2 

DISA

-1
 - 951

-2
 - 952

解释：

1. 外线来电者拨"集团电话-1的DISA电话号码"、集团电话-1的空闲线路接入号码"9"和电话号码"01-23-4567"。
2. 根据集团电话-1的ARS编程，集团电话-1修改该呼叫（添加"952"和集团电话-2的空闲线路接入号码"9"），

并且通过TIE线路（中继线群[TRG] 2）发送呼叫至集团电话代码为"952"的集团电话-2。
3. 根据自身的ARS编程，集团电话-2把改变的呼叫发送到外线用户"23-4567"。
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4.3.1.3  TIE线路编程

说明

拨打TIE线路电话

当分机用户拨打TIE线路电话时，集团电话参考TIE线路路由和修改表，以识别中继线路由。

对TIE线路网络上的全部集团电话须制作统一的路由和修改表。

适合每个呼叫的路由类型由所拨号码决定。

对于这些表，有两个系统程序：

TIE线路路由表：用于指定前置号码（集团电话代码或分机号码）和中继线群搜索顺序。

® 17.1  PBX Configuration—[9-1] Private Network—TIE Table— Leading Number
TIE修改删除的位数/添加的号码：用于从TIE线路呼叫的所拨号码中删除位数和对其添加号码。根据TIE线路网

络配置，可能需要这种修改。

17.1  PBX Configuration—[9-1] Private Network—TIE Table
® Removed Number of Digits
® Added Number
® Trunk Group
[编程示例]
您的集团电话为集团电话-1，TIE线路网络中有四台集团电话。为了识别如图所示的中继线路由，应该制作下

表。

a. 分机号码方法（无集团电话代码接入）

10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Other PBX Extension— Dial

TRG 1 

a) 2xxx

TIE

4xxx

1xxx 2xxx

3xxx

c) 4xxxTRG 2

a) 2xxx

b) 3xxx

c) 4xxx

b-2nd) 3xxx

b-1st) 3xxx
2 3 4

 [TIE]
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[集团电话-1的TIE线路路由和修改表]

位置编号 前置号码

优先权1 优先权2 . .

TRG

拨号修改

TRG

拨号修改 . .

删除的位数
添加的号

码
删除的位数

添加的号

码
. .

01 2 1 0     . .

02 3 1 0  2 0  . .

03 4 2 0     . .

: : : : : : : : :

解释：

位置01：
拨[2XXX]的搜索顺序：

第1个路由—中继线群（TRG）1  将号码发送到集团电话-2：2XXX
位置02：
拨[3XXX]的搜索顺序：

第1个路由—中继线群（TRG）1  将号码发送到集团电话-2：3XXX
第2个路由—中继线群（TRG）2  将号码发送到集团电话-4：3XXX
位置03：
拨[4XXX]的搜索顺序：

第1个路由—中继线群（TRG）2  将号码发送到集团电话-4：4XXX

b. 集团电话代码方法（有集团电话代码接入）

® 10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features— TIE Line Access
® 17.1  PBX Configuration—[9-1] Private Network—TIE Table— Own PBX Code

TRG 1 

TIE

xxxx

1xxx xxxx

xxxx

TRG 2

-1

a) 952-xxxx

-2

-4 -3

952951

953

b-1st) 953-xxxx

c)      954#-xxxx

a) 7-952-xxxx

b) 7-953-xxxx

c) 7-954-xxxx

7

TIE

954

b-2nd)      953#-xxxx
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[集团电话-1的TIE线路路由和修改表]

位置编号 前置号码

优先权1 优先权2 . .

TRG

拨号修改

TRG

拨号修改 . .

删除的位数
添加的号

码
删除的位数

添加的号

码
. .

01 952 1 0     . .

02 953 1 0  2 3 953# . .

03 954 2 3 954#    . .

: : : : : : : : :

解释：

位置01：
拨[7+集团电话代码952+XXXX]的搜索顺序：

第一个路由—中继线群（TRG）1
 将号码发送到集团电话-2：952–XXXX

位置02：
拨[7+集团电话代码953+XXXX]的搜索顺序：

第一个路由—中继线群（TRG）1
 将号码发送到集团电话-2：953–XXXX

第二个路由—中继线群（TRG）2
 将号码发送到集团电话-4： 953#–XXXX

位置03：
拨[7+集团电话代码954+XXXX]的搜索顺序：

第一个路由—中继线群（TRG）2
 将号码发送到集团电话-4： 954#–XXXX
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接听TIE线路电话

a. 分机号码方法（无集团电话代码接入）

[示例]

-1 -2

1011

1 3011

2 3011

-4

2011

-3

3011

"3011"

3

TIE

1 将TIE线路呼叫从集团电

话-1发送到集团电话-2。
如果从集团电话-1发送的

号码是集团电话-2的一个

分机号码（例如：2011），
则将在分机"2011"处接到

该呼叫。如若不然，集团

电话-2检查集团电话-2TIE
线路路由和修改表中的号

码。

2 如果在表中找到匹配的号

码，将根据此表修改该呼

叫并将其发送到相应的集

团电话（集团电话-3）。

3 从集团电话-2发送的号

码"3011"是集团电话-3的
一个分机号码。在分

机"3011"处接到该呼叫。

注

当从一台集团电话发送TIE线路呼叫至另一台集团电话时，接收呼叫的集团电话首先会根据中继线端口

的分配情况修改接收到的号码：删除的位数和增加的位数由该分配情况决定。然后，该集团电话检查此

完整号码是否为该集团电话中已存在的分机号码。
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b. 集团电话代码方法（有集团电话代码接入）

[示例]

1011

1 953-1011

953-10112

3

1011

1011

"7-953-1011"
-1 -2

-4 -3

 952 951

 953 954

TIE

1 将TIE线路呼叫从集团

电话-1发送到集团电

话-2。如果从集团电

话-1发送的号码具有集

团电话-2的集团电话代

码"952"，将在相应的

集团电话-2分机处（例

如：集团电话-2的
1011）接到呼叫。如若

不然，集团电话-2检查

集团电话-2TIE线路路

由和修改表中的号码。

2 如果在表中找到匹配的

号码，将根据此表修改

该呼叫并将其发送到相

应的集团电话（集团电

话-3）。

3 从集团电话-2发送的号

码"953-1011"具有集团

电话-3的集团电话代

码"953"。因此该呼叫

在集团电话-3的分

机"1011"上被接到。

注

当从一台集团电话发送TIE线路呼叫至另一台集团电话时，集团电话首先会根据集团电话每个中继线端

口的分配情况修改发送到该集团电话的号码：发送到该集团电话的号码的位数删除和/或号码添加由该

分配情况决定。然后集团电话开始检查该号码，确定其是否是集团电话的集团电话代码。
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TIE线路路由流程图

[从分机拨打TIE线路电话]

TIE

7-abc-xxxx

dexx

Yes

TIE 7

de

No

No

No

No

Yes

Yes

TIE

?

?

Yes

?

TIE

 ( abc de) ?

/

TIE 

A
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[通过TIE线路接收呼叫]

<  ( )>

TIE

1

# 1021

# 1021=1021

# 1021

1021 1033

No

No

No

Yes

Yes 9511033

1

<  ( )>

TIE

3

9

## 0511033

"951" ?

?

"951"

##0511033= 9511033

## 0511033

1) 3 2) "9"

Yes

?

(

— )

No

—

/

A

A

(       [

TIE ] 

)

A

(       [

TIE

] )

A

Yes

/

COS ?

(

— )
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条件

• 应将用于专用网络的中继线的网络类型指定为"Private（专用）"。（® 2.1.1.1  中继线呼叫来电功能—概

要）

• 若要建立QSIG网络（® 4.3.4  QSIG标准功能），TIE线路网络中的每个ISDN（QSIG）连接必须指定一部

集团电话上的端口为主端口，并指定另一部集团电话上的端口为从端口。支持此功能的集团电话为KX-NS
系列、KX-NCP系列、KX-TDE系列和KX-TDA系列集团电话。

[TIE线路网络连接示例]

-1

-3

-2
1000

        :

1999

2000

        :

2999

(A) 

(B) 

(C) 

QSIG

(A) 

(C) 

(B) 

3000

        :

3999

• 当TIE线路呼叫到达已停用呼叫等待的占线分机时，来电者将听到忙音。如果需要，可以启动截取路由—占

线/免打扰功能。

• 可以为TIE线路呼叫指定数字码间时间。

® 10.3  PBX Configuration—[2-3] System—Timers & Counters—Miscellaneous— Incoming Call
Inter-digit Timer—TIE (s)

使用说明书（PC编程手册）参考

9.2  PBX Configuration—[1-1] Configuration—Slot—System Property
→V-IPGW–GW Settings–Main
→V-IPGW–DN2IP

9.11.2  PBX Configuration—[1-1] Configuration—Slot—Shelf Property—V-IPGW—Hunt Pattern
9.27  PBX Configuration—[1-1] Configuration—Slot—Port Property - PRI Port—Network Numbering Plan—
Trunk Property
10.3  PBX Configuration—[2-3] System—Timers & Counters—Miscellaneous— Incoming Call Inter-digit
Timer—TIE (s)
10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features

→ Idle Line Access (Local Access)
→ Trunk Group Access
→ TIE Line Access

10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Other PBX Extension
10.7.1  PBX Configuration—[2-7-1] System—Class of Service—COS Settings—TRS— TRS Level—Day,
Lunch, Break, Night
10.9  PBX Configuration—[2-9] System—System Options—Option 4— Private Network—TIE Call by
Extension Numbering
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11.1.1  PBX Configuration—[3-1-1] Group—Trunk Group—TRG Settings—Main— COS
17.1  PBX Configuration—[9-1] Private Network—TIE Table
18.2  PBX Configuration—[10-2] CO & Incoming Call—DIL Table & Port Settings

→DIL— Trunk Property
→DIL— DIL Destination—Day, Lunch, Break, Night
→DDI / DID / TIE / MSN

18.3  PBX Configuration—[10-3] CO & Incoming Call—DDI / DID Table— DDI / DID Destination—Day, Lunch,
Break, Night
18.5  PBX Configuration—[10-5] CO & Incoming Call—Miscellaneous— Intercept—Routing to Operator -
No Destination (Destination is not programmed.)

使用说明书（PT编程手册）参考

[453] DID目的地

[500]中继线群号码
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4.3.1.4  2个集团电话的公用分机编号

说明

2部集团电话可以具有相同前置号码的分机。可以使用分机编号进行TIE线路呼叫。

-1 -2

10131011 1012

"1013"

TIE

解释：

如果在本地集团电话中没有找到所拨号码，该呼叫会被发送到远程集团电话。

拨打了分机号码时，集团电话首先搜索与号码相匹配的本地分机。如果没有找到匹配号码，远程集团电话会在

TIE线路路由表中检查是否有相应的条目。如果找到了条目，该呼叫会被发送到连接的集团电话。

例1：
集团电话-1的分机1012拨分机号码"1011"。
® 因为在本地集团电话里找到了所拨的号码，所以将集团电话-1的分机1012连接到集团电话-1的分机1011。
例2：
集团电话-1的分机1012拨分机号码"1013"。
® 因为在本地的集团电话里没有找到所拨号码，所以该呼叫被转接到指定的TIE线路，然后把集团电话-1的分

机1012连接到集团电话-2的分机1013。

条件

• 使用此功能需要KX-NSN002（QSIG 网络激活密钥）。

• 要允许此功能需要进行系统编程。
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4.3.2  通过互联网传输语音协议（VoIP）网络

说明

当通过专用IP网络将一部集团电话连接至另一部集团电话时，会将语音信号转换成IP数据包并通过网络发送。

这被称为IP电话（VoIP）。本集团电话使用H.323标准进行VoIP通信。

VoIP网络支持使用TIE线路业务的专用网络通信。

[示例]

V-IPGW V-IPGW

V-IPGW

-1 -2

1000

        :

1999

2000

        :

2999

-3

3000

        :

3999

"2999"

IP

TRG 1

TRG 2
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编程要求

• 集团电话

对于拨打电话：

ARS编程（® 2.8.1  自动路由选择（ARS））或TIE线路业务编程

对于接听电话：

TIE线路业务编程

[TIE线路路由和修改表]

位置编号 前置号码

优先权1 优先权2 . .

TRG

拨号修改

TRG

拨号修改 . .

删除的位数
添加的号

码
删除的位数

添加的号

码
. .

01 2
2

（VoIP
端口）

0
    . .

02 3 2 0     . .

: : : : : : : : :

[解释]
拨打到带有前置号码"2"或"3"的目的地的呼叫通过VoIP端口自动路由，指定为中继线群2。

• IP网关

本地集团电话和其它集团电话的IP地址分配。

[编程示例]

目的地

前置号码 IP地址

2 200.45.11.35

3 199.176.64.1

: :

[解释]
根据所拨的前置号码，呼叫被路由到每个V-IPGW卡的IP地址。

将VoIP呼叫自动重新路由至公共中继线

当VoIP呼叫无法成功拨打时，集团电话会自动尝试改用公共中继线拨打该呼叫。当IP网络传送无法成功地完成

时，这提供了拨打电话的后备方法。
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[示例]

V-IPGW V-IPGW

-1 -2

1000 1011

(012-345-1011)

"7-20-1011"

IP

098 012

2030

012-345-1011

通过VoIP网络接入的分机前置号码，会增添为进入快速拨号表的条目，同时被注册为其它集团电话分机号码，

显示如下：

[编程示例]
使用VoIP网络在其它集团电话呼叫某一分机的拨号：

7（TIE线路接入号码）+ 20（集团电话代码）+ 1011（分机号码）

使用公共中继线呼叫该分机的拨号：

9（中继线接入号码）+ 012-345-1011
[快速拨号表]

快速拨号号码 目的地号码

720 9012345

如果使用VoIP网络无法拨打该呼叫，以及所拨的前置号码在快速拨号表中找到，该呼叫将会自动重新路由至对

应目的地号码所指定的中继线。

当使用VoIP网络拨打呼叫时，如果集团电话在拨打该呼叫后约4秒内无法收到来自其它集团电话的回答，或者

有错误返回，该呼叫会重新路由至所指定的公共中继线。

使用ARS将VoIP呼叫自动重新路由至公共中继线

使用ARS拨打外线用户时，如果呼叫无法成功完成，可以将其路由至公共中继线。

(012-345-1011)1000 V-IPGW V-IPGW

"9-012-345-1011"                                                                    

-1

012-345-1011

098
012

IP

-2

解释：

1. 集团电话-1的分机拨集团电话-1的空闲线路接入号码"9"和电话号码"012-345-1011"。
2. 集团电话-1根据集团电话-1的ARS编程修改呼叫并通过专用IP网络将其路由至集团电话-2。
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3. IP网络传输无法成功完成，呼叫通过公共中继线重新路由至外线用户"012-345-1011"。
[快速拨号表]
可以在快速拨号表中找到拨打号码的前置号码（此例中为"9"），呼叫会被自动路由至指定的中继线群。必须指

定中继线群才能进行此类呼叫。如果目的地号码中使用了空闲线路接入号码，该呼叫将根据ARS编程通过相同

的专用IP网络重新路由，而且该呼叫将无法完成。

快速拨号号码 目的地号码

9 802

通过网络发送传真

通过系统编程，可以选择是使用模拟还是使用T.38协议信号来发送传真。

条件

• 可使用某些QSIG服务。（® 4.3.4  QSIG标准功能）

• TRS/呼叫限制设定适用于重新路由至公共中继线的呼叫。当使用系统速拨拨打电话时，即使启用了用系统

速拨占优插入长途限制/限制功能，也会应用常规的TRS/呼叫限制设定。（® 2.7.1  长途限制（TRS）/呼叫

限制（限制））

使用说明书（安装手册）参考

4.4  虚拟卡

使用说明书（PC编程手册）参考

9.11.2  PBX Configuration—[1-1] Configuration—Slot—Shelf Property—V-IPGW—Hunt Pattern
9.12  PBX Configuration—[1-1] Configuration—Slot—Port Property—V-IPGW
17.1  PBX Configuration—[9-1] Private Network—TIE Table

使用说明书（功能手册）参考

2.8.1  自动路由选择（ARS）
4.3.1  TIE线路业务
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4.3.2.1  网关群

说明

根据预先指定的网关群，可以自动重新路由去电VoIP呼叫。

可以根据网关设备的IP地址为其分配网关群号码。使用分配到网关群的前置号码拨打电话时，电话被路由至该

群内可用的最小编号设备。换句话说，如果最小编号设备遇忙或不可用，呼叫会移至下一可用的设备。

[示例]

V-IPGW IP

 

1. IP (1) GW -1

2. IP (2) GW -1

3. IP (3) GW -2

4. IP (4) GW -2

"123XXX"

IP (1)

IP (2)

IP (3)

IP (4)

A GW -1

B GW -2

1. 1xx GW -1

2. 2xx GW -2

拨打了"123XXX"时，呼叫被路由至GW群－1。但是，最小编号设备（IP网关（1））遇忙或不可用，因此呼叫

被路由至IP网关（2）。
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4.3.2.2  多个集团电话的公用分机编号

说明

在各个位置连接在IP网络中的多部集团电话可以共享在网关群中所指定的普通分机区块。

203

202

102

303

201

105

1) 105

A A

B B

C C

101

103

104

4) 

5) C

105

3) 

2) 

B 105

V-IPGW

V-IPGW

V-IPGW

解释：

按照与通过TIE线路连接时相同的方式，如果在本地集团电话没有找到拨打的号码，呼叫可发送到通过IP网络

所连接的其他集团电话。拨打了分机号码时，集团电话首先搜索与号码相匹配的本地分机。如果没有找到匹配

号码，集团电话会在网关群的TIE线路路由表中检查是否有相应的条目。如果找到了条目，该呼叫会被发送到

连接的集团电话。

条件

• 要允许此功能需要进行系统编程。

• 如果被叫集团电话处没有被叫分机，则会自动呼叫相同网关群中的下一部集团电话。

• 为了使用该功能，必须禁用系统编程中的路由到话务员设置。

• 为了使用该功能，IP网络中的所有集团电话必须都是KX-NS系列集团电话或KX-NCP　KX-TDE系列集团电

话，MPR软件版本3.0000或更高版本。

使用说明书（PC编程手册）参考

18.5  PBX Configuration—[10-5] CO & Incoming Call—Miscellaneous— Intercept—Routing to Operator -
No Destination (Destination is not programmed.)
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4.3.2.3  呼叫分配端口群

说明

可以根据呼叫方的电话号码来设定哪个虚拟端口来接收每个呼叫。

通过将每个端口分配到呼叫分配端口群（CDPG），可以选择哪个群来接收每个呼叫。CDPG设定包括了集团电

话中的所有V-IPGW卡，允许将不同卡上的端口分配到相同的CDPG。换句话说，可以将两个8端口卡用作一个

16端口卡。

编程示例：

若要允许此功能，需要通过系统编程对以下2个表格进行编程：

• CDPG表

-为了将端口分配到呼叫分配端口群。

• 搜索类型表

-为了编程每个前置号码的CDPG目的地优先权列表。

[CDPG表的编程示例]

V-IPGW卡号码 端口号码 呼叫分配端口群*1

1 1 CDPG 1

1 2 CDPG 2

1 : :

1 8 CDPG 2

2 1 CDPG 1

2 : :

2 8 CDPG 3

*1 ® 9.12  PBX Configuration—[1-1] Configuration—Slot—Port Property—V-IPGW— Call Distribution Port Group

[搜索类型表的编程示例]

号码 前置号码*1
呼叫分配端口群（第

一）*2
呼叫分配端口群（第

二）*2 …
呼叫分配端口群（第十

六）*2

1 10 CDPG 1 CDPG 4 … -

2 20 CDPG 1 CDPG 2 … CDPG 3

: : : : … :

32 300 CDPG 8 CDPG 11 … -

*1 ® 9.11.2  PBX Configuration—[1-1] Configuration—Slot—Shelf Property—V-IPGW—Hunt Pattern—Hunt Pattern 1–
16— Leading Number

*2 ® 9.11.2  PBX Configuration—[1-1] Configuration—Slot—Shelf Property—V-IPGW—Hunt Pattern—Hunt Pattern 1–
16— Call Distribution Port Group—1st–16th

注

可以为多个前置号码设定相同的CDPG。

420 使用说明书（功能手册）

4.3.2 通过互联网传输语音协议（VoIP）网络



解释：

如上CDPG表所示，CDPG 1包括第一个卡的端口1和第二个卡的端口 1。拨打"1023-456-7890"（前置号码：

10）时：

10

CDPG 1 CDPG

1 1

1 1

如果所有属于CDPG 1的端口均占线，呼叫会重新路由至属于设定为该前置号码第二优先权的CDPG 4的最小

号码可用端口。
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4.3.3  ISDN虚拟专用网（ISDN-VPN）

说明

ISDN虚拟专用网（ISDN-VPN）是电话公司提供的一项服务。它使用已有的线路，如同使用专用线路一样。不

需要建立专用线路或从电话公司租用一条线路。使用同一条线路就可以拨打和接听公共电话与专用电话。

公共/专用区别：

a. 拨打电话：在将所拨号码发送到电话公司之前，需要公共/专用区别号码。可以人工拨公共/专用区别号码，

也可以通过ARS编程（® 2.8.1  自动路由选择（ARS））和/或TIE线路业务编程自动拨公共/专用区别号码。

b. 接听电话：电话公司会区别电话类型。如果它是专用呼叫，则用TIE线路业务方法接收该呼叫。如果它是公

共呼叫，则由指定给中继线的中继线呼叫来电分配方法（DIL/DDI/MSN）接收该呼叫。

[示例]

201 202 301 302

(DDI

01-45-6789)

401 402

01-23-4567

ISDN-VPN

ISDN

"401"

(TIE)

"9-01-23-4567"

(ARS)

"01-45-

6789"

< >

 9-0-01-23-4567

        

< >

 113-401

       

 111  112  113

条件

• 通过系统编程可以将每个PRI端口设定为公共或VPN。若要使用该服务，请选择VPN。

• 即使电话公司不支持ISDN-VPN服务，当用TIE线路业务编程和/或快速拨号编程打电话时，仍可以使用同类

服务（® 2.6.5  快速拨号）。
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[快速拨号编程示例]

位置编号 快速拨号号码 所需号码

快速拨号01 2345（其它集团电话的分机号码） 9-123-4321（分机2345的公共

号码）

: : :

解释：

当分机用户拨"2345"时，将被连接到公共号码为"123-4321"的其它集团电话的分机"2345"。

使用说明书（PC编程手册）参考

9.27  PBX Configuration—[1-1] Configuration—Slot—Port Property - PRI Port—Network Numbering Plan—
Trunk Property
16.2  PBX Configuration—[8-2] ARS—Leading Number— Leading Number
17.1  PBX Configuration—[9-1] Private Network—TIE Table

→ Leading Number
→ Removed Number of Digits
→ Added Number

使用说明书（功能手册）参考

4.3.1  TIE线路业务
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4.3.4  QSIG标准功能

4.3.4.1  QSIG标准功能—概要

说明

QSIG是一项基于ISDN（Q.931）的协议，用在专用网络中可提供增强的集团电话功能。QSIG网络支持使用TIE
线路业务方法的专用通信。

ISDN-QSIG或VoIP专用网络有以下功能可以使用。对于ISDN，需要进行系统编程以指定专用网络的每个端口

是否都可使用所有功能（包括呼叫线路识别显示[CLIP]）。

[服务表]

服务 说明与参考

呼叫线路识别显示（CLIP） 打电话时，将来电号码发送到QSIG网络上。

® 4.3.4.2  呼叫/连接线路识别显示（CLIP/COLP）和呼叫/连接姓名

识别显示（CNIP/CONP）—用QSIG

连接线路识别显示（COLP） 接电话时，将应答方的号码发送到QSIG网络上。

® 4.3.4.2  呼叫/连接线路识别显示（CLIP/COLP）和呼叫/连接姓名

识别显示（CNIP/CONP）—用QSIG

呼叫线路识别限制（CLIR） 防止主叫方的CLI被主叫方显示给被叫方。

® 4.3.4.2  呼叫/连接线路识别显示（CLIP/COLP）和呼叫/连接姓名

识别显示（CNIP/CONP）—用QSIG

连接线路识别限制（COLR） 防止应答方发送COLP。

® 4.3.4.2  呼叫/连接线路识别显示（CLIP/COLP）和呼叫/连接姓名

识别显示（CNIP/CONP）—用QSIG

呼叫姓名识别显示（CNIP） 打电话时，将来电者的名称发送到QSIG网络上。

® 4.3.4.2  呼叫/连接线路识别显示（CLIP/COLP）和呼叫/连接姓名

识别显示（CNIP/CONP）—用QSIG

连接姓名识别显示（CONP） 应答呼叫时，将应答方的姓名发送到QSIG网络上。

® 4.3.4.2  呼叫/连接线路识别显示（CLIP/COLP）和呼叫/连接姓名

识别显示（CNIP/CONP）—用QSIG

呼叫姓名识别限制（CNIR） 防止主叫方姓名被主叫方显示给被叫方。

® 4.3.4.2  呼叫/连接线路识别显示（CLIP/COLP）和呼叫/连接姓名

识别显示（CNIP/CONP）—用QSIG
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服务 说明与参考

连接姓名识别限制（CONR） 防止应答方发送CONP。

® 4.3.4.2  呼叫/连接线路识别显示（CLIP/COLP）和呼叫/连接姓名

识别显示（CNIP/CONP）—用QSIG

呼叫转送（CF）—用QSIG 转送呼叫至QSIG网络。

® 4.3.4.3  呼叫转送（CF）—用QSIG

呼叫转移（CT）—用QSIG 转移呼叫至QSIG网络。

® 4.3.4.4  呼叫转移（CT）—用QSIG

完成对占线用户的呼叫

（CCBS）—用QSIG
当QSIG网络上的占线被叫方变得空闲时，接收回叫振铃。

® 4.3.4.5  完成对占线用户的呼叫（CCBS）—用QSIG

使用说明书（功能手册）参考

4.1.2  综合业务数字网（ISDN）服务功能

4.3.1  TIE线路业务
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4.3.4.2  呼叫/连接线路识别显示（CLIP/COLP）和呼叫/连接姓名识别显示

（CNIP/CONP）—用QSIG
说明

呼叫线路/姓名识别显示（CLIP/CNIP）：
当分机用户打电话时，集团电话可以将预编程设定的分机号码和/或姓名发送给QSIG网络。被叫方在应答呼叫

前，可以在其电话显示器上看到号码和/或姓名。

连接线路/姓名识别显示（COLP/CONP）：
当分机用户应答来电时，集团电话将预编程设定的分机号码和/或姓名发送给QSIG网络。当呼叫被应答时，来

电者能在其电话显示器上看到应答方的号码和/或姓名。

[CLIP/CNIP示例]

1) "202"

2) "John  101"

-1 -2CLIP 101

CNIP John

( 202)( 101

 John)

[COLP/CONP示例]

-2-1

FWD IRNA

1) "203"

2) 

( 204 

 Paul) 

COLP 204

CONP Paul
3) "Paul 204"

 

( 203 

  Tom) 

CLIP/COLP号码：

通过系统编程，可以为每部分机分配发送到QSIG网络的用于CLIP/COLP的分机号码。

CNIP/CONP姓名：

通过系统编程，可以为每部分机分配发送到QSIG网络的用于CNIP/CONP的分机姓名。

呼叫/连接线路识别限制（CLIR/COLR）：

通过按CLIR键、COLR键或输入功能号码，每部分机都可以限制发送其分机号码至QSIG网络。

呼叫/连接姓名识别限制（CNIR/CONR）：

每部分机都可以限制发送其分机姓名至QSIG网络。当启动CLIR时，CNIR也自动启动。当启动COLR时，CONR
也自动启动。
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条件

• 这些功能符合以下欧洲电信标准（ETS）规范：

– CLIP/COLP：ETS 300 172 电路方式基本服务。

– CNIP/CONP：ETS 300 238 姓名识别补充服务。

• 各端口的COLP/CLIR/COLR/CNIP/CONP/CNIR/CONR分配

在集团电话的每个ISDN（QSIG）端口上都可以允许或停用各项服务。

• CLIR键和COLR键

通过按CLIR键可以在CLIP和CLIR之间切换，通过按COLR键可以在COLP和COLR之间切换。可以将一个

灵活键定制为CLIR或COLR键。

使用说明书（PC编程手册）参考

9.27  PBX Configuration—[1-1] Configuration—Slot—Port Property - PRI Port—Supplementary Service—
COLP, CLIR, COLR, CNIP, CONP, CNIR, CONR, CF (Rerouting), CT, CCBS, AOC-D, AOC-E, E911, 3PTY
10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features

→ COLR Set / Cancel
→ CLIR Set / Cancel

12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Main
→ Extension Number
→ Extension Name

使用说明书（功能手册）参考

2.21.2  灵活键

使用说明书（PT编程手册）参考

[003]分机号码

[004]分机名称

使用说明书（用户手册）参考

1.9.4  在被叫方和主叫方电话上显示您的电话号码（呼叫/连接线路识别显示[CLIP/COLP]）
1.9.5  防止您的电话号码显示在主叫方电话上（连接线路识别限制[COLR]）
1.9.6  防止您的号码显示在被叫方电话上（呼叫线路识别限制[CLIR]）
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4.3.4.3  呼叫转送（CF）—用QSIG
说明

集团电话将呼叫转送至QSIG网络中另一台集团电话的目的地分机。可以在分机基础上，在您自己的集团电话

上设定目的地作为中继线呼叫的转送目的地（® 2.3.2  呼叫转送（FWD））。

如果将同样的中继线群用于来电呼叫和转送呼叫，则可能产生以下情况。

[示例]

-1

QSIG

-2

"2000"

QSIG

1001 2000

1001 2000

(

1001)

20001

10012

3

1000

1000

-1 -2

1 集团电话-1的分机1000拨分机号

码"2000"，该呼叫通过QSIG网络被发送

至集团电话-2的分机"2000"。

2 该呼叫被转送到分机2000的中继线呼叫

转送目的地，即集团电话-1的分

机"1001"。

3 集团电话-1与集团电话-2之间的呼叫被释

放，该呼叫被直接连接到分机2000的转

送目的地。

条件

• 该功能符合欧洲电信标准（ETS）规范ETS 300 257，转移补充业务。

• 可以在集团电话的每个ISDN（QSIG）端口上允许或停用此功能。

使用说明书（PC编程手册）参考

9.27  PBX Configuration—[1-1] Configuration—Slot—Port Property - PRI Port—Supplementary Service—
COLP, CLIR, COLR, CNIP, CONP, CNIR, CONR, CF (Rerouting), CT, CCBS, AOC-D, AOC-E, E911, 3PTY
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使用说明书（用户手册）参考

1.6.1  转送呼叫
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4.3.4.4  呼叫转移（CT）—用QSIG
说明

集团电话将呼叫转移至QSIG网络中另一台集团电话的目的地分机。

如果将同样的中继线群用于来电呼叫和转移呼叫，则可能产生以下情况。

[示例]

QSIG

QSIG

1000 1001 2000

1000 1001 2000

1

2

3

-1 -2

-1 -2

"2000"

2000

1001

1 集团电话-1的分机1000拨分机号

码"2000"，该呼叫通过QSIG网络被发送

至集团电话-2的分机"2000"。

2 呼叫被从分机2000转移到集团电话-1的
分机"1001"。

3 集团电话-1与集团电话-2之间的呼叫被释

放，该呼叫被直接连接到分机2000的转

移目的地。

条件

• 该功能符合欧洲电信标准（ETS）规范ETS 300 261，呼叫转移补充业务。

• 可以在ISDN（QSIG）端口基础上允许或停用此功能。

• 可以进行有通知的呼叫转移和无通知的呼叫转移。（® 2.12.1  呼叫转移）

使用说明书（PC编程手册）参考

9.27  PBX Configuration—[1-1] Configuration—Slot—Port Property - PRI Port—Supplementary Service—
COLP, CLIR, COLR, CNIP, CONP, CNIR, CONR, CF (Rerouting), CT, CCBS, AOC-D, AOC-E, E911, 3PTY
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使用说明书（用户手册）参考

1.4.1  转移呼叫（呼叫转移）
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4.3.4.5  完成对占线用户的呼叫（CCBS）—用QSIG
说明

如果已打电话给QSIG网络中另一台集团电话的分机而被叫方占线，分机用户可以设定当被叫方空闲时接收回

叫振铃。当用户应答回叫振铃时，该被叫方的号码就被自动拨出。

条件

• 该功能符合欧洲电信标准（ETS）规范ETS 300 366，呼叫完成补充业务。

• 在下列情况下可使用此功能：

a. 主叫方的集团电话能够使用CCBS。
b. 被叫方的集团电话能够接受CCBS。

• 为了接收和发送CCBS，必须通过系统编程，在ISDN（QSIG）端口基础上分别允许接收和发送CCBS。
• 一个分机用户只能设定一个CCBS。最后设定是有效设定。

• 如果在60分钟内没有回叫振铃或在10秒钟内没有应答回叫振铃，CCBS设定就被取消。

使用说明书（PC编程手册）参考

9.27  PBX Configuration—[1-1] Configuration—Slot—Port Property - PRI Port—Supplementary Service—
COLP, CLIR, COLR, CNIP, CONP, CNIR, CONR, CF (Rerouting), CT, CCBS, AOC-D, AOC-E, E911, 3PTY

使用说明书（用户手册）参考

1.2.4  当被拨线路占线或没有应答时
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4.3.5  QSIG增强功能

说明

集团电话使用ISDN或V-IPGW卡联网时，可以使用以下增强功能。

呼叫另一部集团电话中的分机而且被叫分机正在振铃时

功能 说明与参考

留下留言待取 ® 2.20.1  留言待取

缺席留言显示 ® 2.20.2  缺席留言

应答前显示振铃分机名称 在应答呼叫之前，向主叫方显示振铃分机的名称。

另一部集团电话的被叫分机占线时

功能 说明与参考

呼叫等待 ® 2.1.3.3  呼叫等待

注

通过网络使用此功能时，即使启用了OHCA或耳语OHCA也将

发送呼叫等待音。

主管遇忙优先插入 ® 2.10.2  主管遇忙优先插入

呼叫监听 ® 2.10.3  呼叫监听

留下留言待取 ® 2.20.1  留言待取

• 另一部集团电话上的被叫分机正忙时，可以将占线自动回叫用作标准的QSIG功能（® 4.3.4.5  完成对占线

用户的呼叫（CCBS）—用QSIG）。

• 将使用忙音和显示提示通知主叫方分机占线。

• 可以为呼叫等待、占线自动回叫和主管遇忙优先插入使用软键操作。

另一部集团电话的被叫分机具有免打扰（DND）设定时

功能 说明与参考

免打扰占优插入 ® 2.3.3  免打扰（DND）

• 将使用DND音和显示提示通知主叫方分机已设为免打扰。

• 可以为免打扰占优插入使用软键操作。

从另一部集团电话的分机接收呼叫时

功能 说明与参考

振铃音 关于振铃音设定，会将来自其他集团电话中分机的来电作为内线电

话处理。

® 2.1.3.2  振铃音类型选择
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功能 说明与参考

呼叫等待 关于呼叫等待设定，会将来自其他集团电话中分机的来电作为内线

电话处理。

® 2.1.3.3  呼叫等待

呼叫转送（FWD） 关于呼叫转送设定，会将来自其他集团电话中分机的来电作为内线

电话处理。

老板和秘书功能也可以通过网络应用。

® 2.3.2  呼叫转送（FWD）

免打扰（DND） 关于免打扰设定，会将来自其他集团电话中分机的来电作为内线电

话处理。

老板和秘书功能也可以通过网络应用。

® 2.3.3  免打扰（DND）

免提应答 关于免提应答设定，会将来自其他集团电话中分机的来电作为内线

电话处理。

具有免提应答的服务等级也将通过网络应用。

® 2.4.4  免提应答

内部通话阻止 关于内部通话阻止功能，会将来自其他集团电话中分机的来电作为

内线电话处理。

例如，只允许分公司经理呼叫总公司的社长，而分公司中的其他分

机无法呼叫社长。

® 2.1.2.2  内部通话阻止

® 5.1.1  服务等级（COS）

与另一方通话期间

功能 说明与参考

使用排队转移到占线分机（预占线转

移）

可以通过网络将呼叫转移到另一部集团电话中的占线分机，而不必

使用呼叫等待操作。

® 2.12.1  呼叫转移

注

网络呼叫转移也是受支持的标准QSIG功能。(® 4.3.4.4  呼叫

转移（CT）—用QSIG)

对于拨打到另一部联网集团电话上分机的来电

功能 说明与参考

直接呼叫应答 分机用户可以应答正在其他联网集团电话分机上振铃的呼叫。

® 2.4.3  呼叫接听

条件

• 每个主设备都需要KX-NSN002（QSIG网络激活密钥）才能使用这些功能。此外，网络中的所有集团电话

必须为具有MPR软件版本4.1000或更高版本的KX-NS系列集团电话或KX-NCP　KX-TDE系列集团电话。
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• 非KX-NS系列集团电话需要单独的激活密钥。有关详情，请参阅相应的使用说明书（功能手册）。

• 可以通过系统编程在TIE表级别禁用增强的QSIG功能。

• 使用S-CO键或中继线群接入功能号码等通过访问中继线拨打的电话无法使用增强的QSIG功能，因为其并

没有参照TIE表。

• 使用呼叫转送（CF）—用QSIG转接的呼叫无法使用增强的QSIG功能。

• 留下留言待取

通过网络，留言待取设定/取消/回叫功能号码无法用于设定或取消留言待取。

• 主管遇忙优先插入

使用主管遇忙优先插入中断与其他集团电话中分机间的呼叫，并且外线来电者要进行三方会议通话，随后

其他集团电话中的分机离开通话时，呼叫将被认为是一个中继线间的呼叫。如果通过系统编程将其启用，

通话将在此时终止。

• 直接呼叫应答

– 使用集团电话代码方法拨号时（有集团电话代码接入）

如下拨号：[TIE线路接入号码] + [振铃分机的集团电话代码] + [直接呼叫应答功能号码] + [振铃分机号

码]。
例如，要使用集团电话代码123接听另一部集团电话中振铃的分机101，应拨"7-123- 41-101"。

– 使用分机号码方法拨号时（无集团电话代码接入）

如下拨号：[除最后一位外的所有振铃分机号码 + ] + [直接呼叫应答功能号码] + [振铃分机号码]。
例如，要通过网络接听振铃分机321，拨"32 - 41-321"。

– 要使用多个集团电话的通用分机编号通过VoIP网络使用直接呼叫应答，必须使用CTI预拨号或执行操

作。

使用说明书（PC编程手册）参考

10.9  PBX Configuration—[2-9] System—System Options—Option 2— CO - CO Call Limitation—After
Conference
17.1  PBX Configuration—[9-1] Private Network—TIE Table—Enhanced QSIG
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4.3.5.1  网络直接分机选择（NDSS）
说明

当集团电话使用ISDN卡或V-IPGW卡联网时，可以将灵活键分配为网络直接分机选择（NDSS）键。这些键用

于监听与网络中其它集团电话（最多7 个）连接的分机的状态，以及用单键拨打电话或将呼叫转移至这些分机，

如同普通DSS键一样。这样，即使办公室地点比较远，也可以使话务员功能集中。

NDSS键以如下方式显示被监听分机的状态：

指示灯类型 状态

关闭 被监听分机空闲。

红灯亮 被监听分机占线或对中继线呼叫设定了DND。

[网络示例]

-1

ID 1

-2

ID 2

2001

2002

4001

-3

ID 0

-4

ID 3

2001

2002

4001

1001

1001

2002

[编程程序]
1. 路由表分配

必须事先对网络中的全部集团电话编程设定TIE线路路由和修改表，以便可以在集团电话之间打电话和转移

呼叫（® 4.3.1  TIE线路业务）。

在以下的编程示例中，网络中的集团电话使用分机号码方法，如上图所示。但是，也可以使用集团电话接

入代码方法。

2. 网络集团电话ID分配

为网络中的每台集团电话分配一个网络集团电话ID。

® 17.2  PBX Configuration—[9-2] Private Network—Network Data Transmission— Network Data
Transmission for Centralised Operator Feature—Network PBX ID
• ID 1-8：可以监听其它集团电话的分机和传输本地分机的监听数据。每个ID号码可以分配给网络中的一

个集团电话。

• ID 0：通过网络重新传输监听数据。该ID号码可以分配给多个集团电话。

3. QSIG端口设定[被监听集团电话]

ISDN－QSIG（集团电话直接连接）

必须通过系统编程，将用于传输分机状态信息的PRI卡的每个QSIG端口设定为执行此传输功能。即使端口

被设定为不传输信息，仍会从其它集团电话接收信息。
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® 9.27  PBX Configuration—[1-1] Configuration—Slot—Port Property - PRI Port—CO Setting—
Networking Data Transfer

传输 分机状态信息功能

允许 • 在自己的集团电话分机上传输信息

• 从其它集团电话接收信息；转送至集团电话的其它QSIG端口

• 重新传输由集团电话的其它QSIG端口接收的信息

停用 • 从其它集团电话接收信息；转送至集团电话的其它QSIG端口

请根据网络布局设定每个端口的传输设定，这样分机状态信息可以在NDSS监听集团电话之间传输。

[ISDN网络端口设定示例]

-1

ID 1

-2

ID 0

4001

     

OFF

OFF

OFF

ON

ON

ON

OFF

4001

4001

4001

-3

-5

-4

ID 3

4001 NDSS

ON

OFF

IP网关QSIG
根据V-IPGW卡的路由表，将IP数据通过网络路由。使用VoIP时，需要确定监听集团电话，每个要使用的

板卡的分机信息都将发送到此集团电话上。可以通过将监听集团电话里任一分机（例如：集团电话话务员）

的分机号码指定为该V-IPGW卡的网络话务员分机来完成。
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[VoIP网络示例]

V
-IP

G
W

-1 -2

-3 -4

ID 1

IP

4001 NDSS

4001

     

ID 2

4001 NDSS

混合网络

在包含一部分为VoIP和一部分为ISDN线路的混合网络上使用NDSS功能时，可以设定是否在每个集团电话

内的VoIP和ISDN卡间转移状态信息。例如，如果监听集团电话在VoIP网络上，被监听的集团电话在ISDN
网络上，VoIP和ISDN网络间用作网关的集团电话必须为ISDN至VoIP允许此设定。

4. 网络监听分机注册[监听集团电话]
注册要被监听的分机（与其它集团电话相连接）。最多可以注册250部分机。只有在此处注册过的分机可以

分配NDSS键。

® 17.4  PBX Configuration—[9-4] Private Network—NDSS Key Table— Network Extension No.

网络监听分机表

序号 网络分机号码 网络分机姓名

001 2001 Branch 1: T. Durden

002 2002 Branch 1: M. Singer

003 4001 Branch 2: R. Paulson

: : :

250   

当使用集团电话接入代码编号方法时，必须在此处注册的分机号码前加入相关接入代码。

5. 定制NDSS键[监听集团电话]
在与监听集团电话连接的任一分机上，将一个灵活键定制为上述一部注册分机的NDSS键。然后摘机，按

一下该键，再挂机。这样即可启动监听功能。被监听集团电话开始传输有关该分机状态的信息，而监听集

团电话开始接收这些信息。该键的灯会显示连接到另一台集团电话的分机的状态。

删除或编辑已注册分机[监听集团电话]
若要在已监听250部分机的情况下，监听一部新的分机，就需要删除现有的一部已注册分机。

可以使用NDSS监听释放功能停止监听某一分机。当在监听集团电话上执行此功能时：

• 如果没有其它的集团电话监听所选分机，则被监听集团电话将停止传输此分机的状态信息。

• 监听集团电话停止接收所选分机的状态信息。用于该分机的所有NDSS键都会停止显示状态信息。
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但是，相关信息不会从网络监听分机表中删除。因此，如果监听集团电话的分机用户随后摘机并按用于该

分机的NDSS键，监听会重新启动。若要完全删除对一部分机的监听，必须从每个监听集团电话的网络监

听分机表中删除其注册数据。

每个NDSS键的监听目的地由该表中特定序号的注册信息决定。因此，如果某一个序号对应的注册信息发

生更改（例如：上例中分配给序号001的网络分机号码从"2001"更改为"4002"），则为该分机设定的所有

NDSS键都会自动指向新的监听目的地。

条件

• 监听分机或有分机被监听的每个主设备都需要KX-NSN002（QSIG网络激活密钥）。

非KX-NS系列集团电话需要单独的激活密钥。有关详情，请参阅相应的使用说明书（功能手册）。

• 在将通用分机编号用于2部集团电话或多部集团电话的网络上，NDSS键将不起作用。

• 网络中的所有集团电话都必须为KX-NS系列、KX-NCP系列、KX-TDE系列或KX-TDA系列的集团电话。有

关要监听分机或带有被监听分机的非KX-NS系列集团电话的硬件要求信息，请参考相应的使用说明书（功

能手册）。

• 在一个网络中，网络集团电话ID 1-8中的每一个只能分配给一台集团电话。将同一网络集团电话ID分配给

两台集团电话会导致网络数据传输问题。

• 只能为先前已在网络监听分机表中注册过的分机分配NDSS键。

12.1.4  PBX Configuration—[4-1-4] Extension—Wired Extension—Flexible Button
® Type
® Dial (for NDSS)

• 连接到一台集团电话的分机可以监听最多250台其它集团电话的分机。一台分机可以被多个集团电话的多个

分机监听。

• 若要减少NDSS数据流量，建议在单个来电呼叫分配群中监听的分机数目不要超过8台。

• 只有在首次建立用于一部新注册分机的NDSS键时，才需要启动NDSS键。一旦首次按下NDSS键将其启

动，用于同一被监听分机的任何其它NDSS键不需启动即可自动显示该分机状态。

• 若要使用NDSS监听释放功能，必须将一部分机指定为管理员。

® 10.7.1  PBX Configuration—[2-7-1] System—Class of Service—COS Settings—Manager— Manager
• 通过系统编程，可以设定分机状态信息传输经过的"Hop"（集团电话之间的转移）的最大数目。每向另一台

集团电话转送一条分机状态信息，其计数器就增加1。当此计数器达到指定的最大值时，就会抛弃数据。这

样可以防止数据在网络中作不必要的循环。

® 17.2  PBX Configuration—[9-2] Private Network—Network Data Transmission— Network Data
Transmission for Centralised Operator Feature—Data Transmission Counter

• 如果因为网络条件而无法使用NDSS监听释放功能来远程关闭分机状态信息传输，可以通过系统编程在被

监听集团电话上直接执行同样的操作。

® 12.1.6  PBX Configuration—[4-1-6] Extension—Wired Extension—NDSS Link Data - Send
• 使用VoIP网络时，如果分机状态信息经网络丢失，在某些情况下，NDSS键可能不会显示相关信息的状态。

• 当两个集团电话使用了[ 内部集团电话分机号码的TIE 呼叫] 功能（® 4.3.1  TIE线路业务）连成网络时，

NDSS 会无法使用。

使用说明书（PC编程手册）参考

9.27  PBX Configuration—[1-1] Configuration—Slot—Port Property - PRI Port—CO Setting— Networking
Data Transfer
10.7.1  PBX Configuration—[2-7-1] System—Class of Service—COS Settings—Manager— Manager
12.1.4  PBX Configuration—[4-1-4] Extension—Wired Extension—Flexible Button
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→ Type
→ Dial (for NDSS)

12.1.6  PBX Configuration—[4-1-6] Extension—Wired Extension—NDSS Link Data - Send
17.2  PBX Configuration—[9-2] Private Network—Network Data Transmission
17.3  PBX Configuration—[9-3] Private Network—Network Operator (VoIP)
17.4  PBX Configuration—[9-4] Private Network—NDSS Key Table

使用说明书（PT编程手册）参考

[511]管理员分配

使用说明书（功能手册）参考

4.3.1  TIE线路业务

4.3.2  通过互联网传输语音协议（VoIP）网络

4.3.4  QSIG标准功能

使用说明书（用户手册）参考

1.2.1  基本呼叫

2.1.7  释放网络直接分机选择（NDSS）监听

440 使用说明书（功能手册）
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4.3.5.2  集中语音信箱

说明

TIE线路网络中通过VoIP或ISDN与本集团电话连接的最多7部集团电话可以共享本集团电话统一消息系统的服

务。统一消息系统可以为连接到网络中的任何集团电话的分机提供语音信箱。另外，统一消息系统可以给任意

集团电话的分机发送留言待取通知，并且用户可以使用留言待取键直接接入自己的信箱。

网络中的分机可用的统一消息功能如下：

• 呼叫转送到一个信箱

• 截取路由到一个信箱

• 语音信箱（VM）转移键

• 听取录制的留言（信箱直接接入）

• 中继线服务和来电的自动时间方式通知

• 来电者识别通知

• 状态通知

• 显示语音留言号码

[统一消息系统应答中继线呼叫，转移到其它集团电话的分机（分机号码方法）]

-1

TIE

-2

-3

-4

-5

-6

-7

-8

201 202

101

101

201

202

[解释]
中继线呼叫由统一消息系统的自动值机员（AA）服务应答。来电者输入分机号码201，则呼叫通过专用网络转

移到分机201。
如果分机201没有应答，信箱201将应答该来电并播放相应的留言。
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[至分机的中继线呼叫未应答，转送到信箱（分机号码方法）]

-1

TIE

-2

-3

-4

-5

-6

-7

101

201

202 -8

101

202

 201

201

"

"

[解释]
分机201未应答中继线呼叫，则该呼叫被转送到统一消息系统，并由信箱201应答。如果外线来电者留下留言，

则统一消息系统使用QSIG增强信息通过专用网络发送留言待取通知到分机。

当转送此呼叫时，集团电话-2将任何收到的呼叫信息（来电显示号码/名称，DDI号码）连同使用的中继线群号

码、适用的时间方式、分机号码和原目的地分机的转送理由作为QSIG增强信息发送到集团电话-1。
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集团电话代码方法

TIE

-3

-4

-5

-6

-7

-8

101

101

101

201

730101

730102

"7-30-102"

[ ]

[

]

-1

20

-2

30

[TIE

]

 102

730102

"

"

[解释]
分机102未应答中继线呼叫，使用包含TIE线路接入号码、接收呼叫的集团电话的集团电话代码和接收呼叫的分

机号码的信箱号码，该呼叫被转送到统一消息系统。

该信箱号码也相同，如同连接到集团电话-1的分机呼叫了集团电话-2的分机102。应将该信箱号码编程为统一

消息系统上的信箱号码和所有者分机号码。

多种语音信箱服务

网络中的多部集团电话可以为连接到其他集团电话的分机提供语音信箱服务。

条件

[一般]
• 本节假设正在共享统一消息系统，以说明集中语音信箱。如果您希望通过堆叠连接用VPS使用集中语音信

箱功能，请参阅您将与之共享VPS的集团电话的说明书。

• 使用此功能的所有KX-NS系列集团电话都需要KX-NSN002（QSIG网络激活密钥），无论是主控语音信箱服

务还是仅仅使用该服务而已。

注

仅在通过TIE线路连接的集团电话之间使用集中语音信箱。

• 非KX-NS系列集团电话需要单独的激活密钥。有关详情，请参阅相应的使用说明书（功能手册）。

• 网络中的所有集团电话都必须为KX-NS系列、KX-NCP系列、KX-TDE系列或KX-TDA系列集团电话。有关

共享相同语音信箱服务的非KX-NS系列集团电话的硬件要求信息，请参考相应的使用说明书（功能手册）。

• 分机可以从多个连接到网络中其它集团电话的语音信箱服务收到留言待取通知。如果从不同的语音信箱服

务向分机用户留言箱中发送了多个未收听留言的通知，则将显示最新的通知。
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• 灵活键不能定制为不同的集团电话中其它分机的留言待取键。

• 可以在TIE表中设定是否传输QSIG增强信息。

• 集团电话代码方法

此方法中使用的号码不能多于8位数。

[语音信箱（VM）转移键]
• 用远程语音信箱系统的UM群（KX-NS系列集团电话）或VM群（KX-TDA　KX-TDE　KX-NCP　KX-NS系

列集团电话）的浮动分机号码作为参数，可以把一个灵活键定制为VM转移键。

• 按下VM转移键再（1）按下DSS键或NDSS键，或者（2）直接拨打所需分机号码，可以将进行中的呼叫转

移到统一消息信箱。直接拨打所需分机号码（或TIE线路接入号码 + 集团电话代码 + 所需分机号码）时，

在以下情况下必须加上"#"键：

– 执行转移的分机用户以及收件人分机属于不同的集团电话。

– 按下VM转移键分机用户的集团电话本身没有语音信箱服务。

• 在为2部集团电话或多部集团电话使用通用分机编号的网络上，不能使用VM转移键功能。必须创建一个能

使用线路接入号码或其他集团电话分机号码来访问语音信箱的网络。

示例：将集中语音信箱与通用分机编号配合使用

 204

 305

 102

 101

-1
 304

 203

-2

 301

 103

-3

 800

IP

[解释]
在此例中，只有集团电话-1具有（为统一消息系统）指定的以"8"为开头的分机。在集团电话-2和集团电

话-3的灵活编号计划中，必须将"1"、"2"和"3"设为"分机号码"，且必须将"8"设为"其他集团电话分机号码

（TIE）"。

使用说明书（PC编程手册）参考

17.1  PBX Configuration—[9-1] Private Network—TIE Table—Enhanced QSIG
17.2  PBX Configuration—[9-2] Private Network—Network Data Transmission
17.5  PBX Configuration—[9-5] Private Network—Centralised UM/VM Unit
19.1  PBX Configuration—[11-1] Maintenance—Main—Maintenance

→ Error Log for Centralised VM—Network MSW Transmission (Counter)
→ Error Log for Centralised VM—Network MSW Transmission (Buffer)

444 使用说明书（功能手册）
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使用说明书（功能手册）参考

章节  3  统一消息系统

2.28.3  语音信箱DPT（数字）集成

4.3.1  TIE线路业务
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4.3.6  网络ICD群

说明

一个来电呼叫分配（ICD）群可以包含专用网络中其它集团电话的最多4个目的地，其中包括另一个ICD群的浮

动分机号码。指定一部虚拟PS作为该ICD群的成员，然后设定另一部集团电话的目的地号码作为该虚拟PS的转

送目的地，就可以实现上述功能了。这样可以让多个相距较远的ICD群一起接收呼叫。

除振铃分配方法外，还可以选择均匀呼叫分配（UCD）和优先搜索。（® 2.2.2.2  群呼叫分配）

-2-1

-5

-4

-3

ICD

ICD

ICD

ICD

ICD

PS 1

PS 2

PS 3

PS 4

条件

• 使用此功能需要KX-NSE101或KX-NSE110（移动分机的激活密钥）。每个使用此功能的分机（虚拟PS）都

需要一个激活密钥。

另外， 每个虚拟PS的Mobile Extension设定必须设为Enable。
• 2.2.2.3  来电呼叫分配群中的外线目的地 的情况也适用于此功能。

• 分配到空闲时间最长分机的呼叫（自动呼叫分配）无法用于虚拟PS ICD群成员。

使用说明书（PC编程手册）参考

10.9  PBX Configuration—[2-9] System—System Options—Option 4

446 使用说明书（功能手册）
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→ Send CLIP of CO Caller—when call is forwarded to CO
→ Send CLIP of Extension Caller—when call is forwarded to CO

12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Option 9— Mobile
Extension

使用说明书（功能手册）参考

2.2.2.3  来电呼叫分配群中的外线目的地

5.2.4.1  虚拟PS
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章节  5
系统配置与管理功能
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5.1  系统配置—系统

5.1.1  服务等级（COS）
说明

每部分机都必须属于一个服务等级（COS）。通过把某些分机指定给一个COS，根据指派给它们的任务不同，

可以控制分机用户的行为和权限（允许或拒绝某些分机接入各种功能、分机和中继线）。

通过给各分机指定相同的COS号码，许多分机可以属于同一个COS，使相同的限制和权限适用于分机群。

以下功能在COS基础上得到控制：

a. ® 2.1.2.2  内部通话阻止

b. ® 2.3.2  呼叫转送（FWD）

c. ® 2.3.3  免打扰（DND）—免打扰占优插入

d. ® 2.4.3  呼叫接听

e. ® 2.5.4.3  计费代码输入

f. ® 2.5.5.3  中继线接入

g. ® 2.10.2  主管遇忙优先插入

h. ® 2.10.3  呼叫监听

i. ® 2.10.4.3  摘机呼叫通知（OHCA）
j. ® 2.10.4.4  耳语OHCA
k. ® 2.7.1  长途限制（TRS）/呼叫限制（限制）

l. ® 2.7.3  分机锁定

m. ® 2.7.5  流动COS
n. ® 2.11.8  中继线呼叫限制

o. ® 2.12.1  呼叫转移

p. ® 2.18.2  开门

q. ® 2.16.1  直接拨入系统接入（DISA）
r. ® 4.1.2.4  呼叫转送（CF）—用ISDN（P-MP）
s. ® 2.22.1.1  电话通信详细记录（SMDR）—中继线外拨电话的电话通信详细记录

t. ® 5.1.4  定时服务—定时服务开关

u. ® 5.1.6  管理员功能

v. ® 5.5.3  PT编程

w. ® 2.9.1  主要号码簿号码（PDN）/次要号码簿号码（SDN）分机—SDN键方式、SDN流动COS、以及通

过PT编程指定SDN键

统一消息的COS
统一消息系统具有其自己的COS设定用于控制访问各种功能。（® 3.2.1.11  服务等级（COS））

条件

• 流动COS
分机用户可以在另一部COS权限较低的分机上暂时使用其自己的COS，以接入该分机在一般情况下由于

COS较低而无法接入的功能、分机或中继线。

450 使用说明书（功能手册）
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使用说明书（PC编程手册）参考

10.7.1  PBX Configuration—[2-7-1] System—Class of Service—COS Settings
12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Main— COS

使用说明书（PT编程手册）参考

[602]服务等级

使用说明书（功能手册）参考

3.2.1  系统功能

6.1  系统资源的容量

使用说明书（用户手册）参考

1.2.7  无限制的呼叫
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5.1.2  群
说明

本集团电话支持各种类型的群。

1. 中继线群

中继线可以被分组为特定数目的中继线群（例如：用于每个运营商、中继线类型等）。可以在中继线群基础

上分配若干设定。属于一个中继线群的全部中继线都遵循特定于该中继线群的分配。

® 11.1.1  PBX Configuration—[3-1-1] Group—Trunk Group—TRG Settings
® [402]中继线群号码

一条中继线只能在端口基础上属于一个中继线群。

端口基础：LCOT/ISDN-PRI30/SIPGW
信道基础：E1

2. 分机用户群

本集团电话支持分机用户群，每个分机用户群用来组成以下各群：

a. 租户（® 5.1.3  租户业务）

b. 呼叫接听群（见下图。）

c. 广播群（见下图。）

每部分机必须属于一个分机用户群，但不能属于一个以上的分机用户群。

® 11.2  PBX Configuration—[3-2] Group—User Group
® [603]分机用户群

可分配分机：PT/SLT/SIP分机/ISDN分机

[示例]

1

100 101

2

102 103

3

104 105

4

106 107

呼叫接听群

使用群呼叫应答功能，各分机可以应答特定群内的任何呼叫。

一个分机用户群可以属于数个呼叫接听群。（®2.4.3  呼叫接听）

® 11.3  PBX Configuration—[3-3] Group—Call Pickup Group
® 11.3.1  PBX Configuration—[3-3] Group—Call Pickup Group—All Setting
® [650]应答群的分机用户群

[示例]

1

1

100 101

2

102 103

3

104 105

2 3

4

106 107
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广播群

使用广播功能，分机可以对任何广播群广播或应答对其自己的群的广播。一个分机用户群或外部广播机可

以属于数个广播群。

(® 2.17.1  广播)
® 11.4  PBX Configuration—[3-4] Group—Paging Group
® 11.4.1  PBX Configuration—[3-4] Group—Paging Group—All Setting
® 11.4.2  PBX Configuration—[3-4] Group—Paging Group—External Pager
® [640]广播群的分机用户群

[示例]

1

1

100 101

2

102 103

3

104 105

2 3

3. 空闲分机搜索群

如果被叫分机占线或处于DND方式，空闲分机搜索将来电转接到属于同一空闲分机搜索群的一部空闲电话，

可以通过系统编程对转接进行编程。根据预编程设定的搜索类型自动搜索空闲分机：

循环搜索或终止搜索（® 2.2.1  空闲分机搜索）。

® 11.6  PBX Configuration—[3-6] Group—Extension Hunting Group
® 11.6.1  PBX Configuration—[3-6] Group—Extension Hunting Group—Member List
® [680]空闲分机搜索类型

® [681]空闲分机搜索群成员

4. 来电呼叫分配群

来电呼叫分配群是一个接收接到该群的来电呼叫的分机群。每个来电呼叫分配群都有一个浮动分机号码（默

认：6 + 两位数群号码*1）和名称。一部分机可以属于多个群。

® 11.5.1  PBX Configuration—[3-5-1] Group—Incoming Call Distribution Group—Group Settings
® 11.5.1.1  PBX Configuration—[3-5-1] Group—Incoming Call Distribution Group—Group
Settings—Member List
® [623]来电呼叫分配群名称

可分配分机：PT/SLT/SIP分机/ISDN分机

(® 2.2.2  来电呼叫分配群功能)
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[示例]

1

601

1

2

602

2

100 101 102 105 106

103 104

107

*1 浮动分机号码的位数取决于简易设置中为Numbering Plan指定的值。请参阅使用说明书（安装手册）中

的"5.4.1  简易设置指示"。
5. UM群

UM群是一部集团电话所有统一消息端口的集合。一个UM群分配一个浮动分机号码。

(® 3.1.1  统一消息系统概述)
® 11.7.1  PBX Configuration—[3-7-1] Group—UM Group—System Settings
® 11.7.2  PBX Configuration—[3-7-2] Group—UM Group—Unit Settings
® [660]UM群浮动分机号码

6. VM群

有如下两种类型的VM群：

类型 说明

VM（DTMF）群 一组使用语音信箱DTMF集成功能的SLT端口。

一个SLT端口只能属于一个群。

VM（DPT）群 一组使用语音信箱DPT（数字）集成功能的DPT端口。

一个DPT端口只能属于一个群。

→ 2.28.1  语音信箱（VM）群

→ 11.11.1  PBX Configuration—[3-11-1] Group—VM(DPT) Group—System Settings
→ 11.11.2  PBX Configuration—[3-11-2] Group—VM(DPT) Group—Unit Settings
→ 11.12.1  PBX Configuration—[3-12-1] Group—VM(DTMF) Group—System Settings
→ 11.12.2  PBX Configuration—[3-12-2] Group—VM(DTMF) Group—Group Settings
→ 11.12.2.1  PBX Configuration—[3-12-2] Group—VM(DTMF) Group—Group Settings—Member List
→ [661]语音信箱群浮动分机号码

454 使用说明书（功能手册）
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[示例]

DPT DPT DPT DPT DPT SLT SLT SLT SLTSLT

VM DPT  VM DTMF  

VPS

DPT[ ]

VPS

DTMF

7. 会议群

会议群是分机用户使用会议群呼叫功能（® 2.15.1  会议组呼叫）呼叫的用户群。当通过系统编程启用广播

通信模式时，一个群最多可以分配31位用户。当禁用广播通信模式时，一个群最多可以分配7位用户。最多

可以编程8个会议群。

→ 11.9  PBX Configuration—[3-9] Group—Conference Group
→ 11.9.1  PBX Configuration—[3-9] Group—Conference Group—Member List

8. P2P群
相同P2P群的设备可以建立对等（P2P）连接和通信（打电话）而无需使用集团电话资源。IP-PT、SIP分
机、SIP中继线和集团电话均分配到P2P群中。

相同P2P群内设备之间的连接

P2P

P2P 1

DSP
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不同P2P群内设备之间的连接

P2P

P2P 1 P2P 2

DSP

→ 11.10  PBX Configuration—[3-10] Group—P2P Group

使用说明书（安装手册）参考

5.4.1  简易设置指示

使用说明书（PC编程手册）参考

Section  11  PBX Configuration—[3] Group

使用说明书（PT编程手册）参考

[402]中继线群号码

[603]分机用户群

[620]来电呼叫分配群成员

[622]来电呼叫分配群浮动分机号码

[623]来电呼叫分配群名称

[640]广播群的分机用户群

[650]应答群的分机用户群

[660]UM群浮动分机号码

[661]语音信箱群浮动分机号码

[680]空闲分机搜索类型

[681]空闲分机搜索群成员

使用说明书（功能手册）参考

5.5.8  浮动分机

6.1  系统资源的容量
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5.1.3  租户业务

说明

本集团电话可以由一定数量的租户共享使用。

1. 租户配置

租户成员

租户成员由分机用户群组成。一个分机用户群只能属于一个租户。因此，一部分机只能属于一个租户。

(® 5.1.2  群)

定时服务

每个租户都有一个时间表。可以为一周的每一天设定每种时间方式（白天/午餐/休息/夜间）的开始和/或结

束时间。时间表号码分别对应于租户号码。

(® 5.1.4  定时服务)
[示例]

1

1

1

2

3

4

2

2

5

6

2. 系统管理

可以给每个租户分配以下系统管理项目中的每一个。

a. 租户话务员（分机号码/来电呼叫分配群的浮动分机号码/无）（® 5.1.5  话务员功能）

® 14.6  PBX Configuration—[6-6] Feature—Tenant— Operator (Extension Number)
b. ARS方式（断开/市话接入/全部接入/系统）（® 2.8.1  自动路由选择（ARS））

® 14.6  PBX Configuration—[6-6] Feature—Tenant— ARS Mode
c. 待机音乐的音乐源（系统/BGM号码/信号音）

(® 2.13.4  待机音乐)
® 14.6  PBX Configuration—[6-6] Feature—Tenant— Music On Hold

d. 系统速拨（系统/租户专用）

(® 2.6.4  速拨—个人/系统)
® 14.6  PBX Configuration—[6-6] Feature—Tenant— System Speed Dial

[编程示例]

租户号码 话务员 ARS方式 音乐源 系统速拨

1 分机101 市话接入 系统*3 系统*4

2 无*1 系统*2 信号音
系统/

租户专用
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租户号码 话务员 ARS方式 音乐源 系统速拨

3
浮动分机号码200

关闭 BGM1
系统/

租户专用

: : : : :

*1 遵循集团电话话务员的系统分配。

® 10.2  PBX Configuration—[2-2] System—Operator & BGM— PBX Operator—Day, Lunch, Break, Night
*2 遵循ARS方式的系统分配。

® Section  16  PBX Configuration—[8] ARS
*3 遵循待机音乐的音乐源的系统分配。

® 10.2  PBX Configuration—[2-2] System—Operator & BGM— BGM and Music on Hold—Music on Hold
*4 遵循系统速拨的系统分配。

® 14.1  PBX Configuration—[6-1] Feature—System Speed Dial

条件

• ARS分配

为租户将"On for Local Access Operation"或"On for Any CO Access Operation"分配为ARS
模式时，只有ARS前置号码表的子集应用到租户的去电呼叫。租户1至8在前置号码表中会在50个条目的范

围内被分配，如下：

– 租户1：条目1至50
– 租户2：条目51至100
– 租户3：条目101至150

 :
– 租户8：条目351至400
如果选择了"Same as System Setting"，那么表中的所有1000个条目会被应用到该租户的去电呼叫。

启用ARS时，无论租户的ARS模式如何，表中的所有1000个条目都会被应用。

通过划分租户，特定的ARS设置可根据各租户的要求应用到特定租户。

以下示例示意了ARS前置号码表如何应用到租户：

租户号码 ARS方式 应用的ARS条目

1 打开市话接入操作 条目1至50

2 关闭 未应用

3 与系统设定相同（系统设定：打开） 条目1至1000

4 打开市话接入操作 条目151至200

5 关闭 未应用

• 租户到租户呼叫阻止

通过内部通话阻止功能，可以在每部分机的COS基础上（而不是在租户基础上）限制以下功能（®
2.1.2.2  内部通话阻止）：

– 呼叫受限制租户中的分机或门电话

– 应答受限制租户中的呼叫振铃

– 恢复在限制租户中保留的呼叫
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5.1.3 租户业务



[示例]

COS 4COS 1 COS 2

1

1

 100  101

2

 103 102

COS 3

3

2

 104  105

4

 107 106

COS 5 COS 6

5

3

 108  109

6

 111 110

[编程示例]

主叫方
被叫方

COS 1 COS 2 COS 3 COS 4 COS 5 COS 6 ...

COS 1       ...

COS 2       ...

COS 3     ü ü ...

COS 4     ü ü ...

COS 5 ü ü ü ü   ...

COS 6 ü ü ü ü   ...

: : : : : : : :

ü：限制

解释：

1. 给租户中的每部分机分配一定的COS号码。各租户必须具有唯一的COS号码。

租户1：COS1和COS2
租户2：COS3和COS4
租户3：COS5和COS6

2. 由内部通话阻止功能允许租户到租户呼叫阻止。
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a. 租户1（COS 1和COS 2）可以打电话给租户2（COS 3和COS 4）和租户3（COS 5和COS 6）以

及租户1。
b. 租户2（COS 3和COS 4）可以打电话给租户1（COS 1和COS 2）和租户2。
c. 租户3（COS 5和COS 6）只能打电话给租户3自己。

• 一个来电呼叫分配群必须属于一个租户，因为以下功能是在租户基础上确定的（® 2.2.2.1  来电呼叫分配

群功能—概要）：

– 当呼叫在排队中等待时的待机音乐

– 决定溢出目的地的时间表

使用说明书（PC编程手册）参考

10.2  PBX Configuration—[2-2] System—Operator & BGM
→ PBX Operator—Day, Lunch, Break, Night
→ BGM and Music on Hold—Music on Hold

10.4  PBX Configuration—[2-4] System—Week Table
10.5  PBX Configuration—[2-5] System—Holiday Table
10.7.3  PBX Configuration—[2-7-3] System—Class of Service—Internal Call Block
11.2  PBX Configuration—[3-2] Group—User Group
11.5.1  PBX Configuration—[3-5-1] Group—Incoming Call Distribution Group—Group Settings—Main—
Tenant Number
12.1.1  PBX Configuration—[4-1-1] Extension—Wired Extension—Extension Settings—Main— User Group
13.1  PBX Configuration—[5-1] Optional Device—Doorphone— Tenant Number
13.5  PBX Configuration—[5-5] Optional Device—External Sensor— Tenant No.
14.1  PBX Configuration—[6-1] Feature—System Speed Dial
14.6  PBX Configuration—[6-6] Feature—Tenant
Section  16  PBX Configuration—[8] ARS
16.5  PBX Configuration—[8-5] ARS—Carrier—Authorisation Code for Tenant
18.2  PBX Configuration—[10-2] CO & Incoming Call—DIL Table & Port Settings—DIL— Tenant Number
18.3  PBX Configuration—[10-3] CO & Incoming Call—DDI / DID Table— Tenant Number
18.4  PBX Configuration—[10-4] CO & Incoming Call—MSN Table—MSN— Tenant Number

使用说明书（PT编程手册）参考

[001]系统速拨号码

[006]话务员分配

[320] ARS方式

[711]待机音乐

使用说明书（功能手册）参考

6.1  系统资源的容量

460 使用说明书（功能手册）

5.1.3 租户业务



5.1.4  定时服务

说明

本集团电话支持白天、夜间、午餐和休息操作方式。可以分别安排TRS/限制。可以分别为每种方式设定来电呼

叫目的地。

1. 定时服务转换方式

可以人工或自动转换白天/午餐/休息/夜间方式。可以为每个租户指定转换方式。

通过按定时服务转换方式（自动/人工）键，也可以改变转换方式。只能由被指定为管理员的分机或在COS
基础上预编程设定的分机来执行此功能。

类型 说明

自动 集团电话将根据预编程设定的时间表转换方式。

人工 管理员或在COS基础上预编程设定的分机可以通过拨功能号码或按定时服

务键来转换方式。

统一消息系统管理员可以从外线电话设定定时服务方式。

即使在自动转换方式下，也可以人工改变白天/午餐/休息/夜间方式。

2. 时间表

每个租户都有一个用于自动转换方式的时间表。可以为一周的每一天设定每种时间方式的开始和/或结束时

间。时间表号码分别对应于租户号码。

[时间表示例]

Day 1 start

Lunch start

Day 2 start 

Break 1 start

Break 1 end (Day restart)

Night start

Day 1 start

Lunch start

Day 2 start

Break 1 start

Break 1 end (Day restart)

Night start

    :

08:00

12:00

13:00

16:00

08:00

12:05

13:00

16:31

    :  

11:00

20:00

11:00

20:00

    :

MON

TUE

    :

 

1 2 3 4

00:00

< >

08:00 11:00 12:0013:00 16:00 20:00

1

08:00

16:00

12:00

08:00

13:00

17:00

    :

08:00

12:00

08:00

13:00

    :

…

…

…

…

…

…

…

…

…

…

…

…

     … 

24:00 08:00

1

1

1

1

2

3

4

…

1

1

1

2
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3. 使用定时服务的功能

以下功能可以在每种时间方式（白天/午餐/休息/夜间）中设定：

a. 中继线呼叫来电的目的地（DIL/DID/DDI/MSN）（® 2.1.1  中继线呼叫来电功能）

b. 截取路由的目的地（® 2.1.1.6  截取路由）

c. 来电呼叫分配群的排队时间表（® 2.2.2.4  排队功能）

d. 来电呼叫分配群的溢出目的地（® 2.2.2.7  溢出功能）

e. 门电话呼叫来电的目的地（® 2.18.1  门电话呼叫）

f. 集团电话话务员（® 5.1.5  话务员功能）

g. 用于TRS/限制和用于中继线接入的COS
h. 定时提醒的外播留言（OGM）（® 2.24.4  定时提醒）

i. 截取路由－无应答（® 2.1.1.6  截取路由）和DISA截取路由－无应答（® 2.16.1  直接拨入系统接入

（DISA））的截取时间

j. 语音信箱的服务群设定（® 3.2.1.39  服务群）

以下功能仅当时间模式设置为"休息"时才起作用：

a. 在休息模式下使用快速拨号将一体化网络内线电话重新路由到中继线（® 2.6.5  快速拨号）

[DID/DDI表和DIL表的编程示例]
可以为每个DID/DDI号码编程设定DID/DDI表，并且将一个租户（时间表）号码指定给每个DID/DDI号码。

可以为每条中继线编程设定DIL表，并且将一个租户（时间表）号码指定给每条中继线。

<DID/DDI表>
位置 DID/DDI号码 租户（时间

表）号码
DID/DDI目的地

白天 午餐 休息 夜间

001 123-4567 1 105 100
（UM）

105 100
（UM）

002 123-2468 1 102 100
（UM）

102 100
（UM）

: : : : : : :

<DIL表>
中继线号码 租户（时间表）号码 DIL目的地

白天 午餐 休息 夜间

01 1 101 100
（UM）

101 100
（UM）

02 2 102 100
（UM）

102 100
（UM）

: : : : : :

解释：

如果在20:00收到一个有DID号码（123-4567）的中继线呼叫：

462 使用说明书（功能手册）

5.1.4 定时服务



1. 将使用租户（时间表）号码1。
2. 在时间表1的夜间方式中接到呼叫。

3. 该呼叫将被路由到分机100（UM群）。

4. 假日方式

使用自动转换方式会自动启动假日方式。可以存储多达24个假日（开始和结束日期），而且可以为全部假日

选择一个时间方式。

5. 定时服务键

可以将一个灵活键定制为以下键：

a. 白天/夜间键

b. 白天/夜间/午餐键

c. 白天/夜间/休息键

d. 白天/夜间/午餐/休息键

这些键中的每一个键都用于转换时间方式。例如，按白天/夜间键在白天和夜间方式之间转换。所有这些键

都以如下方式显示当前状态：

指示灯类型 状态

关闭 白天方式

红灯亮 夜间方式

绿灯亮 午餐方式

绿灯慢闪 休息方式

红灯慢闪 假日方式

注

通过按定时服务键，任何分机用户（允许其改变方式的分机用户除外）都只能检查显示器上的当前状

态。

条件

• 系统编程可以设定以下时间段：

– 白天-1（白天开始时间）

– 午餐（午餐开始时间）

– 白天-2（午餐结束时间）

– 夜间（夜间开始时间）

– 休息-1开始

– 休息-1结束（白天重新开始）

– 休息-2开始

– 休息-2结束（白天重新开始）

– 休息-3开始

– 休息-3结束（白天重新开始）

• 定时服务转换方式（自动/人工）键

可以把一个灵活键定制为定时服务转换方式（自动/人工）键。
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使用说明书（PC编程手册）参考

10.4  PBX Configuration—[2-4] System—Week Table
10.5  PBX Configuration—[2-5] System—Holiday Table
10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Features— Time Service (Day /
Lunch / Break / Night) Switch
10.7.1  PBX Configuration—[2-7-1] System—Class of Service—COS Settings—Manager— Time Service
Switch
12.1.4  PBX Configuration—[4-1-4] Extension—Wired Extension—Flexible Button

→ Type
→ Parameter Selection (for Time Service)
→ Parameter Selection (for Time Service - Automatic/Manual)
→ Optional Parameter (Ringing Tone Type Number) (for Time Service)

使用说明书（功能手册）参考

2.6.5  快速拨号

2.7.1  长途限制（TRS）/呼叫限制（限制）

2.21.2  灵活键

3.2.1  系统功能

5.1.1  服务等级（COS）
5.1.3  租户业务

6.1  系统资源的容量

使用说明书（PT编程手册）参考

[101]定时服务转换方式

[102]定时服务开始时间

[514]定时服务人工转换

使用说明书（用户手册）参考

1.9.10  检查定时服务状态

2.1.2  定时服务方式控制

2.2.1  系统管理员功能—  远程定时服务方式设定
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5.1.5  话务员功能

说明

可以把任何分机或来电呼叫分配（ICD）群指定为话务员。

本集团电话支持以下类型的话务员：

类型 说明

集团电话话务员 可以把一部分机或一个来电呼叫分配群指定为每种时间方式（白天/午餐/
休息/夜间）的集团电话话务员。

租户话务员 可以把一部分机或一个来电呼叫分配群指定为租户话务员。租户话务员可

以是另一个租户的分机或来电呼叫分配群。

[示例]租户1的分机110是租户3的租户话务员。

话务员呼叫：

分机用户可以通过拨预编程设定的话务员呼叫功能号码来呼叫话务员。话务员呼叫的目的地取决于以下情况：

– 如果没有使用租户业务：

根据相应的时间方式，呼叫被接到集团电话话务员。

– 如果正在使用租户业务：

呼叫被接到分机的租户话务员。如果没有指定租户话务员，呼叫就被接到集团电话话务员。这种情况下，

将使用分机的租户的当前时间方式来确定该呼叫所连接的集团电话话务员。

如果既没有指定租户话务员又没有指定集团电话话务员，来电者将听到挂机重拨音。

条件

• 可以把一部分机或一个来电呼叫分配群同时指定为租户话务员和集团电话话务员。

• 可以为多个租户分别指定租户话务员。

使用说明书（PC编程手册）参考

10.2  PBX Configuration—[2-2] System—Operator & BGM— PBX Operator—Day, Lunch, Break, Night
14.6  PBX Configuration—[6-6] Feature—Tenant— Operator (Extension Number)

使用说明书（PT编程手册）参考

[006]话务员分配

使用说明书（功能手册）参考

5.1.3  租户业务

6.1  系统资源的容量

使用说明书（用户手册）参考

1.2.1  基本呼叫

1.12.1  在宾馆类环境中使用电话（友好功能）
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5.1.6  管理员功能

说明

允许指定为管理员的分机（管理员分机）使用特殊功能。COS编程决定了可以使用以下管理员功能的分机：

功能 说明与参考 管理员密码

管理员编程 管理员密码更改 更改管理员密码。 需要

话费管理 设定、显示、清除和打印话费数据。

® 2.22.3  话费服务

需要

设定验证代码个人

识别号码（PIN）

为每个验证代码设定验证代码PIN。

® 2.7.6  验证码输入

需要

远程PIN清除 远程清除分机的分机PIN和验证代码PIN。PIN
锁也被解开。

® 2.24.1  分机个人识别号码（PIN）

® 2.7.6  验证码输入

需要

远程分机锁定 远程设定或取消分机上的分机锁定。

® 2.7.3  分机锁定

需要

拨号音转移 临时改变分机的TRS/限制级。

[示例]分机用户可以打电话要求管理员释放去

电呼叫限制（例如：国际长途）。

® 2.7.4  拨号音转移

不需要

外播留言（OGM） 录制和播放外播留言（OGM）。

® 2.30.2  外播留言（OGM）

不需要

定时服务 人工转换时间方式（白天/午餐/休息/夜间）。

® 5.1.4  定时服务

不需要

BGM─外部 设定外部BGM开和关。

® 2.30.1  背景音乐（BGM）

不需要

中继线忙清除 清除中继线的占线状态。

® 2.5.4.6  中继线忙

不需要

NDSS监听释放 删除一个NDSS键的监听功能。

® 4.3.5.1  网络直接分机选择（NDSS）

不需要
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条件

注意

如果第三方发现了集团电话的个人识别号码（PIN）（验证代码PIN或分机PIN），便有可能发生欺诈呼叫的

危险。

此类呼叫将向集团电话的所有者/租用者收费。

为保护集团电话免受此类欺诈使用，我们强烈建议：

a. 对PIN进行保密。

b. 选择不容易猜到的复杂、随机PIN。

c. 定期更改PIN。

• 管理员密码

每台集团电话可以指定一个管理员密码。

使用说明书（PC编程手册）参考

10.7.1  PBX Configuration—[2-7-1] System—Class of Service—COS Settings—Manager— Manager
19.1  PBX Configuration—[11-1] Maintenance—Main—Password— Manager Password - PT
Programming—Prog *1

使用说明书（PT编程手册）参考

[112]管理员密码

[511]管理员分配

使用说明书（功能手册）参考

5.1.1  服务等级（COS）

使用说明书（用户手册）参考

2.1  控制功能

4.1.2  管理员编程

使用说明书（功能手册） 467

5.1.6 管理员功能



5.2  系统配置—分机

5.2.1  IP专用话机（IP-PT）
说明

IP专用话机（IP-PT）是使用IP拨打和接听电话且通过LAN连接至集团电话的电话。除使用IP外，其功能几乎与

传统专用话机完全相同。

IP-PT有两个用于连接的以太网端口，主要端口和次要端口。其通过网络集线器或其它分离设备连接到集团电

话，并可以用次要以太网端口连接PC。

[连接示例]

V-IPEXT

PCIP-PT

IP

IP-PT

IP-PT

条件

• IP-PT可以用于集团电话前，需要通过系统编程注册IP-PT。只有指定了分机号码后才能使用IP-PT。但是，

根据系统编程，可能完全自动进行注册，或只需要输入所需分机号码。

有关如何注册IP-PT的详情，请参阅使用说明书（安装手册）。

• KX-NT265没有次要以太网端口。

• 以下选配件可以用于KX-NT300系列（KX-NT321除外）IP-PT：
– KX-NT307（PSLP1528）Bluetooth模块

– KX-NT303附加12键模块（不可用于KX-NT366）
– KX-NT305附加60键模块（不可用于KX-NT366）

• DSP资源占用

根据使用的编解码器，从IP-PT打电话需要一定数量的DSP资源。如果所有DSP资源都在使用，则无法进行

此操作。为确保最低的性能水平，可为VoIP通信预留DSP资源。（® 5.5.4  DSP资源占用）

但是，P2P电话无需DSP资源。（® 5.2.3  对等（P2P）连接）

• KX-NT307（PSLP1528）Bluetooth模块

Bluetooth无线头戴式耳机可以通过个人编程注册到包含KX-NT307（PSLP1528）Bluetooth模块的

KX-NT300系列（KX-NT321除外）IP-PT。头戴式耳机方式关闭时，Bluetooth头戴式耳机可以用来应答呼

叫或重拨。这种情况下，头戴式耳机方式会自动打开，然后在挂机后关闭。

该Bluetooth模块也兼容KX-DT343　KX-DT346 DPT。
• 使用Bluetooth无线头戴式耳机拨打的呼叫不会在用户超出范围时立即断开。但是，如果Bluetooth无线头戴

式耳机在指定的时间段内一直处于超出范围状态，呼叫将被断开。
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• 以下功能不能用于IP-PT：
– XDP
– DXDP
– OHCA

• 自动重新路由到次要集团电话

主要集团电话断开时，KX-NT300系列或KX-NT500系列IP-PT可以自动连接到次要集团电话。重新连接主

要集团电话时，IP-PT会重新连接到集团电话上。

使用说明书（安装手册）参考

4.4  虚拟卡

使用说明书（PC编程手册）参考

9.2.2  PBX Configuration—[1-1] Configuration—Slot—System Property—Site—Main— IP Terminal
Registration Mode
9.13  PBX Configuration—[1-1] Configuration—Slot—Card Property—V-IPEXT
9.14  PBX Configuration—[1-1] Configuration—Slot—Port Property—V-IPEXT
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5.2.2  SIP（会话初始协议）分机

说明

本集团电话支持连接SIP兼容IP电话（硬电话和软电话）。SIP分机使用互联网协议（IP）拨打和接听电话。

有关SIP分机与功能号码兼容性的信息，请参阅5.5.7  灵活编号/固定编号。

如需有关Panasonic SIP电话（P-SIP）的信息，请参阅5.2.2.2  Panasonic SIP电话（P-SIP）。
下面是SIP分机支持的功能：

• 缺席留言（® 2.20.2  缺席留言）

• 计费代码输入（® 2.5.4.3  计费代码输入）

• 自动路由选择（ARS）（® 2.8  自动路由选择（ARS）功能）

• 呼叫转送（FWD）（® 2.3.2  呼叫转送（FWD））

• 呼叫保留（® 2.13.1  呼叫保留）

• 呼叫寄存*1（® 2.13.2  呼叫寄存）

• 呼叫接听（® 2.4.3  呼叫接听）

• 有通知的呼叫转移（ ® 2.12.1  呼叫转移）

• 呼叫等待音（® 2.1.3.3  呼叫等待）

• COLR/CLIR/CLIP/COLP（® 4.1.2.2  呼叫/连接线路识别显示（CLIP/COLP））
• 会议*2（® 2.14  会议功能）

• 会议组呼叫（®2.15.1  会议组呼叫）

• 数据线路安全（® 2.11.5  数据线路安全）

• 拨号信息（CTI）（® 2.26.1  电脑电话集成（CTI））
• 直接拨入系统接入（DISA）（® 2.16.1  直接拨入系统接入（DISA））
• 开门（® 2.18.2  开门）

• 门电话呼叫（® 2.18.1  门电话呼叫）

• 紧急呼叫（® 2.5.4.2  紧急呼叫）

• 主管遇忙优先插入拒绝（® 2.10.2  主管遇忙优先插入）

• 分机锁定（® 2.7.3  分机锁定）

• 清除分机功能（® 2.24.2  清除分机功能）

• 分机PIN（® 2.24.1  分机个人识别号码（PIN））

• 外部BGM开/关（® 2.30.1  背景音乐（BGM））

• 呼叫转送/免打扰（® 2.3  呼叫转送（FWD）/免打扰（DND）功能）

• 群FWD（® 2.3.2  呼叫转送（FWD））

• 空闲线路接入（® 2.5.5.3  中继线接入）

• 注册/注销（® 2.2.2.8  注册/注销）

• 留言待取（® 2.20.1  留言待取）

• 未准备（® 2.2.2.8  注册/注销）

• 话务员呼叫（® 5.1.5  话务员功能）

• 广播（® 2.17.1  广播）

• 个人速拨（® 2.6.4  速拨—个人/系统）

• 快速拨号（® 2.6.5  快速拨号）

• 重拨（® 2.6.3  最后号码重拨）

• 远程电话锁（® 2.7.3  分机锁定）

• S-CO线路接入（® 2.5.5.3  中继线接入）

• 系统速拨（® 2.6.4  速拨—个人/系统）

• TIE线路呼叫（® 4.3.1  TIE线路业务）
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• 定时服务（® 5.1.4  定时服务）

• 定时提醒（® 2.24.4  定时提醒）

• 中继线群接入（® 2.5.5.3  中继线接入）

• 验证代码（® 2.7.6  验证码输入）
*1 SIP分机可以恢复寄存呼叫但是无法寄存呼叫。
*2 仅作为成员（不作为发起人）。

SIP视频电话

使用视频电话功能可以在SIP分机之间建立起视频电话通话。

条件

[一般]
• 本集团电话支持使用RFC 3261、3264、3310、2327或4028的SIP设备。

• 一些SIP电话可能与本集团电话不兼容。

• 集团电话可使用SIP分机之前，必须在SIP分机和集团电话上分配主板的IP地址、密码和分机号码。即使IP
终端注册模式已设为全自动模式或分机输入模式，仍必须手动注册一般SIP分机。

有关如何注册的详情，请参阅使用说明书（安装手册）。

• 注册SIP分机时，用户ID必须为SIP分机的分机号码。

• SIP分机使用呼叫保留功能时，目标呼叫被置于协商保留。

• DSP资源占用

根据使用的编解码器，从SIP分机打电话需要一定数量的DSP资源。如果所有DSP资源都在使用，则无法

进行此操作。为确保最低的性能水平，可为VoIP通信预留DSP资源。（® 5.5.4  DSP资源占用）

但是，P2P电话无需DSP资源。（® 5.2.3  对等（P2P）连接）

使用说明书（安装手册）参考

4.4  虚拟卡

使用说明书（PC编程手册）参考

9.15  PBX Configuration—[1-1] Configuration—Slot—Card Property—V-SIPEXT
9.16  PBX Configuration—[1-1] Configuration—Slot—Port Property—V-SIPEXT
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5.2.2.1  简易远程连接

说明

使用内置媒体中继网关

使用内置媒体中继网关功能，无需SBC（会话边界控制器）等额外设备即可将KX-NT500系列IP-PT和Panasonic
IP软电话连接至远程位置。配置内置媒体中继网关后，可将这些设备注册至远程位置。也可方便地将一般SIP
电话安装在远程位置。

简易远程连接表示即使电话位于NAT路由器、防火墙或两者之后，仍无需为各远程分机配置专门设定（如NAT
Traversal设定）。

共有2种方案用于配置和连接电话：

a. 在集团电话的本地网络上将电话连接并注册至集团电话。必要设定由集团电话自动配置。

b. 配置电话的远程IP设定而无需先将电话连接至集团电话。

一旦经过编程，就会将电话送到远程位置、连接至网络并自动连接至集团电话。

注

• 内置媒体中继网关不支持对等通信。

条件

• 必须在集团电话上配置以下类型的设定：

– SIP电话端口的远程设定

– 集团电话侧网络网关的对外IP地址和端口

– NAT设备的必要NAT Traversal设定

• 必须在集团电话侧的网络网关上配置以下类型的设定：

当使用内置媒体中继网关时

– 用于穿越内置媒体中继网关的静态端口转送设定（SIP、TR-069、RTP、NTP、PTAP、MGCP和FTP）
• 一般SIP电话必须支持早期媒体。

使用说明书（安装手册）参考

5.8.3  使用内置媒体中继网关在远程现场安装IP电话

使用说明书（PC编程手册）参考

9.2.2  PBX Configuration—[1-1] Configuration—Slot—System Property—Site—Port Number— Firmware
Update Port No. for IP-PT/IP-CS (Media Relay)
9.2.2  PBX Configuration—[1-1] Configuration—Slot—System Property—Site—Media Relay

→ Common—NAT - External IP Address
→ IP Extension / IP-CS—NAT - MGCP Server Port No.
→ IP Extension / IP-CS—Keep Alive Packet Type
→ IP Extension / IP-CS—Keep Alive Packet Sending Interval Time (s)
→ IP Extension / IP-CS—NAT - FTP Server Port No.
→ SIP Extension / UT Extension—NAT - SIP Proxy Server Port No.
→ Option—NAT - RTP IP Address
→ Option—NAT - SIP Proxy Server IP Address
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→ Option—NAT - CWMP Server IP Address
→ Option—NAT - CWMP Server IP Address for Network Survivability
→ Option—NAT - NTP Server IP Address

9.14  PBX Configuration—[1-1] Configuration—Slot—Port Property—V-IPEXT—Remote Place
9.16  PBX Configuration—[1-1] Configuration—Slot—Port Property—V-SIPEXT—Remote Place

使用说明书（功能手册） 473

5.2.2 SIP（会话初始协议）分机



5.2.2.2  Panasonic SIP电话（P-SIP）
说明

Panasonic SIP电话（P-SIP）具有以下特征。

• P-SIP使用IP-PT/P-SIP的激活密钥（例如，KX-NSM201），而非SIP分机的激活密钥（例如，

KX-NSM701）。
• P-SIP电话与一般SIP电话的功能相同。

• 将P-SIP电话注册到集团电话以及从中注销的方式与一般SIP电话相同。

请参阅相应的P-SIP手册了解注册和注销流程。

条件

• 要求：

使用P-SIP电话需要V-SIPEXT卡。

• P-SIP电话被视为一般SIP电话，因而包含在一般SIP电话的最大容量中。

使用说明书（安装手册）参考

4.4  虚拟卡

使用说明书（PC编程手册）参考

9.15  PBX Configuration—[1-1] Configuration—Slot—Card Property—V-SIPEXT
9.16  PBX Configuration—[1-1] Configuration—Slot—Port Property—V-SIPEXT
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5.2.3  对等（P2P）连接

说明

本集团电话会在对等兼容IP分机（即，IP-PT和SIP分机）和属于相同P2P群的SIP中继线之间建立对等通信。

使用对等呼叫，会将呼叫从一部IP分机直接路由至另一部分机而不经过DSP卡。这意味着无需使用集团电话的

资源也可以建立P2P通话。

P2P方案

可以在现场的电话之间建立P2P通话。以下示意图显示各种网络配置中建立的P2P通话。假设所有设备均通过

专用IP网络连接。

现场内的P2P连接

P2P

现场内建立P2P连接的IP电话之间的通话。

使用说明书（功能手册） 475

5.2.3 对等（P2P）连接



[示例]

IP-PT SIP

SIP

SIP

SIP

现场内IP分机和IP中继线之间的P2P连接

在现场内的IP分机和IP中继线之间传送并接收语音数据包。

通过VPN（轴辐式连接）在分支办公室之间建立P2P连接*1

1

2

P2P

使用现场的集线路由器通过VPN进行通信，在不同分支办公室的IP电话之间通话可建立P2P连接。
*1 当VPN使用轮辐式（星形）拓扑时，必须配置集线路由器以允许掉头连接。

476 使用说明书（功能手册）

5.2.3 对等（P2P）连接



通过VPN（网状连接）在分支办公室之间建立P2P连接

P2P

1

2

在不同分支办公室的IP电话之间进行通话可通过各分支的VPN路由器直接建立P2P连接。

条件

[一般]
• 有3种codecs用于对等呼叫：G.722、G.711和G.729A。codecs的语音质量如下变化：（高）G.722、G.

711、G.729A（低）。

每一方首选的codec不同时，将使用较低的codec建立通话。例如，如果主叫方选择了G.711而被叫方选择

了G.729A，将使用G.729A建立通话。

• G.722仅适用于对等通信期间支持此编解码器的KX-NT300系列 IP-PT、KX-NT500系列IP-PT和一些SIP分
机之间的呼叫。

• 通过系统编程，可以分配IP-PT使用的首选编解码器。

• 对于一般SIP分机，可以通过电话本身指定要使用的编解码器的优先权。

• 对于通过DSP卡的非对等呼叫，如果卡的所有资源都正被使用则无法进行呼叫或接收。

• 一般SIP电话支持通过SIP中继线建立P2P通信。

• KX-NT500系列IP-PT支持通过SIP中继线建立P2P连接。有关各KX-NT500系列IP-PT的兼容软件版本，请

联系经销商。其他IP-PT不支持此功能。

• 本集团电话支持P2P视频通信H.263/H.264编解码器。

• IP分机之间或PI分机和IP中继线之间的通话支持使用T.38协议的P2P通信。但是，只能使用SIP分机和SIP
中继线。

[P2P群]
• 电话或SIP中继线必须属于相同的P2P群才能建立P2P连接。可以将电话或SIP中继线分配至相同的P2P群。

• 在"DSP直通模式"中通过DSP卡可建立不同P2P群中IP分机之间的通话。无论使用何种编解码器，DSP直
通模式均只需要1个DSP资源。

• 不同P2P群中分机或SIP中继线之间的通话会消耗DSP资源。

• 要激活IP分机和IP中继线之间的P2P通信，请将IP Extension - SIP Trunk P2P设为启用（® 10.9  PBX
Configuration—[2-9] System—System Options—Option 8— Extension - Trunk P2P—IP Extension - SIP
Trunk P2P）。

• 集团电话会配置每个SIP中继线端口的P2P群设定，且仅当双方均属于相同P2P群时才允许建立P2P通信。

• 在因提供商限制而禁止在IP分机和IP中继线之间建立P2P通信的环境中，将IP Extension - SIP Trunk P2P
设为禁用，或在来电者之间分配不同的P2P群设定。
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注

P2P通信期间，由于在IP分机和IP中继线之间直接处理声音RTP数据包，所以集团电话无法检测到DTMF信
号。因此，无法使用那些使用DTMF检测的功能（例如，DISA呼叫转移到外线用户）。要使用此类功能，请

改变设定以允许非P2P通话，从而打造DTMF检测可用的环境。与您的ITSP确认是否有使用DTMF检测的服

务以及可否建立P2P通信。

使用说明书（安装手册）参考

4.3.3  DSP S卡（KX-NS5110）、DSP M卡（KX-NS5111）、DSP L卡（KX-NS5112）

使用说明书（PC编程手册）参考

9.2.2  PBX Configuration—[1-1] Configuration—Slot—System Property—Site—VoIP-DSP Options
9.10  PBX Configuration—[1-1] Configuration—Slot—Port Property—V-SIPGW—Main— P2P Group
9.10  PBX Configuration—[1-1] Configuration—Slot—Port Property—V-SIPGW—Main— P2P Group Name
9.14  PBX Configuration—[1-1] Configuration—Slot—Port Property—V-IPEXT—Main— P2P Group
9.14  PBX Configuration—[1-1] Configuration—Slot—Port Property—V-IPEXT—Main— P2P Group Name
9.14  PBX Configuration—[1-1] Configuration—Slot—Port Property—V-IPEXT—Option— IP Codec Priority
9.16  PBX Configuration—[1-1] Configuration—Slot—Port Property—V-SIPEXT—Main— P2P Group
9.16  PBX Configuration—[1-1] Configuration—Slot—Port Property—V-SIPEXT—Main— P2P Group Name
9.16  PBX Configuration—[1-1] Configuration—Slot—Port Property—V-SIPEXT—FAX/T.38
10.9  PBX Configuration—[2-9] System—System Options—Option 8— Extension - Trunk P2P—IP Extension
- SIP Trunk P2P

使用说明书（功能手册）参考

5.2.1  IP专用话机（IP-PT）
5.1.2  群

478 使用说明书（功能手册）
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5.2.4  便携话机（PS）功能

5.2.4.1  虚拟PS
说明

可以不注册PS机本身，而将分机号码分配给便携话机（PS）。这称为暂时注册。如果接着又给此PS分配了转

送目的地，那么所有拨打此分机号码的呼叫将被转送到分配的目的地。使用此设定可以将呼叫转送到外线目的

地或另一部集团电话的目的地，让它们像在集团电话内部一样接收呼叫。另外，根据系统编程，转送目的地可

以使用集团电话的某些功能。这对移动电话用户特别有用，当不在办公桌旁时，他们可以使用移动电话代替自

己的分机。

[示例]

-1

TIE

TIE

-2

PS 2PS 1

"201"

201 202

使用此方法可以接入以下功能：

功能 说明与参考

来电呼叫分配群中的外线目的地 虚拟PS可以让外线目的地或另一部集团电话的分机应答来电呼叫分配

（ICD）群的来电。

® 2.2.2.3  来电呼叫分配群中的外线目的地

网络ICD群 在一个ICD群里使用虚拟PS，可以最多同时拨打4个其它的集团电话。

® 4.3.6  网络ICD群

使用说明书（功能手册） 479
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功能 说明与参考

传真自动转移 可以使用虚拟PS将传真呼叫转送到通过TIE线路连接的另一部集团电

话中的传真机。

® 2.16.2  传真自动转移

内装简化语音留言 注册虚拟PS为ICD群的第一部分机，这将为该ICD群提供一个专用的

留言箱，而不是与实际的分机共享留言箱。

®2.16.3  内装简化语音留言（SVM）

条件

• 若要使用此功能，必须通过COS编程允许呼叫转送到中继线。

使用说明书（PC编程手册）参考

9.35  PBX Configuration—[1-2] Configuration—Portable Station

使用说明书（功能手册）参考

2.3.2  呼叫转送（FWD）

480 使用说明书（功能手册）

5.2.4 便携话机（PS）功能



5.2.5  ISDN分机功能

5.2.5.1  ISDN分机

说明

可以把一个ISDN（PRI）端口用于中继线或分机连接。当允许分机连接时，可以把ISDN终端设备（例如：ISDN
电话、G4传真机、PC）或一台后方集团电话连接到该端口。

如果ISDN端口处于点到点（P-P）配置，可以将一个终端设备连接到该端口。如果ISDN端口处于点到多点

（P-MP）配置，最多能将8台终端设备连接到该端口。然而，最多只能同时使用两台设备。

后方集团电话上的单个终端设备可以用多个用户号码（MSN）寻址。

MSN由ISDN分机号码和一个附加数字组成，该附加数字的范围是0至9或00至99。

[示例]

(131)

13X (MSN)

14XX (MSN)

15XX 

                  (MSN)

(132) (139)

...

...

(1234)

1234ISDN

 (P-MP)

(1234) (1234)

...

...

1234

8

131-139

8

130

(1400) (1401) (1499)

...

...

1400-1499

(

DDI/ 

MSN )

ISDN

 (P-P/P-MP)

ISDN

(P-P/P-MP)

ISDN

 (P-MP)

条件

• 子地址

可以在ISDN终端设备之间进行子地址寻址。子地址直接从集团电话转到ISDN终端设备。

• 呼叫转移（集团电话功能）只适用于P-MP配置中的ISDN分机。（® 2.12.1  呼叫转移）

• ISDN分机可以属于来电呼叫分配群（® 2.2.2  来电呼叫分配群功能）或空闲分机搜索群（® 2.2.1  空闲分

机搜索）。这样，可以分配MSN。

使用说明书（功能手册） 481
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• 如果MSN的最后数字是"0"，而且每个终端设备的规格都可用，则同一个ISDN端口上的全部终端设备将同

时收到呼叫。为了将最后一位数字为"0"的MSN作为单独的MSN使用，需要对每个ISDN端口进行系统编程。

• 不支持通过电话线路接收电源的ISDN终端设备。

使用说明书（PC编程手册）参考

9.27  PBX Configuration—[1-1] Configuration—Slot—Port Property - PRI Port—Extension Setting

使用说明书（功能手册）参考

2.1.1.4  多个用户号码（MSN）振铃服务

482 使用说明书（功能手册）
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5.2.6  分机端口配置

说明

有以下三种类型的分机端口：

a. DPT端口：可以连接DPT、DSS话务台或Panasonic VPS（DPT[数字]集成）。

b. SLT端口：可以连接SLT或Panasonic VPS（DTMF集成）。

c. 超级混合端口：可以连接DPT、APT、SLT、DSS话务台或Panasonic VPS。

超级混合端口的附加设备端口（XDP）：
可以把一部DPT和一部SLT连接到一个超级混合端口（TR：SLT，HL：DPT）。在此情况下，可以把超级混合

端口的SLT端口（TR）用作XDP端口，用来连接一部SLT作为子电话。XDP端口有如下两种方式：

方式 说明

并联方式 DPT和SLT有相同的分机号码，这样他们就可以作为一部分机工作。

它们使用主电话的（DPT的）分机数据（例如：分机号码、COS）。
(® 2.11.10  并联电话)

XDP方式 DPT和SLT有不同的分机号码，这样它们可以作为完全不同的分机工

作。若要使用XDP方式，必须通过系统编程在端口上允许XDP方式。

条件

• 超级混合端口上的自动检测

不用任何编程，就可自动检测到连接到超级混合端口的DPT或SLT。当不允许XDP方式时，可以自动检测

到连接到超级混合端口的APT。
• 也可以用XDP方式将DSS话务台或Panasonic VPS（DPT[数字]集成）与SLT相连。

• 并联方式中的APT和SLT
也可以把一部APT和一部SLT连接到一个超级混合端口并且以并联方式使用。

• DXDP
可以把DPT接到另一部DPT，并作为一部完全不同的分机来使用。（® 2.11.10  并联电话）

• DSS话务台和配对电话分配

当连接DSS话务台时，必须通过系统编程分配一部配对分机。只有PT才能成为配对分机。

使用说明书（PC编程手册）参考

9.22  PBX Configuration—[1-1] Configuration—Slot—Port Property—Extension Type
12.3  PBX Configuration—[4-3] Extension—DSS Console— Pair Extension

使用说明书（PT编程手册）参考

[007] DSS话务台成对电话

[600]附加设备端口（XDP）方式

使用说明书（功能手册） 483
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5.3  旧设备连接

5.3.1  中继适配器连接

说明

可将IP中继线（V-SIPGW和V-IPGW）连接至中继适配器（KX-NS8188　KX-NS8290），使KX-NS300可连接

至E1中继线和PRI线路。

条件

[一般]
• 一个IP中继线端口对应于中继适配器中的1个信道。

• Connection Attribute设定设为Trunk Adaptor的端口无需激活密钥。没有此设定的端口也可连接至中继

适配器，但需要激活密钥。

• 一个KX-NS300可连接至多个中继适配器。

• 有关配置E1中继线和PRI线路设定的详情，请参阅中继适配器的说明书。

[通过SIP中继线连接]
• SIP中继线验证ID和中继适配器上IP接口的验证ID必须相同。

• 连接至中继适配器的SIP中继线的信道属性必须设为Basic channel。

使用说明书（PC编程手册）参考

9.10  PBX Configuration—[1-1] Configuration—Slot—Port Property—V-SIPGW—Programming Port
Properties—Trunk Adaptor
9.10  PBX Configuration—[1-1] Configuration—Slot—Port Property—V-SIPGW—Main

→ Connection Attribute
→ Channel Attribute

9.12  PBX Configuration—[1-1] Configuration—Slot—Port Property—V-IPGW
→Trunk Adaptor
→ Connection Attribute

484 使用说明书（功能手册）
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5.4  电子邮件通知功能

5.4.1  分机用户的电子邮件通知

说明

可以向分机用户发送电子邮件，在他们收到新的语音留言等事件时通知他们。可以为以下事件发送通知：

• 未接中继线呼叫

• 新语音留言

条件

• 对于需接收新语音留言通知的分机用户，他们必须拥有分配至其分机的信箱。（® Section  20  UM
Configuration—[1] Mailbox Settings）

• 对于需接收未接中继线呼叫通知的分机用户，必须配置以下设定：

→ 8.2.1  Users—Add User—Single User中的"Contact—Email 1–3"
→ 8.2.1  Users—Add User—Single User中的Email notification

• 要发送电子邮件通知，必须配置SMTP服务器设定。

• 最多可以为每位分机用户注册3个电子邮件地址。

• 电子邮件附件的最大文件大小为30 MB。超过此大小的文件不能作为附件发送。

使用说明书（PC编程手册）参考

8.2  Users—Add User
20.1.2  UM Configuration—[1-2] Mailbox Settings—Full Setting—Notification Parameters— E-mail/Text
Message Device—Device No. 1, 2, 3—E-mail Address
27.2.5  Network Service—[2-6] Server Feature—SMTP

使用说明书（功能手册）参考

3.2.1.28  留言待取通知—电子邮件装置

使用说明书（用户手册）参考

3.2.1  用户编程—更改您的联系信息

使用说明书（功能手册） 485
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5.4.2  系统级事件的电子邮件通知

说明

当发生特定系统别事件时，会向管理员或其他指定的电子邮件地址发送电子邮件。可以为以下事件发送通知：

事件 详情

系统警报 将一封电子邮件发送至两个已注册的电子邮件地址。

软件更新 可以为以下四种类型的软件更新事件发送通知：

1. 更新FTP服务器上有可用的软件更新。

2. 已从更新FTP服务器下载软件更新。

3. 已成功安装软件更新。

4. 软件许可证即将到期。

条件

• 要发送电子邮件通知，必须配置SMTP服务器设定。

• 通过系统编程可以配置电子邮件通知的系统名称。

® 27.3.3  Network Service—[3-3] Client Feature—SNMP Agent— MIB info—SysName

使用说明书（PC编程手册）参考

5.1  System Control—Program Update
7.7  Utility—Email Notification
8.2  Users—Add User
27.2.5  Network Service—[2-6] Server Feature—SMTP

使用说明书（功能手册）参考

5.5.9  软件升级

486 使用说明书（功能手册）
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5.4.3  传感器警报的电子邮件通知

说明

当外部传感器检测到警报时，可以将电子邮件发送至指定的电子邮件地址。您可以在电子邮件中添加注释。如

果在注释中留下网络摄像头的URL，则该通知的收件人可以通过单击注释中的URL监视来自网络摄像头的视频

录像。

条件

• 硬件要求：

外部传感器和DPH2卡。

• 要发送传感器警报的电子邮件通知，必须安装DPH2卡。

• 可将最多8个传感器连接至集团电话。可以为各外部传感器设定电子邮件地址。

• 对于接收传感器警报通知的用户，必须配置以下设定：

– 必须启用传感器警报的通知电子邮件

13.5  PBX Configuration—[5-5] Optional Device—External Sensor Sensor Alarm—Email notification
– 电子邮件地址

13.5  PBX Configuration—[5-5] Optional Device—External Sensor Sensor Alarm—Email Address
– 电子邮件的注释

13.5  PBX Configuration—[5-5] Optional Device—External Sensor Sensor Alarm—Email Comment

使用说明书（PC编程手册）参考

13.5  PBX Configuration—[5-5] Optional Device—External Sensor

使用说明书（功能手册）参考

2.18.3  外部传感器
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5.4.4  管理员的电子邮件通知

说明

使用自动双向录音时，管理员可以收到电子邮件通知。录音可转换为音频文件，然后作为附件发送。

电子邮件的目的地是为自动双向录音信箱设置的电子邮件地址。

条件

• 使用此功能需要KX-NSU002（双向录音控制激活密钥）。

• 以下激活密钥不是使用此功能必需的。

– KX-NSU201、KX-NSU210、KX-NSU299（统一消息电子邮件通知激活密钥）

– KX-NSU301、KX-NSU310、KX-NSU399（双向录音激活密钥）

• 在自动双向录音完成后发送电子邮件。

• 如果录音期间目标电子邮件地址发生更改，更改将立即生效，录音完成后，录制的对话将发送到新的电子

邮件地址。

• 电子邮件附件的最大文件大小为30 MB。超过此大小的文件不能作为附件发送。

• 该功能通过设置信箱的电子邮件地址启用。如果未设置此地址，将不会发送电子邮件通知。

→ 20.1.2  UM Configuration—[1-2] Mailbox Settings—Full Setting— E-mail/Text Message
Device—Device No. 1, 2, 3—E-mail Address

使用说明书（PC编程手册）参考

7.5.4  Utility—Report—E-mail Report
20.1.2  UM Configuration—[1-2] Mailbox Settings—Full Setting—Notification Parameters

→ E-mail/Text Message Device—Device No. 1, 2, 3—User Name
→ E-mail/Text Message Device—Device No. 1, 2, 3—E-mail Address
→ E-mail/Text Message Device—Device No. 1, 2, 3—Only Urgent Messages
→ E-mail/Text Message Device—Device No. 1, 2, 3—Title Order
→ E-mail/Text Message Device—Device No. 1, 2, 3—Title String
→ E-mail/Text Message Device—Device No. 1, 2, 3—Callback Number
→ E-mail/Text Message Device—Device No. 1, 2, 3—Send Wait Time [0-120 min]
→ E-mail/Text Message Device—Device No. 1, 2, 3—Attach Voice File
→ E-mail/Text Message Device—Device No. 1, 2, 3—Use Mode

24.4  UM Configuration—[5-4] System Parameters—Parameters—E-mail Option

使用说明书（功能手册）参考

3.2.1.4  管理员自动双向录音

使用说明书（用户手册）参考

管理员操作

3.2.1  用户编程—  管理员自动双向录音

488 使用说明书（功能手册）
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5.5  系统数据控制

5.5.1  用户配置文件

说明

按用户等级管理各用户的以下信息设定。

• 用户信息（姓名、语言等）

• 联系信息（分机号码、电子邮件地址等）

• 统一消息信息（信箱号码、密码等）

• 电子邮件通知信息

• 电话功能信息（呼叫转送/免打扰、个人速拨等）

• 登录帐户信息

用户可以通过Web维护控制台配置特定的用户信息。

通过以"User（管理员）"帐户或"安装人员"帐户登录可以查看、添加、编辑和删除其他帐户的用户信息。

注

建议在"User Profiles"中注册用户信息（分机号码、名称、信箱号码、登录帐户等）。

在"User Profiles"中设置的分机或信箱必须在该屏幕上进行维护，而不是使用"PBX
Configuration—Extension"或"UM Configuration—Mailbox Settings"。

使用说明书（安装手册）参考

5.11  自动配置信箱

使用说明书（PC编程手册）参考

Section  8  Users
Section  12  PBX Configuration—[4] Extension
Section  20  UM Configuration—[1] Mailbox Settings

使用说明书（功能手册）参考

3.1.2.1  自动配置信箱

5.5.2  PC编程

使用说明书（用户手册）参考

3.2.1  用户编程

使用说明书（功能手册） 489
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5.5.2  PC编程

说明

可以使用PC来编程设定和管理本集团电话。编程方法有两种：

1. 现场编程：把PC直接连接到集团电话，就可以在现场进行系统编程/诊断。

2. 远程编程：可以从远程位置进行系统编程/诊断和数据上传。

1. 现场编程：

方法 说明

使用LAN接口 通过MPR卡的LAN端口可用。

通过SLT端口使用调制解调

器*1

必须安装RMT卡。分配模拟远程维护的浮动分机号码（默认：599），
并且从PC拨该号码以连接到集团电话。

通过ISDN分机线路使用

ISDN TA接口（64
kbps）*1

分配ISDN远程维护的浮动分机号码（默认：699），并且从PC拨该号

码以连接到集团电话。此方法不需要RMT卡。

只有使用用户自备的支持CAPI的ISDN TA才能使用该方法。

*1 如果通过系统编程停用远程接入，则不能进行现场编程。

2. 远程编程：

方法 说明

使用调制解调器（RMT卡） 必须安装RMT卡。必须分配模拟远程维护的浮动分机号码（默认：

599）。
使用与调制解调器并联连接的电话，可以用以下方法进行PC编程：

• 直接接入

拨DIL/DID/DDI号码，其目的地是模拟远程维护的浮动分机号码。

• 通过DISA
使用DISA功能拨模拟远程维护的浮动分机号码。（® 2.16.1  直
接拨入系统接入（DISA））

• 呼叫转移

呼叫一部分机（可能是话务员），并要求转移到模拟远程维护的

浮动分机号码。（® 2.12.1  呼叫转移）

通过ISDN中继线使用ISDN TA
接口（64 kbps）

必须分配ISDN远程维护的浮动分机号码（默认：699），并且拨DIL/
DID/DDI号码，其目的地是ISDN远程维护的浮动分机号码。此方法

不需要RMT卡。

只有使用用户自备的支持CAPI的ISDN TA才能使用该方法。

共有三个等级的集团电话编程权限，每个等级控制编程可访问和改变的设定。三个等级如下：

等级 说明 帐户/网络数量

安装人员 适用于经销商和系统安装人员 1

User（管理员） 适用于现场管理员 8

User（用户） 适用于终端用户 492

490 使用说明书（功能手册）

5.5.2 PC编程



条件

• 每个帐户会分配一个登录所需的密码。

• 使用添加用户指示可以添加用户。

注意

关于帐户密码，对管理员或安装人员的要求

1. 请将所有的系统密码提供给顾客。

2. 为了防止未经授权的访问和滥用集团电话，请保管好密码，并且告知顾客密码的重要性，以及向他人泄

露的危害。

3. 集团电话在初始情况下没有设定密码。为安全起见，请在现场安装集团电话系统时尽快选择安装者密

码。

4. 定期更改密码。

5. 强烈建议使用10个数字或字符的密码，尽可能避免未经授权的访问。

使用说明书（安装手册）参考

4.3.10  主机中的RMT卡（KX-TDA0196）
5.2  PC连接

5.3  启动Web维护控制台

使用说明书（PC编程手册）参考

2.1.1  Web Maintenance Console Accounts
2.1.2  Access Levels
8.2  Users—Add User

使用说明书（PT编程手册）参考

[801]外部调制解调器控制

[810]远程编程

[811]调制解调器浮动分机号码

[812] ISDN远程浮动分机号码

使用说明书（用户手册）参考

3.2  使用Web维护控制台进行系统编程

使用说明书（功能手册）参考

2.1.1.2  外线直接到分机振铃的功能（DIL）
2.1.1.3  直接向内拨号（DID）/直接拨入（DDI）
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5.5.3  PT编程

说明

PT用户可以进行以下编程：

a. 个人编程：根据需要定制分机。

b. 系统编程：根据组织机构的需要定制集团电话。

c. 管理员编程：定制特定的经常更改的项目（例如：计费管理和远程分机锁定）。

条件

• COS编程决定可以进行何种编程：

– 系统编程和个人编程

– 仅个人编程

– 不能编程

• 只可以从多线路显示器DPT或IP-PT执行系统编程。不支持多线路显示器APT。
• 不管COS如何，连接到最低编号分机端口的分机可以进行个人编程和系统编程。

• 被指定为管理员COS的分机可以进行管理员编程。

• 在编程过程中，PT被认为占线。

• 一次只允许一个系统编程人员或一个管理员编程人员执行系统编程或管理员编程。每台集团电话支持的最

多数目同时编程人员如下：

– 1个系统编程人员 + 63个个人编程人员

– 1个管理员编程人员 + 63个个人编程人员

– 64个个人编程人员

• 系统编程密码等级

若要接入系统编程，必须输入有效的密码。有关详情，请参阅使用说明书（PT编程手册）中的"1.1.2  密码

安全"。
• 个人编程数据默认设定

用户可以使电话上编程设定的项目返回到默认值。

使用说明书（PC编程手册）参考

10.7.1  PBX Configuration—[2-7-1] System—Class of Service—COS Settings—Manager— PT Programming
Mode Level
19.1  PBX Configuration—[11-1] Maintenance—Main—Password— System Password - PT
Programming—Prog *#: Administrator Level
19.1  PBX Configuration—[11-1] Maintenance—Main—Password— System Password - PT
Programming—Prog **: User Level
19.1  PBX Configuration—[11-1] Maintenance—Main—Password— Manager Password - PT
Programming—Prog *1

使用说明书（PT编程手册）参考

[516]编程方式限制
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使用说明书（功能手册）参考

5.1.1  服务等级（COS）
5.1.6  管理员功能

6.1  系统资源的容量

使用说明书（用户手册）参考

1.9.13  清除在您分机上设定的功能（清除分机功能）

3.1  定制您的电话设置（个人编程）

4.1  管理员编程
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5.5.4  DSP资源占用

说明

要数字化处理音频信号，如电话呼叫，集团电话必须使用一定数量的DSP（数字信号处理）资源。DSP资源由

集团电话中安装的DSP卡提供。由于DSP资源的数量有限，所以如果所有资源正在使用，则无法进行更多操作

（例如，电话呼叫、播放OGM）。

以下列表显示某些需要DSP资源的基本操作。

• IP分机呼叫

• IP中继线呼叫

• 会议

• 接入统一消息系统（包括记录呼叫）

• OGM播放

• 回声消除器

对于IP分机和中继线呼叫，所需资源的数量会因使用的编解码器（G.711或G.729）而不同。

注

本节中的示例旨在说明DSP资源占用的概念。更复杂的情况可能需要额外资源，且在某些情况下，可能需

要更少资源。

DSP资源占用的示例

基本上，给定情形所需的资源数量为每个单独操作所需资源的总和。以下示例说明不同情形下的DSP资源占用

情况。

[IP中继线至IP分机]

IP

IP-PT

X Y

G.729A G.711

如果使用G.729编解码器的IP中继线呼叫需要X个资源，而使用G.711编解码器的IP分机需要Y个资源，则从IP
分机向IP中继线呼叫所需的资源数量为X + Y个资源。

[统一消息接入]

IP-PT

Y

X

G.711

UM

从统一消息（上图中的UM）系统播放留言或将留言记录至统一消息系统都需要DSP资源，本例中需X个资源，

外加G.711编解码器所需的资源（Y）。总成本为X + Y个资源。

494 使用说明书（功能手册）

5.5.4 DSP资源占用



[会议电话]

IP

IP SLT

IP-PT

W

Y

Z

X

X

X

X

G.729A

G.711

G.711

G.711

G.711

会议需要额外的资源（Y）以处理多个语音信道。另外，在标准双向通话中，模拟线路通常不需要任何DSP资
源，但在会议中却需要。此外，会议中的IP中继线需要额外的DSP资源。

本例中，所需资源的数量为X + X + X + X + Y + Z + W。

DSP占用图表

集团电话会保留以下各功能/服务每小时的最大DSP占用记录。在Web维护控制台可以显示DSP占用随时间变

化趋势的图表，以及因资源不足而无法进行的呼叫和操作数量。

• VoIP（IP中继线和IP分机占用）

• 会议

• 统一消息

• OGM
• 双向录音

图表还会显示剩余资源的数量以及总资源使用情况。

可以为每项服务储备DSP资源，从而保证每项服务有资源可用。有关储备DSP资源的详细信息，请参阅

5.5.4.1  DSP资源储备。如果为某项服务储备的DSP资源全部用完，可以使用剩余（非储备）DSP资源。DSP
资源占用图表按小时显示为每个服务储备的DSP资源、剩余DSP资源以及可用DSP资源总量。DSP资源占用图

表的示例如下。
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[示例]

条件

[一般]
• 大多内部VoIP呼叫不需要资源，因为IP电话通过P2P连接（® 5.2.3  对等（P2P）连接）进行连接。也就

是说，电话本身会进行信号处理而无需消耗集团电话资源。集团电话只需进行初始连接。

• 电话和中继线与直接连接至集团电话的模拟电话和中继线使用相同数量的资源。

[DSP占用图表]
• 记录最近30天的DSP占用情况。

• 图标的间隔标度可以设为1小时、4小时、或24小时。

• 纵轴的最大值为记录的最大DSP占用值，而非可用DSP资源容量。

• 要查看测出DSP资源繁忙的次数，请参阅Counting of DSP busy times。
• 可以通过单击Export将DSP资源占用的状态输出为CSV文件。在此数据中，可以查看为每项服务储备的

DSP资源的繁忙状态以及图表中显示的数据。

• 如果未对每项服务储备DSP资源，所有DSP资源都将从剩余DSP资源获取，并视为图表中的剩余资源。在

此情况下，剩余DSP资源与DSP资源总量应为同一条线。为准确测出每项服务使用的DSP资源量，请为每

个服务储备DSP资源。

使用说明书（安装手册）参考

2.3.3  系统容量—DSP资源

4.3.3  DSP S卡（KX-NS5110）、DSP M卡（KX-NS5111）、DSP L卡（KX-NS5112）
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使用说明书（PC编程手册）参考

9.2.1  PBX Configuration—[1-1] Configuration—Slot—System Property—Main—V-IPGW–GW Settings–Option
1— IP Codec Priority—1st, 2nd, 3rd
9.2.1  PBX Configuration—[1-1] Configuration—Slot—System Property—Main—Main

→ DSP CODEC G.711 only (SIP extension)
→ DSP CODEC G.711 only (IP-GW)
→ DSP CODEC Priority-1 value only (others)

9.11  PBX Configuration—[1-1] Configuration—Slot—Shelf Property—V-IPGW
→ Voice Codec Priority 1st
→ Voice Codec Priority 2nd
→ Voice Codec Priority 3rd

9.10  PBX Configuration—[1-1] Configuration—Slot—Port Property—V-SIPGW—Voice/FAX— IP Codec
Priority—1st, 2nd, 3rd
9.14  PBX Configuration—[1-1] Configuration—Slot—Port Property—V-IPEXT—Option— IP Codec Priority
9.18  PBX Configuration—[1-1] Configuration—Slot—Port Property—V-IPCS—Option— IP Codec Priority
9.38  PBX Configuration—[1-5] Configuration—DSP Resource

使用说明书（功能手册）参考

2.14.1  会议功能—概要

2.14.2  会议

2.30.2  外播留言（OGM）

3.2  系统和用户功能

3.2.2.30  双向录音/双向转移

3.2.1.4  管理员自动双向录音

5.2.1  IP专用话机（IP-PT）
5.2.2  SIP（会话初始协议）分机
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5.5.4.1  DSP资源储备

说明

可以为特殊功能或服务储备一定数量的资源以保证最低等级的服务。为特殊服务（例如，会议）储备的资源无

法用于另一服务（例如，统一消息）。

例如，有人可能希望为OGM（外播留言）储备资源以确保向来电呼叫播放录制的留言。

可以为以下类型的服务储备资源：

• VoIP（G.711）
• 会议中继线

• 统一消息

• 双向录音

• OGM

注

无需为某功能储备所要使用的资源。正常操作中，基于先到先用原则分配剩余DSP资源。只有在您的系统

需要最低等级的性能时，才储备资源。

例如，为双向录音（® 3.2.1.4  管理员自动双向录音，® 3.2.2.30  双向录音/双向转移）储备资源还会储备

UM端口。即使没有进行任何录音，这仍可能不必要地阻止统一消息系统的接入。因此，只有在必须保证可

以进行双向录音时，才储备双向录音的资源。（® 3.1.1  统一消息系统概述）

资源储备示例

下表所示为必须为给定工作负荷储备的资源数量和类型。为计算剩余（即，未储备）资源的数量，假设使用

DSP M卡（127个DSP资源）。

服务 最低性能*1 每个性能单元的资源 所需DSP资源数

VoIP呼叫（G.711） 40个电话 1 40

统一消息*2 5个操作 1.3 6.5

双向录音 3个录音 2.3 6.9

OGM 10个播放 2 20

会议中继线*3 10个会议 0.5 5

统一消息音*4 2个音 1 2

总储备资源 80.4

剩余资源*5 47

*1 最低性能是指最小数量的同时操作。
*2 统一消息操作包括用户接入其信箱和外线来电者在用户信箱中留下留言等操作。
*3 当DSP Conference Priority设置为Preferential时，将使用DSP。
*4 自动为统一消息音（用于双向录音）储备资源且该资源无法释放。
*5 剩余资源 = DSP容量 - 总储备资源，四舍五入到最近的整数。

如果集团电话资源的储备如上例所示，则保证可以使用满足"最低性能"栏中所列操作数所需的资源。但是，注

意，对于会议电话等操作，除会议中继线本身所需的资源外，每个单独会议方另外还需要DSP资源。因此，如

果全部40个VoIP单元以及所有剩余资源均在使用，则即使有足够的会议资源可用，仍无法建立新的会议电话。
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条件

• 各种DSP卡所提供的资源总数如下：

– DSP S卡：63
– DSP M卡：127
– DSP L卡：254

使用说明书（PC编程手册）参考

9.2.2  PBX Configuration—[1-1] Configuration—Slot—System Property—Site—DSP Conference— DSP 
Conference Priority
9.38  PBX Configuration—[1-5] Configuration—DSP Resource
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5.5.4.2  DSP资源顾问

说明

Web维护控制台提供用于计算给定操作条件所需资源数的工具。Web维护控制台用户可提供给定资源的端口数

量（例如，使用G.729编解码器的16个分机端口）和预期占用负载（例如，50%占线）等信息，并且资源顾问

可计算满足那些条件所需DSP资源的数量。

此工具可以以离线模式使用，模拟各种集团电话配置和占用情况以帮助确定所需DSP卡的尺寸。

此工具还会推荐为各种功能储备何种以及多少资源（® 5.5.4.1  DSP资源储备）。可以从资源顾问工具立即应

用推荐的设定。

可以计算使用以下各种类型的服务和功能的资源占用情况：

服务/功能 每单元DSP资源

使用G.729编解码器的中继线 2.2

使用G.711编解码器的中继线 1

非IP中继线（ISDN中继线、模拟中继线等） 1

使用G.729编解码器的分机 2.2

使用G.711编解码器的分机 1

统一消息*1 1.3

双向录音*1*2 2.3

OGM*1 2

会议中继线*1 0.5

*1 每单元DSP资源数量不包括操作中所涉及分机/中继线的DSP成本。
*2 双向录音还需要会议中继线。有关所需DSP资源的示例，请参阅5.5.4  DSP资源占用。

示例1：小型办公室

在小型办公室（例如，32位雇员）中，所需的中继线和分机数量可能相对较少。此外，系统的预期负载也会较

小。

（为清楚起见，表中不包括未使用的服务。）

服务 端口数 负载（占线率%） DSP成本*1

使用G.729编解码器的中继线 3 5% 0.3

非IP中继线 1 5% 0.05

使用G.729编解码器的分机 32 10% 7.0

统一消息 4 — 5.2

OGM 2 — 4.0

会议 4 — 2.0

总DSP成本 18.55

*1 DSP成本 = 端口数 ´ 每端口（单位）资源成本 ´ 负载
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在上例中，总DSP成本为18.55。在此类环境中，使用带DSP S卡（最多63个DSP资源 ）的集团电话就已足

够。

条件

• 通过P2P（® 5.2.3  对等（P2P）连接）建立的通话不使用集团电话的DSP资源，因此可以从占用资源计

算中排除。

使用说明书（PC编程手册）参考

9.38  PBX Configuration—[1-5] Configuration—DSP Resource
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5.5.5  自动设置

说明

可以使用以下自动设置功能：

1. 时间自动调整

可以用以下两种方式自动调整集团电话时钟：

a. 夏令时（日光节约时间）设定：

可以编程夏令时的开始和结束日期。如果通过系统编程启用，将在编程设定日期的上午2:00调整集团电

话时钟（往前或往后拨一个小时）。这意味着在夏令时开始日期，上午2:00将变成上午3:00，而在结束

日期，上午2:00将变成上午1:00。

注

如果设定定时提醒（唤醒电话）；

– 在夏令时开始日期，上午2:00与上午3:00之间的设定将不会发生。

– 在夏令时结束日期，上午1:00与上午2:00之间的设定将振铃两次。

b. 来自电话公司的时间信息：

可以在以下呼叫上收到时间信息：

• 通过ISDN线路的来电或去电呼叫

• 通过带来电显示（包括时间信息）的模拟线路的来电呼叫。

如果通过系统编程启用，集团电话时钟每天将根据在上午3:05后收到的第一个呼叫进行调整。

注

如果设定定时提醒（唤醒电话），根据调整情况不同，设定将不会发生或会两次振铃。

c. 通过网络时间协议（NTP）的时间信息：

通过将集团电话连接到NTP服务器，可以接收并更新时间设定。

如果通过系统编程启用，集团电话时钟每天将在上午3:05进行调整。

条件

[一般]
• 通过系统编程，可以指定NTP、ISDN或不选择方法作为自动时间调整的所选方法。

• SMDR将使用集团电话时钟记录通话信息，因此记录时间将在夏令时结束时重叠。（® 2.22.1.1  电话通信

详细记录（SMDR））

[NTP时间信息]
• 通过NTP的时间设定会同样应用到所有连接到集团电话的PT，无论IP分机是否位于其它时区。

使用说明书（PC编程手册）参考

10.1.1  PBX Configuration—[2-1-1] System—Date & Time—Date & Time Setting
10.1.2  PBX Configuration—[2-1-2] System—Date & Time—SNTP / Daylight Saving
10.1.2.1  PBX Configuration—[2-1-2] System—Date & Time—SNTP / Daylight Saving—Daylight Saving
27.2.4  Network Service—[2-5] Server Feature—NTP— NTP server
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使用说明书（功能手册）参考

4.1.2.1  综合业务数字网（ISDN）—概要

2.24.4  定时提醒
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5.5.6  动态主机配置协议（DHCP）服务器

说明

集团电话具有内置DHCP服务器。当启用DHCP服务器时，集团电话会自动将IP地址分配至网络上的其他设备，

如IP-PT。
使用DHCP服务器无需手动为设备分配IP地址，简化了网络管理。

条件

• 如果集团电话的IP地址分配模式设为DHCP，则无法使用DHCP服务器功能。

• 如果启用集团电话的DHCP服务器，请确保相同网络上没有其他DHCP服务器正在运行。网络上存在多个

DHCP服务器会导致网络错误。

• 对于以下设定，集团电话会将其LAN端口设定发送至设备：子网掩码、默认网关地址和DNS服务器地址。

使用说明书（PC编程手册）参考

27.2.1  Network Service—[2-1] Server Feature—DHCP
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5.5.7  灵活编号/固定编号

说明

若要拨另一个分机用户或接入集团电话功能，就需要接入号码（分机号码或功能号码）。

有三种编号方案：

1. 灵活编号（在听到拨号音时可用）

2. 灵活编号（在听到忙音、DND音或回铃音时可用）

3. 固定编号（在拨号或通话时可用）

1. 灵活编号（在听到拨号音时可用）

为方便使用，可以定制听到拨号音时可以使用的分机号码和功能号码。这些号码不能有冲突。也可以使用

下表中显示的默认设定。

a. 分机号码：分机号码由前置号码和附加号码组成。可以按如下方式指定分机号码（由"0"至"9"之间的数

字组成）：

• 编号方案：1–64
• 前置号码：最多三位数

• 附加号码：最多两位数（默认：两位数）

b. 功能号码：最多四位数的号码，包括"0"至"9"、" "及"#"

c. 其它集团电话分机号码（其它集团电话分机号码[TIE] - 1至16）：最多3位数的号码，包

括"0"至"9"、" "及"#"

[灵活编号表（在听到拨号音时可用）]

功能 默认

分机编号计划1—前置号码 1 / 2

分机编号计划2—前置号码 2 / 3

分机编号计划3—前置号码 3 / 4

分机编号计划4—前置号码 4 / 1

分机编号计划5–20—前置号码 无

分机编号计划21—前置号码 5

分机编号计划31—前置号码 6

分机编号计划32–64—前置号码 无

话务员呼叫*1 9 / 0

空闲线路接入（市话接入）*1 0 / 1 / 9

中继线群接入*1 8

TIE线路接入*1 7

重拨*1 #

速拨—系统/个人*1
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功能 默认

个人速拨—编程*1 30

门电话呼叫*1 31

会议群呼叫*1 32

群广播*1 33

外部BGM开/关*1 35

外播留言（OGM）播放/录音/清除 36

S-CO线路接入*1 37

简化语音留言接入 38

并联电话（振铃）方式设定/取消 39

群呼叫应答*1 40

直接呼叫接听*1 41

TAFAS—通过外部广播机的呼叫 42

群广播应答*1 43

占线自动回叫取消/CCBS取消 46

用户远程操作/流动COS/验证码输入 47

计费代码输入*1 49

呼叫保留/恢复呼叫保留 50

恢复呼叫保留—以保留分机号码指定*1 51

呼叫寄存/呼叫寄存恢复*1*2 52

恢复呼叫保留—以保留中继线号码指定*1 53

开门*1 55

外部继电器 56

外部功能接入 60

SIP参考（无条件）*3 61

ISDN保留 62

COLR设定/取消*1 7 0

CLIR设定/取消*1 7 1

中继线/分机的CLIP/COLP转换*1 7 2

MCID 7 3

ISDN-FWD设定/取消/确认 7 5
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功能 默认

留言待取设定/取消/回叫 70

FWD/DND设定/取消—两者*1 710

FWD/DND设定/取消—外部*1 711

FWD/DND设定/取消—内部*1 712

FWD/DND无应答定时器设定*1 713

群FWD设定/取消—两者*1 714

群FWD设定/取消—外部*1 715

群FWD设定/取消—内部*1 716

拒绝呼叫接听设定/取消*1 720

拒绝广播设定/取消*1 721

可移动分机/增强的可移动分机 727

数据线路安全设定/取消*1 730

分机呼叫的人工呼叫等待关闭/BSS/OHCA/耳语OHCA*1 731

自动呼叫等待设定/取消*1 732

主管遇忙优先插入拒绝设定/取消*1 733

未准备方式开/关*1 735

注册/注销*1 736

来电队列监听 739

热线编程/设定/取消 740

缺席留言设定/取消*1 750

BGM设定/取消 751

远程唤醒电话 76

定时提醒设定/取消 760

打印留言 761

分机锁定设定/取消*1 77

定时服务开关*1 780

远程分机锁定关闭*1 782

远程分机锁定上锁*1 783

NDSS监听释放 784

中继线忙清除 785
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功能 默认

清除分机功能*1 790

分机个人识别号码（PIN）设定/取消*1 799

拨号信息（CTI） 无

其他集团电话分机号码（TIE）1–16 无

快速拨号*4 无

*1 SIP分机用户可以使用这些功能号码。
*2 通过SIP分机，仅呼叫寄存恢复可以使用此功能号码。
*3 此功能号码用于SIP运营商转移功能。有关详情，请参阅2.12.2  SIP参考转移。
*4 可以注册与其它注册的号码一致的快速拨号号码。这用于将VoIP呼叫自动重新路由至公共中继线功能。

2. 灵活编号（在听到忙音、DND音或回铃音时可用）

为方便使用，可以定制当听到忙音、DND音或回铃音时可以使用的功能号码。这些号码应该是一位数（"0"
至"9"、" "或"#"）并且不能冲突。有关默认值，请参考下表：

[灵活编号表（在听到忙音、DND音或回铃音时可用）]

功能 默认

呼叫等待/免打扰占优插入*1 1或2*2

主管遇忙优先插入*1 3

留言待取设定*1 4

呼叫监听*1 5

占线自动回叫/CCBS 6

交替呼叫—振铃/话音

*1 SIP分机无法执行免打扰占优插入、主管遇忙优先插入、留言待取或呼叫监听，但可以是受话人。
*2 若要使用呼叫等待/免打扰占优插入，默认情况下"1"和"2"均可用。

3. 固定编号（在拨号或通话时可用）

在拨号或通话时可用的功能有固定号码，如下表所示：

[固定编号表（在拨号或通话时可用）]

功能 固定编号

脉冲至音频转换

会议*1 3

开门*2 5

*1 SIP分机无法建立会议，但可以参与。
*2 SIP分机用户可以使用这些功能号码。
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条件

• 所有功能都有一个默认功能号码。

• 下面是功能号码冲突的例子：1和11，0和00，2和21，10和101，32和321等。

• 功能号码+附加号码（参数）

为了使功能生效，一些灵活功能号码需要额外的数字。例如，要设定呼叫等待，必须在"呼叫等待"的功能

号码后面加上"1"，而要取消的话，必须在同一个功能号码后面加上"0"。
• 如果一个功能号码包括" "或"#"，旋转SLT用户就不能使用它。

• ISDN分机用户不能使用以下功能：

– OGM播放/录制

– 呼叫保留/恢复呼叫保留（保留在自己的分机上）

– ISDN保留

– MCID
– 可移动分机

– 呼叫等待

– 热线

– 定时提醒

– 主管遇忙优先插入

– 呼叫监听

– 占线自动回叫/CCBS

使用说明书（PC编程手册）参考

10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main
→Extension
→Features
→Other PBX Extension

10.6.2  PBX Configuration—[2-6-2] System—Numbering Plan—Quick Dial
10.6.3  PBX Configuration—[2-6-3] System—Numbering Plan—B/NA DND Call Feature

使用说明书（PT编程手册）参考

[100]灵活编号

使用说明书（功能手册）参考

3.1.1  统一消息系统概述

6.1  系统资源的容量

使用说明书（用户手册）参考

5.3.1  功能号码表
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5.5.8  浮动分机

说明

可以将虚拟分机号码分配给各种资源，使它们看起来像真实分机一样。此功能也称为浮动分机。

这些号码被定义为浮动分机号码，可以被指定为来电呼叫的目的地等。

资源 说明 默认

设备 外部广播机 用作TAFAS功能的目的地。（® 2.17.2  从任

意用户电话应答中继线上的呼叫（TAFAS））
600或6000*1

外播留言（OGM） 用于为DISA功能发送信息。（® 2.16.1  直接

拨入系统接入（DISA））
5或50 + 两位

数群号码*1

内装简化语音留言

（SVM）

用于接入与分机相关的留言箱。（® 2.16.3  内
装简化语音留言（SVM））

591或5091*1

模拟远程维护 用于通过PC上的调制解调器接入PC编程方

式。
599或5099*1

ISDN远程维护 用于通过PC上的ISDN接口接入PC编程方式。 699或6099*1

群 来电呼叫分配群 用于呼叫一个来电呼叫分配群。（® 2.2.2.1  来
电呼叫分配群功能—概要）

6或60 + 两位

数群号码*1*2

VM（DPT）群 用于呼叫一个VM（DPT）群。 —

VM（DTMF）群 用于呼叫一个VM（DTMF）群。 —

UM群 用于呼叫UM群。 500或5000*1

*1 默认浮动分机号码取决于简易设置中Numbering Plan指定的值。
*2 仅为编号为64以下的群提供默认浮动分机号码。必须分别为群65及更高编号的群设定浮动分机号码。

条件

• 可以给浮动分机号码提供名称。

使用说明书（安装手册）参考

5.4.1  简易设置指示

使用说明书（PC编程手册）参考

10.6.1  PBX Configuration—[2-6-1] System—Numbering Plan—Main—Extension
11.5.1  PBX Configuration—[3-5-1] Group—Incoming Call Distribution Group—Group Settings—Main

→ Floating Extension Number
→ Group Name

11.7.2  PBX Configuration—[3-7-2] Group—UM Group—Unit Settings— Floating Extension No.
13.2  PBX Configuration—[5-2] Optional Device—External Pager— Floating Extension Number

510 使用说明书（功能手册）
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13.3.2  PBX Configuration—[5-3-2] Optional Device—Voice Message—DISA Message— Floating Extension
Number

使用说明书（PT编程手册）参考

[623]来电呼叫分配群名称

[660]UM群浮动分机号码

[700]外部广播机浮动分机号码

[730]外播留言（OGM）浮动分机号码

[731]外播留言（OGM）名称

[811]调制解调器浮动分机号码

[812] ISDN远程浮动分机号码

使用说明书（功能手册）参考

2.28.1  语音信箱（VM）群

3.1.1  统一消息系统概述

5.5.2  PC编程
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5.5.9  软件升级

说明

可以手动或自动更新集团电话的主软件以及其他所连接设备的软件。

• 手动获取更新

通过Web维护控制台可以手动获取软件更新（将更新下载至集团电话）。在此情况下，可以从FTP服务器、

连接至集团电话的USB存储设备、NAS或可以访问Web维护控制台的PC获取软件更新。

• 自动获取更新

集团电话可以自动检查并从FTP服务器下载更新。另外，当有更新可用时和更新已下载时，可以向指定的

电子邮件地址发送通知电子邮件。

另外，可以配置集团电话以自动检查更新，但不下载更新。

可以通过Web维护控制台手动安装更新，或根据设定计划安装。

可以更新以下类型设备和组件的软件：

数据类型 说明

主软件数据 集团电话主板上的操作系统数据区

扩展单元软件数据 扩展单元主板上的操作系统数据区

LPR（插槽卡上的软件）软件数据 位于插槽卡上的闪存ROM（例如：DHLC4）
这包括扩展单元的LPR软件。

IP-PT/SIP分机软件数据*1 所支持IP-PT和SIP分机的固件

*1 仅支持Panasonic电话。有关特定电话的详情，请参阅电话的说明书。

条件

安装以上软件的升级需要SD存储卡（KX-NS3134、KX-NS3135或KX-NS3136）或USB存储器（市售）。

可以通过系统编程确认主板的软件版本。

使用说明书（安装手册）参考

4.3.1  主板

使用说明书（PC编程手册）参考

5.1  System Control—Program Update
9.2.3  PBX Configuration—[1-1] Configuration—Slot—System Property—Slot Summary— Card Type

使用说明书（PT编程手册）参考

[190]主处理（MPR）软件版本参考

512 使用说明书（功能手册）
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5.6  故障恢复/诊断

5.6.1  UPS（不间断电源）集成

说明

不间断电源设备（UPS）是一种在发生电源故障时为所连接设备提供几分钟电源的设备。

条件

• 有关与本集团电话自动关机功能兼容的UPS设备的详情，请咨询经销商。如果连接不兼容的UPS及UPS电
源耗尽，则集团电话会在没有关机的情况下关闭。

• 在断电后恢复供电时，集团电话按以下方式操作：

– 如果集团电话未关机，则继续进行正常操作。

– 如果集团电话已关机且UPS中有剩余电量，则必须手动重新启动集团电话。（必须关闭并重新打开电源

开关）

– 如果集团电话已关机且UPS中没有剩余电量，则集团电话自动启动。（这是因为集团电话的电源打开的

缘故。）

使用说明书（安装手册）参考

4.10  连接外围设备

使用说明书（PC编程手册）参考

4.1.1  Status—Equipment Status—UPS
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5.6.2  电源故障转移

说明

当集团电话发生电源故障时，指定的SLT自动地与指定的中继线连接（电源故障连接）。集团电话将从正常操作

切换为电源故障连接，而且所有现存的通话将被中断。

在电源故障期间，只能使用由电源故障连接处理的中继线。

条件

• 电源故障期间只能打中继线呼叫。所有其它功能不起作用。

• 在电源故障期间连接以下SLT端口和LCOT端口。可以使电源故障期间建立的中继线呼叫得到维持，即使电

源恢复且连接从电源故障连接切换回正常配置。

主机 预装MCSLC16上的端口1和预装LCOT6上的端口1
预装MCSLC16上的端口2和预装LCOT6上的端口2

扩展单元 预装MCSLC16上的端口1-4和预装LCOT6上的端口1-4（如果

装有两张卡，则使用编号小的卡）。

使用说明书（安装手册）参考

4.12  电源故障连接
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5.6.3  电源故障重新启动

说明

当重新接通电源时，集团电话自动重新启动存储的数据，而且集团电话会将事件（系统重新启动）记录在错误

日志中。

条件

• 万一发生电源故障，集团电话存储器受出厂时配备的锂电池保护。除了占线自动回叫（预占线）（®
2.10.1  占线自动回叫（预占线））和呼叫寄存（® 2.13.2  呼叫寄存）的存储数据外，没有任何存储数据丢

失。
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5.6.4  本机告警信息

说明

当集团电话发生错误并且检测到该错误时，分机PT上的系统警报键的灯会呈红色亮起（通过系统编程允许使用

此功能，每台集团电话最多2台分机）。按该键将在显示器上显示错误号码。如果发生多个错误，错误号码将按

最高优先权高低顺序显示。显示完所有错误号码后，系统警报键的灯自动熄灭。

有关错误及其解决方式的详情，请参考使用说明书（安装手册）。

[错误示例]

ERR #100 (00 10000)

(1) (2)

[解释]

示例中的号码 项目 说明

(1) 错误代码 显示3位数错误代码。

(2) 子代码 显示8位数子代码（BBWXYYZZ）。
BB：00
W：槽类型（物理机架：空白，虚拟机架：*）
X：设备号码/非集团电话处理代码

YY：槽号码/处理代码

ZZ：端口号码/处理号码

条件

• 系统警报键

可以将一个灵活键定制为系统警报键。

• 如果通过系统编程启用，将在SMDR上记录警报信息。

• 每天可以在预编程设定的时间自动诊断集团电话。

使用说明书（安装手册）参考

7.1.6  通过错误记录进行故障检修

使用说明书（PC编程手册）参考

7.3.1  Utility—Log—Error Log
12.1.4  PBX Configuration—[4-1-4] Extension—Wired Extension—Flexible Button— Type

516 使用说明书（功能手册）
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19.1  PBX Configuration—[11-1] Maintenance—Main
→SMDR— Print Information—Error Log
→Maintenance— Local Alarm Display—Extension 1, Extension 2
→Maintenance— Daily Test Start Time—Set
→Maintenance— Daily Test Start Time—Hour
→Maintenance— Daily Test Start Time—Minute

使用说明书（功能手册）参考

2.21.2  灵活键

2.22.1.1  电话通信详细记录（SMDR）
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5.6.5  简单网络管理协议（SNMP）系统监听

说明

被指定为SNMP管理员的PC可以使用SNMP来管理和接收集团电话系统状态信息，如警报信息和常规系统活

动。管理信息库（MIB）被发送到通过LAN连接到集团电话的PC（即：SNMP管理员），然后可以使用SNMP管
理员软件来将其存储和分析。

使用SNMP管理信息的2种功能如下所示：

– 查询：

信息的双向处理。查询允许管理员从集团电话请求信息。

PC

– TRAP：
发生状态更改或检测到警报时，集团电话的自动中继信息。

PC

TRAP执行

集团电话会发送两种类型的TRAP，如下所示：

类型 TRAP名称 说明

标准TRAP 冷启动 打开集团电话的电源或复位集团电话后发送信息。

验证失败 输入了未注册的团体名称和/或管理员IP地址时发送信

息。

公司特定的TRAP*1 主要警报 检测到主要警报时发送信息。

次要警报 检测到次要警报时发送信息。

*1 公司特定的TRAP包含集团电话专用的信息（公司特定的MIB）。

条件

• 通过系统编程，可以允许或停用此功能。

• 最多可以指定2个SNMP管理员。
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• 本集团电话支持SNMP协议版本1.0、2.0c和SNMP版本1.0-TRAP。
• 本集团电话仅可以接收只读MIB。不支持写入MIB。
• 本集团电话支持MIB II。
• 有关主要和次要警报的详情，请参考使用说明书（安装手册）。

• 有关本集团电话支持的MIB对象群列表，请参考附录中的6.4  支持的管理信息库（MIB）表。

• 通过系统编程，可以选择是否向SNMP管理员发送每种类型的TRAP（例如：冷启动）。

使用说明书（安装手册）参考

7.1.6  通过错误记录进行故障检修

使用说明书（PC编程手册）参考

27.3.3  Network Service—[3-3] Client Feature—SNMP Agent

使用说明书（功能手册）参考

5.6.4  本机告警信息
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5.6.6  动态主机配置协议（DHCP）指定

说明

可以将本集团电话指定为动态主机配置协议（DHCP）客户端，以允许从LAN上的DHCP服务器接收IP地址。

条件

• 通过系统编程可以允许此功能。

小心

将IP电话注册到集团电话后，一定要设定您的DHCP服务器不更改主板和DSP卡的IP地址。如果更改了这

些IP地址，IP电话将不能正常运行。

使用说明书（PC编程手册）参考

27.1  Network Service—[1] IP Address/Ports—DHCP Server
→ LAN Setting—Obtain an IP address automatically/Use the following IP address
→ LAN Setting—IP Address
→ DSP IP Setting—Obtain DSP IP address automatically/Use the following DSP IP address
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5.6.7  PING确认

说明

本集团电话可以使用PING确认专用网络内部或外部的IP电话、路由器和集线器连接。集团电话会通过PC编程

终端发送互联网控制消息协议（ICMP）回音请求并接收ICMP消息确认连接。

条件

• 本集团电话如下执行PING：

– 测试信息包长度：56字节

– Ping尝试数：5
– 超时长度：1秒
– Ping间隔时间：1秒

使用说明书（PC编程手册）参考

7.1.2  Utility—Diagnosis—Ping
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章节  6
附录

使用说明书（功能手册） 523



6.1  系统资源的容量
系统

项目 容量

缺席留言—分机 1 ´ 16个字符

缺席留言—系统 8 ´ 16个字符

呼叫寄存区 100

会议 每个会议3 – 8方
总共32方（默认）/96方（安装DSP）

COS 64

DID/DDI表 32位数，1000条

分机号码 1–5位数

分机个人识别号码（PIN） 10位数，1条/分机

集团电话主机接入代码 10位数，10条/中继线群

名称的字符数 20

打印留言 8

排队时间表 64

振铃音类型规划 8

同时编程人员

（PT编程）

• 1个系统编程人员 + 63个个人编程人员

• 1个管理员编程人员 + 63个个人编程人员

• 64个个人编程人员

同时编程人员（Web维护控制台） • 一个安装人员级别帐户

• 32个User（用户）和User（管理员）级别帐户

SMDR呼叫存储 1000个呼叫（没有SD卡）/40,000个呼叫（有SD卡）

特殊运营商接入代码 16位数，20条

租户 8

定时服务假日 24

验证代码 4位数，1000条

验证代码个人识别号码（PIN） 10位数，1000条

拨号

项目 容量

紧急呼叫 32位数，10条
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项目 容量

热线 32位数

键盘协议拨号（ISDN服务接入） 32位数

个人速拨 32位数，100条/分机

快速拨号 8位数，4000条

重拨 32位数

系统速拨 32位数，1000条/租户

单键拨号—PT 32位数，

5000条/系统

群

项目 容量

会议群 8（会议群模式有31个成员/群，

广播模式31个成员/群）

用户群 32

呼叫接听群 64

空闲分机搜索群 64（16部分机/群）

来电呼叫分配群 128（128部分机/群）

广播群 32

中继线群 64

UM群 1

VM（DPT）群 2台´ 12个端口（24条信道）

VM（DTMF）群 2个群 ´ 32个信道

P2P群 32

TRS/限制

项目 容量

TRS/限制级 7

TRS/限制拒绝代码 16位数，100条/级

TRS/限制特殊代码 16位数，100条/级
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ARS
项目 容量

路由计划表 48条

前置号码表 16位数，1000条

前置号码特殊表 16位数，200条

ARS运营商 48

分项计费码 10位数

租户的特许码 16位数

中继线群的特许码 10位数

呼叫记录和留言待取

项目 容量

去电呼叫记录—PT 100个记录/分机

1520条记录/系统

来电记录—PT 100个记录/分机

3040条记录/系统

留言待取—PT + SLT 256

语音留言

项目 容量

外播留言（OGM） 64

OGM总录音时间 约20分钟

内装简化语音留言（SVM） 125条留言

SVM总录音时间 120分钟

友好和话费管理功能

项目 容量

客房的计费项目 1000条记录/集团电话（没有SD卡）/10,000条记录/集团电话

（有SD卡）

宾馆话务员 4

费率 7位数，包括小数部分

收费单位 3个货币字符/符号

526 使用说明书（功能手册）

6.1 系统资源的容量



网络

项目 容量

TIE线路路由和修改表 32条

前置号码 3位数

集团电话代码 7位数

NDSS：被监听集团电话 8

NDSS：监听集团电话的已注册分机 250

统一消息

项目 容量

信箱 500个用户信箱

1个系统管理员信箱

1个消息管理员信箱

注

每个信箱类型中可存储的最大录音数为9000。

群发列表 用户：4个群，每个群40位成员

系统：20个群，每个群200位成员

服务群 64条

统一消息端口 24端口

Web维护控制台帐户

项目 容量

Users（用户） 492

Users（管理员） 8个帐户

安装人员 1个帐户

密码（所有帐户类型） 4–16个字符
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6.2  音频/振铃音

6.2.1  音频/振铃音

1

1

2

3

4

1

2

3

4

1

2

DND

5
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15 

1

S-

1 

2

*

1 

*：振铃音的时间长短可能因国家/地区不同而不同。
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6.3  需要激活密钥的功能

功能 需要的激活密钥

来电呼叫分配群中的外线目的地

(® 2.2.2.3  来电呼叫分配群中的外线目的地)
移动分机激活密钥

(KX-NSE101, KX-NSE110)

告知排队状态（等待队列中的呼叫数量/等待队列中的呼叫数

量和估计等待时间）

(®  2.2.2.4  排队功能)

呼叫中心增强功能激活密钥(KX-NSF201)或
队列位置通知激活密钥(KX-NSXF021)

ACD监控功能

(® 2.2.2.10  监控功能（ACD）)
呼叫中心增强功能激活密钥(KX-NSF201)或
内置ACD报表激活密钥(KX-NSXF022)

转送到中继线时并联振铃

(® 2.3.2  呼叫转送（FWD）)
移动分机激活密钥

(KX-NSE101, KX-NSE110)

DISA自动流动COS
(® 2.16.1  直接拨入系统接入（DISA）)

移动分机激活密钥

(KX-NSE101, KX-NSE110)

电脑电话集成（CTI）
(® 2.26.1  电脑电话集成（CTI）)

CTI接口激活密钥

(KX-NSF101)

UM端口扩充

(® 3.1.1  统一消息系统概述)
4通道统一消息激活密钥

(KX-NSU104)

统一消息的计划备份

(® 3.1.2.5  系统备份/恢复)
留言备份激活密钥

(KX-NSU003)

管理员自动双向录音

(® 3.2.1.4  管理员自动双向录音)
双向录音控制激活密钥

(KX-NSU002)

留言待取通知—电子邮件装置

(® 3.2.1.28  留言待取通知—电子邮件装置)
统一消息电子邮件通知激活密钥

(KX-NSU201, KX-NSU210, KX-NSU299)

双向录音/双向转移

(® 3.2.2.30  双向录音/双向转移)
双向录音激活密钥

(KX-NSU301, KX-NSU310, KX-NSU399)

IMAP集成

(® 3.3.1  IMAP集成)
统一消息电子邮件通知激活密钥

(KX-NSU201, KX-NSU210, KX-NSU299)

2个集团电话的公用分机编号

(® 4.3.1.4  2个集团电话的公用分机编号)
QSIG网络激活密钥

(KX-NSN002)

多个集团电话的公用分机编号

(® 4.3.2.2  多个集团电话的公用分机编号)
QSIG网络激活密钥

(KX-NSN002)

QSIG增强功能

(® 4.3.5  QSIG增强功能)
QSIG网络激活密钥

(KX-NSN002)

网络直接分机选择（NDSS）
(® 4.3.5.1  网络直接分机选择（NDSS）)

QSIG网络激活密钥

(KX-NSN002)

集中语音信箱

(® 4.3.5.2  集中语音信箱)
QSIG网络激活密钥

(KX-NSN002)
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功能 需要的激活密钥

网络ICD群

(® 4.3.6  网络ICD群)
移动分机激活密钥

(KX-NSE101, KX-NSE110)
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6.4  支持的管理信息库（MIB）表
系统群（1.3.6.1.2.1.1）

对象ID 项目 说明

1 sysDescr 设备硬件类型和软件版本的信息。

2 sysObjectID 本产品的对象标识符。

3 sysUpTime 系统重新启动后经过的时间。

4 sysContact 设备管理员。

5 sysName 设备名称。

6 sysLocation 设备的安装位置。

7 sysService 支持层。

接口群（1.3.6.1.2.1.2）

对象ID 项目 说明

1 ifNumber 网络设备的数目。

2 IfTable (NA) 每个网络设备的管理表。

2.1 IfEntry (NA) ifTable的组成部分。

2.1.1 ifIndex 每个接口识别器。

2.1.2 ifDescr 接口的解释。

2.1.3 ifType 接口的类型。

2.1.4 ifMtu 可以发送/接收的最大数据报长度。

2.1.5 ifSpeed 最大转移速度。

2.1.6 ifPhysAddress 物理地址（MAC地址）。

2.1.7 ifAdminStatus 接口的所需状态。

2.1.8 ifOperStatus 接口当前的操作状态。

2.1.9 ifLastChange 接口进入其当前操作状态（上或下）时sysUpTime的值。

2.1.10 ifInOctets 接收的八位位组数目。

2.1.11 ifInUcastPkts 传输到更高层协议的单播包数目。

2.1.12 ifInNUcastPkts 传输到更高层协议的非单播包数目。

2.1.14 ifInErrors 含有错误的入站信息包数目。

2.1.15 ifInUnKnownProtos 由于未知/不支持的协议而丢弃的已接收信息包数目。

2.1.16 ifOutOctets 传送的八位位组数目。

2.1.17 ifOutUcastPkts 从上层协议接收的单播包数目。
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对象ID 项目 说明

2.1.18 ifOutNUcastPkts 从上层协议接收的非单播包数目。

2.1.21 ifOutQLen 输出信息包队列的长度（以信息包为单位）。

2.1.22 ifSpecific 相关MIB对象标识符。

IP群（1.3.6.1.2.1.4）

对象ID 项目 说明

1 ipForwarding 表示作为路由器操作可用性的值（无论是否转移了数据报）。

2 ipDefaultTTL IP信息包里TTL的默认值（使用期限）。

3 iplnReceives 接收的信息包总数目（包括错误接收的信息包）。

4 ipnHdrErrors 由于其报头中的错误而丢弃的信息包数目。

5 ipInAddrError 由于目的地IP地址无效而丢弃的信息包数目。

7 ipInUnknownProtos 由于协议未知/不支持而丢弃的信息包数目。

8 ipInDiscards 由于接收缓冲区不足而丢弃收到的信息包数目。

9 ipInDelivers 正常接收的信息包总数目（包括ICMP）。

10 ipOutRequests 尝试传送的IP信息包（ICMP）的总数目（不包括中继信息包）。

13 ipReasmTimeout 在缓冲区内重建分片信息包的最大秒数。

14 ipReasmReqds 从分片状态重建所需要的信息包数目。

15 ipReasmOKs 从分片状态正确重建的信息包数目。

16 ipReasmFails 无法从分片状态正确重建的信息包数目。

17 ipFragOKs 正确分片的信息包数目。

18 ipFragFails 无法正确分片的信息包数目。

19 ipFragCreates 因分片而产生的IP数据报数目。

20 ipAddrTable (NA) 与该实体IP地址相关的地址信息管理表。

20.1 IpAddrEntry (NA) ipAddrTable的组成部分。

20.1.1 IpAdEntAddr IP地址。

20.1.2 IpAdEntIfindex 分配到IP地址的接口的索引值。

20.1.3 IpAdEntNetMask 与IP地址有关的子网掩码。

20.1.4 ipAdEntBcastAddr 与IP地址有关的广播通信地址值。

20.1.5 IpAdEntReasmMax-
Size

可以通过IP地址发送/接收的最大IP数据报大小。
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ICMP群（1.3.6.1.2.1.5）

对象ID 项目 说明

1 cmpInMsgs 接收的ICMP信息总数目（不包括错误接收的信息）。

2 icmpInErrors 接收的包含错误的ICMP信息总数目。

8 icmpInEchos 接收的ICMP回音请求信息总数目。

9 icmpInEchoReps 接收的ICMP回音应答信息总数目。

14 icmpOutMsgs 发送的ICMP信息数目。

15 icmpOutErrors 由于错误而未发送的ICMP信息数目。

21 icmpOutEchos 发送的ICMP回音请求信息数目。

22 icmpOutEchoReps 发送的ICMP回音回复信息数目。

TCP群（1.3.6.1.2.1.6）

对象ID 项目 说明

1 tcpRtoAlgorithm 响应未被承认时用来确定重新传送时间的算法。

2 tcpRtoMin 重新传送超时允许的最小值（以毫秒为单位）。

3 tcpRtoMax 重新传送超时允许的最大值（以毫秒为单位）。

4 tcpMaxConn 可支持的TCP连接最大数目。

5 tcpActiveOpens 主动开放的TCP连接总数目。

6 tcpPassiveOpens 被动开放的TCP连接总数目。

7 tcpAttemptFails 连接错误的总数目。

8 tcpEstabResets 复位的总数目。

10 tcpInSegs 接收的段的总数目。

11 tcpOutSegs 发送的段的总数目。

12 tcpRetransSegs 重新传送的段的总数目。

14 tcpInErrs 错误接收的段的总数目。

15 tcpOutRsts 发送的带RST标记（复位连接）的TCP段的总数目。

UDP群（1.3.6.1.2.7）

对象ID 项目 说明

1 udpInDatagrams 接收的UDP数据报总数目。

2 udpNoPorts 接收的在目的地端口无应用程序的UDP数据报总数目。

3 udpInError 接收的包含错误的UDP数据报总数目。

4 udpOutDatagrams 发送的UDP数据报总数目。
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SNMP群（1.3.6.1.2.1.11）

对象ID 项目 说明

1 snmpInPkts 接收的SNMP消息总数目。

2 snmpOutPkts 发送的SNMP消息总数目。

3 snmpInBadVersions 接收的不支持版本的SNMP消息总数目。

4 snmpInBadCommuni-
tyNames

带有未知团体名称的SNMP消息总数目。

6 snmpInASNParseErrs 带有错误OID类型的SNMP消息总数目。

13 snmpInTotalReqVars 已被成功检索值的对象总数目。

15 snmpInGetRequests 已接受并处理的Get-Request总数目（例如：使用snmpget/
snmpwalk命令提取的数据）。

16 snmpInGetNexts 已接受并处理的Get-Next总数目（用于使用snmpwalk命令跟随层树

时）。

20 snmpOutTooBigs 返回"TooBig"错误信息的已发送SNMP消息总数目。

21 snmpOutNoSuch-
Names

返回"NoSuchName"错误信息的已发送SNMP消息总数目。

24 snmpOutGenErrs 返回"GenErr"错误信息的已发送SNMP消息总数目。

28 snmpOutGetRespon-
ses

发送的GetResponse总数目。

29 snmpOutTraps 发送的TRAP总数目。

30 snmpEnableAuthen-
Traps

表示是否允许SNMP网管代理进程产生认证失败陷阱。
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6.5  修订记录

6.5.1  PFMPR软件文件版本004.21xxx
新增内容

• 2.1.1.4  多个用户号码（MSN）振铃服务

• 2.2.2.5  分配顺序

• 2.24.3.3  可移动分机-初始位置控制

• 4.1.1.1  SIP服务器故障转移

• 4.1.1.2  直接SIP连接

• 4.2  一体化网络

• 5.2.2.2  Panasonic SIP电话（P-SIP）
• 5.4.4  管理员的电子邮件通知

变更的内容

• 引言—功能限制

• 缩写列表

• 2.1.1.1  中继线呼叫来电功能—概要

• 2.1.1.2  外线直接到分机振铃的功能（DIL）
• 2.1.1.3  直接向内拨号（DID）/直接拨入（DDI）
• 2.1.1.5  呼叫线路识别（CLI）分配

• 2.1.3.2  振铃音类型选择

• 2.1.3.3  呼叫等待

• 2.2.2.6  贵宾电话

• 2.2.2.8  注册/注销

• 2.2.2.9  监控功能

• 2.2.2.10  监控功能（ACD）

• 2.3.2  呼叫转送（FWD）

• 2.3.4  呼叫转送/免打扰键，群FWD键

• 2.4.3  呼叫接听

• 2.5.2  分机自动释放

• 2.5.4.2  紧急呼叫

• 2.5.5.3  中继线接入

• 2.6.3  最后号码重拨

• 2.6.4  速拨—个人/系统

• 2.6.5  快速拨号

• 2.7.2  预算管理

• 2.7.5  流动COS
• 2.10.1  占线自动回叫（预占线）

• 2.10.2  主管遇忙优先插入

• 2.10.3  呼叫监听

• 2.10.4.3  摘机呼叫通知（OHCA）
• 2.11.4  头戴式耳机操作

• 2.11.8  中继线呼叫限制
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• 2.11.10  并联电话

• 2.11.11  一个编号分机

• 2.13.4  待机音乐

• 2.14.1  会议功能—概要

• 2.17.1  广播

• 2.17.2  从任意用户电话应答中继线上的呼叫（TAFAS）
• 2.18.1  门电话呼叫

• 2.18.2  开门

• 2.18.3  外部传感器

• 2.18.4  外部继电器控制

• 2.19.1  来电显示

• 2.19.2  来电记录

• 2.21.2  灵活键

• 2.21.4  显示信息

• 2.22.1  记录日志功能

• 2.23.1  友好功能—概要

• 2.23.2  房间状态控制

• 2.23.3  客房呼叫计费

• 2.28.1  语音信箱（VM）群

• 2.30.1  背景音乐（BGM）

• 3.1.1  统一消息系统概述

• 3.1.2.5  系统备份/恢复

• 3.2.1.4  管理员自动双向录音

• 3.2.2.16  现场呼叫屏蔽（LCS）
• 4.1.2.1  综合业务数字网（ISDN）—概要

• 4.1.2.2  呼叫/连接线路识别显示（CLIP/COLP）
• 4.1.2.3  话费通知（AOC）

• 4.1.2.4  呼叫转送（CF）—用ISDN（P-MP）
• 4.1.2.5  呼叫转送（CF）—用ISDN（P-P）
• 4.1.2.8  三方会议（3PTY）－用ISDN
• 4.1.2.10  完成对占线用户的呼叫（CCBS）
• 4.3.1  TIE线路业务

• 4.3.1.3  TIE线路编程

• 4.3.3  ISDN虚拟专用网（ISDN-VPN）

• 4.3.4.2  呼叫/连接线路识别显示（CLIP/COLP）和呼叫/连接姓名识别显示（CNIP/CONP）—用QSIG
• 4.3.4.3  呼叫转送（CF）—用QSIG
• 4.3.4.4  呼叫转移（CT）—用QSIG
• 4.3.4.5  完成对占线用户的呼叫（CCBS）—用QSIG
• 4.3.5.1  网络直接分机选择（NDSS）
• 4.3.5.2  集中语音信箱

• 5.1.1  服务等级（COS）
• 5.1.2  群
• 5.1.3  租户业务

• 5.1.4  定时服务

• 5.2.2  SIP（会话初始协议）分机

• 5.2.2.1  简易远程连接
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• 5.2.3  对等（P2P）连接

• 5.2.5  ISDN分机功能

• 5.4.1  分机用户的电子邮件通知

• 5.4.3  传感器警报的电子邮件通知

• 5.5.1  用户配置文件

• 5.5.4  DSP资源占用

• 5.5.5  自动设置

• 5.5.9  软件升级

• 6.1  系统资源的容量

6.5.2  PFMPR软件文件版本004.4xxxx
变更的内容

• 引言—功能限制

• 2.2.2.4  排队功能

• 2.2.2.10  监控功能（ACD）

• 3.2.2.8  回叫号码输入

• 5.5.4.1  DSP资源储备

• 6.3  需要激活密钥的功能
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